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1. Εισαγωγή και εγκατάσταση του GstarCAD 2025 
 
 

1.1. GstarCAD 2025 Εισαγωγή 

 
Το GstarCAD 2025 ανεβάζει τις επιδόσεις σε νέο επίπεδο με την επιτάχυνση υλικού και άλλες βελτιώσεις σε μια σειρά 

χαρακτηριστικών, που βελτιώνουν σημαντικά την εμπειρία του σχεδιασμού. Συναρπαστικές νέες λειτουργίες, όπως οι 

παραμετρικοί περιορισμοί, η επεξεργασία δεδομένων BIM και ο φωνητικός σχολιασμός κ.λπ. εμπλουτίζουν περαιτέρω τη 

λειτουργικότητα. Επιπλέον, η συμβατότητα έχει επεκταθεί με την προσθήκη υποστήριξης Python, δίνοντας τη δυνατότητα πιο 

ισχυρής προσαρμογής και αυτοματοποίησης. Χωρίς άλλη καθυστέρηση, ας εξερευνήσουμε αυτές τις συναρπαστικές ενημερώσεις! 

 
1.2. Απαιτήσεις συστήματος 

 
Πριν εγκαταστήσετε το GstarCAD, βεβαιωθείτε ότι οι προδιαγραφές του υπολογιστή σας πληρούν τις ακόλουθες απαιτήσεις: 

 
⚫  OS (λειτουργικό σύστημα) Windows 11 

Windows 10 έκδοση 1507 ή νεότερη: Σπίτι, Επαγγελματίας, Εκπαίδευση και Επιχείρηση (δεν υποστηρίζονται τα LTSC και τα 

Windows 10 S) 

Windows 8.1 (με την ενημέρωση 2919355): Enterprise 

Windows 7 SP1 (με τις τελευταίες ενημερώσεις των Windows): Windows Server 2016: Home Premium, 

Professional, Enterprise, Ultimate: Datacenter 

Windows Server 2019: Standard και Datacenter 

Windows Server 2022: Essentials, Standard, Datacenter 

 
Σημείωση: Επειδή το GstarCAD και τα σχετικά εργαλεία αναπτύσσονται και μεταγλωττίζονται με το visual studio 2017, για να 

διασφαλιστεί η κανονική λειτουργία του λογισμικού, το λειτουργικό σύστημα πρέπει να μπορεί να εγκαταστήσει κανονικά 

το πακέτο περιβάλλοντος του visual studio 2017. 

 

⚫  CPU 

Επεξεργαστής 1,6 GHz (συνιστάται επεξεργαστής πολλαπλών πυρήνων 2 GHz ή ταχύτερος) 

 

⚫  RAM 

2GB (συνιστάται 8GB ή περισσότερο) 

 

⚫  Κάρτα γραφικών 

GPU 1 GB (συνιστάται GPU 2 GB ή μεγαλύτερη) 

 

⚫  Σκληρός δίσκος 

Το σύστημα και ο δίσκος εγκατάστασης χρειάζονται περισσότερο από 1 GB χώρο. (συνιστώνται 10 GB ή περισσότερο) 

Για τη βελτίωση των επιδόσεων, συνιστάται η εγκατάσταση και αποθήκευση του λογισμικού σε μονάδα δίσκου στερεάς κατάστασης (SSD). 

 

⚫  Ανάλυση οθόνης 

1024*800 ή παραπάνω- το GstarCAD θα λειτουργήσει καλύτερα σε ανάλυση HD και 4K. 
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⚫  Πρόσθετη απαίτηση 

Για την εγκατάσταση του GstarCAD και των εργαλείων αδειοδότησης απαιτούνται δικαιώματα διαχειριστή. 

.NET Framework 4.8 ή ανώτερο (μόνο για την ανάπτυξη προσαρμοσμένου λογισμικού). 

Ο διακομιστής αδειών δικτύου και όλοι οι σταθμοί εργασίας που εκτελούν εφαρμογές που βασίζονται σε άδειες δικτύου 

πρέπει να υποστηρίζουν το πρωτόκολλο TCP/IP. 

 
1.3. Εγκατάσταση του GstarCAD 2025 

 
Οι χρήστες μπορούν να επισκεφθούν τη διεύθυνση www.gstarcad.net για να κατεβάσουν το GstarCAD 2025 στον υπολογιστή ή 

τον διακομιστή σας. 

 
Ο Οδηγός εγκατάστασης του GstarCAD 2025 θα καθοδηγήσει τον χρήστη να εγκαταστήσει το λογισμικό στο λειτουργικό σύστημα 

πλήρως και με επιτυχία. Παρακαλούμε ακολουθήστε τα παρακάτω βήματα για να εγκαταστήσετε το GstarCAD 2025: 

 

1. Κάντε διπλό κλικ στο εκτελέσιμο αρχείο που κατεβάσατε και θα εμφανιστεί το παράθυρο διαλόγου Οδηγός εγκατάστασης του GstarCAD. 
 

 

http://www.gstarcad.net/
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2. Κάντε κλικ στο κουμπί Αναζήτηση   και επιλέξτε τη διαδρομή προορισμού όπου η εγκατάσταση θα εγκαταστήσει τα αρχεία. 
 

3. Κάντε κλικ στο κουμπί Οδηγός εγκατάστασης του GstarCAD > Επιλογές, οι χρήστες μπορούν να επιλέξουν ή να 

αποεπιλέξουν τη λειτουργία VBA ανάλογα με τις ανάγκες σας. Μπορείτε επίσης να διαβάσετε τις απαιτήσεις 

συστήματος και τον τρόπο ενεργοποίησης του GstarCAD. 
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4. Διαβάστε τη Συμφωνία άδειας χρήσης και την Πολιτική απορρήτου και επιλέξτε Συμφωνώ με τη Συμφωνία άδειας χρήσης 

και την Πολιτική απορρήτου της Gstarsoft. 

 

 
 

 
5. Κάντε κλικ στο κουμπί Install (Εγκατάσταση) για να συνεχίσετε την εγκατάσταση. 
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6. Απλά πρέπει να περιμένετε μερικά λεπτά για τη συνολική πρόοδο. 
 

 
 
 

 
7. Στη συνέχεια, θα εμφανιστεί το παράθυρο επιλογής χώρου εργασίας. Επιλέξτε τον αγαπημένο σας χώρο εργασίας και κάντε 

κλικ στο κουμπί Επόμενο. 
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8. Κάντε κλικ στο κουμπί Finish για να βγείτε από τον οδηγό. Ο οδηγός του GstarCAD εγκατέστησε με επιτυχία το GstarCAD 2025. 

 



Κεφάλαιο2_Έναρξη λειτουργίας του GstarCAD 2025 
 

Σ ε λ ί δ α  4 | 296 
 

 
 

2. Εκκίνηση του GstarCAD 2025 
 

 
2.1. Η διεπαφή χρήστη 

 
Μπορείτε να απολαύσετε την εργασία σας στο περιβάλλον της GstarCAD 2025 με διάφορους τρόπους. Μπορείτε να 

εμφανίσετε και να αναδιατάξετε στοιχεία όπως οι γραμμές εργαλείων, να εμφανίσετε τη γραμμή εντολών, να αλλάξετε 

μεταξύ χώρων εργασίας, να αλλάξετε τα θέματα του περιβάλλοντος εργασίας και να ενεργοποιήσετε τη γραμμή κατάστασης. 

Οι γραμμές εργαλείων και η γραμμή εντολών μπορούν επίσης να αιωρούνται οπουδήποτε στην οθόνη ή να είναι 

επίσης προσαρτημένες. 

 
 
 
 
 
 

 
12 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
2.1.1. Γραμμή εργαλείων γρήγορης πρόσβασης 

 
Εμφάνιση των συχνά χρησιμοποιούμενων εργαλείων όπως: Αποθήκευση, Αναίρεση, Επανάληψη, Αποθήκευση ως, Διάγραμμα, 

Προεπισκόπηση διαγράμματος και Βοήθεια. Επιπλέον, μπορείτε να το προσαρμόσετε (προσθέτοντας περισσότερες εντολές από 

το αναπτυσσόμενο κουμπί) ή να το εμφανίσετε κάτω/πάνω από την κορδέλα. 

 

1 2 3 

4 
5 
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2.1.2. Χώρος εργασίας 

 
2.1.2.1. Εναλλαγή χώρου εργασίας 

 

Εναλλαγή μεταξύ χώρων εργασίας (2D Drafting και GstarCAD Classic). Επιπλέον, το GstarCAD 2025 παρέχει πολλά χρωματικά 

θέματα, όπως GstarCAD, Lightblue, Blue, Black, Sliver και Aqua, μπορείτε να επιλέξετε το αγαπημένο σας χρωματικό θέμα 

άμεσα. 
 

 
2.1.2.2. Εντολή χώρου εργασίας 

 

Η εντολή WORKSPACE σας επιτρέπει να δημιουργείτε, να τροποποιείτε και να αποθηκεύετε τρέχοντες χώρους εργασίας. 

Μπορείτε να προσαρμόσετε την κορδέλα του GstarCAD ή τον κλασικό χώρο εργασίας ώστε να ταιριάζει στις ανάγκες του 

περιβάλλοντος διεπαφής πολύ πιο εύκολα. 

 
Οι χώροι εργασίας είναι σύνολα μενού, γραμμές εργαλείων, παλέτες και πίνακες ελέγχου κορδέλας που είναι ομαδοποιημένα και 

οργανωμένα έτσι ώστε να μπορείτε να εργάζεστε σε ένα προσαρμοσμένο, προσανατολισμένο στις εργασίες περιβάλλον 

σχεδίασης. Όταν χρησιμοποιείτε ένα χώρο εργασίας, εμφανίζονται μόνο τα μενού, οι γραμμές εργαλείων και οι παλέτες που είναι 

σχετικά με μια εργασία. Επιπλέον, ένας χώρος εργασίας μπορεί να εμφανίζει αυτόματα την κορδέλα, μια ειδική παλέτα με 

πίνακες ελέγχου για συγκεκριμένες εργασίες. Μπορείτε να εναλλάσσεστε εύκολα μεταξύ χώρων εργασίας. Οι ακόλουθοι 

χώροι εργασίας βάσει εργασιών έχουν ήδη οριστεί στο GstarCAD: 2D Drafting και GstarCAD Classic. 
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Εάν εκτελέσετε την εντολή WORKSPACE, εμφανίζονται οι ακόλουθες προτροπές: 

 
Set Current: Ορίζει έναν τρέχοντα χώρο εργασίας. 

Αποθήκευση ως: Αποθηκεύει μια τρέχουσα διαμόρφωση διασύνδεσης ως χώρο εργασίας. 

 
Επεξεργασία: Ανοίγει το παράθυρο διαλόγου Προσαρμογή διεπαφής χρήστη, καρτέλα Προσαρμογή, όπου μπορείτε να κάνετε 

τροποποιήσεις σε ένα χώρο εργασίας. 
 

 

 
Μετονομασία: Μετονομάζει ένα χώρο 

εργασίας. Διαγραφή: Διαγράφει 

έναν χώρο εργασίας. 

Ρυθμίσεις: Ανοίγει το παράθυρο διαλόγου Ρυθμίσεις χώρου εργασίας, το οποίο 

ελέγχει την εμφάνιση, τη σειρά των μενού και τις ρυθμίσεις Αποθήκευση ενός 

χώρου εργασίας. 
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2.1.3.1. Μενού και μενού συντομεύσεων 

 
2.1.3. Γραμμή μενού 

 
Η γραμμή μενού χρησιμοποιείται για την επιλογή εντολών με το ποντίκι αντί για την εισαγωγή εντολών με το πληκτρολόγιο. 

Σε αυτήν μπορείτε να βρείτε τις ακόλουθες καρτέλες μενού: File, Edit, View, Insert, Format, Tools, Draw, Text, Dimension, 

Modify, Window, Application, Help, Express and Collaboration. 

 
 

Μπορείτε να χρησιμοποιήσετε οποιαδήποτε από τις επιλογές στα μενού από τη 

γραμμή μενού στο επάνω μέρος της περιοχής σχεδίασης. Επιλέξτε μία από τις 

παρακάτω μεθόδους για να χρησιμοποιήσετε ένα μενού: - Στη γραμμή μενού, 

κάντε κλικ σε ένα όνομα μενού για να επιλέξετε το μενού ή για να επεκτείνετε 

μια λίστα επιλογών. 

Πατήστε Alt και το πλήκτρο για το υπογραμμισμένο γράμμα στο όνομα του 

μενού για να ανοίξετε την αντίστοιχη λίστα στοιχείων μενού και, στη συνέχεια, 

επιλέξτε στοιχεία μενού από αυτήν. Για παράδειγμα, για να επεξεργαστείτε το 

αρχείο σχεδίασης, πατήστε <Alt+E> για να ανοίξετε το μενού 

Επεξεργασία. 

 

 
Τα μενού συντόμευσης παρέχουν γρήγορη πρόσβαση σε συγκεκριμένες εντολές. Ένα μενού συντόμευσης εμφανίζεται όταν 

κάνετε δεξί κλικ σε ένα αντικείμενο, στη γραμμή κατάστασης, στο όνομα της καρτέλας Μοντέλο ή σε ένα όνομα καρτέλας 

Διάταξη. Οι επιλογές που παρουσιάζονται στο μενού συντόμευσης εξαρτώνται από το τι κάνατε κλικ. 
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2.1.3.2. Προσαρμογή συντομεύσεων 

 

Ένας ταχύτερος τρόπος για την κλήση μιας εντολής είναι η 

προσαρμογή της συντόμευσής της. Η εντολή CUSTACC σας 

επιτρέπει να προσαρμόσετε, να διαγράψετε ή να 

τροποποιήσετε τις υπάρχουσες συντομεύσεις εντολών. Για να 

αποκτήσετε πρόσβαση σε αυτήν την εντολή, μεταβείτε στη γραμμή 

μενού, στην ενότητα εργαλεία, επιλέξτε Προσαρμογή και επιλέξτε 

Προσαρμογή συντομεύσεων. Μετά από αυτό, θα εμφανιστεί το 

παράθυρο προσαρμογής συντόμευσης. Όπως μπορείτε να δείτε, 

υπάρχει μια λίστα με εντολές συντομεύσεων που μπορείτε 

εύκολα να τροποποιήσετε, να διαγράψετε ή ακόμη και να 

δημιουργήσετε μια νέα εντολή πάνω σε μια υπάρχουσα. 
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Πίνα
κας 

Κα
ρτέ
λα 

Επεκτάσιμο πάνελ Επεκτάσιμο κουμπί 
εργαλείων 

 
 

 

 
Αν θέλετε να δημιουργήσετε μια νέα, απλώς κάντε κλικ στο κουμπί New και 

θα εμφανιστεί το παράθυρο εντολών προσαρμογής. Στη συνέχεια, 

μπορείτε να αναζητήσετε την εντολή ή να επιλέξετε μία από τη λίστα 

εντολών. Για παράδειγμα, μπορείτε να εισαγάγετε "γραμμή εντολών" και στη 

συνέχεια να επιλέξετε τη ζητούμενη εντολή. Παρατηρήστε ότι θα 

εμφανιστούν οι ιδιότητες της εντολής επιλέγοντας τη ζητούμενη εντολή 

στη δεξιά πλευρά του παραθύρου. Αφού επιλέξετε την εντολή, πατήστε 

OK. 

 
Στη συνέχεια, θα εμφανιστεί το παράθυρο ορισμού συντόμευσης. Μπορείτε 

να εισαγάγετε τη λέξη-κλειδί που επιθυμείτε. Για παράδειγμα, μπορείτε να 

ορίσετε τις συντομεύσεις SHIFT+D. Εάν θέλετε να διαγράψετε μια 

δημιουργημένη εντολή συντόμευσης, επικαλεστείτε την εντολή CUSTACC και στη 

συνέχεια επιλέξτε το κουμπί διαγραφής από το παράθυρο Προσαρμογή 

συντόμευσης. 
 

2.1.4. Η κορδέλα 

 
Η κορδέλα αποτελείται από διάφορους πίνακες, οι οποίοι είναι οργανωμένοι σε κάθε καρτέλα σύμφωνα με την ετικέτα 

εργασίας τους. Τα εργαλεία και τα στοιχεία ελέγχου σε κάθε πίνακα είναι επίσης διαθέσιμα σε γραμμές εργαλείων και 

πλαίσια διαλόγου. 

 
 
 

 
Καρτέλα: Η κορδέλα είναι δομημένη με καρτέλες. 

Κάθε καρτέλα εμφανίζει μια σειρά από πίνακες με 

τα δικά της εργαλεία (εντολές ή μικρογραφίες) που 

είναι πιο εύκολο να επιλέξετε ή να διαλέξετε. 
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Πάνελ: Ο πίνακας εμφανίζει τα εργαλεία που 

χρησιμοποιούνται περισσότερο. Ορισμένες 

μικρογραφίες έχουν ένα κουμπί εργαλείων με 

δυνατότητα επέκτασης που μπορεί να επεκταθεί 

με μια μέθοδο drop-down. Επιπλέον, οι 

περισσότεροι πίνακες στην αρχική καρτέλα έχουν 

έναν επεκτάσιμο πίνακα που εμφανίζει 

περισσότερες εντολές που σχετίζονται με 

αυτούς. 
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Επεκτάσιμος πίνακας: Ο επεκτάσιμος πίνακας βρίσκεται στο κάτω μέρος του πίνακα. Αν κάνετε κλικ στο 

κάτω μέρος του πίνακα, θα εμφανιστούν περισσότερες σχετικές εντολές. 

 
Επεκτάσιμο κουμπί εργαλείων: Ορισμένες μικρογραφίες 

(εργαλεία ή εντολές στον πίνακα) διαθέτουν ένα επεκτάσιμο 

κουμπί εργαλείων που μπορεί να επεκταθεί με μια 

αναπτυσσόμενη μέθοδο. Εάν κάνετε κλικ σε αυτό το κουμπί, θα 

εμφανιστούν όλα τα σχετικά εργαλεία. 

 
2.1.5. Εμφάνιση 

 
Μπορείτε να διαχειριστείτε το θέμα του περιβάλλοντος εργασίας καθώς και να εμφανίσετε/εμφανίσετε γραμμές εργαλείων, 

γραμμή μενού, καρτέλες αρχείων και γραμμή κατάστασης. 

 

2.1.6. Περιοχή σχεδίασης 
 
Τα σχέδιά σας εμφανίζονται στο παράθυρο σχεδίασης. 
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2.1.7. Γραμμές εργαλείων 

 
Οι γραμμές εργαλείων περιέχουν εν μέρει κουμπιά που ξεκινούν εντολές. Όταν μετακινείτε το ποντίκι ή τη συσκευή υπόδειξης 

πάνω από ένα κουμπί της γραμμής εργαλείων, η συμβουλή εργαλείων εμφανίζει το όνομα του κουμπιού. 

 

 

 

 

 

 

 
Η Βασική γραμμή εργαλείων στο επάνω μέρος της περιοχής σχεδίασης περιέχει συχνά χρησιμοποιούμενες εντολές, όπως 

Αντιγραφή Μετατόπιση και Ζουμ, καθώς και τις τυπικές εντολές του Microsoft Office, όπως Νέα, Άνοιγμα και Αποθήκευση. 

Ο κλασικός χώρος εργασίας του GstarCAD 2025 εμφανίζει αρχικά αρκετές γραμμές εργαλείων από προεπιλογή: 

 
- Γραμμή εργαλείων σχεδίασης 

- Γραμμή εργαλείων εντολής σχεδίασης 

- Τροποποίηση της γραμμής εργαλείων 

- Γραμμή εργαλείων ιδιοτήτων 

- Γραμμή εργαλείων επιπέδου 

- Γραμμή εργαλείων στυλ 

- Τυπική γραμμή εργαλείων 

 
2.1.7.1. Εμφάνιση και απόκρυψη γραμμών εργαλείων 

 

Το GstarCAD 2025 παρέχει πολλές γραμμές εργαλείων, τις οποίες μπορείτε να εμφανίσετε ή να αποκρύψετε τόσο στο κλασικό 

περιβάλλον εργασίας όσο και στην κορδέλα. Μπορείτε επίσης να μετακινήσετε και να συνδέσετε τις γραμμές εργαλείων. 

Για να επιλέξετε ποιες γραμμές εργαλείων θα εμφανιστούν: 

 
1.- Εκτελέστε την εντολή TOOLBAR ή επιλέξτε την επιλογή TOOLBARS από την αναπτυσσόμενη λίστα στο κουμπί Εμφάνιση (στο 

επάνω δεξί μέρος του περιβάλλοντος εργασίας) για να ανοίξετε το παράθυρο διαλόγου Γραμμή εργαλείων. 

 
2.- Επιλέξτε τις γραμμές εργαλείων που θέλετε να αποκρύψετε ή να εμφανίσετε, τσεκάροντας/ακυρώνοντας τα μικρά πλαίσια στο 
πλαίσιο διαλόγου και, στη συνέχεια, κάντε κλικ στο κουμπί OK. 
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Για να κάνετε μια οριζόντια ελλιμενισμένη γραμμή 

εργαλείων να αιωρείται, απλά κάντε κλικ και κρατήστε 

πατημένο το αριστερό μέρος της και σύρετε γύρω από το 

σημείο που χρειάζεστε. 

 
Για να κάνετε μια κατακόρυφη ελλιμενισμένη γραμμή εργαλείων, απλά κάντε κλικ και κρατήστε πατημένο το 

στην κορυφή του και σύρετε γύρω του. Για να προσαρτήσετε οποιαδήποτε γραμμή εργαλείων,  

απλώς κάντε διπλό κλικ στην αριστερή πλευρά της. 
 
 
 

 
2.1.7.2. Εκκίνηση εντολών με χρήση γραμμών εργαλείων 

 

Για να ξεκινήσετε μια εντολή από μια γραμμή 

εργαλείων, κάντε κλικ σε ένα κουμπί εντολής και 

απαντήστε στις οδηγίες. 

 
2.1.8. Σύστημα συντεταγμένων χρήστη (UCS) 

 
Το εικονίδιο υποδεικνύει τον προσανατολισμό του σχεδίου στον δισδιάστατο χώρο. 

 

 
2.1.9. Καρτέλες Model Space και Layout Space 

 
Κάντε κλικ σε μια καρτέλα για να μεταβείτε μεταξύ του σχεδίου του μοντέλου σας και μιας εκτυπωμένης διάταξης. 
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2.1.10. Παράθυρο εντολών 

 
Η γραμμή εντολών είναι ένα παράθυρο με δυνατότητα πρόσδεσης στο οποίο μπορείτε να πληκτρολογείτε εντολές και να 

βλέπετε προτροπές και άλλα μηνύματα του προγράμματος. Μπορείτε να μετακινήσετε τη γραμμή εντολών σύροντάς την. 

 
Όταν η γραμμή εντολών είναι κυμαινόμενη, μπορείτε να σύρετε την κορυφή ή το κάτω μέρος του παραθύρου για να αλλάξετε 

τον αριθμό των γραμμών κειμένου που εμφανίζει. Μπορείτε να αγκιστρώσετε τη γραμμή εντολών στο επάνω ή στο κάτω 

μέρος του σχεδίου. 
 

 

 
2.1.10.1. Εισαγωγή εντολών στη γραμμή εντολών 

 

Πληκτρολογήστε την πλήρη εντολή στη γραμμή εντολών και πατήστε 

ENTER ή SPACEBAR ή κάντε δεξί κλικ στη συσκευή επισήμανσης για να 

εκκινήσετε την εντολή. Ορισμένες εντολές έχουν επίσης συντομευμένα 

ονόματα (ψευδώνυμα). 

 
2.1.10.2. Καθορισμός επιλογών εντολής 

 

Μόλις εισαγάγετε μια εντολή στη γραμμή εντολών, 

εμφανίζεται ένα σύνολο επιλογών ή ένα παράθυρο διαλόγου. 

Για να επιλέξετε μια διαφορετική επιλογή, πληκτρολογήστε μια 

από τις επιλογές στις παρενθέσεις (είναι εντάξει οποιοδήποτε 

κεφαλαίο ή πεζό γράμμα) και, στη συνέχεια, πατήστε ENTER ή 

SPACEBA. 

 
2.1.10.3. Εντολές εκτέλεσης, επανάληψης και ακύρωσης 

 

Για να εκτελέσετε εντολές, πατήστε το πλήκτρο διαστήματος ή το ENTER ή κάντε δεξί κλικ στη συσκευή υπόδειξης όταν 

τα ονόματα των εντολών έχουν εισαχθεί ή ανταποκρίνονται στις υποδείξεις. Εάν θέλετε να επαναλάβετε μια εντολή που 

μόλις χρησιμοποιήσατε, πατήστε ENTER ή SPACEBAR. Για να ακυρώσετε μια εντολή που βρίσκεται σε εξέλιξη, 

πατήστε ESC. 

 
2.1.10.4. Ενσωμάτωση μιας εντολής 

 

Για να χρησιμοποιήσετε μια εντολή μέσα σε μια ενεργή εντολή, πληκτρολογήστε μια απόστροφο πριν πληκτρολογήσετε την 

εντολή. Για παράδειγμα, ενεργοποιείτε τη δυνατότητα σύλληψης αντικειμένου ενώ σχεδιάζετε έναν κύκλο, επομένως 

μπορείτε να ρυθμίσετε τη δυνατότητα σύλληψης αντικειμένου πριν συνεχίσετε το σχέδιο. 
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Εντολή: circle>Ορισμός κεντρικού σημείου για κύκλο ή [3P/2P/Ttr (ακτίνα 

tan tan)]: 'osnap 

 
 

(Ρυθμίστε τη λειτουργία σύσφιξης αντικειμένου ως Κέντρο στο διάλογο 

Ρυθμίσεις σχεδίου και, στη συνέχεια, κλείστε το διάλογο για να 

συνεχίσετε την εκτέλεση της εντολής CIRCLE) 
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2.1.10.5. Εισαγωγή μεταβλητών συστήματος στη γραμμή εντολών 

 

Οι μεταβλητές συστήματος είναι διαθέσιμες για 

τον έλεγχο του τρόπου λειτουργίας 

ορισμένων εντολών. Για παράδειγμα, η 

GRIDMODE χρησιμοποιείται για τον έλεγχο 

της κατάστασης του δικτύου ON ή OFF. 

 
2.1.10.6. Χρήση του παραθύρου κειμένου του GstarCAD 

 

Το παράθυρο κειμένου του GstarCAD εμφανίζει ένα 

ιστορικό των εντολών και των προτροπών που έχουν 

δοθεί από τότε που ξεκινήσατε την τρέχουσα 

συνεδρία του GstarCAD. 

 
Για να εμφανίσετε ή να κλείσετε το παράθυρο κειμένου  
του GstarCAD πατήστε F2. 

 
Για να προβάλετε καταχωρήσεις στο παράθυρο κειμένου 

του GstarCAD, απλά σύρετε τις μπάρες κύλισης ή 

χρησιμοποιήστε τα βέλη Πάνω (↑) και Κάτω (↓) για να 

εμφανίσετε τις εντολές που χρησιμοποιήθηκαν 

προηγουμένως. 

 
2.1.10.7. Εναλλαγή πλαισίων διαλόγου και γραμμής εντολών 

 

Αν πληκτρολογήσετε LINETYPE στη γραμμή εντολών, θα εμφανιστεί το παράθυρο διαλόγου Διαχείριση γραμμοτύπων. 

Η εισαγωγή -LINETYPE στη γραμμή εντολών εμφανίζει τις αντίστοιχες επιλογές της γραμμής εντολών. Οι παρακάτω 

μεταβλητές συστήματος επηρεάζουν ε π ί σ η ς  την εμφάνιση των πλαισίων διαλόγου: 

 
-ATTDIA ελέγχει αν η INSERT χρησιμοποιεί παράθυρο διαλόγου για την εισαγωγή τιμών χαρακτηριστικών. 

-EXPERT ελέγχει εάν εμφανίζονται ορισμένα παράθυρα διαλόγου προειδοποίησης. 

-FILEDIA ελέγχει την εμφάνιση των παραθύρων διαλόγου που χρησιμοποιούνται με εντολές που διαβάζουν και γράφουν 

αρχεία. Για παράδειγμα, εάν η τιμή FILEDIA έχει οριστεί σε 1, η εντολή OPEN εμφανίζει το πλαίσιο διαλόγου Άνοιγμα 

σχεδίου ως. Εάν το FILEDIA έχει οριστεί σε 0, το OPEN εμφανίζει προτροπές στη γραμμή εντολών. Ακόμα και όταν ορίζετε 

FILEDIA σε 0, μπορείτε να εμφανίσετε ένα πλαίσιο διαλόγου αρχείου εισάγοντας ένα tilde (~) στην πρώτη προτροπή. 
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2.1.10.8. Δυναμική είσοδος 

 

Το πλαίσιο "Δυναμική εισαγωγή" είναι ένα κυμαινόμενο 

παράθυρο που εμφανίζεται κοντά στο δρομέα του σταυρού. 

Παρέχει μια βολική μέθοδο για τους χρήστες να εισάγουν 

δυναμικά εντολές ή μεταβλητές συστήματος και να 

εμφανίζουν τις πληροφορίες του δείκτη. Πληκτρολογήστε μια 

εντολή χρησιμοποιώντας τη δυναμική είσοδο, θα εμφανιστεί 

μια λίστα με όλες τις εντολές των οποίων το πρόθεμα 

ταιριάζει με αυτό που πληκτρολογήσατε καθώς και θα 

εμφανιστούν όλα τα εικονίδια τους διευκολύνοντας την 

αναγνώρισή τους με μια ματιά. Όταν δημιουργείτε και 

επεξεργάζεστε αντικείμενα, η δυναμική διάσταση μπορεί να 

σας καθοδηγήσει να σχεδιάσετε με ακρίβεια. Επιπλέον, η 

δυναμική είσοδος εμφανίζει όλες τις επιλογές μιας εντολής 

και θα μπορούσε να τις επιλέξει με διαφορετικές μεθόδους. 

 
Το GstarCAD 2025 υποστηρίζει τις λειτουργίες εισαγωγής διαστάσεων, κατακόρυφης λίστας δυναμικών υποδείξεων και 

ανεξάρτητων πλαισίων εισαγωγής δείκτη,  παρέχει ευκολότερη εμπειρία χρήσης και βελτιώνει την αποδοτικότητα του 

σχεδιασμού. 
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⚫  Ανεξάρτητα πλαίσια εισαγωγής δείκτη 

Τα πλαίσια εισαγωγής δείκτη για το μήκος, τη γωνία και τις συντεταγμένες κ.λπ. εμφανίζονται ανεξάρτητα, καθιστώντας πιο 

βολικό για τους χρήστες να εισάγουν διαφορετικές τιμές με απλή εναλλαγή μεταξύ των πλαισίων χρησιμοποιώντας το 

πλήκτρο TAB. 

 
⚫  Εισαγωγή δυναμικής διάστασης 

Κατά τη δημιουργία και την επεξεργασία αντικειμένων, δεδομένα όπως μήκος, γωνία, ακτίνα κ.λπ. εμφανίζονται με τη μορφή 

διαστάσεων, οι οποίες μεταβάλλονται δυναμικά καθώς κινείται ο δρομέας του ποντικιού. Με τη βοήθεια των 

ανεξάρτητων πλαισίων εισαγωγής δείκτη, οι χρήστες είναι πλέον σε θέση να εισάγουν δεδομένα διαστάσεων και να 

εκτελούν πιο αποτελεσματικά τις εργασίες σχεδίασης. 

 

 
⚫  Κάθετη δυναμική λίστα προτροπών 

Η δυναμική λίστα υποδείξεων εμφανίζεται πλέον κάθετα από προεπιλογή στο GstarCAD 2025, γεγονός που επιτρέπει 

στους χρήστες να βλέπουν όλες τις υποδείξεις ταυτόχρονα, απλοποιώντας τις εργασίες σχεδίασης. Η οριζόντια λίστα 

υποδείξεων θα μπορούσε ακόμα να ενεργοποιηθεί με τη χρήση της μεταβλητής συστήματος DYNLISTSTYLE. 
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το εικονίδιο της γραμμής κατάστασης, αποεπιλέξτε την 

επιλογή "Χρήση εικονιδίου" και θα έχετε μια άλλη μέθοδο 

εμφάνισης της γραμμής κατάστασης. 

 
2.1.11. Γραμμή κατάστασης 

 
Εμφάνιση πληροφοριών όπως οι τρέχουσες συντεταγμένες του δρομέα, 

Snap, Grid, Ortho, Polar, Osnap, Otrack και άλλες ρυθμίσεις. Εκτός από 

την εμφάνιση πληροφοριών, η γραμμή κατάστασης είναι ένας γρήγορος 

τρόπος πρόσβασης σε πολλές λειτουργίες. Μπορείτε να κάνετε κλικ σε 

στοιχεία της γραμμής κατάστασης για να πραγματοποιήσετε αλλαγές 

και να κάνετε δεξί κλικ σε στοιχεία για να εμφανίσετε μενού 

συντομεύσεων που σας επιτρέπουν περισσότερες επιλογές. Από 

προεπιλογή, η γραμμή κατάστασης εμφανίζεται όπως στην παρακάτω 

εικόνα: 

 
 

 
Το εικονίδιο της γραμμής κατάστασης μπορεί επίσης να εμφανιστεί ως κουμπί κειμένου, κάντε δεξί κλικ σε ένα από τα 

 
2.1.12. Παλέτα ιδιοτήτων 

 
Μπορείτε να τροποποιήσετε την τιμή ή τις ιδιότητες των αντικειμένων που επιθυμείτε σε κάθε στήλη. Η παλέτα Ιδιότητες 

εμφανίζει όλες τις ιδιότητες του καθορισμένου αντικειμένου. Όταν επιλέγετε πολλαπλά αντικείμενα, η παλέτα Ιδιότητες 

εμφανίζει τις ιδιότητες εντολών των επιλεγμένων αντικειμένων. Εάν κανένα από τα αντικείμενα δεν είναι επιλεγμένο, η παλέτα 

Ιδιότητες εμφανίζει τις γενικές ιδιότητες του τρέχοντος επιπέδου, τις ιδιότητες προβολής καθώς και τις πληροφορίες UCS. Από 

προεπιλογή, με διπλό κλικ σε ένα αντικείμενο ανοίγει η παλέτα Ιδιότητες, εάν η παλέτα Ιδιότητες είναι κρυμμένη. Αυτή η 

λειτουργία δεν είναι διαθέσιμη όταν τα αντικείμενα είναι μπλοκ, μοτίβο οριζοντιογραφίας, κείμενο, πολυγραμμή, εξωτερική 

αναφορά ή γέμισμα διαβάθμισης. 
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Το GstarCAD υποστηρίζει επίσης τις Γρήγορες ιδιότητες, οι 

οποίες είναι ένα σύνολο ιδιοτήτων αντικειμένων που 

εμφανίζονται μέσω της παλέτας ιδιοτήτων. Μπορείτε να 

προσαρμόσετε τις δικές σας Γρήγορες Ιδιότητες- μπορείτε να 

αποφασίσετε να εμφανίσετε τον τύπο αντικειμένου που 

προτιμάτε με επιλεγμένες ιδιότητες αντικειμένου για να 

εξοικονομήσετε τον περιορισμένο χώρο σχεδίασης. Μπορείτε να 

ορίσετε τις ιδιότητες των αντικειμένων που θα εμφανίζονται 

στις γρήγορες ιδιότητες από το CUI. 

 

 
Ρυθμίσεις παλέτας: 

Μπορείτε να κάνετε κλικ στο κουμπί Ιδιότητες ή να κάνετε δεξί κλικ στη γραμμή τίτλου της παλέτας ή του παραθύρου για να 

ενεργοποιήσετε την Αγκύρωση αριστερά/δεξιά, την Αυτόματη απόκρυψη (υπάρχει ένα κουμπί Αυτόματης απόκρυψης στη 

γραμμή τίτλου) ή να ρυθμίσετε τη διαφάνεια των κυμαινόμενων παλετών ή παραθύρων. 
 

Άγκυρα Αριστερά<: Αγκυροβολεί ένα παράθυρο ή μια παλέτα με δυνατότητα πρόσδεσης στα αριστερά της περιοχής 

σχεδίασης. Όταν ο δρομέας μετακινείται πάνω του, η αγκυρωμένη παλέτα ή το παράθυρο εμφανίζεται με πλήρη αδιαφάνεια, 

ενώ όταν ο δρομέας απομακρύνεται, αποκρύπτεται αυτόματα. Επίσης, όταν ένα αγκυρωμένο παράθυρο είναι ανοιχτό, το 

περιεχόμενό του επικαλύπτει την περιοχή σχεδίασης. 

Άγκυρα Δεξιά>: Αγκυροβολεί ένα παράθυρο ή μια παλέτα με δυνατότητα πρόσδεσης στα δεξιά της περιοχής σχεδίασης. 

Όταν ο δρομέας μετακινείται πάνω του, η αγκυρωμένη παλέτα ή το παράθυρο εμφανίζεται με πλήρη αδιαφάνεια, ενώ όταν ο 

δρομέας απομακρύνεται, αποκρύπτεται αυτόματα. Επίσης, όταν ένα αγκυρωμένο παράθυρο είναι ανοιχτό, το 

περιεχόμενό του επικαλύπτει την περιοχή σχεδίασης. 

Αυτόματη απόκρυψη: Ένα κυμαινόμενο παράθυρο ανοίγει και κλείνει καθώς ο δρομέας μετακινείται σε αυτό. Όταν αυτή η 

επιλογή είναι απενεργοποιημένη, το παράθυρο παραμένει ανοιχτό. 

Διαφάνεια: Ρυθμίζει το επίπεδο διαφάνειας για το παράθυρο και κατά το 

πέρασμα του ποντικιού. 
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• Πόσο διαφανής πρέπει να είναι η παλέτα: Ορίζει τη διαφάνεια μιας 

παλέτας ενώ ο δρομέας απομακρύνεται από την παλέτα. Ελέγχεται επίσης από 

τη μεταβλητή συστήματος GLOBALOPACITY. 

• Πόσο διαφανής θα πρέπει να είναι η παλέτα κατά το mouse-

over: Ορίζει τη διαφάνεια μιας παλέτας ενώ ο δρομέας κινείται πάνω 

στην παλέτα. Ελέγχεται επίσης από τη μεταβλητή συστήματος 

ROLLOVEROPACITY. 

 

 

• Κάντε κλικ στο κουμπί Προεπισκόπηση: Πατήστε το κουμπί, εμφανίζει τη διαφάνεια της 

παλέτας ενώ ο δρομέας απομακρύνεται από την παλέτα, αφήστε το κουμπί, εμφανίζει τη διαφάνεια μιας παλέτας ενώ ο 

δρομέας κινείται στην παλέτα. 

 
 

• Εφαρμόστε αυτές τις ρυθμίσεις σε όλες τις παλέτες: Εφαρμόζει τις ρυθμίσεις διαφάνειας σε όλες τις παλέτες. Ελέγχεται 
επίσης από την επιλογή 

Μεταβλητή συστήματος APPLYGLOBALOPACITIES. 

 
• Απενεργοποίηση της διαφάνειας όλων των παραθύρων(global): Ελέγχει αν οι παλέτες μπορούν να ρυθμίσουν τη 

διαφάνεια. Ελέγχεται επίσης από τη μεταβλητή συστήματος PALETTEOPAQUE. 

 
2.1.13. NAVICUBE 

 
Ο κύβος NaviCube είναι ένα εργαλείο πλοήγησης που εμφανίζεται όταν εργάζεστε σε χώρο μοντέλου 2D ή σε 

τρισδιάστατο οπτικό στυλ, το οποίο επιτρέπει την ευκολότερη εναλλαγή μεταξύ τυπικής και ισομετρικής προβολής. 

Αποτελείται από έναν κύβο, πυξίδα και επιλογές, μπορεί να μετακινηθεί και να κάνει κλικ και υποστηρίζει την εναλλαγή σε 

οποιαδήποτε διαθέσιμη προκαθορισμένη προβολή, την κύλιση της τρέχουσας προβολής ή τον ορισμό της τρέχουσας προβολής 

ως αρχικής προβολής. 

Μπορείτε να εισαγάγετε την εντολή NAVICUBE ή να κάνετε κλικ στην Κορδέλα  Προβολή  Εργαλείο 3D  NaviCube για να 

ελέγξετε αν θα εμφανίζεται ο κύβος NaviCube στην περιοχή σχεδίασης. Όταν η τιμή είναι ON, ο κύβος NaviCube 

εμφανίζεται, όταν η τιμή είναι OFF, ο κύβος NaviCube εξαφανίζεται. 
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Εμφάνιση του κύβου NaviCube: Ο κύβος NaviCube εμφανίζεται σε μία από 

τις δύο καταστάσεις: ανενεργός και ενεργός. Όταν ο δρομέας δεν 

αγγίζει το 

NaviCube, είναι ανενεργό, εμφανίζεται μερικώς διαφανές από 

προεπιλογή, ώστε να μην επισκιάζει την προβολή του μοντέλου. Όταν 

μετακινείτε τον κέρσορα πάνω του, γίνεται ενεργός, είναι αδιαφανής, 

οπότε η προβολή των αντικειμένων στην τρέχουσα προβολή του 

μοντέλου ενδέχεται να επισκιάζεται. Και μπορείτε να έχετε και 

άλλες ιδιότητες του NaviCube μέσα από την επιλογή Ρυθμίσεις. 

 
 

 
Κύβος: Βρίσκεται στις επάνω δεξιές γωνίες 

της περιοχής σχεδίασης πάνω από το 

μοντέλο και δείχνει την τρέχουσα οπτική 

γωνία του μοντέλου. Όταν μετακινείτε τον 

κέρσορα πάνω του, μπορείτε να κάνετε κλικ 

στις επιφάνειες, τις γωνίες ή τις ακμές για να 

αλλάξετε τις προβολές με ευκολία, καθώς και 

να κάνετε κλικ στον κύβο και να τον σύρετε 

για να μετακινήσετε την τρέχουσα προβολή. 
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Πυξίδα: Η πυξίδα εμφανίζεται κάτω από τον κύβο 

NaviCube και υποδεικνύει τη βόρεια κατεύθυνση που έχει 

οριστεί για το μοντέλο. Μπορείτε να κάνετε κλικ σε 

οποιοδήποτε από τα γράμματα κατεύθυνσης στην 

πυξίδα για να περιστρέψετε το μοντέλο. 

 
 
 
 
 

 
Όταν η προβολή είναι "Μπροστά" "Πίσω" "Αριστερά" ή "Δεξιά", θα εμφανιστούν μερικά μικρά τριγωνικά κουμπιά γύρω από 

τον κύβο, τα οποία σας επιτρέπουν να αλλάζετε μεταξύ γειτονικών προβολών κάνοντας κλικ σε αυτά. 

 
⮚  Όταν κάνετε κλικ στο τριγωνικό κουμπί στη δεξιά ή αριστερή πλευρά, η προβολή αλλάζει στη δεξιά ή αριστερή 

παρακείμενη προβολή. Έτσι, μπορείτε 

μπορείτε να εναλλάσσεστε συνεχώς μεταξύ διαφορετικών προβολών και να περιστρέφετε τον κύβο πλοήγησης 

οριζόντια κάνοντας κλικ σε αυτά τα δύο κουμπιά. 
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⮚  Όταν κάνετε κλικ στο τριγωνικό κουμπί στην επάνω ή στην κάτω πλευρά, η 

προβολή αλλάζει σε προβολή από πάνω ή από κάτω. Τα τριγωνικά κουμπιά πάνω 

και κάτω μπορούν να πατηθούν μόνο μία φορά. 

 
 
 

 
⮚  Όταν κάνετε κλικ στο κουμπί τρίγωνο στις γωνίες, η προβολή αλλάζει σε προβολή 

ακμών δύο γειτονικών προβολών. Τα κουμπιά τριγώνου στις γωνίες μπορούν 

να πατηθούν μόνο μία φορά. 

 
 

 

 
Μενού επιλογών: 

⮚  Σπίτι: Αλλαγές στην προβολή Home 

⮚  Ρυθμίσεις NaviCube: Ανοίγει το παράθυρο ρυθμίσεων NaviCube 

• Στην οθόνη: Προσδιορίζει το σημείο στο παράθυρο προβολής όπου εμφανίζεται ο κύβος NaviCube. 

 
• Μέγεθος Navicube: Καθορίζει το μέγεθος του NaviCube. 

 
• Ανενεργό Αδιαφάνεια: Ελέγχει την αδιαφάνεια του NaviCube όταν είναι ανενεργό. 

 
• Εμφάνιση μενού UCS: Ελέγχει την εμφάνιση του πτυσσόμενου μενού UCS. 

 
• Μεγέθυνση σε εκτάσεις μετά την αλλαγή προβολής: Καθορίζει εάν το μοντέλο αναγκάζεται να προσαρμοστεί στο τρέχον παράθυρο 

προβολής μετά από αλλαγή προβολής. 

 
• Προσανατολισμός του Navicube στο τρέχον UCS: Ελέγχει αν ο κύβος NaviCube αντικατοπτρίζει το τρέχον USC ή WCS. 

 
• Εμφάνιση πυξίδας κάτω από το Navicube: Ελέγχει αν η πυξίδα εμφανίζεται κάτω από το εργαλείο NaviCube. 

 
• Επαναφορά προεπιλογής: Επαναφορά των ρυθμίσεων του NaviCube στις προεπιλεγμένες τιμές. 

⮚  Τρισδιάστατες προβολές: Εμφανίζει τη λίστα ελέγχου προβολής. 

⮚  Συντονισμένο σύστημα: Συντεταγμένο σύστημα: Ελέγχει το σύστημα συντεταγμένων. 

⮚  Ανάποδα: Αλλάζει στην πλευρά προβολής που είναι παράλληλη με την τρέχουσα πλευρά προβολής. 

⮚  90°C δεξιόστροφα: Περιστρέφει 90 μοίρες δεξιόστροφα. 

⮚  90°C αριστερόστροφα: Περιστρέφεται κατά 90 μοίρες αριστερόστροφα. 
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Μενού δεξί κλικ: 

⮚  Σπίτι: Επιστρέφει στην αρχική προβολή 

⮚  Ορισμός τρέχουσας προβολής ως αρχικής προβολής: 

Καθορίζει την τρέχουσα προβολή ως αρχική προβολή. 

⮚  Ρυθμίσεις NaviCube: Ανοίγει το παράθυρο ρυθμίσεων NaviCube. 

⮚  Βοήθεια: -Εντολές - N - 

Εντολή NAVICUBE. 
 
 
 
 

 
2.1.14. Επιλογή Lasso 

 

 
Η επιλογή Lasso σάς επιτρέπει να δημιουργήσετε ένα ακανόνιστου σχήματος παράθυρο ή ένα σύνολο επιλογής 

διασταύρωσης. Η εφαρμογή της επιλογής lasso μπορεί όχι μόνο να αντικαταστήσει την επιλογή πλαισίου για την επιλογή 

απλών αντικειμένων, αλλά και να λύσει το πρόβλημα της δύσκολης επιλογής ορισμένων πολύπλοκων αντικειμένων με τη 

χρήση της επιλογής πλαισίου. 

Για να χρησιμοποιήσετε την επιλογή λάσο, απλά κρατήστε πατημένο το κουμπί του ποντικιού ενώ σύρετε το ποντίκι για να 

δημιουργήσετε το λάσο. Όταν απελευθερώσετε το κουμπί του ποντικιού, το λάσο ολοκληρώνεται. 

2.1.14.1. Τρόποι επιλογής Lasso 

 

Η επιλογή Lasso παρέχει τρεις λειτουργίες: Μπορείτε να πατήσετε το πλήκτρο διαστήματος για να μετακινηθείτε 

μεταξύ των τρόπων λειτουργίας του λάσο. 

⮚  Επιλογή Lasso παραθύρου: Κρατήστε πατημένο το κουμπί του ποντικιού και σύρετε το ποντίκι από αριστερά προς τα δεξιά, μόνο τα 

αντικείμενα που είναι  που περικλείονται πλήρως στην περιοχή επιλογής επιλέγονται. 
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⮚  Επιλογή διασταυρούμενου λάσο: Επιλέγονται τα αντικείμενα που περικλείονται και διασχίζουν την περιοχή επιλογής. 

⮚  Επιλογή Lasso φράχτη: Τα αντικείμενα που περνούν μέσα από τον φράχτη θα επιλεγούν. 

 

 
2.1.14.2. Μεταβλητή συστήματος Συμβατότητα 

 

Το GstarCAD βελτιστοποιεί τη μεταβλητή συστήματος PICKAUTO ώστε να είναι συνεπής με το ACAD. 
 

Μεταβλητή 
συστήματος 

Περιγραφή Αξία Αξία Περιγραφή 

 
 
 
 

 
PICKAUTO 

 

 
Χρησιμοποιείται σε συνδυασμό με 

την επιλογή lasso για τον έλεγχο της 

αυτόματης παραθυροποίησης για 

την επιλογή αντικειμένων. Αυτή η 

μεταβλητή συστήματος 

χρησιμοποιείται επίσης για τον έλεγχο 

του ανοίγματος και του κλεισίματος 

του λάσο. 

-7 ~ 

-1 
 

 
0 

 

 
1 

Επιλέγει ένα αντικείμενο κάνοντας 

κλικ. Αποθηκεύει μόνο την τιμή και 

η τιμή δεν τίθεται σε ισχύ. 

Επιλέγει ένα αντικείμενο 

κάνοντας κλικ. Απενεργοποιεί την 

αυτόματη επιλογή παραθύρων και 

διασταυρώσεων. 

Ξεκινάει ένα παράθυρο ή μια 

επιλογή διασταύρωσης εάν ο 

δρομέας δεν είναι απευθείας 

πάνω από ένα αντικείμενο όταν 
κάνετε κλικ, 
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Επιλέγει ένα αντικείμενο απευθείας 
με 

κάνοντας κλικ εάν ο δρομέας 

βρίσκεται στο αντικείμενο, η 

επιλογή ολοκληρώνεται. 

 
2 

Ξεκινά ένα παράθυρο ή μια διάβαση 

επιλογή ακόμη και αν ο δρομέας 

βρίσκεται ακριβώς πάνω από ένα 

αντικείμενο. 
 
 
 

 
4 

Ξεκινά μια επιλογή παραθύρου ή 

διασταυρούμενου λάσο, εάν ο 

δρομέας δεν βρίσκεται ακριβώς 

πάνω από ένα αντικείμενο όταν 

κάνετε κλικ, 

Επιλέγει ένα αντικείμενο 

απευθείας με κλικ και σύρσιμο, 

εάν ο δρομέας βρίσκεται πάνω 

στο αντικείμενο, επιλογή 

ολοκληρωμένη. 

Σημείωση: Για να καθορίσετε περισσότερες από μία επιλογές, πληκτρολογήστε το άθροισμα των τιμών τους. Για παράδειγμα, 

η εισαγωγή 5 καθορίζει τις επιλογές bitcode 1 και 4. 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
Περίληψη: 

⮚  Όταν η τιμή του PICKAUTO είναι 0, τα αντικείμενα μπορούν να επιλεγούν μόνο με κλικ. 

⮚  Όταν η τιμή είναι 1, 2 ή 3, πρόκειται για επιλογή παραθύρου. 

⮚  Όταν η τιμή είναι 4, 5, 6 ή 7, πρόκειται για την επιλογή παραθύρου και την επιλογή διασταυρούμενου λάσο (Για να καθορίσετε μια περιοχή 
επιλογής παραθύρου, 

κάντε κλικ και αφήστε το αριστερό κουμπί του ποντικιού, μετακινήστε τον κέρσορα και κάντε ξανά κλικ για να 

ολοκληρώσετε- Για να δημιουργήσετε μια επιλογή λάσο, κάντε κλικ, σύρετε και, στη συνέχεια, αφήστε το αριστερό 

κουμπί του ποντικιού για να ολοκληρώσετε). 

Αξία 
Περιγραφή 

3 Ο συνδυασμός του bitcode 1 και του bitcode 2 που έχει το ίδιο αποτέλεσμα με τον 
bitcode 2 

5 Ο συνδυασμός του bitcode 1 και του bitcode 4 που έχει το ίδιο αποτέλεσμα με τον 
bitcode 4 

6 Ο συνδυασμός των bitcode 2 και bitcode 4 

7 Ο συνδυασμός των bitcode 1, 2 και 3 που έχει το ίδιο αποτέλεσμα με τον bitcode 6 
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2.2. Προσαρμογή του περιβάλλοντος σχεδίασης 

 
Στο GstarCAD 2025, υπάρχουν διάφορα στοιχεία του περιβάλλοντος εργασίας που μπορούν να προσαρμοστούν στις ανάγκες σας. 

 
2.2.1. Ορισμός επιλογών διασύνδεσης 

 
Στο πλαίσιο διαλόγου Επιλογές, μπορείτε να αλλάξετε πολλές από τις ρυθμίσεις που επηρεάζουν το περιβάλλον εργασίας και το περιβάλλον 
σχεδίασης. 

 

 
2.2.2. Ρυθμίσεις τροποποίησης της διεπαφής 

 
Αυτόματη αποθήκευση (καρτέλα Άνοιγμα και αποθήκευση): Αποθήκευση του σχεδίου σας σε καθορισμένα χρονικά 

διαστήματα. Για να χρησιμοποιήσετε αυτήν την επιλογή, στο πλαίσιο διαλόγου Options (Επιλογές), καρτέλα Open and Save 

(Άνοιγμα και αποθήκευση), επιλέξτε Automatic Save (Αυτόματη αποθήκευση) και εισαγάγετε το διάστημα σε λεπτά. 



Κεφάλαιο2_Έναρξη λειτουργίας του GstarCAD 2025 
 

Σ ε λ ί δ α  29 | 296 
 

 
 

Χρώμα (καρτέλα Εμφάνιση): Καθορίστε τα χρώματα φόντου που χρησιμοποιούνται στις καρτέλες Διάταξη και Μοντέλο και 

το χρώμα που χρησιμοποιείται για τις προτροπές και το σταυρόνημα. 

Γραμματοσειρά (καρτέλα Εμφάνιση): Αλλαγή των γραμματοσειρών που χρησιμοποιούνται στο παράθυρο και στο παράθυρο 

κειμένου. Αυτή η ρύθμιση δεν επηρεάζει το κείμενο στα σχέδιά σας. 

 
Διαδρομή αναζήτησης (καρτέλα Αρχεία): Ορίστε τη διαδρομή αναζήτησης για την εύρεση αρχείων υποστήριξης σχεδίασης, 

όπως γραμματοσειρές κειμένου, σχέδια, τύποι γραμμών και μοτίβα διαγράμμισης. 

 
 

 

 
2.2.3. Αποθήκευση και επαναφορά προφίλ 

 
Είναι δυνατή η δημιουργία προφίλ για διαφορετικούς χρήστες ή έργα και η κοινή χρήση προφίλ με την εισαγωγή και 

εξαγωγή αρχείων προφίλ. Από προεπιλογή, οι τρέχουσες επιλογές σας αποθηκεύονται σε ένα προφίλ με το όνομα Default 

(Προεπιλογή). Το τρέχον όνομα προφίλ, καθώς και το τρέχον όνομα σχεδίου, εμφανίζονται στο πλαίσιο διαλόγου 

Options (Επιλογές). 

 
Το GstarCAD 2025 αποθηκεύει τις πληροφορίες προφίλ στο μητρώο του συστήματος και τις αποθηκεύει ως αρχείο κειμένου 

(αρχείο ARG), ενώ οργανώνει επίσης τα βασικά δεδομένα και διατηρεί τις αλλαγές στο μητρώο, όπως απαιτείται. Εάν κάνετε 

αλλαγές στο τρέχον προφίλ σας κατά τη διάρκεια μιας συνεδρίας και θέλετε να αποθηκεύσετε αυτές τις αλλαγές στο αρχείο 

ARG, πρέπει να εξάγετε το προφίλ. Όταν εξάγετε το προφίλ με το όνομα του τρέχοντος προφίλ, το GstarCAD ενημερώνει το 

αρχείο ARG με τις νέες ρυθμίσεις. Μπορείτε να επαναφέρετε το προφίλ για να ενημερώσετε τη ρύθμιση του προφίλ σας 
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2.2.3.1. Εντολή MOVEBAK 

 

Η νέα εντολή MOVEBAK αλλάζει το φάκελο προορισμού για τα αρχεία αντιγράφων ασφαλείας σχεδίασης (BAK). Μόλις 
καθορίσετε μια διαδρομή, η εντολή 

τα αρχεία BAK του σχεδίου τοποθετούνται σε αυτή τη διαδρομή μετά 

από κάθε αποθήκευση. Εισάγετε νέα τιμή για το MOVEBAK, ή για 

κανένα <τρέχουσα ρύθμιση>: 

Πληκτρολογήστε ένα . (τελεία) για κανένα ή πληκτρολογήστε το όνομα του φακέλου. 

 
Εάν πληκτρολογήσετε ".", το όνομα του φακέλου MOVEBAK διαγράφεται και νέα αρχεία BAK θα δημιουργηθούν στον αρχικό φάκελο. 

 
 

 
2.3. Προσαρμογή διεπαφής χρήστη 

 
Προσαρμογή Drag & Drop: Αυτό είναι εφικτό με την ενέργεια drag and drop, που σημαίνει ότι οι χρήστες μπορούν να 

σύρουν οποιαδήποτε εντολή από τη λίστα εντολών και να την αφήσουν σε στοιχεία του χώρου εργασίας, όπως οι πίνακες 

κορδέλας και οι γραμμές εργαλείων που είναι ορατές στην επάνω δεξιά γωνία του πλαισίου διαλόγου CUI. Οι χρήστες δεν 

θα έχουν περιορισμούς για να τοποθετήσουν οπουδήποτε ή ακόμη και να τακτοποιήσουν μια προτιμώμενη εντολή σε ένα 

πάνελ ή μια γραμμή εργαλείων. Η προσαρμογή του UI δεν ήταν ποτέ πιο εύκολη και ευέλικτη μέσω της ενέργειας Drag & 

Drop. 



Κεφάλαιο 2_Έναρξη λειτουργίας του GstarCAD 2025  

Σ ε λ ί δ α  31 | 296 
 

 

 
Σύντομη εισαγωγή του πλαισίου διαλόγου CUI: 

1. Παράθυρο διαλόγου CUI: Τώρα το πλαίσιο διαλόγου CUI χωρίζεται σε τρεις καρτέλες: Το κύριο αξιοθέατο είναι η καρτέλα 

Προσαρμογή στοιχείων μέσω του νέου τρόπου προσαρμογής (Drag & Drop). 
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2. Μενού δεξιού κλικ: Μενού περιβάλλοντος είναι διαθέσιμο για διαφορετικά στοιχεία διεπαφής, όπως φαίνεται παρακάτω: 

 

3. Εντολή εύρεσης: Με αυτές τις μεθόδους, δεν χρειάζεται ποτέ να περιηγηθείτε στην εντολή από την κορυφή της λίστας μέχρι 

το τέλος, γεγονός που ενισχύει σημαντικά την αποδοτικότητα της εργασίας σας. 
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1- Φιλτράρετε την εντολή ανά κατηγορία: και επιλέξτε την κατηγορία στην οποία ανήκει η 

εντολή, η οποία θα μειώσει το πεδίο αναζήτησης της εντολής. 

 
2- Φιλτράρετε μια εντολή με τις σχετικές λέξεις-κλειδιά καταχώρησης: θα εμφανιστούν όλες οι 

εντολές που περιέχουν τη λέξη "διάσταση", μειώνοντας τον αριθμό των εντολών που 

πρέπει να αναζητήσετε. 
 

3- Καθαριστής εντολών: Αν εισαγάγετε τις λέξεις-κλειδιά στο φίλτρο, το εικονίδιο  θα αλλάξει αυτόματα σε  το 

οποίο χρησιμοποιείται για τον καθαρισμό του περιεχομένου στο φίλτρο, εν τω μεταξύ, η ακόλουθη λίστα εντολών θα 

επιστρέψει στην προεπιλεγμένη κατάσταση. 

4- Εύρεση και αντικατάσταση: Στην καρτέλα Εύρεση εισαγάγετε την εντολή που θέλετε να βρείτε και κάντε κλικ στο κουμπί 

Εύρεση Επόμενο, η εντολή που αναζητήσατε θα τοποθετηθεί με ακρίβεια. Στην καρτέλα replace, μπορείτε να αντικαταστήσετε 

μια εντολή με μια άλλη εντολή, αλλά προτείνουμε να μην αλλάξετε το τυπικό όνομα και την περιγραφή της εντολής. 

 
5- Δημιουργήστε μια νέα εντολή: Εάν είναι απαραίτητο να προσθέσετε δευτερεύουσα εντολή προγράμματος ανάπτυξης στη 

λίστα εντολών, μπορείτε να ορίσετε τα στοιχεία που ακολουθούν τις τρέχουσες ρυθμίσεις εντολών, όπως φαίνεται 

παρακάτω. 
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Επαναφορά και επαναφορά: 

Εάν έχει ολοκληρωθεί όλη η λειτουργία προσαρμογής, αλλά κάνατε κάποια λάθη 

κατά την προσαρμογή της CUI ή δεν είστε ικανοποιημένοι με το αποτέλεσμα, η 

επαναφορά και η επαναφορά μπορούν να σας βοηθήσουν να ανακτήσετε τις 

αρχικές ρυθμίσεις. 

Επαναφορά：Επαναφορά των ρυθμίσεων του αντιγράφου ασφαλείας, κάντε κλικ  

στο κουμπί "Εφαρμογή", τα δεδομένα πριν 

τροποποίηση θα αποθηκευτούν ως αρχεία αντιγράφων ασφαλείας τα οποία 

χρησιμοποιούνται για την ανάκτηση. Επαναφορά：Επαναφορά στην αρχική 

ρύθμιση κατά την πρώτη εγκατάσταση του GstarCAD. 
 
 
 

 
2.4. Εισαγωγή, εξαγωγή και μετεγκατάσταση προσαρμοσμένων ρυθμίσεων χρήστη 

 
Το GstarCAD 2025 υποστηρίζει την εισαγωγή και εξαγωγή των ρυθμίσεων της τρέχουσας έκδοσης, καθώς και την εισαγωγή 

ρυθμίσεων της παλαιάς έκδοσης, γεγονός που επιτρέπει στους χρήστες να αποφεύγουν την επανάληψη των ίδιων ρυθμίσεων 

κατά την εγκατάσταση του λογισμικού. Οι χρήστες μπορούν επίσης να εισάγουν παλέτες εργαλείων από το AutoCAD. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
2.4.1. Εισαγωγή και εξαγωγή ρυθμίσεων της τρέχουσας έκδοσης 

 
Μπορείτε να εισάγετε και να εξάγετε τις ρυθμίσεις της τρέχουσας έκδοσης στο μενού Έναρξη των WINDOWS χωρίς να εκκινήσετε 

το GstarCAD, γεγονός που καθιστά τη λειτουργία πιο βολική και απλή. Και, η εισαγωγή των αποθηκευμένων εξαγόμενων 

ρυθμίσεων κατά την επανεγκατάσταση ή την εγκατάσταση του λογισμικού σε άλλα μηχανήματα θα εξοικονομήσει άφθονο 

χρόνο. 
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Εξαγωγή ρυθμίσεων της τρέχουσας έκδοσης: Ανοίξτε το μενού Έναρξη των παραθύρων, βρείτε το στοιχείο Gstarsoft και κάντε 
κλικ στο "Εξαγωγή των ρυθμίσεων της τρέχουσας έκδοσης". 

version", επιλέξτε τη θέση που προτιμάτε να αποθηκεύσετε το αρχείο ".cfgbak" και αποθηκεύστε το. 

 

 

 
Εισαγωγή ρυθμίσεων της τρέχουσας έκδοσης: Βρείτε το αρχείο ".cfgbak" και ανοίξτε το. 

 

 

 
Οι εξαγόμενες ρυθμίσεις περιλαμβάνουν: 

⮚  Επιλογές: Προτιμήσεις χρήστη, ρυθμίσεις σύνταξης, ρυθμίσεις επιλογής και άλλες προσαρμοσμένες ρυθμίσεις. 

⮚  Προσαρμογή διεπαφής χρήστη: Προσαρμογές εντολών, πλήκτρων πληκτρολογίου και ποντικιού. 

⮚  Αρχείο ψευδώνυμο (gacd.pgp) 

⮚  Αρχείο υποστήριξης εκτυπωτή 

⮚  Μοτίβο καταπακτής (*.pat) 

⮚  Παλέτες εργαλείων 

⮚  Αρχείο προτύπου (*.dwt) 

⮚  Γραμματοσειρές και σχήματα (*.shx) 

⮚  Τύπος γραμμής (*.lin) 

⮚  Αρχείο αντιστοίχισης γραμματοσειρών (gacd.fmp) 
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2.4.2. Επαναφορά ρυθμίσεων στην προεπιλογή 

 
Στο GstarCAD 2025, μπορείτε να επαναφέρετε τις ρυθμίσεις του GstarCAD στην προεπιλεγμένη κατάσταση κάνοντας κλικ στο 

μενού Έναρξη των Windows  GstarCAD 2025  Επαναφορά ρυθμίσεων στην προεπιλεγμένη κατάσταση. 

 
 
 
 
 
 
 
 
 
 

 
Μπορείτε να επαναφέρετε τις ρυθμίσεις μόνο όταν το λογισμικό είναι κλειστό. 

 
Εάν το λογισμικό είναι κλειστό, θα εμφανιστεί το παράθυρο διαλόγου Επαναφορά ρυθμίσεων, μπορείτε να επιλέξετε την 

επιλογή "Δημιουργία αντιγράφου ασφαλείας και επαναφορά προσαρμοσμένων ρυθμίσεων" για να δημιουργήσετε ένα αρχείο 

αντιγράφου ασφαλείας που περιέχει τα προσαρμοσμένα αρχεία σας πριν από την επαναφορά του προϊόντος. Ή, μπορείτε να 

επιλέξετε την επιλογή "Επαναφορά προσαρμοσμένων ρυθμίσεων" για να επαναφέρετε το προϊόν χωρίς να δημιουργήσετε 

αρχεία αντιγράφων ασφαλείας των προσαρμοσμένων ρυθμίσεών σας. 

 
Σημείωση: 

• Η επαναφορά των προσαρμοσμένων ρυθμίσεων είναι στην πραγματικότητα ο καθαρισμός των πληροφοριών 

μητρώου του λογισμικού GstarCAD και η διαγραφή του τοπικού φακέλου και του φακέλου περιαγωγής. Μετά την 

εκ νέου εκκίνηση του GstarCAD, ο νέος τοπικός φάκελος και ο φάκελος περιαγωγής θα αναγεννηθούν. 

• Η δημιουργία αντιγράφων ασφαλείας και η επαναφορά των προσαρμοσμένων ρυθμίσεων είναι στην 

πραγματικότητα ο καθαρισμός των πληροφοριών μητρώου του λογισμικού GstarCAD και η δημιουργία αντιγράφων 

ασφαλείας του τοπικού φακέλου και του φακέλου περιαγωγής στο C:\Users\username\AppData και, στη συνέχεια, η 

διαγραφή του τοπικού φακέλου και του φακέλου περιαγωγής. Μετά την εκ νέου εκκίνηση του GstarCAD, ο νέος 

τοπικός φάκελος και ο φάκελος περιαγωγής θα αναγεννηθούν. 
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2.4.3. Μετεγκατάσταση από προηγούμενη έκδοση 

 
Το GstarCAD 2025 προσθέτει μια λειτουργία "Μετεγκατάσταση από προηγούμενη έκδοση" στα στοιχεία προγράμματος 

του μενού WINDOWS Start, η οποία επιτρέπει στους χρήστες να μεταφέρουν επιλεγμένες ρυθμίσεις των παλαιών 

εκδόσεων απευθείας στη νέα έκδοση μετά την εγκατάσταση χωρίς αντιγραφή και χειροκίνητη ρύθμιση στην ίδια γλώσσα. 

Η παλαιότερη έκδοση που μπορεί να μεταφερθεί είναι το GstarCAD 2016. 

 
Οι μεταφερόμενες ρυθμίσεις περιλαμβάνουν: 

⮚  Επιλογές: Προτιμήσεις χρήστη, ρυθμίσεις σύνταξης, ρυθμίσεις 
επιλογής και άλλες προσαρμοσμένες ρυθμίσεις. 

⮚  Προσαρμογή διεπαφής χρήστη: Προσαρμογή 
κορδέλας, εντολών, πλήκτρων πληκτρολογίου και 
ποντικιού. 

προσαρμογές 

⮚  Αρχείο ψευδώνυμο (gacd.pgp) 

⮚  Αρχείο υποστήριξης εκτυπωτή 

⮚  Μοτίβο καταπακτής (*.pat) 

⮚  Παλέτες εργαλείων 

⮚  Αρχείο προτύπου (*.dwt) 

⮚  Γραμματοσειρές και σχήματα (*.shx) 

⮚  Τύπος γραμμής (*.lin) 

⮚  Αρχείο αντιστοίχισης γραμματοσειρών (gacd.fmp) 

 
Σημείωση: 

⮚  Μετά τη μετάβαση από παλαιότερη έκδοση, οι σχετικές ρυθμίσεις της τρέχουσας έκδοσης θα αντικατασταθούν και δεν θα μπορούν να 

επαναφερθούν. 

⮚  Μετά τη μετάβαση από την παλαιότερη έκδοση, οι νέες λειτουργίες που υποστηρίζει μόνο η τρέχουσα έκδοση θα 

επανέλθουν στις προεπιλογές. 

 

 
2.4.4. Εισαγωγή παλετών εργαλείων AutoCAD 

 
Μπορείτε εύκολα να εισαγάγετε προσαρμοσμένες παλέτες εργαλείων του AutoCAD στο μενού Έναρξη των WINDOWS. Εάν έχετε 

εγκαταστήσει το AutoCAD στον υπολογιστή σας, μπορείτε απλώς να εισαγάγετε το αρχείο από τη διαδρομή στις επιλογές του 

AutoCAD. Εάν πρέπει να εισαγάγετε προσαρμοσμένες παλέτες εργαλείων AutoCAD από άλλο εξοπλισμό, η διαδρομή μπορεί να 

είναι οπουδήποτε, αλλά ο φάκελος πρέπει να περιλαμβάνει το αρχείο AcTpCatalog.atc. 

 

 

 

Προτού εισαγάγετε μια παλέτα εργαλείων του AutoCAD, διαβάστε προσεκτικά τις ακόλουθες σημειώσεις: 

 
1. Τα προεπιλεγμένα μπλοκ του AutoCAD δεν μπορούν να εισαχθούν απευθείας στο GstarCAD. Εάν θέλετε να εισαγάγετε τα 
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προεπιλεγμένα μπλοκ του AutoCAD στο GstarCAD, πρέπει να τα σύρετε στο σχέδιο από τις παλέτες εργαλείων και να τα 

προσθέσετε ξανά στις παλέτες εργαλείων στο AutoCAD, στη συνέχεια να αποθηκεύσετε το σχέδιο και να τα εισαγάγετε. 

2. Το εισαγόμενο αρχείο είναι μόνο μπλοκ και εντολή, μοτίβο καταπακτής, πηγή φωτός, περιορισμός, πίνακας και άλλα αντικείμενα δεν έχουν 

υποστηρίζεται ακόμα. 

3. Εάν υπάρχει έλλειψη σημείου πρόσφυσης στο εισαγόμενο δυναμικό μπλοκ, πιθανόν να είναι αποτέλεσμα της ατελούς δράσης του δυναμικού 
μπλοκ. 

4. Όλες οι επιλέξιμες διαδρομές του GstarCAD θα εντοπιστούν πρώτα όταν εισάγετε το αρχείο απευθείας στο GstarCAD, όλες 

οι παλέτες εργαλείων στο GstarCAD θα αντικατασταθούν. 

5. Η σειρά της λίστας εργαλείων στις παλέτες εργαλείων μετά την εισαγωγή μπορεί να είναι διαφορετική από εκείνη του 

AutoCAD. Ο λόγος είναι ότι το AutoCAD υποστηρίζει ένα αρχείο που καταγράφει τη σειρά των εργαλείων στις παλέτες 

εργαλείων, αλλά το GstarCAD όχι. 

6. Εάν η θέση του αρχικού σχεδίου DWG αλλάξει πριν εισαγάγετε προσαρμοσμένες παλέτες εργαλείων AutoCAD και τα 

εργαλεία του, το μπλοκ (ή τα μπλοκ) που εισάγονται στις παλέτες στο GstarCAD δεν θα μπορούν να χρησιμοποιηθούν χωρίς την 

αντίστοιχη αρχική αποθηκευμένη διαδρομή του σχεδίου DWG. 

 
2.5. Παλέτες εργαλείων 

 
Οι παλέτες εργαλείων είναι περιοχές με καρτέλες μέσα στο παράθυρο Παλέτες εργαλείων. Τα 

στοιχεία που προσθέτετε σε μια παλέτα εργαλείων ονομάζονται εργαλεία. Μπορείτε να 

δημιουργήσετε ένα εργαλείο σύροντας ένα αντικείμενο στην παλέτα εργαλείων. Στο 

GstarCAD, τα μπλοκ και οι εξωτερικές αναφορές (xrefs) μπορούν να σύρονται στην παλέτα 

εργαλείων. Το νέο εργαλείο που θα εισαχθεί θα έχει τις ίδιες ιδιότητες στο σχέδιό σας. 

Επίσης, μπορείτε να κλείσετε,να δημιουργήσετε, να προσαρμόσετε την παλέτα εργαλείων 

κάνοντας δεξί κλικ πάνω της. Για να ανοίξετε τις παλέτες εργαλείων απλά πατήστε CTRL+3 ή 

πληκτρολογήστε την εντολή TOOLPALETTES. 
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2.6. Κέντρο σχεδιασμού 

 
Με το Κέντρο σχεδίασης, μπορείτε να οργανώσετε την πρόσβαση σε σχέδια, μπλοκ, στυλ κειμένου και άλλα περιεχόμενα σχεδίων: 

 
-Ψάξτε για περιεχόμενο σχεδίασης 

στον υπολογιστή σας ή σε μια 

μονάδα δίσκου δικτύου. 

-Προβολή πινάκων ορισμών για 

ονομαστικά αντικείμενα και, στη 

συνέχεια, εισαγωγή, επισύναψη, 

αντιγραφή και επικόλληση των ορισμών 

στο τρέχον σχέδιο. 

-Δημιουργήστε συντομεύσεις για σχέδια 

και φακέλους στους οποίους έχετε 

συχνή πρόσβαση. 

-Προσθήκη περιεχομένου όπως xrefs, 

μπλοκ σε ένα σχέδιο. 

 
-Συγκέντρωση σχεδίων, μπλοκ σε μια παλέτα εργαλείων για εύκολη πρόσβαση 

 
Καρτέλα Φάκελοι: Xrefs, διατάξεις και ονομαστικά αντικείμενα, συμπεριλαμβανομένων των μπλοκ, των επιπέδων, των 

τύπων γραμμών, των στυλ κειμένου και των στυλ διαστάσεων μέσα σε ένα σχέδιο. 

 
Ανοιχτά σχέδια: Εμφανίζεται μια λίστα με τα σχέδια που είναι ανοιχτά αυτή τη στιγμή. Εάν κάνετε κλικ σε ένα αρχείο σχεδίου 

και στη συνέχεια σε έναν από τους πίνακες ορισμού, μπορείτε να φορτώσετε το περιεχόμενο στην περιοχή 

περιεχομένου. 

Ιστορία: Εμφανίζεται μια λίστα με τα αρχεία που έχουν ανοιχτεί προηγουμένως. Εάν κάνετε διπλό κλικ σε ένα αρχείο 

σχεδίασης από τη λίστα, μπορείτε να φορτώσετε το περιεχόμενο στην περιοχή περιεχομένου. 

 
Αγαπημένα: Αν έχετε περιεχόμενο που χρειάζεται να προσπελάσετε γρήγορα σε τακτική βάση, το Κέντρο σχεδιασμού παρέχει μια 

λύση για την εύρεσή του. Όταν επιλέγετε οποιονδήποτε τύπο περιεχομένου, μπορείτε να κάνετε δεξί κλικ και να επιλέξετε 

να το προσθέσετε στα Αγαπημένα. Στο φάκελο αγαπημένων μπορείτε να αποθηκεύσετε συντομεύσεις σε περιεχόμενο σε 

τοπικές μονάδες δίσκου, σε μονάδες δικτύου. Το αρχικό αρχείο ή φάκελος δεν μετακινείται- αλλά όλες οι συντομεύσεις που 

δημιουργείτε αποθηκεύονται στο φάκελο Αγαπημένα. 

 
2.7. Καθαρή οθόνη 

 
Τώρα, αν οι χρήστες θέλουν να μεγιστοποιήσουν το χώρο σχεδίασης, μπορούν να πατήσουν τις λέξεις-κλειδιά Ctrl+0 ή να 

επιλέξουν το εικονίδιο (Καθαρή οθόνη) που βρίσκεται στη δεξιά γωνία της γραμμής κατάστασης. Μετά την εκτέλεση αυτής της 

εντολής, οι γραμμές εργαλείων και τα παράθυρα που μπορούν να προσαρτηθούν (εκτός από τη γραμμή κύριου μενού, τη 

γραμμή εντολών και τη γραμμή κατάστασης)θα καθαριστούν αυτόματα. Αυτή η λειτουργία μπορεί να παρέχει καλύτερη 

ορατότητα όσο το δυνατόν μεγαλύτερη, ώστε να είναι ευκολότερο να κατανοήσετε πλήρως κάθε λεπτομέρεια του 

σχεδίου. 
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2.8. Κλείδωμα UI 

 
Το Κλείδωμα UI κλειδώνει τη θέση και το μέγεθος των γραμμών εργαλείων και των παραθύρων με δυνατότητα πρόσδεσης, 

όπως το Κέντρο σχεδίασης, η παλέτα ιδιοτήτων κ.λπ. Για να τα ξεκλειδώσετε προσωρινά, κρατήστε πατημένο το πλήκτρο 

CTRL. Η ρύθμιση LockUI αποθηκεύεται ως κωδικός bit χρησιμοποιώντας τον ήλιο των ακόλουθων τιμών: 

0 Γραμμές εργαλείων και παράθυρα που δεν είναι κλειδωμένα 

1 Κλειδωμένες γραμμές εργαλείων 

2 Κλειδωμένα παράθυρα σε σύνδεση ή 

αγκυροβολημένα παράθυρα 4 

Κλειδωμένες κυμαινόμενες 

γραμμές εργαλείων 

8 Πλωτά παράθυρα κλειδωμένα 
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3. Δημιουργία, άνοιγμα, αποθήκευση, ανάκτηση ενός σχεδίου και διαχείριση σχεδίων 

 
 

3.1. Δημιουργήστε ένα σχέδιο 

3.1.1. Δημιουργία νέου σχεδίου με χρήση προεπιλεγμένων ρυθμίσεων  

Όταν οι μεταβλητές συστήματος FILEDIA και STARTUP έχουν οριστεί σε 1, 

πληκτρολογώντας ΝΕΟ στη γραμμή εντολών, ανοίγει το παράθυρο 

διαλόγου Έναρξη, από το οποίο μπορείτε να χρησιμοποιήσετε την 

Προεπιλεγμένη ρύθμιση, το Πρότυπο ή τον Οδηγό για να 

δημιουργήσετε ένα νέο σχέδιο. 

 
Μπορείτε να επιλέξετε είτε αυτοκρατορικές είτε μετρικές μονάδες για το νέο σχέδιο. 

 
Αυτοκρατορικό σύστημα μέτρησης: Το σχέδιο χρησιμοποιεί 

εσωτερικές προεπιλεγμένες τιμές με προεπιλεγμένο όριο 12 × 

9 ίντσες. 

 
Μετρικό σύστημα μέτρησης: Το σχέδιο χρησιμοποιεί εσωτερικές 

προεπιλεγμένες τιμές με προεπιλεγμένο όριο 429 × 297 

χιλιοστά. 

 
3.1.2. Δημιουργία ενός νέου σχεδίου με χρήση ενός Οδηγού ρυθμίσεων 

 
Από το παράθυρο διαλόγου Έναρξη, μπορείτε να επιλέξετε την 

καρτέλα "Χρήση οδηγού" για να δημιουργήσετε ένα νέο σχέδιο 

με τον οδηγό. Υπάρχουν δύο επιλογές οδηγού που φωτίζονται 

ως εξής: 

 
Οδηγός προηγμένης ρύθμισης: 

 
Από αυτήν την επιλογή, μπορείτε να ορίσετε τις μονάδες μέτρησης, την ακρίβεια των εμφανιζόμενων μονάδων και τα όρια 

πλέγματος. Επίσης, καθορίστε ρυθμίσεις γωνίας, όπως στυλ μονάδων μέτρησης, ακρίβεια, κατεύθυνση και προσανατολισμό 

με βάση το πρότυπο gcadiso.dwt. 
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Οδηγός γρήγορης ρύθμισης: Από αυτή την επιλογή, μπορείτε να καθορίσετε τις 

μονάδες μέτρησης, την ακρίβεια των εμφανιζόμενων μονάδων και τα όρια του 

πλέγματος με βάση το πρότυπο gcadiso.dwt. 

 
 
 
 

 
3.1.3. Δημιουργία νέου σχεδίου με χρήση προτύπου 

 
Όταν χρειάζεται να δημιουργήσετε πολλά σχέδια με 

τις προεπιλεγμένες ρυθμίσεις, μπορείτε να 

εξοικονομήσετε χρόνο δημιουργώντας ένα αρχείο 

πρότυπο που έχει σχεδιαστεί για να δημιουργεί τα 

ίδια αρχεία σχεδίων, ώστε να μην χρειάζεται να 

καθορίζετε τις προεπιλεγμένες ρυθμίσεις κάθε φορά 

που ξεκινάτε. Οι συμβάσεις και οι ρυθμίσεις που 

συνήθως αποθηκεύονται σε πρότυπα αρχεία 

περιλαμβάνουν: τύπο και ακρίβεια μονάδας, μπλοκ 

τίτλων, πλαίσια και λογότυπα, ονόματα στρώσεων, 

ρυθμίσεις συμπληρωματικών, πλέγματος και 

ορθογώνιων, όρια πλέγματος, στυλ διαστάσεων, στυλ 

κειμένου και Linetypes. 

 
Επίσης, όταν οι μεταβλητές συστήματος FILEDIA και STARTUP χουν οριστεί σε 1 και 0 ξεχωριστά, πληκτρολογώντας ΝΕΟ ανοίγει το 
παράθυρο διαλόγου Επιλογή προτύπου, από το οποίο μπορείτε να επιλέξετε το επιθυμητό ή να χρησιμοποιήσετε το 
προεπιλεγμένο πρότυπο κάνοντας κλικ στο κουμπί με το βέλος δίπλα στο κουμπί Άνοιγμα. 

 
3.2. Ανοίξτε ένα σχέδιο 

 

 
3.2.1. Ανοίξτε ένα σχέδιο 

 
Μπορείτε να ανοίξετε αρχεία σχεδίασης (.dwg), αρχεία Drawing Exchange 

Format (.dxf), αρχεία Drawing Standard (dws) και αρχεία προτύπου 

σχεδίασης (.dwt). Μπορείτε επίσης να ανοίξετε και να ελέγξετε σχέδια για 

τα οποία υποψιάζεστε ότι έχουν υποστεί βλάβη. 

 
Για να ανοίξετε ένα υπάρχον σχέδιο: 

Χρησιμοποιώντας συντόμευση> CTRL+O 

 
-Στο παράθυρο διαλόγου, επιλέξτε τον τύπο του 

αρχείου που θέλετε να ανοίξετε. 

 
-Επιλέξτε το φάκελο που περιέχει το επιθυμητό file. 
-Επιλέξτε το σχέδιο που θέλετε να ανοίξετε, και στη συνέχεια κάντε κλικ στο κουμπί  
Άνοιγμα ή κάντε διπλό κλικ στο σχέδιο που θέλετε να ανοίξετε. 
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3.2.2. Πολλαπλά ανοικτά σχέδια 

 
Μπορείτε να ανοίξετε πολλά σχέδια ταυτόχρονα. Υπάρχουν διάφορες μέθοδοι για την εναλλαγή ενός σχεδίου σε ένα άλλο. 

 
- Ενεργοποιήστε το σχέδιο κάνοντας κλικ σε αυτό ή χρησιμοποιώντας τα πλήκτρα συντόμευσης <Ctrl+Tab>. 

- Μπορείτε να αλλάξετε τα στυλ εμφάνισης σε Cascade, Τίτλος κάθετα ή Τίτλος οριζόντια από το μενού Παράθυρο. Μπορείτε 

επίσης να χρησιμοποιήσετε την επιλογή Arrange Icons (Τακτοποίηση εικονιδίων) για να ευθυγραμμίσετε τα εικονίδια εάν 

υπάρχουν πολλά ελάχιστα σχέδια. 

 

 

 
3.3. Αποθήκευση ενός σχεδίου 

 

 
3.3.1. Αποθήκευση ενός σχεδίου 

 
Αποθηκεύετε αρχεία σχεδίασης για μετέπειτα χρήση. Μπορείτε επίσης να ρυθμίσετε αυτόματη αποθήκευση και 

δημιουργία αντιγράφων ασφαλείας και να αποθηκεύσετε μόνο επιλεγμένα αντικείμενα. Επιπλέον, μπορείτε επίσης να 

αποθηκεύσετε ένα σχέδιο σε αρχείο Drawing Exchange Format (.dxf) ή σε αρχείο προτύπου σχεδίου (.dwt). Εάν δημιουργήσατε 

το σχέδιό σας χρησιμοποιώντας ένα πρότυπο, η αποθήκευση του σχεδίου δεν μεταβάλλει το αρχικό πρότυπο. 

 
Για να αποθηκεύσετε ένα σχέδιο: Αρχείο > Αποθήκευση Γραμμή εντολών>ΑΠΟΘΗΚΕΥΣΗ Χρήση συντόμευσης> CTRL+S 
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Παρατήρηση: Όταν αποθηκεύετε ένα σχέδιο για πρώτη φορά, το πρόγραμμα 

εμφανίζει το παράθυρο διαλόγου Αποθήκευση σχεδίου ως, ώστε να μπορείτε να 

επιλέξετε έναν κατάλογο και να πληκτρολογήσετε ένα όνομα για το σχέδιο. 

 
3.3.2. Αποθηκεύστε το σχέδιό σας αυτόματα 

 
Μπορείτε να καθορίσετε την αυτόματη αποθήκευση των αρχείων σχεδίασης, ώστε να 

ελαχιστοποιήσετε τα χαμένα δεδομένα μόλις εμφανιστεί κάποιο πρόβλημα. 

 
Εάν ενεργοποιήσετε την επιλογή αυτόματης αποθήκευσης, το σχέδιό σας 

αποθηκεύεται σε καθορισμένα χρονικά διαστήματα. Από προεπιλογή, το σύστημα 

εκχωρεί το όνομα filename. sv$ για προσωρινά αποθηκευμένα αρχεία, το filename 

εδώ αναφέρεται στο όνομα του τρέχοντος σχεδίου. 

 
 
 
 
 
 
 

 
3.3.3. Αποθήκευση μέρους ενός αρχείου σχεδίασης 

 
Μπορείτε να χρησιμοποιήσετε την εντολή BLOCK ή την εντολή 

WBLOCK για να δημιουργήσετε ένα νέο σχέδιο από μέρος ενός 

υπάρχοντος σχεδίου. Μπορείτε να επιλέξετε οντότητες ή έναν ορισμό 

μπλοκ στο τρέχον σχέδιό σας και να τις αποθηκεύσετε σε ένα νέο 

αρχείο σχεδίου. Η περιγραφή μπορεί επίσης να αποθηκευτεί στο 

νέο σχέδιο. 

 
 
 

 
3.3.4. Αποθήκευση σε διαφορετικό τύπο αρχείου σχεδίασης 

 
Επιλέξτε τη μορφή από την επιλογή Αποθήκευση ως Τύπος στο παράθυρο διαλόγου Αποθήκευση σχεδίου ως, μπορείτε να 

αποθηκεύσετε ένα σχέδιο σε μια παλαιότερη έκδοση της μορφής σχεδίου (DWG) ή της μορφής ανταλλαγής σχεδίων 

(DXF), ή να αποθηκεύσετε ένα σχέδιο ως 

πρότυπο αρχείο. Για να αποθηκεύσετε 

μια διαφορετική μορφή: 

Αρχείο > Αποθήκευση ως Γραμμή 

εντολών> ΑΠΟΘΗΚΕΥΣΗ ΩΣ Χρήση 

συντόμευσης> SHIFT+CTRL+S 
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3.3.5. Μετατροπή DWG 

 
Η εντολή DWGCONVERT μετατρέπει ένα ή μια δέσμη επιλεγμένων αρχείων σχεδίασης σε μια άλλη διαθέσιμη έκδοση 

dwg. Το νέο αρχείο που δημιουργείται μπορεί να αντικαταστήσει το αρχικό και μπορεί επίσης να συμπιεστεί σε ένα 

αυτοεκχυόμενο αρχείο EXE ή ένα αρχείο ZIP για να διευκολύνει τη μετατροπή μορφής παρτίδας ολόκληρου του 

σχεδίου του έργου. 

 

 

 

3.3.6. Μετατρέπει ένα ή μια δέσμη επιλεγμένων 

αρχείων σχεδίασης 

σε μια παλαιότερη ή τρέχουσα διαθέσιμη 

έκδοση dwg. Το νεοδημιουργηθέν αρχείο μπορεί 

να αντικαταστήσει το αρχικό αρχείο και μπορεί 

επίσης να συμπιεστεί σε ένα 

αυτοεκχυόμενο αρχείο EXE ή ένα αρχείο ZIP για 

να διευκολυνθεί η ομαδική μετατροπή μορφής 

ολόκληρου του σχεδίου έργου. 

 
 

 
Βήματα για να μετατρέψετε αρχεία DWG σε διαφορετική μορφή 

 
1. Κάντε κλικ στο "File">"DWG Convert" με τη σειρά σας. 

2. Κάντε κλικ στο παράθυρο διαλόγου "DWG Convert" > "Add File" (κοντά στο κάτω μέρος) 

3. Στο παράθυρο διαλόγου "Select File" (Επιλογή αρχείου), πρέπει να περιηγηθείτε στο φάκελο όπου πρόκειται να μετατραπεί 
το αρχείο γραφικών. 

4. Κάντε κλικ στο όνομα του αρχείου γραφικών και, στη συνέχεια, κάντε κλικ στο "Άνοιγμα". 

5. Στο παράθυρο διαλόγου "DWG Convert", κάντε κλικ στο "Conversion Setups". Στο πλαίσιο διαλόγου "DWG Convert", δημιουργήστε μια νέα 
ρύθμιση μετατροπής. 

(ΝΕΑ), τροποποιήστε την υπάρχουσα ρύθμιση μετατροπής (ΤΡΟΠΟΠΟΙΗΣΗ) ή επιλέξτε μια προηγούμενη ρύθμιση μετατροπής και, στη 
συνέχεια, κάντε κλικ στο "ΚΛΕΙΣΙΜΟ". 
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6. Στο παράθυρο διαλόγου "DWG Convert", κάντε κλικ στο "CONVERT". 

7. Εάν οι ρυθμίσεις μετατροπής καθορίζουν ένα αρχείο EXE ή ZIP, μεταβείτε στον επιθυμητό φάκελο προορισμού και, στη 

συνέχεια, κάντε διπλό κλικ στο αρχείο για να το επιλέξετε. Εάν χρειάζεται, εισαγάγετε ένα νέο όνομα για το αρχείο. 

8. Κάντε κλικ στο κουμπί "ΑΠΟΘΗΚΕΥΣΗ". 
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3.3.7. Χρήση αρχείων αντιγράφων ασφαλείας 

 
Το GstarCAD δημιουργεί ένα αρχείο αντιγράφων ασφαλείας με το 

όνομα του τρέχοντος σχεδίου και την επέκταση ".bak" για να 

αποθηκεύσει την προηγούμενη έκδοση του τρέχοντος σχεδίου κατά την 

εκκίνηση της επιλογής "αυτόματη δημιουργία αντιγράφων 

ασφαλείας". 

 
3.3.8. Μειώστε το χρόνο που απαιτείται για την αποθήκευση ενός αρχείου σχεδίασης 

 
Για να μειώσετε το χρόνο αποθήκευσης ενός αρχείου σχεδίασης, 

μπορείτε να καθορίσετε το ποσοστό αυξητικής αποθήκευσης στην 

καρτέλα Άνοιγμα και αποθήκευση του πλαισίου διαλόγου Επιλογές 

ή από τη μεταβλητή συστήματος ISAVEPERCENT. 

 
Η σταδιακή αποθήκευση ενημερώνει μόνο τα τμήματα του αποθηκευμένου αρχείου 

σχεδίασης που αλλάξατε. Τα αρχεία σχεδίασης θα περιέχουν ένα ποσοστό δυνητικά 

σπαταλημένου χώρου όταν χρησιμοποιείτε σταδιακή αποθήκευση. Αυτό το ποσοστό 

αυξάνεται μετά από κάθε αυξητική αποθήκευση μέχρι να φτάσει την καθορισμένη 

μέγιστη τιμή και τότε εκτελείται πλήρης αποθήκευση. 

 
3.4. Ανάκτηση ενός σχεδίου 

 

 
3.4.1. Ανάκτηση ενός κατεστραμμένου αρχείου 

 
Μπορείτε να ανακτήσετε μέρος ή το σύνολο των δεδομένων, επαναφέροντας ένα αρχείο αντιγράφου ασφαλείας ή 

χρησιμοποιώντας εντολές για την εύρεση και διόρθωση σφαλμάτων, εάν ένα αρχείο σχεδίασης έχει υποστεί ζημιά. Ένα αρχείο 

σχεδίασης μπορεί να καταστραφεί από βλάβη υλικού, διακοπή ρεύματος και κατάρρευση του συστήματος. Καλύτερα να 

δημιουργήσετε ένα εφεδρικό αρχείο εάν το σχέδιο είναι σημαντικό. 

 
Στην καρτέλα Άνοιγμα και αποθήκευση του πλαισίου διαλόγου Επιλογές, μπορείτε να καθορίσετε το αρχείο αντιγράφων 

ασφαλείας που δημιουργείται όταν αποθηκεύετε σχέδια και να ορίσετε το κατάλληλο χρονικό διάστημα για την αποθήκευση. 

Στη συνέχεια, δημιουργείται ένα εφεδρικό αρχείο αντιγράφου με επέκταση ".bak" όταν αποθηκεύετε ξανά το ονομαστικό 

σχέδιο. Μετά από αυτό, ένα αρχείο αντιγράφου ασφαλείας ενημερώνεται πάντα κατά την εκτέλεση της εντολής SAVE ή 

SAVEAS. 

 

 

 

 

 

 

 

 



Κεφάλαιο3_Δημιουργία, άνοιγμα, αποθήκευση, ανάκτηση ενός σχεδίου 
και διαχείριση σχεδίων 

 

Σ ε λ ί δ α  48 | 296  

 
Μπορείτε να χρησιμοποιήσετε την εντολή RECOVER για να ελέγξετε και να επιχειρήσετε να ανοίξετε ένα αρχείο που έχει 

υποστεί βλάβη. Στη συνέχεια χρησιμοποιεί την εντολή AUDIT για να εντοπίσει και να διορθώσει τα σφάλματα. 

 
Για να ανοίξετε ένα κατεστραμμένο αρχείο: 

Επαναφορά γραμμής εντολών>RECOVER 

 

 

 

 

 

 

 

 

 

 
-Στο πλαίσιο διαλόγου στην περιοχή Αρχεία τύπου, επιλέξτε τον τύπο του αρχείου που θέλετε να ανακτήσετε. 

-Επιλέξτε τον κατάλογο που περιέχει το κατεστραμμένο αρχείο. 

-Επιλέξτε το κατεστραμμένο αρχείο που θέλετε να ανακτήσετε και κάντε κλικ στο κουμπί Άνοιγμα ή κάντε διπλό κλικ στο σχέδιο που θέλετε να 
ανοίξετε. 

 
Για να ελέγξετε τα σφάλματα για ένα αρχείο σχεδίασης:  
Έλεγχος: Αρχείο > Βοηθητικά προγράμματα σχεδίασης> Έλεγχος Γραμμή εντολών> Έλεγχος 

 

 
1. Για να επιλέξετε από το ανοιχτό σχέδιο, κάντε κλικ στο Αρχείο > Βοηθήματα σχεδίασης > Έλεγχος 

2. Εισάγετε Y ή N για να καθορίσετε αν θα ανακτηθούν τα σφάλματα που εντοπίζονται αυτόματα από το GstarCAD και, στη 
συνέχεια, πατήστε Enter. 
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3.4.2. Σχέδιο Recovery Manager 

 
Μόλις τερματιστεί από προβλήματα υλικού, διακοπή ρεύματος ή προβλήματα λογισμικού, η εφαρμογή είναι σε θέση να 

δημιουργήσει αντίγραφα ασφαλείας του αρχείου σχεδίασης που ανοίχτηκε. Κατά την επόμενη εκκίνηση, το πρόγραμμα εκκινεί 

το "Drawing Recovery Manager", στο οποίο θα εμφανιστούν όλα τα αρχεία σχεδίασης με αυτόματη δημιουργία αντιγράφων 

ασφαλείας που έχουν κλείσει κατά λάθος. Μπορείτε να ανοίξετε το αρχείο της ζήτησής σας κάνοντας διπλό κλικ στη 

λίστα αρχείων αντιγράφων ασφαλείας στο "Drawing Recovery", εάν υπάρχει οποιαδήποτε ζημιά στο αρχείο, το σύστημα 

επιχειρεί να ανακτήσει το σχέδιο κατά τη διαδικασία δημιουργίας αντιγράφων ασφαλείας. 

 
Όταν το πρόγραμμα ή το σύστημα σταματήσει κατά λάθος, τα αρχεία σχεδίασης που 

πρέπει να ανακτηθούν ταξινομούνται στους ακόλουθους τύπους. 

 
-Ανακτημένο αρχείο σχεδίασης που αποθηκεύεται όταν το πρόγραμμα αποτυγχάνει (DWG) 

-Προσωρινά αποθηκευμένο αρχείο (sv$) 

-Αρχείο αντιγράφων ασφαλείας (BAK) 

-Αρχείο σχεδίασης (DWG) 

 

 

 

 

 
3.5. Διαχείριση σχεδίων 

 
Στο GstarCAD η Διαχείριση συνόλων φύλλων σας επιτρέπει να διαχειρίζεστε όλα 

τα σύνολα φύλλων σχεδίασης του έργου. Μπορεί να διαχειριστεί όλη τη ροή 

εργασιών από τη δημιουργία φύλλων, την εκτύπωση και τη δημοσίευση. 

κ.λπ. 

 
Στη Διαχείριση συνόλων φύλλων, ένα σύνολο φύλλων είναι μια 

οργανωμένη συλλογή φύλλων από διάφορα αρχεία σχεδίασης και κάθε 

φύλλο σε ένα σύνολο φύλλων είναι μια διάταξη σε ένα αρχείο σχεδίασης. 

Ξεκινήστε να εκμεταλλεύεστε τη λειτουργικότητα των συνόλων φύλλων για τα τρέχοντα έργα σας με ελάχιστη προσπάθεια, 

εισάγοντας τις τρέχουσες διατάξεις σχεδίασης σε ένα σύνολο φύλλων. Μπορείτε εύκολα να ανοίγετε τα σχέδια από μια 

κεντρική τοποθεσία, ενώ συνεχίζετε να τα επεξεργάζεστε χρησιμοποιώντας παραδοσιακά εργαλεία. 

 
3.5.1. Έλεγχος σετ φύλλων 

 
Εμφανίζει τις επιλογές του μενού για τη δημιουργία ενός νέου συνόλου φύλλων, το άνοιγμα ενός υπάρχοντος συνόλου φύλλων ή την εναλλαγή 
μεταξύ ανοικτών συνόλων φύλλων. 
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Προβολή δέντρου: Εμφανίζει τα περιεχόμενα της λίστας φύλλων. 

 

 
Λεπτομέρειες ή προεπισκόπηση: Εμφανίζει είτε περιγραφικές 

πληροφορίες είτε μια μικρογραφία προεπισκόπησης του 

τρέχοντος επιλεγμένου στοιχείου στη δενδρική προβολή. 
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Μπορείτε να χρησιμοποιήσετε τις ακόλουθες ενέργειες στην προβολή δέντρου: 

• Κάντε δεξί κλικ για να αποκτήσετε πρόσβαση σε μενού συντόμευσης των 

λειτουργιών που αφορούν το τρέχον επιλεγμένο στοιχείο. 

 
 
 
 

 
• Κάντε διπλό κλικ σε στοιχεία για να τα ανοίξετε. Αυτή είναι μια βολική μέθοδος για το άνοιγμα αρχείων σχεδίασης από τη 

λίστα φύλλων. Μπορείτε επίσης να κάνετε διπλό κλικ σε στοιχεία στην δενδρική προβολή για να τα επεκτείνετε ή να 

τα συμπτύξετε. 
 

• Κάντε κλικ σε ένα ή περισσότερα στοιχεία για να τα επιλέξετε για λειτουργίες όπως άνοιγμα, δημοσίευση ή μετάδοση. 
 

• Μετακινήστε τον κέρσορα πάνω από ένα μεμονωμένο στοιχείο για να εμφανίσετε περιγραφικές πληροφορίες ή μια 

προεπισκόπηση μικρογραφιών ενός επιλεγμένου φύλλου, προβολής ή αρχείου σχεδίασης. 

 
 
 
 
 
 
 
 
 

 
• Σύρετε τα στοιχεία μέσα στη δενδρική προβολή για να τα αναδιατάξετε. 
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3.5.2. Βασικές πληροφορίες για το 

άνοιγμα του Sheet Set Manager 

Κορδέλα: Sheet Set Manager ή Τύπος: sheetset 
 

 

 
Δημιουργία σετ φύλλων 

Μόλις ανοίξει το Sheet Set Manager, επιλέξτε το πτυσσόμενο πλαίσιο 

στην κορυφή και στη συνέχεια κάντε κλικ στο New Sheet Set. 

 

Θα εμφανιστεί ένα νέο παράθυρο διαλόγου που θα εμφανίζει τα 4 

βήματα για τη δημιουργία ενός σετ φύλλων. 

 
 

 
Έναρξη 

Στην επιλογή Έναρξη υπάρχουν δύο επιλογές για τη δημιουργία 

ενός συνόλου φύλλων. Επιλογή πρώτη 

Χρησιμοποιεί το "An example sheet set" που επιτρέπει τη χρήση 

ενός τυποποιημένου προτύπου για τη δημιουργία του σετ 

φύλλων. 

Επιλογή δύο 

Χρησιμοποιεί Υπάρχοντα σχέδια για να ξεκινήσει ένα νέο σετ 

φύλλων. Θα επιλέξουμε την επιλογή Υπάρχοντα σχέδια. 

Λεπτομέρειες σετ σεντονιών 

Εδώ μπορούν να προστεθούν βασικές πληροφορίες όπως το όνομα του σετ φύλλων, η περιγραφή και η θέση του αρχείου. 
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Επιλέξτε διατάξεις 

Οι υπάρχουσες διατάξεις μπορούν να 

προστεθούν στο σετ φύλλων αναζητώντας 

το κατάλληλο αρχείο που απαιτείται στο 

σετ σχεδίων. Μόλις επιλεγούν οι 

διατάξεις, κάντε κλικ στο κουμπί Next 

(Επόμενο) για επιβεβαίωση. 

 
 
 
 
 
 

 
Επιβεβαίωση 

Η καρτέλα επιβεβαίωσης θα δώσει 

μια σύνοψη των διατάξεων που θα 

προστεθούν στο σετ. Αφού επιλέξετε το 

κουμπί Next (Επόμενο), η νέα διάταξη θα 

προστεθεί στο σετ φύλλων. 

 
 
 
 

 
Εισαγωγή διατάξεων στο Sheet Set Manager 

Για να προσθέσετε ένα νέο φύλλο από μια υπάρχουσα διάταξη σχεδίασης, κάντε 

δεξί κλικ στον τίτλο του συνόλου φύλλων και επιλέξτε Εισαγωγή διάταξης ως φύλλο. Θα 

εμφανιστεί ένα νέο αναδυόμενο πλαίσιο που σας επιτρέπει να αναζητήσετε ένα υπάρχον 

σχέδιο για να προσθέσετε μια διάταξη. 

 
 
 
 
 

 
Συμβουλή: Εάν το πλαίσιο εισαγωγής δεν είναι επιλεγμένο, η διάταξη βρίσκεται 

ήδη στο σετ φύλλων ή η διάταξη δεν μπορεί να εισαχθεί στο σετ. 

 
 
 

 
Σετ φύλλων διαχείρισης 

Μετακίνηση και αφαίρεση φύλλων από ένα σετ 

Αφού προστεθούν τα φύλλα στο Sheet Set Manger, μπορείτε να τα 

σύρετε και να τα αφήσετε στη σειρά που χρειάζεστε. Για να αφαιρέσετε 

ένα φύλλο από το σετ, κάντε δεξί κλικ και επιλέξτε Remove Sheet 

(Αφαίρεση φύλλου). 
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Μετονομασία και αναρίθμηση φύλλων 

Για να μετονομάσετε και να αναριθμήσετε ένα φύλλο ή ένα 

υποσύνολο, κάντε δεξί κλικ στο φύλλο που πρέπει να αλλάξει και 

επιλέξτε Μετονομασία και αναρίθμηση. 

 
Θα εμφανιστεί ένα αναδυόμενο πλαίσιο που θα επιτρέπει την 

αλλαγή του αριθμού, του τίτλου του φύλλου και του ονόματος 

της διάταξης. 

 

 
Προσθήκη πληροφοριών έργου σε σετ φύλλων 

Για να προσθέσετε πληροφορίες έργου στο 

σύνολο φύλλων, όπως όνομα έργου, αριθμό 

έργου και περιγραφή έργου, κάντε δεξί κλικ στον 

τίτλο του συνόλου φύλλων και μετακινηθείτε προς 

τα κάτω στις Ιδιότητες του συνόλου φύλλων. Θα 

εμφανιστεί ένα νέο αναδυόμενο πλαίσιο που 

επιτρέπει την ενημέρωση των πληροφοριών 

έργου. 

Συμβουλές: Οι πληροφορίες έργου στο σύνολο 

φύλλων μπορούν να χρησιμοποιηθούν σε 

αντικείμενα όπως πεδία 

 
Δημιουργία υποσυνόλων στο Sheet Set Manager 

Η δημιουργία υποσυνόλων στο Sheet Set Manager είναι ένας γρήγορος τρόπος 

οργάνωσης και εύρεσης των απαραίτητων στοιχείων σε ένα μεγάλο σύνολο 

σχεδίων. Για να δημιουργήσετε ένα υποσύνολο, κάντε δεξί κλικ στο σύνολο 

φύλλων και στη συνέχεια στο New Subset (Νέο υποσύνολο). 

 
 
 
 
 
 

 
Θα εμφανιστεί το πλαίσιο Ιδιότητες 

υποσυνόλου. Οι περισσότερες από 

τις ιδιότητες είναι βασικές. 

Επιλέξτε OK. 

Ένα νέο υποσύνολο προστίθεται στη 

διαχείριση συνόλου φύλλων. 

Συμβουλή: Για να μετακινήσετε ένα φύλλο 

στο νέο υποσύνολο, απλά κάντε κλικ και 

σύρετε στο επιθυμητό υποσύνολο. 
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Σετ φύλλων δημοσίευσης 

Το Sheet Set Manager καθιστά απλή τη δημοσίευση ενός πλήρους συνόλου ή μόνο επιλεγμένων φύλλων των εγγράφων 

κατασκευής. Υπάρχουν δύο τρόποι για να σχεδιάσετε: Δημοσίευση απευθείας στον πλόττερ/στο αρχείο ή χρήση του 

πλαισίου διαλόγου Δημοσίευση. 

 
Δημοσίευση και σχεδίαση απευθείας στο plotter/αρχείο 

Κάντε δεξί κλικ στο σετ φύλλων, μετακινηθείτε στην επιλογή Δημοσίευση και, στη συνέχεια, Δημοσίευση στο Plotter. 

 
Αυτή η μέθοδος χρησιμοποιείται για τη σχεδίαση και τη δημοσίευση όταν η ρύθμιση σελίδας έχει οριστεί ανά 

διάταξη. Το μειονέκτημα της χρήσης αυτής της επιλογής είναι ότι αν κάποιος σχεδιάσει ένα από τα φύλλα 

χρησιμοποιώντας την εντολή plot και αποθηκεύσει τη ρύθμιση στη διάταξη, η διάταξη δεν θα δημοσιευτεί σωστά. 

Το σετ φύλλων μπορεί επίσης να συσκευαστεί και να διαμοιραστεί μέσω e-transmit. 
 

Η δημοσίευση μέσω του πλαισίου διαλόγου Δημοσίευση μπορεί να μην είναι τόσο γρήγορη όσο η δημοσίευση 

απευθείας στο πλόττερ/αρχείο, αλλά υπάρχει μικρότερη πιθανότητα το έγγραφο να βγει λάθος.  

 
Μπορείτε επίσης να χρησιμοποιήσετε τις ρυθμίσεις 

σελίδων που έχουν αποθηκευτεί στο σχέδιο σε 

συγκεκριμένα φύλλα ή σε ολόκληρο το σετ. 

Για να εμφανίσετε το παράθυρο διαλόγου, κάντε δεξί 

κλικ στον τίτλο του σετ φύλλων, μετακινηθείτε στην 

επιλογή Δημοσίευση και στη συνέχεια στην επιλογή 

Παράθυρο διαλόγου δημοσίευσης. Θα εμφανιστεί το 

πλαίσιο διαλόγου Δημοσίευση. 

 
Τώρα με τις ρυθμίσεις σελίδων, το πλαίσιο διαλόγου 

Δημοσίευση μπορεί να αλλάξει τον τρόπο δημοσίευσης 

του εγγράφου. Τώρα έχουμε τις επιλογές για 

δημοσίευση σε Plotter με όνομα στο Page Setup, 

DWF, DWFx και PDF. 

Η επιλογή των Επιλογών δημοσίευσης σετ φύλλων 

επιτρέπει τις επιλογές για την αλλαγή πληροφοριών όπως η 

προεπιλεγμένη θέση εξόδου και η ονομασία. 
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Συμβουλή: Μία από τις σημαντικότερες επιλογές που αλλάζω περισσότερο είναι ο τύπος. Το αρχείο πολλαπλών φύλλων θα 

τοποθετήσει ολόκληρο το σετ σε ένα αρχείο και το αρχείο ενός φύλλου θα τοποθετήσει κάθε φύλλο ανά αρχείο. 

  



Κεφάλαιο 4_Έλεγχος των προβολών σχεδίασης 
 

Σ ε λ ί δ α  57 | 296  

 
4. Έλεγχος των προβολών σχεδίασης 

 
4.1. Επανασχεδίαση και αναγέννηση ενός σχεδίου 

 
Καθώς εργάζεστε σε ένα σχέδιο, οπτικά στοιχεία μπορεί να παραμείνουν μετά την ολοκλήρωση μιας εντολής. Μπορείτε να 

αφαιρέσετε αυτά τα στοιχεία ανανεώνοντας ή σχεδιάζοντας εκ νέου την οθόνη. 

 
Για να σχεδιάσετε εκ νέου (ανανεώσετε) την τρέχουσα οθόνη του παραθύρου: Προβολή > Επανασχεδίαση Γραμμή εντολών> 
ΑΝΑΔΕΙΞΗ 
Για να αναδημιουργήσετε το τρέχον παράθυρο:  Προβολή > Αναγέννηση Γραμμή εντολών> REGEN 

 

 
Οι πληροφορίες σχετικά με τις οντότητες σχεδίασης αποθηκεύονται σε μια βάση δεδομένων ως τιμές κινητής 

υποδιαστολής, εξασφαλίζοντας υψηλό επίπεδο ακρίβειας. Μερικές φορές ένα σχέδιο πρέπει να υπολογιστεί εκ νέου, ή να 

αναδημιουργηθεί, από τη βάση δεδομένων κινητής υποδιαστολής για να μετατραπούν αυτές οι τιμές στις κατάλληλες 

συντεταγμένες οθόνης. 

 

 
4.2. Μεγέθυνση προβολής (Zoom) 

 
Μπορείτε να χρησιμοποιήσετε την εντολή ZOOM για να 

μεγεθύνετε ή να σμικρύνετε την προβολή του σχεδίου 

ανάλογα με τις ανάγκες σας. Μπορείτε να αλλάξετε τη 

μεγέθυνση του σχεδίου σας ανά πάσα στιγμή. Ο 

δρομέας αλλάζει σε μεγεθυντικό φακό όταν είναι ενεργό 

ένα εργαλείο μεγέθυνσης. Κάντε σμίκρυνση για να 

μειώσετε τη μεγέθυνση, ώστε να μπορείτε να δείτε 

περισσότερο το σχέδιο, ή μεγέθυνση για να αυξήσετε τη 

μεγέθυνση, ώστε να μπορείτε να δείτε ένα τμήμα του 

σχεδίου με μεγαλύτερη λεπτομέρεια. 

 
Παρατήρηση: Εάν εργάζεστε σε ένα παράθυρο προβολής διάταξης και δεν μπορείτε να κάνετε ζουμ, το παράθυρο προβολής 

διάταξης μπορεί να είναι κλειδωμένο. Η κλίμακα και η προβολή δεν αλλάζουν στο χώρο του μοντέλου κατά τη σάρωση ή το 

ζουμ σε ένα κλειδωμένο παράθυρο προβολής διάταξης. 
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4.2.1. Μέθοδοι ζουμ 

 
Για να κάνετε ζουμ, μπορείτε να χρησιμοποιήσετε οποιαδήποτε από τις ακόλουθες μεθόδους: 

 
-Για να ορίσετε το τμήμα του σχεδίου που θα μεγεθυνθεί, δημιουργήστε ένα παράθυρο. 

-Για να κάνετε ζουμ σε πραγματικό χρόνο, χρησιμοποιήστε το εργαλείο Ζουμ σε πραγματικό χρόνο στη γραμμή εργαλείων Standard. 

-Αν έχετε ποντίκι με τροχό, περιστρέψτε τον τροχό για να μεγεθύνετε και να σμικρύνετε. 

 
4.2.2. Ζουμ για μεγέθυνση μιας καθορισμένης ορθογώνιας περιοχής 

 
Μπορείτε να καθορίσετε μια ορθογώνια περιοχή που ορίζεται από δύο γωνίες για να εμφανίσετε τα αντικείμενα εντός της 

περιοχής αυτής όσο το δυνατόν μεγαλύτερα. Η κάτω αριστερή γωνία της καθορισμένης περιοχής γίνεται η κάτω αριστερή 

γωνία της νέας προβολής. 

 
Για να κάνετε ζουμ σε μια περιοχή χρησιμοποιώντας ένα παράθυρο: Προβολή > Ζουμ> Παράθυρο Γραμμή εντολών> ZOOM 

 
-Επιλέξτε Προβολή > Ζουμ > Παράθυρο 

-Επιλέξτε μια γωνία του παραθύρου γύρω από την περιοχή που θέλετε να μεγεθύνετε. 

-Ορίστε την απέναντι γωνία του παραθύρου γύρω από την περιοχή που θέλετε να μεγεθύνετε. 

 

 
 

4.2.3. Ζουμ σε πραγματικό χρόνο 

 
Η επιλογή ζουμ σε πραγματικό χρόνο μεγεθύνει δυναμικά μετακινώντας τη 

συσκευή υπόδειξης προς τα πάνω ή προς τα κάτω. Κάνοντας δεξί κλικ, 

μπορείτε να εμφανίσετε ένα μενού συντόμευσης με πρόσθετες επιλογές 

προβολής. 

 
Για ζουμ σε πραγματικό χρόνο: 

Προβολή > Ζουμ> Γραμμή εντολών σε 

πραγματικό χρόνο> RTZOOM 
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-Επιλέξτε Προβολή > Ζουμ > Πραγματικός χρόνος από το κύριο μενού. 

-Επιμένετε πατημένο το αριστερό κουμπί του ποντικιού και, στη συνέχεια, σύρετε τον κέρσορα προς τα εμπρός για μεγέθυνση και 
προς τα πίσω για σμίκρυνση. 

 
4.2.4. Εμφάνιση της προηγούμενης προβολής ενός σχεδίου 

 
Αφού μεγεθύνετε ή πανοραμίσετε για να δείτε ένα τμήμα του σχεδίου σας με μεγαλύτερη λεπτομέρεια, ίσως θελήσετε να 

μειώσετε ξανά το ζουμ για να δείτε ολόκληρο το σχέδιο. Στο μενού Προβολή > Ζουμ, το εργαλείο Προηγούμενο σας επιτρέπει 

να επαναφέρετε την προηγούμενη προβολή. Με την επιλογή αυτού του εργαλείου μπορείτε να κάνετε επανειλημμένα 

βήματα προς τα πίσω σε έως και 25 διαδοχικές μεγεθυμένες ή πανοραμικές προβολές. 

 
4.2.5. Μεγέθυνση σε συγκεκριμένη κλίμακα 

 
Μπορείτε να αυξήσετε ή να μειώσετε τη μεγέθυνση της προβολής σας με έναν ακριβή συντελεστή κλίμακας που μετράται 

σε σχέση με το συνολικό μέγεθος του σχεδίου ή σε σχέση με την τρέχουσα οθόνη. Όταν αλλάζετε τον παράγοντα μεγέθυνσης, 

το τμήμα του σχεδίου που βρίσκεται στο κέντρο του τρέχοντος παραθύρου προβολής παραμένει κεντραρισμένο στην οθόνη. 

 
Για μεγέθυνση σε μια συγκεκριμένη κλίμακα σε σχέση με την τρέχουσα οθόνη: Προβολή > Ζουμ>Κλίμακα Γραμμή εντολών> ZOOM 

 
-Επιλέξτε Προβολή > Ζουμ > Κλίμακα από το κύριο μενού. 

-Στη γραμμή εργαλείων Ζουμ, κάντε κλικ στην επιλογή Κλίμακα ζουμ. 

-Πληκτρολογήστε ZOOM στη γραμμή εντολών, επιλέξτε την επιλογή Κλίμακα και, στη συνέχεια, πατήστε Enter. 

-Πληκτρολογήστε τον συντελεστή κλίμακας, ακολουθούμενο από ένα x (π.χ. 2x). 

-Πιέστε Enter. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4.2.6. Εμφάνιση ολόκληρου του σχεδίου 

 
Η επιλογή ZOOM Extents, εμφανίζει μια προβολή που περιλαμβάνει όλα τα αντικείμενα του σχεδίου σε όσο το δυνατόν 

μεγαλύτερο μέγεθος. Η προβολή μπορεί να εμφανίζει τα αντικείμενα σε στρώματα που είναι απενεργοποιημένα, αλλά 

δεν περιλαμβάνει αντικείμενα σε παγωμένα στρώματα. 
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Η επιλογή ZOOM All, εμφανίζει όλα τα αντικείμενα είτε εντός των ορίων που ορίζει ο χρήστης είτε εντός της έκτασης του σχεδίου, όποια προβολή 
είναι μεγαλύτερη. 

 
Μπορείτε να χρησιμοποιήσετε το εργαλείο Ζουμ Όλα στη γραμμή εργαλείων ζουμ για να εμφανίσετε ολόκληρο το σχέδιο. Το 

εργαλείο Zoom Extents (Μεγέθυνση σε όλα) στη γραμμή εργαλείων zoom εμφανίζει το σχέδιο σε όλη του την έκταση, 

κάνοντας την εικόνα να γεμίσει την οθόνη στη μεγαλύτερη δυνατή μεγέθυνση. 

 
4.3. Παν και προβολή 

 
Μπορείτε να μετακινήσετε το σχέδιο προς οποιαδήποτε κατεύθυνση χρησιμοποιώντας την εντολή pan. Η σάρωση 

μετατοπίζει ή ολισθαίνει την προβολή του σχεδίου οριζόντια, κάθετα ή διαγώνια. Η μεγέθυνση του σχεδίου παραμένει η 

ίδια, όπως και ο προσανατολισμός του στο χώρο. Η μόνη αλλαγή είναι το τμήμα του σχεδίου που εμφανίζεται. Για να 

πραγματοποιήσετε μετατόπιση, μπορείτε να χρησιμοποιήσετε οποιαδήποτε από τις παρακάτω μεθόδους: 

 
-Για ακριβές panning, καθορίστε δύο σημεία που καθορίζουν το μέγεθος και την κατεύθυνση του pan. Το πρώτο σημείο 

υποδεικνύει το σημείο εκκίνησης της πανοραμικής κίνησης. Το δεύτερο σημείο υποδεικνύει το μέγεθος της μετατόπισης της 

πανοραμικής κίνησης σε σχέση με το πρώτο σημείο.-Για να κάνετε πανοραμική κίνηση σε πραγματικό χρόνο, χρησιμοποιήστε 

το εργαλείο Pan Realtime (Πανοραμική κίνηση σε πραγματικό χρόνο) στη γραμμή εργαλείων Standard. 

-Αν έχετε ποντίκι με τροχό, πατήστε και κρατήστε πατημένο τον τροχό και, στη συνέχεια, 

μετακινήστε το ποντίκι. Για να πραγματοποιήσετε μετακίνηση σε πραγματικό 

χρόνο : Προβολή>Μετακίνηση>πραγματικός χρόνος

 Γραμμή εντολών>Μετακίνηση 

-Επιλέξτε Προβολή > Ζουμ > Πραγματικός χρόνος από το κύριο μενού. 

-Μετακινήστε τον κέρσορα προς την κατεύθυνση που θέλετε να μετακινηθείτε. 

-Για να σταματήσετε τη σάρωση, πατήστε Enter, ESC ή επιλέξτε Έξοδος 

από το μενού συντόμευσης. Για να πραγματοποιήσετε πανοραμική 

κίνηση χρησιμοποιώντας ένα ποντίκι με τροχό: 

-Πιέστε παρατεταμένα τον τροχό και, στη συνέχεια, μετακινήστε το ποντίκι 

προς την κατεύθυνση που θέλετε να μετακινηθείτε (η μεταβλητή 

συστήματος MBUTTONPAN ελέγχει αυτή τη λειτουργία.) 

 
4.4. Εμφάνιση πολλαπλών προβολών στο χώρο του μοντέλου 

 
Όταν ξεκινάτε ένα νέο σχέδιο, αυτό εμφανίζεται σε ένα μόνο παράθυρο. Μπορείτε να προβάλετε το σχέδιο σε ένα δεύτερο 

παράθυρο ή να χωρίσετε ένα παράθυρο σε πολλαπλά παράθυρα. Μπορείτε επίσης να ανοίξετε και να εμφανίσετε 

πολλαπλά σχέδια. 
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4.4.1. Ορισμός Προβολών χώρου μοντέλου 

 
Τα παράθυρα προβολής που δημιουργούνται στην καρτέλα Μοντέλο γεμίζουν πλήρως την περιοχή σχεδίασης και δεν 

επικαλύπτονται. Καθώς πραγματοποιείτε αλλαγές σε ένα παράθυρο προβολής, τα υπόλοιπα ενημερώνονται ταυτόχρονα. 

 

Μπορείτε να εκτελέσετε τις ακόλουθες λειτουργίες 

στο παράθυρο προβολής χώρου μοντέλου: 

 
-Ρύθμιση των λειτουργιών εικονιδίων Snap, Grid 

και UCS, μετατόπιση, ζουμ και επαναφορά 

ονομαστικών προβολών. 

-Αποθήκευση προσανατολισμών του UCS με  
μεμονωμένα παράθυρα προβολής. 

-Κατά την εκτέλεση μιας εντολής, μπορείτε να 

σχεδιάσετε από ένα παράθυρο προβολής σε ένα 

άλλο. 

 
-Ονομάστε μια διάταξη ανοίγματος προβολής, ώστε να μπορείτε να την επαναχρησιμοποιήσετε στην καρτέλα Μοντέλο ή να την εισάγετε σε μια 
καρτέλα διάταξης. 

-Όταν εργάζεστε σε τρισδιάστατα μοντέλα, είναι χρήσιμη η ρύθμιση διαφορετικών UCS σε μεμονωμένα παράθυρα προβολής. 

 
4.4.2. VPMAX/VPMIN 

 

 
Το VPMAX σάς επιτρέπει να επεκτείνετε τα τρέχοντα παράθυρα προβολής διάταξης και να μεταβείτε στο Model Space για 

επεξεργασία χωρίς να ανησυχείτε ότι θα χαλάσετε τις κλίμακες και τα όρια των παραθύρων προβολής, ενώ το VPMIN 

σάς επιτρέπει να επαναφέρετε το τρέχον παράθυρο προβολής διάταξης. 

 
 
 

 

 

 
4.4.2.1. VPMAX 

 

Επεκτείνει τα παράθυρα προβολής της τρέχουσας διάταξης για να γεμίσει την οθόνη και 

μεταβαίνει στο χώρο μοντέλου για επεξεργασία. Μπορείτε να εισέλθετε στην κατάσταση 

μεγιστοποιημένου παραθύρου προβολής με τους ακόλουθους τέσσερις τρόπους: 

⮚  Εισάγετε την εντολή VPMAX στο χώρο διάταξης και, στη συνέχεια, κάντε κλικ για να επιλέξετε το παράθυρο προβολής 

που θα μεγιστοποιηθεί (όταν υπάρχει μόνο ένα παράθυρο προβολής στη διάταξη, το παράθυρο προβολής θα 

μεγιστοποιηθεί απευθείας χωρίς να χρειάζεται να επιλέξετε). 

Μεταβλητή 
συστήματος 

Περιγραφή Αξία Αξία Περιγραφή 

 

 
VPMAXIMIZEDSTATE 

 
Ελέγχει αν θα μεγιστοποιηθεί το τρέχον 

παράθυρο προβολής (μόνο για 

ανάγνωση) 

0 

 
1 

Μην μεγιστοποιείτε 

 
Μεγιστοποίηση 
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⮚  Εισάγετε την εντολή VPMAX αφού επιλέξετε ένα παράθυρο προβολής στο χώρο διάταξης, 

⮚  Κάντε διπλό κλικ στο όριο του παραθύρου προβολής στο χώρο διάταξης, 

⮚  Κάντε κλικ στο εικονίδιο μεγιστοποίησης του παραθύρου προβολής στη γραμμή κατάστασης στο χώρο διάταξης.   

 
4.4.2.2. VPMIN 

 

Βγαίνει από την κατάσταση μεγιστοποίησης και επιστρέφει στον τρέχοντα χώρο διάταξης. Μπορείτε να βγείτε από την 

κατάσταση μεγιστοποιημένου παραθύρου προβολής με τους εξής τρεις τρόπους: 

 
⮚  Εισάγετε την εντολή VPMIN, 

⮚  Κάντε διπλό κλικ στην μπλε γραμμή ορίου, 

⮚  Κάντε κλικ στο εικονίδιο ελαχιστοποίησης του παραθύρου προβολής στη γραμμή κατάστασης στο χώρο διάταξης.   

 
4.4.3. Εργασία με πολλαπλές προβολές ενός ενιαίου σχεδίου 

 
Μπορείτε να ανοίγετε και να εργάζεστε με διάφορες προβολές του ίδιου σχεδίου ταυτόχρονα. Αφού χωρίσετε ένα ενιαίο 

παράθυρο σε πολλαπλά παράθυρα, μπορείτε να ελέγχετε κάθε παράθυρο ξεχωριστά. Για παράδειγμα, μπορείτε να 

μεγεθύνετε ή να πανοραμείτε σε ένα παράθυρο χωρίς να επηρεάζεται η απεικόνιση σε κάποιο από τα άλλα παράθυρα. 

Καθώς σχεδιάζετε, οποιεσδήποτε αλλαγές κάνετε σε ένα παράθυρο είναι αμέσως ορατές και στα υπόλοιπα παράθυρα. Και 

επίσης, μπορείτε να μεταβείτε από το ένα παράθυρο στο άλλο ανά πάσα στιγμή. 

 
Για να δημιουργήσετε πολλαπλές προβολές: Προβολή > Προβολές Γραμμή εντολών> VPORTS 

 
-Επιλέξτε Προβολή> Προβολές-Στο μενού Προβολές, επιλέξτε 1, 2, 3 ή 4 Προβολές. 

-Πληκτρολογήστε h αν θέλετε τον οριζόντιο προσανατολισμό ή v αν θέλετε τον 

κατακόρυφο προσανατολισμό. Για να ενώσετε δύο προβολές: Προβολή 

>Viewports> Join Γραμμή εντολών> VPORTS 

-Επιλέξτε Προβολή > Θέα > Ενσωμάτωση -Κάντε κλικ οπουδήποτε μέσα στο παράθυρο που θέλετε να διατηρήσετε. 

-Κάντε κλικ οπουδήποτε μέσα στο παρακείμενο παράθυρο που θέλετε να ενώσετε με το πρώτο παράθυρο. Για να επαναφέρετε  
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μια διαμόρφωση παραθύρου με όνομα: 

-Πληκτρολογήστε τη μεταβλητή συστήματος -VPORTS στη γραμμή εντολών και πατήστε ENTER. 

-Ακολούθως πληκτρολογήστε Restore. 

-Ακολούθως, πληκτρολογήστε το όνομα της διαμόρφωσης παραθύρου που θέλετε να επαναφέρετε. 

 

 

 

 
 
 
 

4.4.3.1. VPSCALE 

 

Η εντολή VPSCALE (κλίμακα ανοίγματος προβολής) αναφέρει την πραγματική κλίμακα του τρέχοντος ανοίγματος προβολής ενός επιλεγμένου 
ανοίγματος προβολής διάταξης. 

1. Μπορείτε να ανοίξετε ένα πρόσφατο σχέδιο με διατάξεις ή να δημιουργήσετε ένα νέο παράθυρο προβολής στο χώρο 

διάταξης με κλίμακα επιθυμίας σύμφωνα με το σχήμα χαρτιού. 

2. Πληκτρολογήστε την εντολή VPSCALE στη γραμμή εντολών και, στη συνέχεια, επιλέξτε την άκρη του παραθύρου προβολής. 

3. Η γραμμή εντολών θα εμφανίζει τη σωστή κλίμακα του παραθύρου προβολής ανάλογα με τη μονάδα μέτρησης με την οποία εργάζεστε. 

4. Παρατηρήστε ότι η γραμμή κατάστασης εμφανίζει τη δεξιά κλίμακα του επιλεγμένου παραθύρου προβολής μόνο στο χώρο διάταξης. 
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4.4.4. Εργασία με πολλαπλά σχέδια 

 
Με τη διεπαφή πολλαπλών εγγράφων, μπορείτε να ανοίγετε και να επεξεργάζεστε πολλά σχέδια ταυτόχρονα, να αντιγράφετε, να 

αποκόπτετε ή να επικολλάτε μια οντότητα από ένα σχέδιο σε ένα άλλο. Κάθε σχέδιο εμφανίζεται σε ένα παράθυρο σχεδίασης, το 

οποίο έχει τα εξής πλεονεκτήματα: Μπορείτε ναβλέπετε δύο ή περισσότερα σχέδια δίπλα-δίπλα και μπορείτε εύκολα να 

αντιγράψετε οντότητες από το ένα σχέδιο στο άλλο. Στο μενού Παράθυρο, παρέχονται προς επιλογή από το χρήστη οι ακόλουθες 

τρεις μέθοδοι που καθορίζουν τον τρόπο διάταξης των σχεδίων. 

 
 

 
-Cascade 

-Πλακιδώστε οριζόντια 

-Κατακόρυφα 
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4.4.5. Προβολή διαχειριστή 

 
Με τον διαχειριστή προβολής, μπορείτε να δημιουργήσετε, να ορίσετε 

τρέχουσες, να ενημερώσετε τα στρώματα, να επεξεργαστείτε τα όρια και να 

διαγράψετε ονομαστικές προβολές και να μεταβείτε γρήγορα μεταξύ κάθε 

προβολής, είναι χρήσιμο να μειώσετε πολλές περιττές λειτουργίες 

προσαρμογής προβολής. 

 

 
4.5. Καθορίστε μια τρισδιάστατη προβολή 

 
Μπορείτε να ορίσετε μια τρισδιάστατη προβολή για να διευκολύνετε την επαλήθευση των τρισδιάστατων αποτελεσμάτων 

του σχεδίου, την κατασκευή και την απεικόνιση τρισδιάστατων μοντέλων. Μπορείτε να ορίσετε μια νέα προβολή για να 

δημιουργήσετε νέα αντικείμενα ή να τροποποιήσετε τα υπάρχοντα αντικείμενα. 

 
4.5.1. Ορισμός της κατεύθυνσης προβολής 

 
Βλέπετε τρισδιάστατα σχέδια ρυθμίζοντας την κατεύθυνση προβολής. Η κατεύθυνση προβολής καθορίζει τη θέση προβολής, 

Όταν προβάλλετε ένα σχέδιο από την προεπιλεγμένη θέση προβολής (0,0,1), βλέπετε μια κάτοψη του σχεδίου. Μπορείτε να 

αλλάξετε την κατεύθυνση προβολής για να εξετάσετε το σχέδιο από διαφορετικό σημείο θέασης ή για να εργαστείτε σε ένα 

τρισδιάστατο 

διαστατικό μοντέλο από διαφορετικό προσανατολισμό. 

 
Για να ορίσετε μια νέα κατεύθυνση προβολής: Γραμμή 

εντολών> DDVPOINT 

 
-Επιλέξτε Προβολή > Προβολές 3D > Προεπιλογές σημείου προβολής 

-Ρυθμίστε τις γωνίες θέασης σε απόλυτη θέση σε σχέση με το WCS και σε σχετική θέση σε 

σχέση με το UCS μετακινώντας τη θέση της βελόνας σύμφωνα με τις προτιμήσεις σας. 

Στη συνέχεια, κάντε κλικ στο κουμπί OK. 
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Για να εμφανίσετε μια κάτοψη του τρέχοντος σχεδίου: Προβολή > Προβολές 3D> Προβολή κάτοψης 

 
Γραμμή εντολών> PLAN 

 
-Επιλέξτε Προβολή > Προβολές 3D > Προβολή κάτοψης από το κύριο μενού. 

-Καταλήγει σε τρεις προβολές κάτοψης: UCS, World UCS και Named UCS. Επιλέξτε αυτό που θέλετε. 
 

 
 

 
4.5.2. Ισομετρική άποψη 

 
Μπορείτε να ορίσετε προοπτικές 

προβολές ενός μοντέλου για να 

δημιουργήσετε ρεαλιστικά εφέ. 

Επιλέξτε προκαθορισμένες 

τυποποιημένες ορθογραφικές και 

ισομετρικές όψεις με βάση το όνομα ή 

την περιγραφή. Αυτές οι προβολές 

αντιπροσωπεύουν συχνά 

χρησιμοποιούμενες επιλογές: Επάνω, 

Κάτω, Μπροστά, Αριστερά, Δεξιά και 

Πίσω. Επιπλέον, μπορείτε να ορίσετε 

προβολές από ισομετρικές επιλογές: ΝΔ 

(νοτιοδυτική) ισομετρική, ΝΑ 

(νοτιοανατολική) ισομετρική, ΒΑ 

(βορειοανατολική) ισομετρική και ΒΔ 

(βορειοδυτική) ισομετρική. 
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4.5.3. Σχεδιάστε ισομετρικές όψεις 2D 

 
Με το Isometric Snap, μπορείτε να δημιουργήσετε 2D αντικείμενα που φαίνονται να είναι 3D στερεά. 

 
Με τη ρύθμιση Ισομετρική σύλληψη στο πλαίσιο διαλόγου Ρυθμίσεις σχεδίασης και την ενεργοποίηση των επιλογών 

Σύλληψη και πλέγμα, μπορείτε εύκολα να ευθυγραμμίζετε τα αντικείμενα κατά μήκος ενός από τα τρία ισομετρικά επίπεδα. 

Ωστόσο, παρόλο που το ισομετρικό σχέδιο μοιάζει με τρισδιάστατο, στην πραγματικότητα πρόκειται για μια 

αναπαράσταση 2D. 
 

 
4.5.4. Ορισμός ισομετρικού πλέγματος και Snap 

 
Με την ευθυγράμμιση κατά μήκος τριών κύριων αξόνων, το ισομετρικό σχέδιο προσομοιώνει ένα τρισδιάστατο σχέδιο από 

συγκεκριμένη οπτική γωνία. Όταν η γωνία σύσφιξης έχει οριστεί σε 0, οι άξονες του ισομετρικού επιπέδου είναι 30 μοίρες, 90 

μοίρες και 150 μοίρες. Με ενεργοποιημένο το ισομετρικό Snap, μπορείτε να εργαστείτε σε οποιοδήποτε από τα τρία 

ισομετρικά επίπεδα, το καθένα με ένα ζεύγος συσχετιζόμενων αξόνων. 

 
-Αριστερά. Το αριστερό ισομετρικό επίπεδο που ορίζεται από ένα ζεύγος αξόνων 90 και 150 μοιρών. Το κούμπωμα 

και οι λαβές ευθυγραμμίζονται κατά μήκος των αξόνων 90 και 150 μοιρών. 

-Top. Το ανώτερο ισομετρικό επίπεδο που ορίζεται από ένα ζεύγος αξόνων 30 και 150 μοιρών. Το κούμπωμα και οι 

λαβές ευθυγραμμίζονται κατά μήκος των αξόνων 30 και 150 μοιρών. 

-Δεξιά. Το δεξιό ισομετρικό επίπεδο που ορίζεται από ένα ζεύγος αξόνων 90 και 30 μοιρών. Το κούμπωμα και οι 

λαβές ευθυγραμμίζονται κατά μήκος των αξόνων 90 και 30 μοιρών. 
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Εκτός από τη χρήση της εντολής ISOPLANE για την εναλλαγή ισομετρικών επιπέδων, μπορείτε επίσης να χρησιμοποιήσετε 

το πλήκτρο συντόμευσης F5 ή CTRL+E. Ο καθορισμός ενός από τα τρία ισομετρικά επίπεδα έχει ως αποτέλεσμα το Ortho 

και το σταυρόνημα να ευθυγραμμιστούν κατά μήκος των αντίστοιχων ισομετρικών αξόνων. 

 
Για παράδειγμα, όταν είναι ενεργοποιημένο το Ortho, τα σημεία που καθορίσατε ευθυγραμμίζονται κατά μήκος του 

προσομοιωμένου επιπέδου στο οποίο εργάζεστε. Επομένως, μπορείτε να σχεδιάσετε πρώτα το επάνω επίπεδο, να μεταβείτε 

στο αριστερό επίπεδο για να σχεδιάσετε μια άλλη πλευρά και, στη συνέχεια, να μεταβείτε στο δεξί επίπεδο για να 

ολοκληρώσετε το σχέδιο. 

 

 

 
Κορυφαίο αεροπλάνο Αριστερό επίπεδο Δεξί επίπεδο 

 
 

 
4.5.5. Αλλάξτε δυναμικά μια τρισδιάστατη προβολή 

 
Μπορείτε να δείτε αντικείμενα από οποιαδήποτε κατεύθυνση προβολής κρατώντας πατημένο το ποντίκι ή άλλες 

συσκευές επισήμανσης και μετακινούμενοι δυναμικά. Με τη δυναμική προβολή, μπορείτε να εμφανίσετε τα αποτελέσματα 

της αλλαγής της οπτικής γωνίας ενώ αλλάζετε την προβολή. Μπορείτε να εκτελείτε λειτουργίες μετακίνησης ή ζουμ καθώς η 

τρισδιάστατη τροχιά είναι ενεργή. Όταν η 3D Orbit είναι ενεργή, δεν επιτρέπεται η τροποποίηση αντικειμένων. Το 

GstarCAD υποστηρίζει περισσότερες επιλογές τροχιάς, όπως Ελεύθερη τροχιά, Συνεχής τροχιά 3D, Τροχιά κατά μήκος του 

άξονα Χ, Τροχιά κατά μήκος του άξονα Υ, Τροχιά κατά μήκος του 

Z-τροχιά και τρισδιάστατο κέντρο τροχιάς. Επιπλέον, οι χρήστες μπορούν να δημιουργήσουν δύο νέα πλέγματα μέσω των 

εντολών DISH και DOME. Για να κλείσετε το 3D Orbit, πατήστε Enter, ESC ή επιλέξτε Exit από το μενού συντόμευσης. 
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4.5.6. Απόκρυψη γραμμών ή σκίαση 3D αντικειμένων 

 
Αποκρύπτει ή διαμορφώνει για τρισδιάστατα αντικείμενα στο τρέχον σχέδιο, καταστέλλει την εμφάνιση των αντικειμένων (εν 

μέρει ή εξ ολοκλήρου) που βρίσκονται πίσω από άλλα αντικείμενα ή δημιουργεί μια εικόνα με απλή σκίαση που 

εμφανίζεται στην τρέχουσα προβολή. Μπορείτε να χρησιμοποιήσετε την εντολή HIDE για να αφαιρέσετε τις κρυμμένες 

γραμμές για να επαληθεύσετε την τρέχουσα τοποθέτηση αυτών των επιφανειών. Η απόκρυψη των γραμμών φόντου 

κάνει την απεικόνιση πολύ πιο ξεκάθαρη, αλλά δεν μπορείτε να τροποποιήσετε τις προβολές κρυμμένων γραμμών ή την 

απόδοση. 
 

 

 
4.5.7. Προσθήκη απλής σκίασης σε τρισδιάστατα αντικείμενα 

 
Αν και η απόκρυψη των γραμμών μπορεί να βελτιώσει το σχέδιο και να αποσαφηνίσει το σχέδιο, η σκίαση παράγει μια πιο 

ρεαλιστική εικόνα του μοντέλου σας. Μπορείτε να τροποποιήσετε τα σκιασμένα αντικείμενα όπως θα κάνατε κανονικά. 

Όταν επιλέγεται ένα σκιασμένο αντικείμενο, το συρματόσχοινο και οι λαβές εμφανίζονται πάνω από τη σκίαση. 
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4.5.8. Επίπεδο τομής 

 
Η εντολή SECTIONPLANE δημιουργεί ένα αντικείμενο διατομής που λειτουργεί ως επίπεδο κοπής μέσα από αντικείμενα 3D και αποθηκεύει 

το επιλεγμένο επίπεδο διατομής ως μπλοκ 2D ή 3D. Μπορείτε να μετακινήσετε το αντικείμενο τομής δυναμικά σε ένα τρισδιάστατο 

μοντέλο ή σε μια επιφάνεια. Μπορείτε να χρησιμοποιήσετε την ενεργή τομή σε μοντέλο ανάλυσης μετακινώντας το αντικείμενο τομής 

στο αντικείμενο. Δημιουργήστε προβολές διατομής που μπορούν να αποθηκευτούν ή να επαναχρησιμοποιηθούν.  

 

 

4.6. Αναπαράσταση 

 
Η απόδοση δημιουργεί μια δισδιάστατη εικόνα με 

βάση μια τρισδιάστατη σκηνή. Αποχρωματίζει τη 

γεωμετρία της σκηνής χρησιμοποιώντας το φωτισμό 

που έχετε ρυθμίσει, τα υλικά που έχετε εφαρμόσει και 

τις περιβαλλοντικές ρυθμίσεις, όπως το φόντο και η 

ομίχλη. Σε ένα βασικό επίπεδο, μπορείτε να 

χρησιμοποιήσετε την εντολή render για να κάνετε render 

το μοντέλο σας χωρίς να εφαρμόσετε υλικά, να 

προσθέσετε φώτα ή να ρυθμίσετε μια σκηνή. Δεν 

μπορείτε να μετακινήσετε ή να ρυθμίσετε αυτό το φως. 

 
4.6.1. Φως 

 
Ο φωτισμός προσθέτει την τελευταία πινελιά στη σκηνή. Μπορείτε να προσθέσετε σημειακά φώτα, προβολείς και μακρινά 

φώτα και να ορίσετε τη θέση και τις φωτομετρικές ιδιότητες του καθενός. 

Point Light: Ένα σημειακό φως εκπέμπει φως προς όλες τις 

κατευθύνσεις από τη θέση του και δεν στοχεύει ένα 

αντικείμενο. 

Προβολείς: Ένας προβολέας μπορεί να κατευθυνθεί προς 

ένα αντικείμενο. Μακρινά φώτα: Προσομοιώνει την  
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επίδραση του ηλιακού φωτός και μπορεί να χρησιμοποιηθεί 

για να δείξει πώς οι σκιές που ρίχνει μια κατασκευή 

επηρεάζουν τη γύρω περιοχή. 

Λίστα φώτων: Εμφανίζει μια λίστα με τον τύπο και το 

όνομα του φωτός που χρησιμοποιείται στο μοντέλο. Τα 

μακρινά φώτα και ο ήλιος δεν εμφανίζονται ως 

αντικείμενα διασύνδεσης στο μοντέλο. 

 

 

 

 
4.6.2. Υλικά 

 
Μπορείτε να προσθέσετε υλικά στα αντικείμενα των σχεδίων σας για να δώσετε 

ένα ρεαλιστικό αποτέλεσμα. Στο πλαίσιο της απόδοσης, τα υλικά περιγράφουν 

τον τρόπο με τον οποίο ένα αντικείμενο αντανακλά ή μεταδίδει το φως. Μέσα σε 

ένα υλικό, οι χάρτες μπορούν να προσομοιώσουν υφές, εφέ εξογκωμάτων, 

ανακλάσεις ή διαθλάσεις. 
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5. Εργαλεία ακριβείας και οι ιδιότητες των σχεδίων 

 
 

5.1. Καθορισμός μονάδων, γωνιών και κλίμακας 

 
Καθορίστε τις μονάδες μέτρησης που θέλετε να χρησιμοποιήσετε, τη μορφή τους και άλλες συμβάσεις. 

 
5.1.1. Ορισμός της μορφής μονάδων 

 
Μπορείτε να ορίσετε τη μορφή εμφάνισης της μονάδας που περιλαμβάνει: 

επιστημονική, δεκαδική, μηχανική, αρχιτεκτονική και κλασματική σημειογραφία. 

Για να εισαγάγετε αρχιτεκτονική μορφή ποδιών και ιντσών, μπορείτε να υποδείξετε 

πόδια χρησιμοποιώντας το σύμβολο του προβαδίσματος ('), για παράδειγμα, 72'3. 

Δεν χρειάζεται να καθορίσετε ίντσες εισάγοντας εισαγωγικά ("). μπορείτε να 

ορίσετε τον τύπο και την ακρίβεια της μονάδας στον οδηγό γρήγορης ρύθμισης, 

στον οδηγό σύνθετης ρύθμισης ή στο παράθυρο διαλόγου Έλεγχος μονάδων. 

Αυτές οι ρυθμίσεις ελέγχουν τον τρόπο με τον οποίο ερμηνεύονται οι 

καταχωρήσεις συντεταγμένων, μετατοπίσεων και αποστάσεων και τον τρόπο 

με τον οποίο εμφανίζονται οι συντεταγμένες και οι αποστάσεις. 

 
Για να ανοίξετε το διάλογο μονάδων σχεδίασης: Μονάδες Γραμμή εντολών > ΜΟΝΑΔΕΣ 

 
5.1.2. DWGUNITS 

 
Διαφορετικά έργα ή σενάρια εφαρμογών ενδέχεται να απαιτούν διαφορετικές μονάδες. Για παράδειγμα, ο αρχιτεκτονικός 

σχεδιασμός μπορεί να χρησιμοποιεί μέτρα, ενώ ο μηχανολογικός σχεδιασμός μπορεί να χρησιμοποιεί ίντσες. Στο GstarCAD 2025, 

η νεοπροστιθέμενη εντολή DWGUNITS σας επιτρέπει να αλλάζετε τις μονάδες των σχεδίων ώστε να ανταποκρίνονται στις τυπικές 

απαιτήσεις μεγέθους και σχολιασμού του σχεδίου και να αποφεύγονται τα σφάλματα που οφείλονται στη χρήση διαφορετικών 

μονάδων. Μπορείτε να εισαγάγετε την εντολή DWGUNITS ή να κάνετε κλικ στην Κορδέλα  Express  Τροποποίηση  

Μονάδες DWG. 

 
Ενδείξεις γραμμής εντολών: 

⮚  (1) Εισάγετε μονάδες για το μήκος <3>: Η προεπιλεγμένη μονάδα για τα σχέδια του Ηνωμένου Βασιλείου είναι "3. 

Χιλιοστά" και για μετρικά σχέδια είναι "1. ίντσες". Διατίθενται έξι κοινές 

μονάδες. 

 
⮚  (2) Εισάγετε τη μορφή γραμμικής απεικόνισης<4>: 
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⮚  (3) Εισάγετε την ακρίβεια γραμμικής απεικόνισης<4>: 

 

⮚  (4)   

 
Ελέγχει αν τα αντικείμενα που εισάγονται στο τρέχον σχέδιο θα κλιμακώνονται σύμφωνα με τα υπάρχοντα αντικείμενα. 

Εάν οριστεί σε "Ναι", τα αντικείμενα που εισάγονται μπορούν να κλιμακωθούν για να ταιριάζουν καλύτερα με το 

τρέχον περιβάλλον σχεδίασης. 

⮚  (5)   

Βεβαιωθείτε ότι οι διαστάσεις των αντικειμένων αντιστοιχούν στην κλίμακα του σχεδίου. Εάν οριστεί σε "Ναι", τα 

εισαγόμενα αντικείμενα θα μετρηθούν και θα εμφανιστούν χρησιμοποιώντας τις ίδιες μονάδες με το τρέχον 

σχέδιο. 

⮚  (6)   

Ελέγχει αν οι διαστάσεις και η κλίμακα των αντικειμένων στο τρέχον σχέδιο προσαρμόζονται ώστε να αντικατοπτρίζουν την τροποποίηση της 
μονάδας. 

⮚  (7)   

 
Ελέγχει αν τα αντικείμενα περιλαμβάνονται στο χώρο pper. 

 
Για παράδειγμα, κατά τη μετατροπή ενός σχεδίου από αγγλικές (ίντσες) σε μετρικές (χιλιοστά) μονάδες, Μετά την εκτέλεση 

της εντολής DWGUNITS, η μονάδα του αντικειμένου τροποποιείται： 

 

 

Σημείωση: Διαφορετικές επιλογές ενδέχεται να οδηγήσουν σε διαφορετικές προτροπές. Ακολουθήστε τις οδηγίες στη γραμμή εντολών για ακριβείς 
οδηγίες. 
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5.1.3. Ορισμός συμβάσεων γωνίας 

 
Μπορείτε να καθορίσετε τη θέση για τη γωνία 0 και τη θετική 

κατεύθυνση για τη μέτρηση της γωνίας: δεξιόστροφα ή 

αριστερόστροφα. Μπορείτε επίσης να καθορίσετε τη μορφή και τον 

αριθμό του δεκαδικού κλάσματος. 

 
-Καθορίστε τη μονάδα μέτρησης και την ακρίβεια: Οι μονάδες 

περιλαμβάνουν βαθμίδα, ακτίνα, μονάδα τοπογράφου και βαθμό, 

λεπτό και δευτερόλεπτο. 

 
-Καθορίστε από πού ξεκινάει η μέτρηση της γωνίας: ανατολικά, 

δυτικά, νότια, βόρεια ή άλλα. Για παράδειγμα, για να εισαγάγετε μια 

συντεταγμένη σε σχέση με την τρέχουσα συντεταγμένη για μια γραμμή 

ιδιοκτησίας που έχει μήκος 54 πόδια, 7 ίντσες κ α ι  διόπτευση 60 

μοίρες βόρεια, 12 λεπτά, 6 δευτερόλεπτα ανατολικά, εισαγάγετε 

@54'7"<n60d12'6 "e. 

 
-Καθορίστε τη θετική κατεύθυνση: αριστερόστροφα ή δεξιόστροφα. Η γωνία 0 μπορεί να οριστεί σε οποιαδήποτε θέση. 

 

 
5.1.4. Ρύθμιση παραγόντων κλίμακας 

 
Αντί να σχεδιάζετε σε μια συγκεκριμένη κλίμακα, σχεδιάζετε τα πάντα σε 

πλήρες μέγεθος στο πρόγραμμα. Όταν εκτυπώνετε το σχέδιό σας, 

μπορείτε να ορίσετε την κλίμακα στην οποία θα εκτυπωθεί το σχέδιο. Η 

κλίμακα, ωστόσο, επηρεάζει τον τρόπο εκτύπωσης ορισμένων στοιχείων, 

όπως το κείμενο, τα βέλη ή τα είδη γραμμών στο σχέδιό σας. Για 

παράδειγμα, όταν σχεδιάζετε κείμενο, πρέπει να καθορίσετε το μέγεθος 

του κειμένου, ώστε όταν το εκτυπώσετε αργότερα σε συγκεκριμένη 

κλίμακα, το ύψος του κειμένου να είναι σωστό. 

 
Αφού καθορίσετε την τελική κλίμακα του τελικού σχεδίου σας, μπορείτε 

να υπολογίσετε τον συντελεστή κλίμακας για το σχέδιο ως αναλογία μιας 

μονάδας σχεδίασης προς την πραγματική μονάδα κλίμακας που 

αντιπροσωπεύει κάθε μονάδα σχεδίασης. 

 
Ο παρακάτω πίνακας παρουσιάζει ορισμένες τυπικές αναλογίες κλίμακας 

αρχιτεκτονικής και μηχανικής και ισοδύναμα ύψη κειμένου που απαιτούνται 

για τη δημιουργία κειμένου ύψους 1/8 ίντσας όταν εκτυπώνετε το σχέδιο 

στην καθορισμένη κλίμακα. 

 
Μπορείτε να χρησιμοποιήσετε αυτούς τους συντελεστές κλίμακας για να 

προκαθορίσετε το μέγεθος του σχεδίου σας, ώστε να βεβαιωθείτε ότι  

 

Κλίμακα Παράγοντα
ς κλίμακας 

Ύψος 
κειμένου 

1/16" = 1'-0" 192 24" 

1/8" = 1'-0" 96 12" 

3/16" = 1'-0" 64 8" 

1/4" = 1'-0" 48 6" 

3/8" = 1'-0" 32 4" 

1/2" = 1'-0" 24 3" 

3/4" = 1'-0" 16 2" 

1" = 1'-0" 12 1.5" 

1 1/2" = 1'-0" 8 1" 

3" = 1'-0" 4 0.5" 

1" = 10' 120 15" 

1" = 20' 240 30" 

1" = 30' 360 45" 

1" = 40' 480 60" 

1" = 50' 600 75" 

1" = 60' 720 90" 

1" = 100' 1200 150" 

 

 

Τυπικές αναλογίες κλίμακας και ισοδύναμα ύψη κειμένου 
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χωράει σε χαρτί συγκεκριμένου μεγέθους όταν το εκτυπώσετε. Ελέγχετε το 

μέγεθος του σχεδίου σας μέσω των ορίων σχεδίασης. Για να 

υπολογίσετε τα όρια σχεδίασης ώστε να ταιριάζουν με το μέγεθος του 

χαρτιού σας, πολλαπλασιάστε τις διαστάσεις του μεγέθους του 

χαρτιού σας με τον συντελεστή κλίμακας. 

 
5.2. Όρια σχεδίασης 

 
Μπορείτε να καθορίσετε τα όρια σχεδίασης που σχηματίζουν ένα αόρατο όριο γύρω από το σχέδιό σας. Μπορείτε να 

χρησιμοποιήσετε τα όρια σχεδίασης για να βεβαιωθείτε ότι δεν δημιουργείτε ένα σχέδιο μεγαλύτερο από αυτό που 

μπορεί να χωρέσει σε ένα συγκεκριμένο φύλλο χαρτιού όταν εκτυπωθεί σε συγκεκριμένη κλίμακα. 

 
Για παράδειγμα, αν σκοπεύετε να εκτυπώσετε το σχέδιό σας σε 1/8" = 1'-0" (με άλλα λόγια, χρησιμοποιώντας 

συντελεστή κλίμακας 96) σε ένα φύλλο χαρτιού διαστάσεων 36 ίντσες x 24 ίντσες, μπορείτε να ορίσετε τα όρια 

σχεδίασης σε 3.264 μονάδες πλάτους (δηλαδή 34 x 96) και 2.112 μονάδες ύψους (22 x 96), γεγονός που επιτρέπει ένα 

περιθώριο 1 ίντσας γύρω από τις άκρες του 

τυπωμένη εικόνα. 

 
Για να ορίσετε τα όρια σχεδίασης: Γραμμή 

εντολών> ΟΡΙΑ 

 
-Επιλογή Μορφή > Όρια σχεδίασης 

-Ορίστε τη συντεταγμένη x και τη συντεταγμένη y του άνω 

δεξιού ορίου σχεδίασης και του κάτω αριστερού ορίου σχεδίασης. 

Μπορείτε επίσης να κάνετε κλικ στο Select (Επιλογή) για να 

καθορίσετε τα όρια σχεδίασης επιλέγοντας σημεία στο σχέδιο. 

 
5.3. Πλέγμα και πλέγμα 

 
Το πλέγμα είναι ένα ορθογώνιο μοτίβο που αποτελείται 

από δευτερεύουσες και κύριες γραμμές που εκτείνονται 

στην περιοχή σχεδίασης. Εμφάνιση πλεγμάτων 

και η χρήση πλεγμάτων που βελτιώνουν την απόδοση της 

αναγέννησης. Όταν ενεργοποιείτε τη λειτουργία Snap, ο 

δρομέας προσκολλάται ή κουμπώνει στα αόρατα πλέγματα. 

Οι ρυθμίσεις πλέγματος και snap είναι αποτελεσματικά 

εργαλεία που μπορείτε να χρησιμοποιήσετε στο σχέδιό σας 

για να διασφαλίσετε την ακρίβεια. Επιπλέον, ο δρομέας μπορεί 

να περιοριστεί ώστε να κινείται μόνο ορθογώνια ή οι οδηγοί 

μπορούν να εμφανίζονται αυτόματα στην οθόνη σε 

καθορισμένα βήματα πολικής γωνίας. 
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5.3.1. Αλλαγή διαστήματος πλέγματος και Snap 

 
ou μπορείς να ενεργοποιείς και να απενεργοποιείς το πλέγμα και το πλέγμα και να καθορίζεις την απόστασή τους στην 

καρτέλα Πλέγμα και πλέγμα στο παράθυρο διαλόγου Ρυθμίσεις σχεδίασης. Η απόσταση του πλέγματος δεν χρειάζεται να 

ταιριάζει με την απόσταση των συμπληρωματικών στοιχείων. Μια ευρεία απόσταση πλέγματος μπορεί να χρησιμοποιηθεί 

ως αναφορά, ενώ μια στενότερη απόσταση πλέγματος σας βοηθά να προσδιορίσετε με ακρίβεια τα σημεία. 

 

 

 

 

 

 

 

 

 
5.4. Χρήση αντικειμένων Snaps 

 
Τα snaps αντικειμένων σας επιτρέπουν να επιλέγετε γρήγορα ακριβή 

γεωμετρικά σημεία σε υπάρχουσες οντότητες χωρίς να χρειάζεται να 

γνωρίζετε τις ακριβείς συντεταγμένες αυτών των σημείων. Με τα 

στιγμιότυπα αντικειμένων, μπορείτε να επιλέξετε το τελικό σημείο μιας 

γραμμής ή ενός τόξου, το κεντρικό σημείο ενός κύκλου, την τομή δύο 

οντοτήτων ή οποιαδήποτε άλλη γεωμετρικά σημαντική θέση. Μπορείτε 

επίσης να χρησιμοποιήσετε στιγμιότυπα αντικειμένων για να 

σχεδιάσετε οντότητες που εφάπτονται ή είναι κάθετες σε μια υπάρχουσα 

οντότητα. 

 

 

5.4.1. Ρύθμιση αντικειμένων Snaps 

 
Μπορείτε να ορίσετε στιγμιότυπα αντικειμένων χρησιμοποιώντας οποιαδήποτε από τις ακόλουθες μεθόδους: 

 
-Επιλέξτε Εργαλεία > Ρυθμίσεις σχεδίασης > Αντικειμενική 

αποτύπωση και, στη συνέχεια, κάντε κλικ σε ένα από τα 

εργαλεία αποτύπωσης αντικειμένων. 

-Στη γραμμή εργαλείων Object Snap, κάντε κλικ σε ένα από τα εργαλεία Snap αντικειμένου. 

-Στη γραμμή κατάστασης, κάντε δεξί κλικ στο κουμπί Object Snap 

για να επιλέξετε Settings (Ρυθμίσεις). 

-Πιέστε και κρατήστε πατημένο το πλήκτρο Shift ενώ κάνετε δεξί 

κλικ οπουδήποτε μέσα στο παράθυρο σχεδίασης για να εμφανιστεί το 

μενού συντόμευσης αντικειμένου και, στη συνέχεια, επιλέξτε τη 
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συντόμευση αντικειμένου που θέλετε να ορίσετε. 

 
Επιπλέον, μπορείτε να βρείτε μια επιλογή που ονομάζεται Απόσταση από το τελικό σημείο. 

Αυτή η επιλογή επιτρέπει τη λήψη μιας συγκεκριμένης απόστασης από οποιοδήποτε τελικό σημείο του 

αντικείμενα όπως γραμμή, τόξο, spline, pline, τόξο έλλειψης, mline και οποιεσδήποτε άλλες γραμμές. Όσο περνάτε τον 

κέρσορα πάνω από ένα αντικείμενο από τα τελικά του σημεία, θα βλέπετε ένα πράσινο σημείο αποκοπής σε ακριβή 

απόσταση. 

 
 
 
 
 
 
 

 
Μια άλλη επιλογή με την ονομασία Divide Segments (Διαίρεση τμημάτων) επιτρέπει την τοποθέτηση των σημείων του 

διαχωρισμένου τμήματος αντικειμένων όπως γραμμή, τόξο, spline, pline, τόξο έλλειψης, mline και οποιεσδήποτε άλλες 

γραμμές. Πριν, αν θέλετε να βρείτε το σημείο διαχωρισμού, πρέπει πρώτα να δημιουργήσετε το αντικείμενο διαιρεμένων 

σημείων και στη συνέχεια να ασφαλίσετε αυτά τα σημεία για να τα σχεδιάσετε. Τώρα, εφόσον περάσετε τον κέρσορα πάνω από 

ένα αντικείμενο που αναφέρθηκε παραπάνω, θα δείτε ένα πράσινο σημείο snap σε ακριβή απόσταση. 

 
5.4.2. Εργαλεία AutoSnap 

 
Το εργαλείο αυτόματης σύλληψης είναι ένα εργαλείο 

οπτικής βοήθειας για τη σύλληψη που σας βοηθάει να 

βλέπετε και να χρησιμοποιείτε πιο αποτελεσματικά τη 

σύλληψη αντικειμένων. Όταν είναι ενεργοποιημένο 

οποιοδήποτε συμπληρωματικό αντικείμενο, το σύστημα 

εμφανίζει έναν δείκτη και μια συμβουλή εργαλείου όταν 

μετακινείτε τον κέρσορα πάνω από ένα σημείο 

συμπληρωματικού σημείου. Το AutoSnap ενεργοποιείται 

αυτόματα όταν είναι ενεργοποιημένο ένα snap 

αντικειμένου. Από προεπιλογή, ο δείκτης AutoSnap, το 

tooltip και ο μαγνήτης είναι ενεργοποιημένα. Μπορείτε να 

αλλάξετε τις ρυθμίσεις του AutoSnap στο πλαίσιο διαλόγου 

Options (Επιλογές). Το AutoSnap αποτελείται από τα 

ακόλουθα εργαλεία snap: 

 
-Μάρκα. Η θέση του αντικειμένου εμφανίζεται όταν ο δρομέας 

κινείται πάνω ή κοντά σε ένα αντικείμενο. Το σχήμα του  
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μαρκαδόρου καθορίζεται από το στιγμιότυπο που 

μαρκάρει. 

 
-Tooltip. Δείχνει σε ποιο μέρος του αντικειμένου κάνετε κλικ με μια σημαία στη θέση του δρομέα. 

 
-Μαγνήτης. Προσελκύει και κλειδώνει τον κέρσορα στα πλησιέστερα ανιχνευμένα σημεία συγκράτησης. 

 
-Κιβώτιο διαφράγματος. Περιβάλλει το σταυρόνημα και ορίζει μια περιοχή εντός της οποίας, όταν μετακινείτε τον κέρσορα, το 

σύστημα αξιολογεί τα αντικείμενα για αντικειμενικές εμπλοκές. Μπορείτε να καθορίσετε αν το πλαίσιο διαφράγματος 

εμφανίζεται ή όχι, ενώ μπορείτε επίσης να αλλάξετε το μέγεθος του πλαισίου διαφράγματος. 

 
5.4.3. Επιλογή Ποδηλασία 

 
Με τη νέα μεταβλητή του συστήματος SELECTIONCYCLING μπορείτε να επιλέξετε γρήγορα επικαλυπτόμενα ή συμπίπτοντα 

αντικείμενα στο τρέχον σχέδιο, καθώς και να ορίσετε επιλογές κυκλικής επιλογής. 

 

 

 
Το κουμπί Selection Cycling βρίσκεται στη γραμμή κατάστασης. 

Κάντε δεξί κλικ στο κουμπί για να καθορίσετε τις ρυθμίσεις κυκλικής 

επιλογής. Αυτές οι ρυθμίσεις ελέγχουν αν θα εμφανίζεται ένα σήμα ή το 

παράθυρο διαλόγου Selection (Επιλογή) όταν περνάτε με το ποντίκι 

πάνω από ένα επικαλυπτόμενο αντικείμενο ή όταν επιλέγετε ένα 

επικαλυπτόμενο αντικείμενο. 
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Επιτρέψτε την κυκλική επιλογή: Ενεργοποιεί/απενεργοποιεί τη λειτουργία κυκλικής επιλογής. Μπορείτε επίσης να ορίσετε 

αυτή την επιλογή με τη μεταβλητή συστήματος SELECTIONCYCLING. 

Εμφανίζει το πλαίσιο λίστας ποδηλασίας επιλογής: Εμφανίζει το πλαίσιο λίστας Selection Cycling. 

Εξαρτάται από τον κέρσορα: Μετακινεί το πλαίσιο της λίστας σε σχέση με τη θέση του δρομέα ανάλογα με το τεταρτημόριο 

(πάνω αριστερά, πάνω δεξιά, κάτω δεξιά, κάτω αριστερά), την απόσταση σε pixels ή απλά στατικά. 

Εμφάνιση γραμμής τίτλου: Για εξοικονόμηση χώρου στην οθόνη, απενεργοποιήστε τη γραμμή τίτλου. 

Για να επιλέξετε επικαλυπτόμενα αντικείμενα, βεβαιωθείτε ότι είναι ενεργοποιημένη η επιλογή Κύκλωση επιλογής στη 

γραμμή κατάστασης. Καθώς περνάτε τον κέρσορα πάνω από αντικείμενα, θα δείτε ένα εικονίδιο που υποδεικνύει ότι 

πολλαπλά αντικείμενα είναι διαθέσιμα για επιλογή. Κάντε κλικ για να δείτε μια λίστα με τα διαθέσιμα αντικείμενα και, 

στη συνέχεια, κάντε κλικ στη λίστα για να επιλέξετε το αντικείμενο που θέλετε. 
 

 
5.5. Χρήση Polar Tracking και Object Snap Tracking 

 
Η αυτόματη παρακολούθηση περιλαμβάνει την πολική παρακολούθηση και την παρακολούθηση αντικειμένου με 

συμπληρωματική κίνηση. Μπορείτε να τις ενεργοποιήσετε και να τις απενεργοποιήσετε πατώντας ξανά τα κουμπιά POLAR και 

OTRACK στη γραμμή κατάστασης. Όταν είναι ενεργοποιημένη η λειτουργία πολικής παρακολούθησης, ο δρομέας κινείται 

κατά μήκος της καθορισμένης γωνίας. Όταν είναι ενεργοποιημένη η παρακολούθηση με συμπληρωματικό εντοπισμό 

αντικειμένου, ο δρομέας κινείται κατά μήκος μιας διαδρομής ευθυγράμμισης με βάση το σημείο συμπληρωματικού 

εντοπισμού. 

 
 

 
5.5.1. Πολική παρακολούθηση 

 
Οι οδηγοί εμφανίζονται στην οθόνη αυτόματα στην αύξηση της πολικής γωνίας που 

καθορίζετε όταν είναι ενεργοποιημένη η πολική παρακολούθηση. Για παράδειγμα, αν 

σχεδιάσετε μια γραμμή με βήμα γωνίας που έχει οριστεί ως 65 μοίρες με ενεργοποιημένη την 

πολική παρακολούθηση, η γραμμή με ελαστική ταινία εμφανίζεται με βήμα 65 μοιρών. 
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Για να ενεργοποιήσετε την πολική παρακολούθηση και να καθορίσετε την προσαύξηση της πολικής γωνίας: 

 
1. Κάντε ένα από τα ακόλουθα:-Επιλέξτε Εργαλεία > Ρυθμίσεις σχεδίασης από το κύριο μενού. 

-Στη γραμμή εργαλείων Object Snap, κάντε κλικ στο κουμπί Object Snap Settings. 

-Πληκτρολογήστε DSETTINGS στη γραμμή εντολών και, στη συνέχεια, πατήστε Enter. 

2. Μεταβείτε στην καρτέλα Polar Tracking. 

3. Επιλέξτε το πλαίσιο ελέγχου Polar Tracking On. 

 

 

 

 

 

 

 

 

 
4. Κάντε ένα από τα ακόλουθα για να καθορίσετε τα βήματα της πολικής γωνίας: 

-Επιλέξτε μια γωνία από την αναπτυσσόμενη λίστα Increment Angle. 

-Επισημάνετε το πλαίσιο ελέγχου Πρόσθετες γωνίες και κάντε κλικ στην επιλογή Νέα 

για να ορίσετε μια προσαρμοσμένη αύξηση γωνίας. 

5. Κάντε κλικ στο OK. 

 
Παρατήρηση: Για να ενεργοποιήσετε ή να 

απενεργοποιήσετε την παρακολούθηση 

πόλων ανά πάσα στιγμή, κάντε κλικ στο 

κουμπί Polar Tracking στη γραμμή 

κατάστασης ή πατήστε F10. 

 
Για να σχεδιάσετε αντικείμενα χρησιμοποιώντας πολική παρακολούθηση: 

 
-Ενεργοποιήστε την παρακολούθηση πόλων και ξεκινήστε μια εντολή σχεδίασης, 

όπως ARC, CIRCLE ή LINE. Μπορείτε επίσης να χρησιμοποιήσετε την πολική 

παρακολούθηση με εντολές επεξεργασίας, όπως COPY και MOVE. 

 
-Καθώς μετακινείτε τον κέρσορα για να καθορίσετε σημεία, παρατηρήστε τη 

διακεκομμένη γραμμή πολικής παρακολούθησης που εμφανίζεται στις γωνίες 

παρακολούθησης που καθορίσατε. Τα σημεία που καθορίζετε ενώ εμφανίζεται η 

γραμμή συμμορφώνονται με τη γωνία πολικής παρακολούθησης. 

 

 
5.5.2. Παρακολούθηση αντικειμένου Snap Tracking 

 
Η ανίχνευση αντικειμένου με στιγμιαίο εντοπισμό μπορεί να παρακολουθείται κατά μήκος διαδρομών ευθυγράμμισης που 

βασίζονται σε σημεία στιγμιαίου εντοπισμού αντικειμένου και να εμφανίζει συμβουλές εργαλείων στα σημεία που έχουν 



Κεφάλαιο 5_ Εργαλεία ακριβείας και οι ιδιότητες του σχεδίου 
 

Σ ε λ ί δ α  81 | 296  

αποκτηθεί. Αφού αποκτήσετε ένα σημείο, οι οριζόντιες, κατακόρυφες και πολικές διαδρομές ευθυγράμμισης σε σχέση με το 

σημείο εμφανίζονται όταν ο δρομέας κινείται πάνω από τη διαδρομή σχεδίασής τους. Για παράδειγμα, μπορείτε να καθορίσετε 

ένα σημείο κατά μήκος μιας διαδρομής που βασίζεται σε ένα τελικό ή μεσαίο σημείο αντικειμένου ή σε ένα σημείο τομής 

μεταξύ αντικειμένων. 

 
Μπορείτε επίσης να χρησιμοποιήσετε τη μεταβλητή TRACKPATH του συστήματος για να ελέγξετε την εμφάνιση των διαδρομών 
ευθυγράμμισης της πολικής παρακολούθησης και της ευθυγράμμισης αντικειμένου. 
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5.6. Χρήση ορθογωνίου (λειτουργία Ortho) 

 
Μπορείτε να περιορίσετε την κίνηση του δρομέα στους τρέχοντες οριζόντιους και κάθετους άξονες, ώστε να μπορείτε να 

σχεδιάζετε σε ορθές γωνίες ή ορθογώνια. Για παράδειγμα, όταν είναι ενεργοποιημένη η επιλογή Σχεδίαση ορθογωνίου, 

οι γραμμές περιορίζονται σε 0 μοίρες, 90 μοίρες, 180 μοίρες ή 270 μοίρες. Καθώς σχεδιάζετε γραμμές, η ελαστική γραμμή 

ακολουθεί είτε τον οριζόντιο είτε τον κατακόρυφο άξονα, ανάλογα με το ποιος άξονας βρίσκεται πιο μακριά από το δρομέα. 

Όταν ενεργοποιείτε την ισομετρική αποτύπωση και το πλέγμα, η κίνηση του δρομέα περιορίζεται σε ορθογώνια 

ισοδύναμα εντός του τρέχοντος ισομετρικού επιπέδου. Η ορθομετρική λειτουργία και η πολική παρακολούθηση δεν μπορούν 

να είναι ταυτόχρονα ενεργοποιημένες. 

Η ενεργοποίηση της λειτουργίας Ortho 

απενεργοποιεί την πολική 

παρακολούθηση. Για να 

ενεργοποιήσετε γρήγορα την 

ορθογώνια σχεδίαση: 

-Πιέστε F8 ή πιέστε το κουμπί ORTO στη γραμμή κατάστασης. 

 
5.7. Εργασία με τύπους γραμμών 

 
Ο τύπος γραμμής είναι ένα επαναλαμβανόμενο μοτίβο παύλας, κουκκίδων και κενών διαστημάτων που εμφανίζεται σε 

μια γραμμή ή μια καμπύλη. Μπορείτε να εκχωρήσετε τύπους γραμμών σε αντικείμενα ανά επίπεδο ή καθορίζοντας 

ρητά τον τύπο γραμμής. Και επίσης, μπορείτε να καθορίσετε την κλίμακά του, 

να φορτώσετε περισσότερους τύπους γραμμών στο πρόγραμμα από ένα αρχείο 

βιβλιοθήκης τύπων γραμμών και να δημιουργήσετε τους δικούς σας 

προσαρμοσμένους τύπους γραμμών. 

 
Από προεπιλογή, κάθε σχέδιο έχει τουλάχιστον τρεις τύπους γραμμών: ΣΥΝΕΧΗΣ, 

BYLAYER και BYBLOCK. Δεν μπορείτε να μετονομάσετε ή να διαγράψετε αυτούς 

τους τύπους γραμμών. 

 

 

 

 

 
Παρατήρηση: Δεν πρέπει να συγχέετε αυτούς τους τύπους γραμμών με τους τύπους 

γραμμών υλικού που παρέχονται από ορισμένα plotter. Και οι δύο τύποι γραμμών 

παύλας παράγουν παρόμοια αποτελέσματα. Ωστόσο, εάν χρησιμοποιείτε και τους δύο 

τύπους γραμμών ταυτόχρονα, τα αποτελέσματα μπορεί να είναι απρόβλεπτα. 
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5.7.1. Φόρτωση τύπων γραμμών 

 
Το GstarCAD περιλαμβάνει τα αρχεία ορισμού τύπων γραμμών gcad.lin και gcadiso.lin. Εάν επιλέξετε το gcadiso.lin, 

μπορείτε να χρησιμοποιήσετε την επιλογή ISO pen-width όταν σχεδιάζετε.Εάν θέλετε να μάθετε ποια είδη γραμμοτύπων είναι 

ήδη διαθέσιμα, μπορείτε να εμφανίσετε μια λίστα με τα είδη γραμμοτύπων που είναι φορτωμένα στο σχέδιο ή αποθηκευμένα 

σε ένα αρχείο LIN (ορισμός γραμμοτύπων). Και τα δύο αρχεία ορισμού τύπου γραμμής περιέχουν διάφορους σύνθετους 

τύπους γραμμής. 

 
5.7.2. Αλλαγή του τύπου γραμμής ενός αντικειμένου 

 
Μπορείτε να αλλάξετε τον τύπο γραμμής ενός αντικειμένου 

αλλάζοντας τον τύπο γραμμής της στρώσης στην οποία 

βρίσκεται το αντικείμενο, αναθέτοντας το αντικείμενο σε άλλη 

στρώση ή καθορίζοντας απευθείας έναν τύπο γραμμής για το 

αντικείμενο. 

 
 
 

 
5.7.3. Ορισμός του τρέχοντος τύπου γραμμής 

 
Από προεπιλογή, όλα τα αντικείμενα δημιουργούνται 

χρησιμοποιώντας το τρέχον είδος γραμμής, το οποίο 

εμφανίζεται στο στοιχείο ελέγχου είδους γραμμής στη γραμμή 

εργαλείων Ιδιότητες. Για να τροποποιήσετε αυτό το τρέχον 

linetype, μπορείτε να επιλέξετε ένα linetype και να το κάνετε 

τρέχον στο παράθυρο διαλόγου Linetype Manager. Εάν το 

τρέχον linetype είναι BYLAYER, τα αντικείμενα δημιουργούνται 

χρησιμοποιώντας το linetype που έχει εκχωρηθεί στην 

τρέχουσα στρώση. 
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Εάν το τρέχον είδος γραμμής είναι BYBLOCK, τα αντικείμενα δημιουργούνται με το είδος γραμμής CONTINOUS μέχρι να 

ομαδοποιηθούν σε ένα μπλοκ. Όταν εισάγετε το μπλοκ, αποκτά την τρέχουσα ρύθμιση τύπου γραμμής. 

 
Για να καταστήσετε τον τύπο γραμμής τρέχοντα: 

 
Επιλέξτε έναν τύπο γραμμής από την πτυσσόμενη λίστα Linetype Control (Έλεγχος τύπου γραμμής) στη γραμμή εργαλείων Properties (Ιδιότητες), η 
οποία έχει οριστεί στον τρέχοντα τύπο γραμμής. 

 
5.7.4. Κλίμακα γραμμής ελέγχου 

 
Μπορείτε να ορίσετε συνολικές ή μεμονωμένες κλίμακες για αντικείμενα για να ελέγξετε την εμφάνιση των τύπων 

γραμμών. Ο παγκόσμιος παράγοντας κλίμακας και η τρέχουσα κλίμακα αντικειμένου εμφανίζονται στη Διαχείριση 

γραμμοτύπων. Η τιμή του Global Scale Factor αποθηκεύεται στη μεταβλητή συστήματος LTSCALE, η οποία αλλάζει την 

κλίμακα των γραμμοτύπων σε παγκόσμιο επίπεδο για νέα και υπάρχοντα αντικείμενα. 

 
Η Τρέχουσα κλίμακα αντικειμένου αποθηκεύεται στη μεταβλητή 

συστήματος CELTSCALE, η οποία καθορίζει την κλίμακα τύπου 

γραμμής για νέα αντικείμενα. Σε μια διάταξη, μπορείτε να 

χρησιμοποιήσετε τη μεταβλητή συστήματος PSLTSCALE για να 

ρυθμίσετε την κλίμακα γραμμοτύπου σε διαφορετικά παράθυρα 

προβολής. 

 
Παρατήρηση: Η ρύθμιση της κλίμακας τύπου γραμμής σε πολύ 

μεγάλη ή πολύ μικρή κλίμακα μπορεί να έχει ως αποτέλεσμα ένα 

μοτίβο γραμμής να μοιάζει με συμπαγή γραμμή, ανάλογα με την 

προβολή κλίμακας ή την κλίμακα εκτύπωσης του σχεδίου. 

 
Για να ορίσετε την τρέχουσα κλίμακα μεμονωμένων 

γραμμοτύπων: Γραμμή 

εντολών> LINETYPE 

 
-Επιλέξτε Μορφή > Τύπος γραμμής-Κάντε κλικ στο κουμπί Εμφάνιση λεπτομερειών.-Στο πεδίο Τρέχουσα κλίμακα 

αντικειμένου, πληκτρολογήστε την κλίμακα τύπου γραμμής που θέλετε να γίνει τρέχουσα.-Κάντε κλικ στο κουμπί OK. 
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Για να αλλάξετε την παγκόσμια κλίμακα τύπου γραμμής: -Στο πεδίο Global Scale Factor, πληκτρολογήστε την 

παγκόσμια κλίμακα γραμμοτύπου που θέλετε να αλλάξετε. Στη συνέχεια, κάντε κλικ στο κουμπί OK. 

 
5.8. Εργασία με επίπεδα 

 
Τα επίπεδα είναι σαν τις διαφανείς επικαλύψεις που 

χρησιμοποιείτε στη χειροκίνητη σχεδίαση. Χρησιμοποιείτε 

τα επίπεδα για να οργανώσετε διαφορετικούς τύπους 

πληροφοριών σχεδίασης. Κάθε αντικείμενο σε ένα σχέδιο 

υπάρχει σε μια στρώση. Όταν σχεδιάζετε ένα αντικείμενο, 

αυτό δημιουργείται στην τρέχουσα στρώση. 

 
5.8.1. Δημιουργία και ονομασία επιπέδων 

 
Μπορείτε να δημιουργήσετε απεριόριστο αριθμό επιπέδων σε κάθε σχέδιο και να χρησιμοποιήσετε αυτά τα επίπεδα για την 

οργάνωση των πληροφοριών. Όταν δημιουργείτε μια νέα στρώση, της αποδίδεται αρχικά το λευκό χρώμα (ή το μαύρο, 

ανάλογα με τις ρυθμίσεις του συστήματός σας) και ο τύπος γραμμής CONTINUOUS. Από προεπιλογή, μια νέα στρώση 

είναι επίσης ορατή. Αφού δημιουργήσετε και ονομάσετε μια στρώση, μπορείτε να αλλάξετε το χρώμα της, τον τύπο γραμμής, 

την ορατότητα και άλλες ιδιότητες. 

 
Για να δημιουργήσετε μια νέα στρώση: Στρώμα Γραμμή εντολών> LAYER 

 
-Επιλέξτε Μορφή > Στρώμα-Κάντε κλικ στο κουμπί Νέο στρώμα. 

-Πληκτρολογήστε ένα όνομα για το νέο επίπεδο και, στη συνέχεια, κάντε κλικ στο OK. Για να αλλάξετε το όνομα μιας στρώσης 

στο τρέχον σχέδιο: 

-Επιλέξτε Μορφή > Στρώμα-στο παράθυρο διαλόγου Διαχείριση ιδιοτήτων στρώματος, κάντε κλικ στο όνομα του στρώματος που θέλετε να αλλάξετε. 

-Πληκτρολογήστε ένα νέο όνομα και κάντε κλικ στο κουμπί OK. 

 
5.8.2. Ρύθμιση του τρέχοντος επιπέδου 

 
Όταν ξεκινάτε ένα σχέδιο, τα αντικείμενα 

δημιουργούνται στην τρέχουσα στρώση. Από 

προεπιλογή, η στρώση 0 ορίζεται ως η 

τρέχουσα στρώση, αλλά μπορείτε επίσης να 

δημιουργήσετε μια νέα στρώση και να την 

κάνετε τρέχουσα. Κάθε επόμενο αντικείμενο 

που δημιουργείτε συνδέεται με την τρέχουσα 

στρώση και χρησιμοποιεί το χρώμα και τον 

τύπο γραμμής της. 

 

 

 



Κεφάλαιο 5_ Εργαλεία ακριβείας και οι ιδιότητες του σχεδίου 
 

Σ ε λ ί δ α  86 | 296  

 
Για να κάνετε ένα στρώμα τρέχον: 

 
-Επιλέξτε Μορφή > Στρώμα-στο παράθυρο διαλόγου Διαχείριση ιδιοτήτων στρώματος, επιλέξτε ένα στρώμα και, στη 

συνέχεια, κάντε κλικ στο κουμπί Ορισμός τρέχοντος για να κάνετε το στρώμα τρέχον.-Κάντε κλικ στο OK. 

 
5.8.3. Αφαίρεση επιπέδων 

 
Μπορείτε να αφαιρέσετε αχρησιμοποίητες στρώσεις από το σχέδιό σας με την εντολή PURGE ή διαγράφοντας τη στρώση από τη 
Διαχείριση ιδιοτήτων στρώσεων. 

 

 
5.8.4. Έλεγχος ορατότητας στρώματος 

 
Ένα επίπεδο μπορεί να είναι ορατό ή αόρατο. 

Τα αντικείμενα σε αόρατα επίπεδα δεν 

εμφανίζονται και δεν εκτυπώνονται. Ελέγχοντας 

την ορατότητα στρώματος, μπορείτε να 

απενεργοποιήσετε περιττές πληροφορίες. 

 
Για να ενεργοποιήσετε ή να 

απενεργοποιήσετε τα επίπεδα:

 Γραμμή 

εντολών> LAYER 

 
-Επιλογή Μορφή > Στρώμα 

-Κάντε κλικ στο εικονίδιο στην καρτέλα "On" στη λίστα στρώσεων. 

-Κάντε κλικ στο κουμπί OK. 

5.8.5. Κλείδωμα και ξεκλείδωμα 

στρώσεων Το κλείδωμα μιας στρώσης σάς 

αποτρέπει από το τυχαίο 

τροποποιώντας τα αντικείμενά της. Δεν μπορείτε να 

επεξεργαστείτε μια στρώση ό τ α ν  είναι 

κλειδωμένη (αλλά ορατή και αποψυγμένη). Εάν 

κλειδώσετε την τρέχουσα στρώση, μπορείτε να 

προσθέσετε νέα αντικείμενα σε αυτήν. 

Μπορείτε επίσης να αλλάξετε τον τύπο γραμμής 

και το χρώμα που σχετίζονται με μια κλειδωμένη 

στρώση. Το ξεκλείδωμα μιας στρώσης αποκαθιστά 

τις πλήρεις δυνατότητες επεξεργασίας. 

 

 



Κεφάλαιο 5_ Εργαλεία ακριβείας και οι ιδιότητες του σχεδίου 
 

Σ ε λ ί δ α  87 | 296  

 
Για να κλειδώσετε ή να ξεκλειδώσετε 

στρώματα: Γραμμή 

εντολών> LAYER 

 
-Επιλέξτε Μορφή > Στρώμα από το κύριο μενού. 

-Κάντε κλικ στο εικονίδιο στην καρτέλα "Κλείδωμα" στη λίστα στρώσεων. 

-Κάντε κλικ στο κουμπί OK. 
 

 
5.8.6. Έλεγχος της εκτύπωσης στρώματος 

 
Ο έλεγχος της εκτύπωσης στρώσεων είναι ένας άλλος τρόπος με τον οποίο μπορείτε να καθορίσετε ποια αντικείμενα 

εκτυπώνονται στο σχέδιό σας. Ελέγχοντας την εκτύπωση στρώσεων, μπορείτε να απενεργοποιήσετε τις περιττές 

πληροφορίες κατά την εκτύπωση. Όταν απενεργοποιείτε την εκτύπωση για ένα επίπεδο, τα αντικείμενα που σχεδιάζονται σε 

αυτό το 

στρώμα εξακολουθούν να είναι ορατά, αλλά δεν εκτυπώνονται. 

 
Για να ενεργοποιήσετε ή να απενεργοποιήσετε την εκτύπωση στρώματος: Στρώμα: Μορφή > Στρώμα Γραμμή εντολών> LAYER 

 
-Επιλογή Μορφή > Στρώμα 

 
-Κάντε κλικ στο εικονίδιο στην καρτέλα "Plot" στη λίστα στρώσεων. 

 
-Κάντε κλικ στο κουμπί OK. 

 
5.8.7. Ρύθμιση του στυλ εκτύπωσης ενός επιπέδου 

 
Εάν το σχέδιό σας χρησιμοποιεί πίνακες στυλ εκτύπωσης με ονόματα, μπορείτε να καθορίσετε ένα στυλ εκτύπωσης για κάθε 

επίπεδο. Οι ονομαστικοί πίνακες στυλ εκτύπωσης περιέχουν στυλ εκτύπωσης που ρυθμίζετε για να ελέγχετε την εμφάνιση των 

αντικειμένων κατά την εκτύπωση, χωρίς στην πραγματικότητα να αλλάζετε τα αντικείμενα στο σχέδιο. Εάν το σχέδιό σας 

χρησιμοποιεί πίνακες στυλ εκτύπωσης που εξαρτώνται από το χρώμα, δεν μπορείτε να καθορίσετε ένα στυλ εκτύπωσης 

για μια στρώση. Αυτοί οι τύποι πινάκων στυλ εκτύπωσης καθορίζουν αυτόματα τις απαιτήσεις εκτύπωσης με βάση το 

χρώμα που έχει εκχωρηθεί σε μια στρώση ή ένα αντικείμενο. 

 

Για να αλλάξετε το στυλ εκτύπωσης που έχει εκχωρηθεί σε ένα ή περισσότερα επίπεδα (μόνο σε ένα σχέδιο 

που χρησιμοποιεί πίνακες στυλ εκτύπωσης με όνομα): Στρώμα > Στρώμα Γραμμή εντολών> LAYER 

-Επιλογή Μορφή > Στρώμα 

-Κάντε κλικ στο όνομα του Στυλ σχεδίασης στη λίστα επιπέδων 

για να ανοίξει το παράθυρο διαλόγου Select Plot Style (Επιλογή 

στυλ σχεδίασης), από το οποίο μπορείτε να καθορίσετε το 

επιθυμητό στυλ σχεδίασης. 

-Κάντε κλικ στο κουμπί OK. 
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5.8.8. Στρώσεις κατάψυξης ή απόψυξης 

 
Μπορείτε επίσης να παγώσετε στρώματα για να βελτιώσετε την απόδοση λειτουργιών όπως η μεγέθυνση και η σάρωση ή η 

παραγωγή κρυφών γραμμών ή σκιασμένων εικόνων. Όταν ένα επίπεδο παγώσει, τα αντικείμενα που σχεδιάζονται σε 

αυτό το επίπεδο δεν είναι πλέον ορατά. 

 
Για να καταψύξετε ή να ξεπαγώσετε στρώματα: Στρώμα Γραμμή εντολών> LAYER 

 
-Επιλογή Μορφή > Στρώμα 

-Κάντε κλικ στο εικονίδιο στην καρτέλα "Freeze" (Πάγωμα) στη λίστα στρώσεων. 

-Κάντε κλικ στο κουμπί OK. 

 
5.8.9. Ρύθμιση του χρώματος στρώματος 

 
Σε κάθε στρώση ενός σχεδίου εκχωρείται ένα 

χρώμα. Το GstarCAD χρησιμοποιεί το χρώμα 

BYLAYER ως προεπιλεγμένη ρύθμιση χρώματος 

για τη δημιουργία αντικειμένων, έτσι ώστε τα 

νέα αντικείμενα να σχεδιάζονται στο χρώμα της 

στρώσης στην οποία εισάγονται. 

 
Για να αλλάξετε το χρώμα του 

στρώματος: Στρώμα > 

Στρώμα Γραμμή εντολών> LAYER 

 
-Επιλογή Μορφή > Στρώμα 

-Κάντε κλικ στο εικονίδιο κάτω από την καρτέλα "Χρώμα" στη λίστα στρώσεων για να ανοίξει το παράθυρο διαλόγου Επιλογή 

χρώματος, από το οποίο μπορείτε να καθορίσετε το επιθυμητό χρώμα μέσω των καρτελών δείκτης, αληθές και βιβλία 

χρώματος -και στη συνέχεια κάντε κλικ στο κουμπί OK. 
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5.8.10. Ρύθμιση του Linetype ενός Layer 

 
Κάθε στρώμα χρησιμοποιεί ένα προεπιλεγμένο τύπο γραμμής. Ο τύπος γραμμής καθορίζει την εμφάνιση των αντικειμένων 

τόσο στην οθόνη όσο και κατά την εκτύπωση. Συνιστάται να εκχωρείτε το linetype BYLAYER σε όλα τα αντικείμενα που 

σχεδιάζετε σε αυτή τη στρώση. 

 
Για να αλλάξετε τον τύπο γραμμής που έχει 

εκχωρηθεί σε ένα ή περισσότερα επίπεδα: 

Format >Layer Γραμμή 

εντολών>LAYER 

 
-Επιλογή Μορφή > Στρώμα 

-Κάντε κλικ στο όνομα Linetype στη λίστα 

στρώσεων για να ανοίξει το παράθυρο 

διαλόγου Select Linetype, από το οποίο 

μπορείτε να καθορίσετε το επιθυμητό 

linetype. -Κάντε κλικ στο κουμπί OK. 

 
5.8.11. Ρύθμιση του Lineweight ενός Layer 

 
Κάθε στρώμα χρησιμοποιεί ένα προεπιλεγμένο βάρος γραμμής. Τα βάρη γραμμών 

καθορίζουν το πάχος των αντικειμένων τόσο στην οθόνη όσο και κατά την 

εκτύπωση. Σε όλες τις νέες στρώσεις εκχωρείται το DEFAULT lineweight, το οποίο 

είναι 0,25 χιλιοστά ή 0,01 ίντσες. Εάν θέλετε να εκχωρηθεί διαφορετικό βάρος 

γραμμής σε μια στρώση, μπορείτε εύκολα να το αλλάξετε χρησιμοποιώντας τη 

Διαχείριση ιδιοτήτων στρώσης. 

 
Για να αλλάξετε το βάρος γραμμής που αντιστοιχίζεται σε ένα ή 

περισσότερα επίπεδα: Γραμμή 

εντολών> LAYER 

 
-Επιλογή Μορφή > Στρώμα 

-Κάντε κλικ στο όνομα Lineweight (Βάρος γραμμής) στη λίστα στρώσεων για να ανοίξει το παράθυρο διαλόγου Lineweight (Βάρος γραμμής), από το 
οποίο μπορείτε να καθορίσετε το επιθυμητό βάρος γραμμής. 

-Κάντε κλικ στο κουμπί OK. 
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5.8.12. Φίλτρο Λίστα επιπέδων 

 
Μπορείτε να χρησιμοποιήσετε ένα φίλτρο στρώματος για να 

περιορίσετε την εμφάνιση των ονομάτων στρώματος στη 

Διαχείριση ιδιοτήτων στρώματος. Οι ακόλουθες ιδιότητες 

μπορούν να συμπεριληφθούν στον ορισμό του φίλτρου: 

Ονόματα στρώσεων, χρώματα, τύποι γραμμών, βάρη 

γραμμών και στυλ σχεδίασης, Εάν οι στρώσεις είναι 

κλειδωμένες ή ξεκλειδωμένες, ενεργοποιημένες ή 

απενεργοποιημένες, παγωμένες ή αποψυγμένες στο τρέχον 

παράθυρο προβολής ή σε όλα τα παράθυρα προβολής. 

Κατά τον ορισμό των συνθηκών φίλτρου, μπορείτε επίσης 

να χρησιμοποιήσετε χαρακτήρες μπαλαντέρ για να 

φιλτράρετε τα ονόματα με βάση το όνομα. Για παράδειγμα, 

πληκτρολογώντας D* εμφανίζει το όνομα στρώματος που 

προηγείται του D, απλά κάντε κλικ στο κουμπί Add 

(Προσθήκη) εάν έχει καθοριστεί το όνομα του φίλτρου. 

 
Για να φιλτράρετε τη λίστα στρωμάτων: 

 
-Επιλογή Μορφή > Στρώμα 

-Κάντε κλικ στο εικονίδιο New Property Filter, που βρίσκεται πάνω αριστερά στο παράθυρο. 

-Στο παράθυρο διαλόγου Ιδιότητες φίλτρου στρώματος, στην περιοχή Ορισμός φίλτρου, κάντε κλικ στις ιδιότητες των καρτελών που θέλετε να 
φιλτράρετε. Στη συνέχεια, κάντε κλικ στο OK. 

 
5.8.13. LAYULKALL 

 
Αν έχετε κλειδώσει πολλές στρώσεις και πρέπει να τις ξεκλειδώσετε όλες στο σχέδιό σας, μπορείτε να εισαγάγετε την 

εντολή LAYULKALL για να ξεκλειδώσετε αμέσως όλες τις κλειδωμένες στρώσεις. 

 

 
 

5.9. Αποσύνδεση γραμμοζυγίων 

 
Τα βάρη γραμμών εμφανίζονται διαφορετικά στη διάταξη του χώρου χαρτιού από ό,τι στο χώρο μοντέλων. Τα βάρη γραμμών 

είναι χρήσιμα για γραφικές αναπαραστάσεις διαφορετικών αντικειμένων και πληροφοριών. 
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5.9.1. Εμφάνιση γραμμοβαρών στο χώρο του μοντέλου 

 
Στο χώρο του μοντέλου, ένα βάρος γραμμής με τιμή 0 

εμφανίζεται ως εικονοστοιχείο και τα άλλα βάρη γραμμής 

εμφανίζονται με πλάτος εικονοστοιχείου ανάλογο της πραγματικής 

τους τιμής. Στο χώρο του μοντέλου, η απεικόνιση του βάρους 

γραμμής δεν αλλάζει με τον παράγοντα ζουμ. Μια τιμή βάρους 

γραμμής που αναπαρίσταται με πλάτος πολλών εικονοστοιχείων 

εμφανίζεται πάντα με τον ίδιο αριθμό εικονοστοιχείων. Στο χώρο 

μοντέλων, πατήστε το κουμπί LWT στη γραμμή εργαλείων 

κατάστασης για να ενεργοποιήσετε και να απενεργοποιήσετε την 

εμφάνιση του βάρους γραμμής. 

 
5.9.2. Εμφάνιση γραμμικών βαρών σε διατάξεις 

 
Στο χώρο χαρτιού (καρτέλα διάταξης), τα βάρη γραμμών εμφανίζονται σε ακριβές πλάτος σχεδίασης. Στην προεπισκόπηση 

σχεδίασης και στο χώρο χαρτιού, τα βάρη γραμμών εμφανίζονται σε πραγματικές μονάδες και το βάρος γραμμών αλλάζει 

ανάλογα με τον παράγοντα κλίμακας. Από την καρτέλα Plotting Scale (Κλίμακα σχεδίασης) του παραθύρου διαλόγου Plot 

(Σχεδίαση), μπορείτε να ελέγξετε τη σχεδίαση και την κλιμάκωση του βάρους γραμμής σε ένα σχέδιο. Στο χώρο χαρτιού, 

πατήστε το κουμπί LWT στη γραμμή εργαλείων κατάστασης για να ενεργοποιήσετε και να απενεργοποιήσετε την 

εμφάνιση του βάρους γραμμής. Αυτή η αλλαγή δεν επηρεάζει τη χάραξη γραμμικού βάρους. 
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5.10. Εντολή ξορκιών 

 
Οι χρήστες μπορούν να ελέγχουν την ορθογραφία όλου του κειμένου καθώς εισάγεται στο σχέδιό σας με την εντολή Spell. 

Οι χρήστες μπορούν επίσης να καθορίσουν το συγκεκριμένο γλωσσικό λεξικό που χρησιμοποιείται και να προσαρμόσουν 

και να διαχειριστούν πολλαπλά προσαρμοσμένα λεξικά ορθογραφίας. 

 

 

 

 

 

 

 

 
 

 

 
5.11. Επιτάχυνση υλικού 

 
Η επιτάχυνση υλικού αξιοποιεί την GPU, η οποία υπερέχει στο χειρισμό εικόνων, για να βοηθήσει την CPU, βελτιώνοντας 

έτσι την ποιότητα της γραφικής απεικόνισης και την αποδοτικότητα της εργασίας και βελτιώνοντας τη συνολική απόδοση. Η 

ενεργοποίηση της επιτάχυνσης υλικού παρέχει πιο αποδοτικά, υψηλής ποιότητας εφέ απεικόνισης σε πραγματικό χρόνο σε 

σύγκριση με την ΚΜΕ και προσφέρει καλύτερα εφέ επισήμανσης. 

 
Η επιτάχυνση υλικού μπορεί να καθορίσει αυτόματα αν θα ενεργοποιηθεί με 

βάση τη διαμόρφωση του υλικού του χρήστη. Μπορεί επίσης να ελεγχθεί 

χειροκίνητα χρησιμοποιώντας την εντολή GRAPHICSCONFIG ή κάνοντας κλικ 

στο εικονίδιο Ρυθμίσεις απόδοσης στη γραμμή κατάστασης. 
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⮚  Διαμόρφωση υλικού: 

Εμφανίζει το περιβάλλον υλικού του τρέχοντος χρήστη, συμπεριλαμβανομένων των πληροφοριών για την κάρτα 

γραφικών, την έκδοση προγράμματος οδήγησης και την έκδοση OpenGL. 

⮚  Ρυθμίσεις οθόνης γραφικών: 

Επιτάχυνση υλικού: Επιτάχυνση υλικού, χρησιμοποιώντας GPU για βελτιστοποιημένη απόδοση γραφικών. Εάν 

απενεργοποιηθεί, η λειτουργία μεταβαίνει στην προεπιλεγμένη "Λειτουργία λογισμικού". 

Ομαλή εμφάνιση γραμμής: Απομακρύνει τις οδοντωτές άκρες από το γραφικό για πιο ομαλή εμφάνιση. 

Μεταβλητή 
συστήματος 

Περιγραφή Αξία Αξία Περιγραφή 

 

 
HARDWAREACCELERATE 

Δείχνει αν η επιτάχυνση υλικού είναι 

ενεργοποιημένη ή απενεργοποιημένη. 

(Μόνο για ανάγνωση) 

0 Άτομα με ειδικές ανάγκες 

  1 Ενεργοποιημένο 

 
Σημείωση: Εάν η επιτάχυνση υλικού δεν μπορεί να ενεργοποιηθεί, αυτό μπορεί να οφείλεται στο ότι το περιβάλλον υλικού δεν πληροί τις απαιτήσεις: 

⮚  Έκδοση OpenGL κάτω από 4.2 ή ξεπερασμένη έκδοση προγράμματος οδήγησης. Μπορείτε να δοκιμάσετε να αναβαθμίσετε το πρόγραμμα 
οδήγησης γραφικών του συστήματος. 

⮚  Αν αντιμετωπίζετε προβλήματα συμβατότητας ή απόδοσης, μπορείτε να δοκιμάσετε να απενεργοποιήσετε την επιτάχυνση υλικού. 

⮚  Για να διασφαλιστεί η καλύτερη δυνατή εμπειρία λογισμικού, δεν υποστηρίζονται τα Windows 7 και παλαιότερες εκδόσεις του λειτουργικού 
συστήματος. 

 
Εάν το σύστημά σας διαθέτει δύο κάρτες γραφικών (αποκλειστική και ενσωματωμένη), συνιστάται να ρυθμίσετε 

χειροκίνητα την κάρτα γραφικών υψηλής απόδοσης για να επιτύχετε καλύτερη απόδοση της οθόνης. Η μέθοδος ρύθμισης της 

κάρτας γραφικών υψηλής απόδοσης εξαρτάται από το μοντέλο της κάρτας γραφικών και την αντίστοιχη έκδοση λογισμικού και 

προγράμματος οδήγησης. Λαμβάνοντας ως παράδειγμα τα Windows 11, η μέθοδος χειροκίνητης ρύθμισης έχει ως εξής: 

⮚  Κάντε δεξί κλικ στην επιφάνεια εργασίας και επιλέξτε "Ρυθμίσεις οθόνης". 

⮚  Στις "Ρυθμίσεις οθόνης", βρείτε το "Γραφικά". 
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⮚  Στη σελίδα "Γραφικά", στην ενότητα "Προσαρμοσμένες επιλογές για εφαρμογές", κάντε κλικ στην επιλογή "Αναζήτηση", 

βρείτε το gcad.exe στη διαδρομή εγκατάστασης και προσθέστε το στη λίστα. 

⮚  Κάντε κλικ στην εφαρμογή GstarCAD στη λίστα και, στη συνέχεια, κάντε κλικ στην επιλογή "Επιλογές". 

⮚  Στο παράθυρο διαλόγου "Προτιμήσεις γραφικών", επιλέξτε "Υψηλές επιδόσεις" και κάντε κλικ στο κουμπί αποθήκευσης. 

 
Σε σύγκριση με την προηγούμενη έκδοση, το GstarCAD 2025 παρουσιάζει βελτιωμένα εφέ απεικόνισης στους ακόλουθους τομείς: 

 
 

 
5.11.1. Οθόνη επισήμανσης 

 
Η επιτάχυνση υλικού παρέχει σαφέστερα εφέ επισήμανσης, επισημαίνοντας τα επιλεγμένα αντικείμενα με μεγαλύτερη 

ευκρίνεια. Αυτό επιτρέπει στους χρήστες να εντοπίζουν, να επιλέγουν και να χειρίζονται με μεγαλύτερη ακρίβεια, 

βελτιώνοντας την εμπειρία του χρήστη. 

 

 

Μεταβλητή 
συστήματος 

Περιγραφή Αξία Αξία Περιγραφή 

 

Ελέγχει τη λειτουργία προβολής επισήμανσης 
των 

0 Διακεκομμένες γραμμές 

SELECTIONEFFECT επιλεγμένα αντικείμενα όταν η επιτάχυνση 
υλικού 

  

 ενεργοποιημένη 1 Μπλε λαμπερή γραμμή που τονίζει το 
εφέ 

 
SELECTIONEFFECTCOLOR 

Ορίζει το χρώμα του εφέ λαμπερής 

επισήμανσης όταν επιλέγονται αντικείμενα 

Σημείωση: Ισχύει μόνο όταν SELECTIONEFFECT 

 
0 

 
Οι έγκυρες τιμές είναι από 0 έως 255 
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5.11.2. Βασική υποστήριξη οπτικών στυλ 

 
Προστέθηκε υποστήριξη για δύο οπτικά στυλ: X-ray: 

⮚  Εννοιολογικό οπτικό στυλ: Αυτό το στυλ κάνει τα γραφικά να φαίνονται απλούστερα. 

⮚  X-ray Οπτικό στυλ: Επιτρέπει μια σαφέστερη προβολή των σχέσεων μεταξύ των αντικειμένων. 

Αυτά τα οπτικά στυλ ελέγχουν την απεικόνιση των σχεδίων, καθιστώντας τα αντικείμενα πιο σαφή και βελτιώνοντας την 
αποδοτικότητα της σχεδίασης. 

 

Εννοιολογικό Ακτίνες Χ 
 
 

 
5.11.3. Βελτιώσεις φωτισμού 

 
Το GstarCAD βελτιστοποίησε τον φωτισμό, κάνοντας τα εφέ πιο απαλά και επιτρέποντας προσαρμογές με βάση την 

προεπισκόπηση σε πραγματικό χρόνο. Οι βασικές βελτιώσεις περιλαμβάνουν: 

τίθεται σε 1. 
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⮚  Point Light: Προσφέρει ομοιόμορφο φωτισμό προς όλες τις κατευθύνσεις, κατάλληλο για την προσομοίωση 

φωτισμού εσωτερικών χώρων ή γενικού φωτισμού περιβάλλοντος. 

⮚  Spotlight: Συγκεντρώνει το φως σε μια μικρή περιοχή, ιδανικό για την ανάδειξη συγκεκριμένων αντικειμένων ή την έμφαση σε κομβικά σημεία. 

⮚  Web Light: Εμφανίζει το εύρος ή την περιοχή που σχηματίζει το φως, προσομοιώνοντας το εύρος ακτινοβολίας του φωτός. 

⮚  Φως σημείου στόχου: Συνήθως χρησιμοποιείται για την προσομοίωση λαμπτήρα ή φλόγας. 

⮚  Δωρεάν διαδίκτυο: Φωτίζει το περιβάλλον χωρίς να εμποδίζεται από τα γύρω αντικείμενα. 
 

Επιτάχυνση υλικού OFF Επιτάχυνση υλικού ON 
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6. Δημιουργία αντικειμένων 

 
Τα σχέδια αποτελούνται από αντικείμενα. Γενικά, σχεδιάζετε αντικείμενα καθορίζοντας σημεία με τη συσκευή κατάδειξης ή 

εισάγοντας τιμές συντεταγμένων στη γραμμή εντολών. 

 
6.1. Σχεδιάστε γραμμικά αντικείμενα 

 

 
6.1.1. Γραμμές 

 
Μια γραμμή αποτελείται από δύο σημεία: ένα σημείο έναρξης και ένα σημείο λήξης. Μπορείτε να συνδέσετε μια σειρά 

γραμμών, αλλά κάθε τμήμα γραμμής θεωρείται ξεχωριστό αντικείμενο γραμμής. Για να σχεδιάσετε μια γραμμή:

 Σχεδίαση >Γραμμή Γραμμή εντολών> ΓΡΑΜΜΗ 

 
1. Επιλέξτε Σχεδίαση > Γραμμή από το κύριο μενού. 

2. Καθορίστε το σημείο εκκίνησης. 

3. Ολοκληρώστε το πρώτο τμήμα γραμμής καθορίζοντας το τελικό σημείο. 

4. Πατήστε Enter για να ολοκληρώσετε την εντολή. 

 
Για να ξεκινήσετε μια νέα γραμμή στο τελικό σημείο της τελευταίας γραμμής 

που σχεδιάστηκε, ξεκινήστε ξανά την εντολή Γραμμή και πατήστε Enter 

απευθείας στην προτροπή "Specify first point:". 

 
6.1.2. Πολλαπλές γραμμές 

 
Οι πολυγραμμές αποτελούνται από πολλές παράλληλες γραμμές, που ονομάζονται στοιχεία. 

 
Μπορείτε να καθορίσετε τη θέση των στοιχείων καθορίζοντας τη μετατόπιση από την αρχή κάθε στοιχείου. Από προεπιλογή, 

τα αντικείμενα πολλαπλών γραμμών περιέχουν δύο στοιχεία. Μπορείτε να δημιουργήσετε και να αποθηκεύσετε μόνοι 

σας νέα στυλ πολλαπλών γραμμών ή να τροποποιήσετε υπάρχοντα στυλ mline. 

 
Για να σχεδιάσετε μια γραμμή πολλαπλών γραμμών: Πολλαπλής γραμμής Γραμμή εντολών> MLINE 

 
1. Επιλέξτε Draw > Multiline από το κύριο μενού. 

2. Καθορίστε το σημείο εκκίνησης. 

3. Καθορίστε το τελικό σημείο. 

4. Πατήστε Enter για να ολοκληρώσετε την εντολή. 
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6.1.3. Ακτίνες 

 
Μια ακτίνα είναι μια γραμμή στον τρισδιάστατο χώρο που 

ξεκινά από ένα σημείο και εκτείνεται στο άπειρο. Επειδή οι 

ακτίνες εκτείνονται στο άπειρο, δεν υπολογίζονται ως μέρος 

της έκτασης του σχεδίου. Η προεπιλεγμένη μέθοδος για τη 

σχεδίαση μιας ακτίνας είναι να επιλέξετε το σημείο έναρξης 

της ακτίνας και στη συνέχεια να καθορίσετε την 

κατεύθυνσή της. 

 
Για να σχεδιάσετε μια ακτίνα: 

 
Σχέδιο > Ακτίνα Γραμμή εντολών> RAY 

 
1. Επιλέξτε Draw > Ray από το κύριο μενού. 

2. Καθορίστε το σημείο εκκίνησης και την κατεύθυνση. 

3. Πατήστε Enter για να ολοκληρώσετε την εντολή. 
 
 
 

 
6.1.4. Γραμμές κατασκευής 

 
Μια κατασκευαστική γραμμή είναι μια γραμμή που διέρχεται από ένα 

δεδομένο σημείο, προσανατολισμένη σε μια καθορισμένη γωνία στον 

τρισδιάστατο χώρο και εκτείνεται στο άπειρο και προς τις δύο κατευθύνσεις. 

Μπορείτε επίσης να σχεδιάσετε μια γραμμή κατασκευής σε μια 

συγκεκριμένη γωνία ή σε μια γωνία σε σχέση με ένα υπάρχον 

αντικείμενο. 

 
Για να σχεδιάσετε μια γραμμή κατασκευής: Γραμμή 

εντολής> XLINE 
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1. Επιλέξτε Draw > Construction Line (Σχεδίαση > Γραμμή κατασκευής) από το κύριο μενού. 

2. Καθορίστε ένα σημείο κατά μήκος της γραμμής. 

3. Καθορίστε την κατεύθυνση. 

4. Πατήστε Enter για να ολοκληρώσετε την εντολή. 
 

 
6.1.5. Πολυγραμμές 

 
Μια πολυγραμμή είναι ένα ενιαίο αντικείμενο με συνδεδεμένη ακολουθία τμημάτων 

γραμμής ή/και τμημάτων τόξου.Όταν σχεδιάζετε μια πολυγραμμή, μπορείτε να μεταβείτε 

σε διαφορετικές επιλογές. Αφού σχεδιάσετε περισσότερα από ένα τμήματα, μπορείτε 

να κλείσετε την πολυγραμμή, να αναιρέσετε ή να ολοκληρώσετε. 

 
Για να σχεδιάσετε μια πολυγραμμή με ευθύγραμμα τμήματα: Σχεδίαση > Πολυγραμμή Γραμμή εντολών> ΠΟΛΥΓΡΑΜΜΗ 

 
1. Επιλέξτε Draw > Polyline από το κύριο μενού. 

2. Καθορίστε το σημείο εκκίνησης. 

3. Καθορίστε το τελικό σημείο κάθε τμήματος. 

4. Πατήστε Enter για να τερματίσετε ή πληκτρολογήστε c (close) για να κλείσετε την πολυγραμμή. 

 
Για να σχεδιάσετε μια πολυγραμμή συνδυασμού γραμμής και τόξου: 

Σχεδίαση > Πολυγραμμή Γραμμή εντολών> PLINE 

 
1. Επιλέξτε Draw > Polyline από το κύριο μενού. 

2. Καθορίστε το σημείο εκκίνησης. 

3. Καθορίστε το τελικό σημείο. 

4. Στη γραμμή εντολών, επιλέξτε Arc. 

5. Καθορίστε το τελικό σημείο του τμήματος τόξου. 

6. Για να ολοκληρώσετε την εντολή, πατήστε ENTER. 
 
 

 
Για να δημιουργήσετε κλειστές πολυγραμμές: Σχεδίαση > Πολυγραμμή Γραμμή εντολών> PLINE 

 
Κατά τη δημιουργία πολυγραμμών με την εντολή PLINE, η επιλογή Close είναι διαθέσιμη μόνο εάν σχεδιάζονται όχι 

λιγότερα από δύο τμήματα γραμμής ή τόξου. Ένα κλειστό αντικείμενο πολυγραμμής σχεδιάζεται εάν συνδέσετε το σημείο 

έναρξης της πολυγραμμής με το τελικό σημείο του τελευταίου τμήματος γραμμής ή τόξου με μια γραμμή ή ένα τόξο. 
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Για να δημιουργήσετε ευρείες πολυγραμμές: Σχεδίαση > Πολυγραμμή Γραμμή εντολών> ΠΟΛΥΓΡΑΜΜΗ 

 
Μπορείτε να σχεδιάσετε πολυγραμμές διαφόρων πλατών χρησιμοποιώντας τις 

επιλογές Width και Halfwidth της εντολής PLINE. Οι επιλογές Width και Halfwidth 

ορίζουν το πλάτος των επόμενων τμημάτων πολυγραμμής που σχεδιάζετε. Μπορείτε να 

ορίσετε το πλάτος μεμονωμένων τμημάτων και να τα κάνετε να μειώνονται σταδιακά από 

το ένα πλάτος στο άλλο. 

 

 

 

 

 

 
Για να σχεδιάσετε μια πολυγραμμή ορίου: Σχεδίαση >Όριο Γραμμή εντολών>ΟΡΙΖΟΝΤΙΑ 

 
1. Επιλέξτε Draw > Boundary από το κύριο μενού. 

2. Καθορίστε τα αντικείμενα κάνοντας ένα από τα ακόλουθα: 

 
-Τρέχον παράθυρο προβολής Ορίστε ένα σύνολο ορίων 

με όλες τις οντότητες στο τρέχον παράθυρο 

προβολής. εάν επιλεγεί αυτή η επιλογή, κάθε σύνολο 

ορίων που χρησιμοποιείται επί του παρόντος θα 

ακυρωθεί. 

 
-Υπάρχον σύνολο Κάντε κλικ στο κουμπί New για να μεταβείτε στην περιοχή σχεδίασης και να ζητήσετε από τους χρήστες να 

επιλογή αντικειμένων για τον καθορισμό συνόλων ορίων. Πατήστε Enter για να επιστρέψετε στο παράθυρο διαλόγου μετά 

την επιλογή. Αυτή η επιλογή είναι διαθέσιμη μόνο μετά την επιλογή αντικειμένων με τη χρήση του κουμπιού New. 

 
3. Επιλέξτε την επιλογή Island Detection. 

4. Κάντε κλικ στο Pick Points. 

5. Στο σχέδιο, κάντε κλικ στο εσωτερικό της περιοχής της οποίας η κλειστή περίμετρος αποτελεί το όριο, όχι στην ίδια την 

πολυγραμμή. Εάν θέλετε, συνεχίστε να κάνετε κλικ μέσα σε πρόσθετες κλειστές περιμέτρους. 

6. Για να ολοκληρώσετε την επιλογή, πατήστε Enter. 

7. Στο παράθυρο διαλόγου Δημιουργία ορίων, κάντε κλικ στο κουμπί OK. 
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6.1.6. Πολύγωνα 

 
Η δημιουργία πολυγώνων είναι ένας απλός τρόπος για να σχεδιάσετε 

τετράγωνα, ισόπλευρα τρίγωνα, οκτάγωνα και ούτω καθεξής. Τα πολύγωνα 

είναι κλειστές πολυγραμμές με 3 έως 1.024 πλευρές ίσου μήκους. 

 
Για να σχεδιάσετε ένα πολύγωνο ανά κορυφή: 

Πολύγυρο: Σχεδίαση >Πολύγωνο Γραμμή 

εντολών>ΠΟΛΥΓΩΝΟ 

 
1. Επιλέξτε Σχεδίαση > Πολύγωνο από το κύριο μενού. 

2. Πληκτρολογήστε 6 για να καθορίσετε έξι πλευρές για το πολύγωνο. 

3. Καθορίστε το κέντρο του πολυγώνου. 

4. Καθορίστε την κορυφή του πολυγώνου. 

 
6.1.7. Ορθογώνια 

 
Τα ορθογώνια είναι κλειστές πολυγραμμές με τέσσερις πλευρές. Σχεδιάζετε ένα ορθογώνιο καθορίζοντας τις απέναντι 

γωνίες του. Το ορθογώνιο ευθυγραμμίζεται κανονικά παράλληλα με την τρέχουσα ευθυγράμμιση του στιγμιότυπου και του 

πλέγματος, αλλά μπορείτε να χρησιμοποιήσετε την επιλογή Περιστροφή για να ευθυγραμμίσετε το ορθογώνιο σε 

οποιαδήποτε γωνία. 

 
Για να σχεδιάσετε ένα ορθογώνιο: Γραμμή 

εντολών>RECTANG 

1. Κάντε ένα από τα ακόλουθα: 

-Επιλέξτε Σχεδίαση > Ορθογώνιο στο κύριο μενού. 

-Κάντε κλικ στο εργαλείο Ορθογώνιο ή πληκτρολογήστε την 

εντολή RECTANG και πατήστε Enter. 

 
2. Προσδιορίστε μια γωνία του ορθογωνίου ή εισαγάγετε μια 

επιλογή. Καθορίστε το πρώτο σημείο της γωνίας ή 

[λοξότμηση/υψομετρία/πτυχή/πάχος/πλάτος]: 

 
3. Προσδιορίστε την απέναντι γωνία του ορθογωνίου ή εισαγάγετε μια επιλογή. Καθορίστε άλλο σημείο γωνίας ή [Περιοχή/Διαστάσεις/Στροφή]: 
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6.1.8. Σημεία 

 
Μπορείτε να σχεδιάσετε ένα σημειακό αντικείμενο διαμορφωμένο είτε ως απλή κουκκίδα είτε ως ένα από 

τα 19 άλλα πιθανά στυλ εμφάνισης. Για να σχεδιάσετε ένα σημείο: Σχεδίαση > Σημείο Γραμμή 

εντολών>ΣΗΜΕΙΟ 

1. Επιλέξτε Draw > Point > Single Point από το κύριο μενού. 

2. Καθορίστε τη θέση του σημείου. 

 
Για να τραβήξετε διάφορα σημεία: 

 
1. Επιλέξτε Σχεδίαση > Σημείο > Πολλαπλό σημείο από το κύριο μενού. 

2. Καθορίστε τη θέση κάθε σημείου. 

 
Για να αλλάξετε το μέγεθος και την εμφάνιση των 

σημειακών αντικειμένων: Γραμμή 

εντολών>DDPTYPE 

 
1. Επιλέξτε Μορφή > Στυλ σημείου από το κύριο μενού. 

2. Στην περιοχή Στυλ σημείου, επιλέξτε το στυλ που θέλετε. 
3. Στην περιοχή Μέγεθος σημείου, καθορίστε το μέγεθος σημείου ή επιλέξτε μία από τις επιλογές. 

4. Κάντε κλικ στο κουμπί OK. 

 
Όταν αναδημιουργείτε το σχέδιο, όλα τα σημειακά αντικείμενα αλλάζουν ώστε να αντικατοπτρίζουν τις νέες ρυθμίσεις μεγέθους και εμφάνισης. 

 
 
 

 
6.1.9. Ελεύθερα σκίτσα 

 
Ένα ελεύθερο σκίτσο αποτελείται από πολλά ευθύγραμμα τμήματα, τα οποία δημιουργούνται είτε ως μεμονωμένα αντικείμενα 

γραμμής είτε ως πολυγραμμή. Πριν ξεκινήσετε τη δημιουργία ενός σκίτσου ελεύθερου χεριού, πρέπει να ορίσετε το μήκος ή την 

αύξηση κάθε τμήματος. Όσο μικρότερα είναι τα τμήματα, τόσο πιο ακριβές είναι το σκίτσο σας, αλλά τα πολύ μικρά τμήματα 

μπορεί να αυξήσουν σημαντικά το μέγεθος του αρχείου. 

 
Για να δημιουργήσετε ένα ελεύθερο σκίτσο: 

 
1. Στη γραμμή εντολών, πληκτρολογήστε SKETCH και πατήστε Enter. 

2. Στην προτροπή "Record increment", εισαγάγετε το ελάχιστο μήκος τμήματος γραμμής. 

3. Μετακινήστε τον κέρσορα στην περιοχή σχεδίασης και, στη συνέχεια, κάντε κλικ 

 ή πληκτρολογήστε p (στυλό) για να ξεκινήσετε το σκίτσο. 

4. Κάντε κλικ ή πληκτρολογήστε ξανά p (πένα) για να σηκώσετε την πένα και να 

σταματήσετε τη σχεδίαση, ώστε να μπορείτε να μετακινήσετε τον κέρσορα στην 

περιοχή σχεδίασης χωρίς να σχεδιάσετε. 

5. Πληκτρολογήστε R (Record) ανά πάσα στιγμή για να γράψετε στο σχέδιο τη 
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γραμμή που σχεδιάζετε και αυτές που έχουν ήδη σχεδιαστεί. 

6. Πατήστε Enter για να ολοκληρώσετε το σκίτσο και να γράψετε όλες τις γραμμές στο σχέδιο. 

 
Για να διαγράψετε γραμμές σκίτσου ελεύθερου χεριού: 

 
1. Ενώ εκτελείτε την εντολή SKETCH, πληκτρολογήστε E. Αν η πένα ήταν κάτω, μετακινείται προς τα πάνω. 

2. Μετακινήστε το δρομέα στο τέλος της γραμμής που σχεδιάσατε τελευταία και, στη 

συνέχεια, μετακινήστε τον προς τα πίσω όσο μακριά θέλετε να διαγράψετε τη 

γραμμή. 

3. Για να τερματίσετε τη διαγραφή και να επιστρέψετε στην προτροπή εντολών 

σκιαγράφησης, πληκτρολογήστε E. Εάν θέλετε να αλλάξετε το τρέχον παράθυρο 

προβολής κατά τη διάρκεια της σκιαγράφησης, βεβαιωθείτε ότι η πένα είναι σηκωμένη 

και ότι όλες οι γραμμές έχουν γραφτεί στο σχέδιο. 

 
6.2. Σχεδιάστε καμπύλα αντικείμενα 

 

 
6.2.1. Τόξα 

 
Το τόξο είναι ένα τμήμα ενός κύκλου. Υπάρχουν πολλοί τρόποι για να ορίσετε ένα τόξο, η προεπιλεγμένη μέθοδος χρησιμοποιεί 

τρία σημεία επιλογής, ένα σημείο έναρξης, ένα δεύτερο σημείο και ένα σημείο λήξης. Χρησιμοποιώντας αυτή τη μέθοδο, το τόξο 

θα ξεκινά από το πρώτο σημείο επιλογής, θα διέρχεται από το δεύτερο σημείο και θα καταλήγει στο τρίτο σημείο. Αφού μάθετε 

την προεπιλεγμένη μέθοδο δοκιμάστε κάποιες άλλες: 

-3 πόντοι 

-Αρχή, Κέντρο, Τέλος 

-Αρχή, Κέντρο, Γωνία 

 
-Αρχή, Κέντρο, Μήκος 

-Αρχή, Τέλος, Γωνία 

-Αρχή, Τέλος, Κατεύθυνση 

-Αρχή, Τέλος, Ακτίνα 

-Κέντρο, Αρχή, Τέλος 

-Κέντρο, Έναρξη, Γωνία 

-Κέντρο, Έναρξη, Μήκος 

-Συνεχίστε 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Κεφάλαιο 6_ Δημιουργία αντικειμένων 
 

Σ ε λ ί δ α  104 | 296  

 
Για να σχεδιάσετε ένα τόξο από 3 σημεία ως δείγμα: 3 σημεία 

 
1. Επιλέξτε Draw > Arc > 3 Points από το κύριο μενού. 

2. Καθορίστε το αρχικό και το δεύτερο σημείο. 

3. Καθορίστε το τελικό σημείο. 

 
6.2.2. Κύκλοι 

 
Η προεπιλεγμένη μέθοδος για τη σχεδίαση ενός κύκλου είναι ο καθορισμός ενός κεντρικού 

σημείου και μιας ακτίνας. Μπορείτε να σχεδιάσετε κύκλους χρησιμοποιώντας οποιαδήποτε 

από τις ακόλουθες μεθόδους: 

-Κέντρο, Ακτίνα 

-Κέντρο, Διάμετρος 

-Κεντρικό 

-2 πόντοι 

-3 πόντοι 

-Tangent, Tangent, Radius 

-Tangent, Tangent, Tangent 
 
 

 
Για να σχεδιάσετε έναν κύκλο καθορίζοντας το κέντρο και την ακτίνα 

του:Σχεδίαση > Κύκλος>Κέντρο, Ακτίνα Γραμμή εντολών>ΚΥΚΛΟΣ 

 
1. Επιλέξτε Σχεδίαση > Κύκλος > Κέντρο, Ακτίνα από το κύριο μενού. 

2. Καθορίστε το κεντρικό σημείο. 

3. Καθορίστε την ακτίνα του κύκλου. 

 

 

 

 
Για να σχεδιάσετε έναν κύκλο εφαπτόμενο σε υπάρχοντα αντικείμενα: 

Σχεδίαση > Κύκλος>Tan, Tan, Ακτίνα Γραμμή εντολών>ΚΥΚΛΟΣ 

 
1. Επιλέξτε Draw > Circle > Tan, Tan, Radius από το κύριο μενού. 

2. Επιλέξτε το πρώτο εφαπτόμενο σημείο στο αντικείμενο που θα εφάπτεται με τον κύκλο. 

3. Επιλέξτε το δεύτερο εφαπτόμενο σημείο στο αντικείμενο που θα εφάπτεται με τον κύκλο. 

4. Καθορίστε την ακτίνα του κύκλου. 

 
6.2.3. Ελλείψεις 

 
Η προεπιλεγμένη μέθοδος για τη σχεδίαση μιας έλλειψης είναι να καθορίσετε τα τελικά σημεία του ενός άξονα της 

έλλειψης και στη συνέχεια να καθορίσετε μια απόσταση που αντιπροσωπεύει το μισό μήκος του δεύτερου άξονα. Τα 

ακραία σημεία του πρώτου άξονα καθορίζουν τον προσανατολισμό της έλλειψης. Μπορείτε να σχεδιάσετε ελλείψεις 

χρησιμοποιώντας οποιαδήποτε από τις ακόλουθες μεθόδους: 
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-Κέντρο -Άξονας, Τέλος -Εκλειψη, Τόξο 

 
Για να σχεδιάσετε μια έλλειψη καθορίζοντας τον άξονα και τα τελικά σημεία: 

Σχεδίαση > Έλλειψη>Αξονας Γραμμή εντολών>ΕΛΙΨΗ 

 
1. Επιλέξτε Draw > Ellipse > Axis, End από το κύριο μενού. 

2. Καθορίστε το πρώτο τελικό σημείο και το δεύτερο τελικό σημείο.3.Καθορίστε μια 

απόσταση για το μισό μήκος του δεύτερου άξονα. 

 
Για να σχεδιάσετε ένα ελλειπτικό τόξο καθορίζοντας τα τελικά σημεία του 

άξονα: Γραμμή εντολών>ΕΛΙΨΗ 

 
1. Επιλέξτε Draw > Ellipse > Arc από το κύριο μενού. 

2. Καθορίστε το πρώτο τελικό σημείο. 

3. Καθορίστε το δεύτερο τελικό σημείο. 

4. Καθορίστε το μισό μήκος του άλλου άξονα. 

5. Καθορίστε τη γωνία έναρξης του τόξου. 

6. Καθορίστε τη γωνία τέλους. 

 
6.2.4. Splines 

 
Το Spline είναι μια ομαλή καμπύλη που διέρχεται από μια σειρά σημείων ελέγχου. Πολλαπλά σημεία απαιτούνται για τη 

σχεδίαση ακανόνιστων splines από αυτά που μπορούν να είναι και κλειστά, έτσι ώστε τα σημεία έναρξης και λήξης να 

συμπίπτουν και να εφάπτονται. Η ανοχή σε ένα spline, περιγράφει με πόση ακρίβεια ταιριάζει μεταξύ των πολλαπλών 

σημείων (μικρότερη ανοχή, πιο στενή προσαρμογή του spline στα σημεία). Συνήθως υπάρχουν δύο τρόποι για τη δημιουργία 

splines: 

-Δημιουργήστε ένα spline που έχει μετατραπεί από μια πολυγραμμή χρησιμοποιώντας την επιλογή Spline της εντολής PEDIT. 

-Δημιουργήστε ένα spline χρησιμοποιώντας την εντολή SPLINE. 

Για να σχεδιάσετε ένα spline: Σχεδίαση > Spline Γραμμή εντολών>SPLINE 

1. Επιλέξτε Draw > Spline από το κύριο μενού. 

2. Καθορίστε το πρώτο σημείο του spline. 
3. Καθορίστε το δεύτερο σημείο του spline. 

4. Καθορίστε όσα περισσότερα σημεία θέλετε. 

5. Όταν τελειώσετε, πατήστε Enter. 
 

 
Για να σχεδιάσετε μια κλειστή spline: Σχεδίαση > Spline Γραμμή εντολών>SPLINE 

1. Επιλέξτε Draw > Spline από το κύριο μενού. 

2. Καθορίστε το πρώτο σημείο του spline. 

3. Καθορίστε το δεύτερο σημείο του spline. 

4. Καθορίστε όσα περισσότερα σημεία θέλετε. 

5. Όταν τελειώσετε, πληκτρολογήστε στη γραμμή εντολών C και πατήστε Enter. 

6. Για να ολοκληρώσετε την εντολή, καθορίστε το σημείο εφαπτομένης. 
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6.2.5. Helix 

 
Δημιουργεί μια 2D σπείρα ή ένα 3D ελατήριο. Αρχικά, η προεπιλεγμένη ακτίνα 

βάσης ορίζεται σε 1. Κατά τη διάρκεια μιας συνεδρίας σχεδίασης, η προεπιλεγμένη 

τιμή για την ακτίνα βάσης είναι πάντα η τιμή ακτίνας βάσης που έχει εισαχθεί 

προηγουμένως για οποιοδήποτε στερεό πρωτότυπο ή σπείρα. Η ακτίνα βάσης και η 

ακτίνα κορυφής δεν μπορούν να οριστούν και οι δύο σε 0. 

 
Για να σχεδιάσετε μια έλικα: Σχεδίαση > Έλικα Γραμμή εντολών>HELIX 

Εμφανίζονται οι ακόλουθες προτροπές: Αριθμός στροφών = 3 (προεπιλογή)Στροφή = αριστερόστροφα (προεπιλογή) 

1. Καθορίστε το κεντρικό σημείο της βάσης: Καθορίστε ένα σημείο 

2. Καθορίστε ακτίνα βάσης ή [Διάμετρος] <1.0000>: ή πατήστε ENTER για να καθορίσετε την προεπιλεγμένη τιμή της 

ακτίνας βάσης. 

3. Καθορίστε την ακτίνα κορυφής ή [Διάμετρος] <1.0000>: ή πατήστε ENTER για να καθορίσετε την προεπιλεγμένη 

τιμή της ακτίνας κορυφής. 

4. Καθορίστε το ύψος της έλικας ή [Τελικό σημείο άξονα/στροφές/ύψος στροφής/στροφή] <1.0000>: Καθορίστε ένα ύψος έλικας ή εισάγετε μια 
επιλογή 
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6.2.6. Ντόνατ 

 
Τα donuts είναι συμπαγείς, γεμάτοι κύκλοι ή δακτύλιοι που δημιουργούνται ως κλειστή, ευρεία πολυγραμμή. Η μεταβλητή 

συστήματος FILLMODE ελέγχει αν θα γεμίσει ή όχι το ντόνατ. Αν το FILLMODE έχει τιμή 1, δημιουργούνται γεμισμένα 

donuts- αν το FILLMODE έχει τιμή 0, δημιουργούνται χωρίς γέμισμα. 

 
Για να δημιουργήσετε ένα ντόνατ, καθορίζετε την εσωτερική και την 

εξωτερική του διάμετρο και το κέντρο του. Μπορείτε να συνεχίσετε τη 

δημιουργία πολλαπλών αντιγράφων με την ίδια διάμετρο, καθορίζοντας 

διαφορετικά σημεία κέντρου. Για να δημιουργήσετε κύκλους με συμπαγή 

γέμιση, μπορείτε απλώς να ορίσετε την ίδια τιμή για την εσωτερική και την 

εξωτερική ακτίνα. 

 
Για να ζωγραφίσετε ένα ντόνατ: Ντόνατ Γραμμή εντολών>DONUT 

 
1. Επιλέξτε Draw > Donut από το κύριο μενού. 

2. Καθορίστε την εσωτερική διάμετρο του ντόνατ. 

3. Καθορίστε την εξωτερική διάμετρο του ντόνατ. 

4. Καθορίστε το κέντρο του ντόνατ. 

5. Καθορίστε το κεντρικό σημείο για να σχεδιάσετε ένα άλλο ντόνατ ή πατήστε Enter για να ολοκληρώσετε την εντολή. 

 
6.3. Δημιουργία τρισδιάστατων αντικειμένων 

 
Με τα τρισδιάστατα μοντέλα, μπορείτε: Προβολή οντοτήτων σε τρεις διαστάσεις, δημιουργία τρισδιάστατων οντοτήτων, 
επεξεργασία οντοτήτων σε 

τρισδιάστατο χώρο, να επεξεργάζεστε τρισδιάστατα στερεά, να εμφανίζετε κρυφές γραμμές και σκιασμένες προβολές τρισδιάστατων οντοτήτων. 

 
6.3.1. 3D πάχος και ανύψωση 

 
Από προεπιλογή, το πρόγραμμα δημιουργεί νέα δισδιάστατα αντικείμενα 

με μηδενικό υψόμετρο και πάχος. Ο ευκολότερος τρόπος για να 

δημιουργήσετε ένα τρισδιάστατο αντικείμενο είναι να αλλάξετε την 

ιδιότητα ανύψωσης ή πάχους ενός υπάρχοντος δισδιάστατου 

αντικειμένου. Μπορείτε να εξάγετε οποιοδήποτε δισδιάστατο αντικείμενο σε 

τρισδιάστατο αντικείμενο αλλάζοντας το πάχος του αντικειμένου σε μη 

μηδενική τιμή. Για παράδειγμα, ένας κύκλος γίνεται κύλινδρος, μια 

γραμμή γίνεται τρισδιάστατο επίπεδο και ένα ορθογώνιο γίνεται κουτί. 

 
Για να ορίσετε το τρέχον υψόμετρο: ΑΛΛΑΓΗ 

 
1.Πληκτρολογήστε CHANGE στη γραμμή εντολών και στη συνέχεια πατήστε 

Enter αφού επιλέξετε το(τα) δισδιάστατο(α) 

αντικείμενο(α).2.Πληκτρολογήστε P (Properties) και πατήστε Enter. 

3.Πληκτρολογήστε E (Elev) και πατήστε Enter. 
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4.Καθορίστε ένα νέο υψόμετρο και, στη συνέχεια, πατήστε Enter. 

 
Για να ορίσετε το τρέχον πάχος: ΑΛΛΑΓΗ 

 

1. Πληκτρολογήστε CHANGE στη γραμμή εντολών και, στη συνέχεια, πατήστε 
Enter μετά την επιλογή του (των) δισδιάστατου(-ων) αντικειμένου(-ων). 

2. Πληκτρολογήστε P (Ιδιότητες) και πατήστε Enter. 

3. Πληκτρολογήστε T (Πάχος) και πατήστε Enter. 

4. Καθορίστε ένα νέο πάχος και, στη συνέχεια, πατήστε Enter. 
 
 
 

 
6.3.2. Πρόσωπα 3D 

 
Μπορείτε να δημιουργήσετε μια τρισδιάστατη όψη, η οποία αποτελείται από ένα τμήμα ενός επιπέδου στον τρισδιάστατο 

χώρο. Αφού καθορίσετε το τέταρτο σημείο, το πρόγραμμα συνεχίζει να 

σας προτρέπουν για πρόσθετες επιφάνειες 

με εναλλασσόμενες προτροπές για το τρίτο 

σημείο και το τέταρτο σημείο, ώστε να μπορείτε 

να κατασκευάσετε ένα σύνθετο τρισδιάστατο 

αντικείμενο. 

 
Για να δημιουργήσετε ένα τρισδιάστατο πρόσωπο: 

Γραμμή εντολών>3DFACE 

 
 

 
1. Πληκτρολογήστε 3Dface στη γραμμή εντολών. 

2. Καθορίστε το πρώτο σημείο της τρισδιάστατης όψης. 

3. Καθορίστε το δεύτερο, το τρίτο και το τέταρτο σημείο. 

4. Καθορίστε το τρίτο και το τέταρτο σημείο για πρόσθετες επιφάνειες. 

5. Για να ολοκληρώσετε την εντολή, πατήστε Enter. 

 
6.3.3. Κανονικές επιφάνειες 

 
Μπορείτε να δημιουργήσετε μια κυβερνημένη επιφάνεια, η οποία είναι ένα 

τρισδιάστατο σώμα που προσεγγίζει την επιφάνεια μεταξύ δύο υφιστάμενων 

οντοτήτων. Επιλέγετε τις δύο οντότητες που ορίζουν την κυβερνημένη επιφάνεια. 

Αυτές οι οντότητες μπορεί να είναι τόξα, κύκλοι, γραμμές, σημεία ή 

πολυγραμμές. 

Για να δημιουργήσετε μια επιφάνεια με κανόνες:Σχεδίαση > 

Μοντελοποίηση>Ματίγια>Ματίγια με κανόνες Γραμμή 

εντολών>RULESURF 

1. Πληκτρολογήστε RULESURF στη γραμμή εντολών. 
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2. Επιλέξτε το πρώτο αντικείμενο ορισμού. 

3. Επιλέξτε το δεύτερο αντικείμενο ορισμού. 

 
6.3.4. Πίνακας Επιφάνεια 

 
Τα πλέγματα επιφάνειας με πίνακες χρησιμοποιούνται ως σειριακό 

παράλληλο πολύγωνο σε καθορισμένη διαδρομή, θα πρέπει να 

σχεδιάσετε διάνυσμα κατεύθυνσης και αρχικό αντικείμενο πριν 

δημιουργήσετε μια επιφάνεια με πίνακες. Τα αντικείμενα όπως μια 

γραμμή, ένα τόξο, ένας κύκλος, μια έλλειψη ή μια 2D ή 3D πολυγραμμή 

μπορούν να χρησιμοποιηθούν ως καμπύλες περιγράμματος για τον 

καθορισμό πολυγώνων. 

 
Για να δημιουργήσετε ένα πλέγμα εξώθησης επιφάνειας: 

 Γραμμή εντολών>TABSURF 

 
1. Πληκτρολογήστε TABSURF στη γραμμή εντολών. 

2. Επιλέξτε το αντικείμενο προς εξώθηση. 

3. Επιλέξτε τη διαδρομή εξώθησης. 
 
 
 

 
6.3.5. Περιστρεφόμενη επιφάνεια 

 
Χρησιμοποιήστε την εντολή REVSURF για να δημιουργήσετε μια επιφάνεια περιστροφής περιστρέφοντας ένα προφίλ του 

αντικειμένου γύρω από έναν άξονα. Το αντικείμενο προς περιστροφή μπορεί να είναι γραμμή, τόξο, κύκλος, έλλειψη, 

ελλειπτικό τόξο, κλειστή πολυγραμμή, πολύγωνο, κλειστή spline ή τόρος. Το REVSURF είναι χρήσιμο για επιφάνειες με 

περιστροφική συμμετρία. 

 
Για να δημιουργήσετε ένα πλέγμα περιστρεφόμενης επιφάνειας: Πλέγματα>Πλέγματα>Πλέγμα περιστρεφόμενης επιφάνειας: Σχεδίαση > 
Μοντελοποίηση>Πλέγματα> Περιστρεφόμενο πλέγμα Γραμμή εντολών>REVSURF 

 
1. Πληκτρολογήστε REVSURF στη γραμμή εντολών. 

2. Επιλέξτε το αντικείμενο προς περιστροφή. 

3. Επιλέξτε το αντικείμενο που θα χρησιμοποιηθεί ως άξονας περιστροφής. 

4. Καθορίστε τη γωνία εκκίνησης. 

5. Καθορίστε τον αριθμό των μοιρών περιστροφής του αντικειμένου. 
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6.3.6. Στερεό κουτί 

 
Ένα στερεό κουτί αποτελείται από έξι ορθογώνια επιφανειακά επίπεδα. Η βάση του κουτιού είναι πάντα παράλληλη με το 

επίπεδο xy του τρέχοντος UCS. Το μήκος του κουτιού αντιστοιχίζεται στον άξονα X του τρέχοντος UCS, το πλάτος του 

αντιστοιχίζεται στον άξονα Y και το ύψος του στον άξονα Z. 

 
Η εντολή RECTANG ή PLINE δημιουργεί ένα ορθογώνιο ή μια κλειστή πολυγραμμή από την οποία μπορείτε να 

δημιουργήσετε ένα πλαίσιο χρησιμοποιώντας την εντολή EXTRUDE. Για να δημιουργήσετε ένα πλαίσιο: 

Σχεδίαση > Μοντελοποίηση>Κιβώτιο Γραμμή εντολών>Κιβώτιο 

1. Επιλέξτε Σχεδίαση > Μοντελοποίηση > Πλαίσιο από το κύριο μενού. 

2. Καθορίστε την πρώτη γωνία της βάσης. 

3. Καθορίστε την απέναντι γωνία της βάσης. 

4. Καθορίστε το ύψος. 
 
 
 

 
6.3.7. Στερεός κώνος 

 
Από προεπιλογή, ο πυθμένας του κώνου βρίσκεται στο επίπεδο XY του τρέχοντος UCS. Το ύψος του κώνου είναι 

παράλληλο με τον άξονα Z. Η κορυφή καθορίζει το ύψος και τον προσανατολισμό του κώνου. Μπορείτε να σχεδιάσετε 

έναν 2D κύκλο και στη συνέχεια να χρησιμοποιήσετε το EXTRUDE για να κωνοποιήσετε τον κύκλο υπό γωνία κατά μήκος του 

άξονα Z για να δημιουργήσετε έναν συμπαγή κώνο. Για να ολοκληρώσετε την αποκοπή, μπορείτε να αφαιρέσετε ένα πλαίσιο 

από την κορυφή του κώνου με την εντολή SUBTRACT. 

 
Για να δημιουργήσετε έναν κώνο: Σχεδίαση > Μοντελοποίηση>Κώνος Γραμμή εντολών>ΚΩΝΟΣ 

 
1. Επιλέξτε Draw > Μοντελοποίηση > Κώνος από το κύριο μενού. 

2. Καθορίστε το κέντρο της βάσης του κώνου. 

3. Καθορίστε την ακτίνα ή τη διάμετρο. 

4. Καθορίστε το ύψος. 
 
 
 
 
 

 
6.3.8. Στερεός κύλινδρος 

 
Μπορείτε να δημιουργήσετε κυλίνδρους που ορίζονται από μια κυκλική βάση. Η βάση ενός κυλίνδρου είναι πάντα παράλληλη 

με το επίπεδο xy του τρέχοντος UCS- το ύψος ενός κυλίνδρου είναι πάντα παράλληλο με τον άξονα z. Μπορείτε να 

σχεδιάσετε έναν κύκλο και στη συνέχεια να χρησιμοποιήσετε το EXTRUDE για να δημιουργήσετε έναν συμπαγή 

κύλινδρο. 
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Για να δημιουργήσετε έναν κύλινδρο: Σχεδίαση > Μοντελοποίηση > Κύλινδρος Γραμμή εντολών>ΚΥΛΙΝΔΡΟΣ 

 
1. Επιλέξτε Σχεδίαση > Μοντελοποίηση > Κύλινδρος από το κύριο μενού. 

2. Καθορίστε το κέντρο της βάσης του κυλίνδρου. 

3. Καθορίστε την ακτίνα ή τη διάμετρο. 

4. Καθορίστε το ύψος. 

 

 

 
6.3.9. Σφαίρα 

 
Οι γραμμές γεωγραφικού πλάτους μιας σφαίρας είναι πάντα παράλληλες με το επίπεδο xy του τρέχοντος UCS- ο κεντρικός 

άξονας είναι πάντα παράλληλος με τον άξονα z. Καθορίζετε το μέγεθος μιας σφαίρας καθορίζοντας είτε την ακτίνα είτε τη 

διάμετρό της. 

 
Για να δημιουργήσετε μια σφαίρα: Σφαίρα Γραμμή εντολών>ΣΦΑΙΡΑ 

 
1. Επιλέξτε Draw > Μοντελοποίηση > Σφαίρα από το κύριο μενού. 

2. Καθορίστε το κέντρο της σφαίρας. 

3. Καθορίστε την ακτίνα ή τη διάμετρο. 
 
 
 

 
6.3.10. Torus 

 
Ένας δακτύλιος κατασκευάζεται με περιστροφή ενός κύκλου γύρω από μια γραμμή που χαράσσεται στο επίπεδο του κύκλου και 

είναι παράλληλη με τον άξονα z του τρέχοντος UCS. Καθορίζετε το μέγεθος ενός τόρου καθορίζοντας τη συνολική διάμετρο ή 

ακτίνα του και τη διάμετρο ή ακτίνα του σωλήνα (του κύκλου που περιστρέφεται). 

 
Για να δημιουργήσετε έναν τόρο: Γραμμή εντολών>ΤΟΡΟΣ 

 
1. Επιλέξτε Draw > Modeling > Torus από το κύριο μενού. 

2. Καθορίστε το κέντρο ολόκληρου του δακτυλίου. 

3. Καθορίστε την ακτίνα ή τη διάμετρο ολόκληρου του δακτυλίου. 

4. Καθορίστε την ακτίνα ή τη διάμετρο του σώματος του τόρου. 
 
 
 
 

 
6.3.11. Πυραμίδα 

 
Μπορείτε να δημιουργήσετε ένα τετράεδρο (πυραμίδα με τρεις πλευρές) ή μια πυραμίδα με τέσσερις πλευρές. Η βάση της 

πυραμίδας είναι πάντα παράλληλη με το επίπεδο xy του τρέχοντος UCS. Καθορίζετε το μέγεθος της πυραμίδας καθορίζοντας τα 

σημεία της βάσης και είτε την κορυφή, είτε τις γωνίες της άνω επιφάνειας, είτε τα τελικά σημεία της κορυφογραμμής. 
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Για να δημιουργήσετε μια πυραμίδα: Πυραμίδα Γραμμή εντολών>ΠΥΡΑΜΙΔΑ 

 
1. Επιλέξτε Σχεδίαση > Μοντελοποίηση > Πυραμίδα από το κύριο μενού. 

2. Καθορίστε το πρώτο σημείο για τη βάση της πυραμίδας. 

3. Καθορίστε το δεύτερο και το τρίτο σημείο. 

4. Στο πλαίσιο προτροπής, επιλέξτε Τετράεδρο. 

5. Καθορίστε την κορυφή του τετραέδρου. 

 

 
6.3.12. Σφήνα 

 
Μπορείτε να δημιουργήσετε τρισδιάστατες σφήνες που αποτελούνται από πέντε επιφανειακά επίπεδα. Καθορίζετε το 

μέγεθος της σφήνας είτε καθορίζοντας μια δεύτερη γωνία και το ύψος, είτε ορίζοντας τη σφήνα με βάση έναν κύβο με 

δεδομένο μήκος, είτε καθορίζοντας το μήκος, το πλάτος και το ύψος. 

 
Για να δημιουργήσετε μια σφήνα: Σφήνα Γραμμή εντολών>ΣΦΗΝΗ 

 
1. Επιλέξτε Draw > Modeling> Wedge από το κύριο μενού. 

2. Καθορίστε την πρώτη γωνία της βάσης. 

3. Καθορίστε την απέναντι γωνία της βάσης.4.Καθορίστε το ύψος. 

 
6.3.13. Εξώθηση στερεών 

 
Η εντολή EXTRUDE, εξωθεί τα προφίλ του επιλεγμένου αντικειμένου κατά μήκος της επιλεγμένης διαδρομής για τη 

δημιουργία στερεών. Οι οντότητες που μπορείτε να εξάγετε είναι επίπεδες τρισδιάστατες επιφάνειες, κλειστές 

πολυγραμμές, πολύγωνα, κύκλοι, ελλείψεις, κλειστές splines, donuts και περιοχές. Δεν μπορείτε να εξωθούν 

αντικείμενα που περιέχονται σε ένα μπλοκ ή πολυγραμμές που έχουν διασταυρούμενα ή αυτοτελή τμήματα. 

 
Για να δημιουργήσετε ένα εξωθημένο στερεό: Σχεδίαση > Μοντελοποίηση>Εξώθηση Γραμμή εντολών>EXTRUDE 

 
1. Επιλέξτε Draw >Modeling>Extrude από το κύριο μενού. 

2. Επιλέξτε το αντικείμενο προς εξώθηση. 

3. Επιλέξτε τη διαδρομή εξώθησης ή καθορίστε το ύψος. 

 
6.3.14. Στερεά περιστρέφονται 

 
Η εντολή REVOLVE περιστρέφει ένα αντικείμενο 2D στην καθορισμένη γωνία για να σχηματίσει στερεά. Ο άξονας 

περιστροφής μπορεί να είναι οι άξονες X, Y του τρέχοντος UCS καθώς και γραμμές, πολυγραμμές. Τα αντικείμενα που 

μπορούν να περιστραφούν είναι κλειστές πολυγραμμές, πολύγωνα, ορθογώνια, κύκλοι, ελλείψεις, περιοχές και ούτω 

καθεξής. 
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Για να δημιουργήσετε ένα περιστρεφόμενο στερεό: Draw > Modeling>Revolve Γραμμή εντολών>REVOLVE 

 
1. Επιλέξτε Draw > Modeling> Revolve από το κύριο μενού. 

2. Επιλέξτε το αντικείμενο προς περιστροφή. 

3. Κάντε ένα από τα ακόλουθα για να ορίσετε τον άξονα περιστροφής: 

-Ορίστε ένα σημείο έναρξης και ένα σημείο λήξης. 

-Πληκτρολογήστε o και πατήστε Enter για να επιλέξετε ένα αντικείμενο. 

-Πληκτρολογήστε x και πατήστε Enter για να επιλέξετε τον άξονα x. 

-Πληκτρολογήστε y και πατήστε Enter για να επιλέξετε τον άξονα y. 

4. Καθορίστε τη γωνία περιστροφής. 

 
6.3.15. Στερεά 

 
Με το εργαλείο Επίπεδο, μπορείτε να σχεδιάσετε ορθογώνιες, τριγωνικές ή τετραγωνικές περιοχές γεμάτες με ένα συμπαγές 

χρώμα. Η προεπιλεγμένη μέθοδος είναι να καθορίσετε τις γωνίες του επιπέδου. Αφού καθορίσετε τις δύο πρώτες γωνίες, το 

επίπεδο εμφανίζεται καθώς καθορίζετε τις υπόλοιπες γωνίες. Το πρόγραμμα σας ζητά να δηλώσετε το τρίτο σημείο και στη 

συνέχεια το τέταρτο σημείο. 

 
 

 
Για να σχεδιάσετε ένα τετράπλευρο επίπεδο: 

 
1. Επιλέξτε Σχεδίαση > Μοντελοποίηση > Πλέγματα> Στερεό 2D 

2. Καθορίστε το πρώτο, το δεύτερο, το τρίτο και το τέταρτο σημείο. 

6. Ολοκληρώστε την εντολή και πατήστε Enter. 
 
 
 
 
 
 
 
 

 
6.3.16. Flatshot 

 
Με την εντολή FLATSHOT μπορείτε να δημιουργήσετε μια δισδιάστατη αναπαράσταση όλων των τρισδιάστατων αντικειμένων 

με βάση την τρέχουσα προβολή.Οι ακμές όλων των τρισδιάστατων στερεών, επιφανειών και πλεγμάτων προβάλλονται σε ένα 

επίπεδο παράλληλο με το επίπεδο προβολής. Οι 2D αναπαραστάσεις αυτών των ακμών εισάγονται ως μπλοκ στο επίπεδο 

XY του UCS. Αυτό το μπλοκ μπορεί να εκραγεί για πρόσθετες αλλαγές. 
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Πλαίσιο διαλόγου Flatshot 

 
Προορισμός: Ελέγχει πού δημιουργείται η ισοπεδωμένη αναπαράσταση. 

Insert As New Block: Καθορίζει την εισαγωγή της πεπλατυσμένης αναπαράστασης ως μπλοκ στο τρέχον σχέδιο. 

Αντικατάσταση υπάρχοντος μπλοκ: Αντικαθιστά ένα υπάρχον μπλοκ στο σχέδιο με το νεοδημιουργηθέν μπλοκ. 

Επιλέξτε Block: Κλείνει προσωρινά το παράθυρο διαλόγου ενώ επιλέγετε το μπλοκ που αντικαθιστάτε στο σχέδιο. Όταν 

ολοκληρώσετε την επιλογή του μπλοκ, πατήστε Enter για να εμφανιστεί ξανά το παράθυρο 

Επιλεγμένο μπλοκ / Δεν έχει επιλεγεί μπλοκ: Δείχνει αν έχει επιλεγεί ένα μπλοκ. 

 
Εξαγωγή σε αρχείο: Αποθηκεύει το μπλοκ σε ένα εξωτερικό αρχείο. 

Foreground Lines (Γραμμές στο προσκήνιο): Περιέχει στοιχεία ελέγχου για τον 

καθορισμό του χρώματος και του τύπου γραμμής των γραμμών που δεν 

καλύπτονται στην ισοπεδωμένη προβολή. 

Χρώμα: Ορίζει το χρώμα των γραμμών που δεν καλύπτονται στην ισοπεδωμένη 

προβολή. Linetype: Ορίζει το είδος γραμμής των γραμμών που δεν αποκρύπτονται 

στην ισοπεδωμένη προβολή. Obscured Lines: Ελέγχει εάν οι γραμμές που είναι 

καλυμμένες στο σχέδιο εμφανίζονται στην ισοπεδωμένη προβολή και ορίζει το 

χρώμα και το linetype αυτών των καλυμμένων γραμμών. 

Εμφάνιση:Ελέγχει αν οι καλυμμένες γραμμές εμφανίζονται στην ισοπεδωμένη 

αναπαράσταση. Όταν είναι επιλεγμένο, η 2D πεπλατυσμένη αναπαράσταση 

εμφανίζει γραμμές που αποκρύπτονται από άλλα αντικείμενα. 

Χρώμα:Ορίζει το χρώμα των γραμμών που βρίσκονται πίσω από τη γεωμετρία 

στην ισοπεδωμένη προβολή. Linetype: Ορίζει το είδος γραμμής των γραμμών που 

βρίσκονται πίσω από τη γεωμετρία στην ισοπεδωμένη προβολή. Include Tangential 

Lines: Δημιουργεί ακμές σιλουέτας για καμπύλες επιφάνειες. 

Δημιουργία: Δημιουργεί την ισοπεδωμένη προβολή. 
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6.3.17. Δημιουργία σύνθετων στερεών 

 
Μπορείτε να δημιουργήσετε σύνθετα τρισδιάστατα στερεά συνδυάζοντας, αφαιρώντας και βρίσκοντας την τομή δύο ή 

περισσότερων στερεών. Με την εντολή UNION, μπορείτε να συνδυάσετε τον συνολικό όγκο δύο ή περισσότερων 

στερεών ή δύο ή περισσότερων περιοχών σε ένα σύνθετο αντικείμενο. 

 
Για να συνδυάσετε τα στερεά: Τροποποίηση>Επεξεργασία στερεών>Ένωση Γραμμή εντολών> ΕΝΩΣΗ 

 
1. Επιλέξτε Modify>Solid Editing> Union από το κύριο μενού. 

2. Επιλέξτε τα αντικείμενα που θέλετε να συνδυάσετε. 

 
Για να αφαιρέσετε τα στερεά: Τροποποίηση>Επεξεργασία στερεών>Αφαίρεση Γραμμή εντολών>ΥΠΟΒΟΛΗ 

 
1. Επιλέξτε Modify>Solid Editing>Subtract από το κύριο μενού. 

 
2. Επιλέξτε τα αντικείμενα προς αφαίρεση μεταξύ τους. 

 
Για να τέμνετε στερεά: Γραμμή εντολών>ΔΙΑΤΟΜΗ 

 
1. Επιλέξτε Modify >Solids Editing >Intersect από το κύριο μενού. 

2. Επιλέξτε τα αντικείμενα προς τομή. 
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6.3.18. POLYSOLID 

 
Η εντολή POLYSOLID σας επιτρέπει να δημιουργήσετε τρισδιάστατο στερεό σε σχήμα τοίχου απευθείας ή επιλέγοντας 

υπάρχουσες πολυγραμμές. Ένα πολυστερεό σχεδιάζεται με τον ίδιο τρόπο που σχεδιάζετε μια πολυγραμμή, η οποία 

δημιουργείται με συνεχή ευθύγραμμα και καμπύλα τμήματα. 

 

 
Αφού εισαγάγετε την εντολή POLYSOLID, θα λάβετε 4 επιλογές 

(αντικείμενο, πλάτος, ύψος και αιτιολόγηση) στη γραμμή εντολών 

και στο πλαίσιο δυναμικής εισαγωγής. 

 

⮚  Πληκτρολογήστε "Πλάτος" ή "Ύψος" για να ορίσετε το πλάτος και το ύψος. 

⮚  Πληκτρολογήστε "Justify" για να ορίσετε την αιτιολόγηση (Αριστερά, Κέντρο, Δεξιά). 

⮚  Όταν αρχίζετε να σχεδιάζετε συμπαγή τοίχο αφού κάνετε κλικ στο πρώτο σας σημείο, σας δίνει 2 επιλογές (Arc, Undo) στην εντολή 

γραμμή και δυναμικό πλαίσιο εισαγωγής. Εάν δεν εισαγάγετε κανένα από αυτά, μπορείτε απλά να συνεχίσετε να σχεδιάζετε τις γραμμές σας. 

⮚  Αν πληκτρολογήσετε "Arc", μπορεί να σας δώσει 3 επιλογές (Close, Direction, Line), μπορείτε να σχεδιάσετε το τόξο από 2 σημεία ή να εισάγετε 
"Direction". 

για να σχεδιάσετε το τόξο με την κατεύθυνση της εφαπτομένης. 
 

 
⮚  Μπορείτε επίσης να πληκτρολογήσετε "Close"  

για να κλείσετε το 

polysolids ή πληκτρολογήστε 

"Line" για να επιστρέψετε και πάλι 

στη γραμμή. Αν πληκτρολογήσετε 

"Αναίρεση", θα επιστρέψετε στο 

προηγούμενο σημείο. 

 

 

⮚  Αν πληκτρολογήσετε "Αντικείμενο" στο δυναμικό πλαίσιο 

εισαγωγής ή στη γραμμή εντολών, μπορείτε να μετατρέψετε 

υπάρχουσες γραμμές, 2D πολυγραμμές, τόξα και κύκλους 

σε 3D στερεά με προεπιλεγμένο ύψος, πλάτος και αιτιολόγηση. 

Αυτή η λειτουργία επιτρέπει μόνο την επιλογή αντικειμένων 

ένα προς ένα. 

 
PSOLWIDTH: Μεταβλητή συστήματος, ορίζει το προεπιλεγμένο 

πλάτος για το τρισδιάστατο πολυστερεό. 

PSOLHEIGHT: Μεταβλητή συστήματος, ορίζει το προεπιλεγμένο 

ύψος για το τρισδιάστατο πολυστερεό. 

 



Κεφάλαιο 6_ Δημιουργία αντικειμένων 
 

Σ ε λ ί δ α  117 | 296  

 
6.3.19. PLANESURF 

 
Μπορείτε να εισαγάγετε την εντολή PLANESURF ή να κάνετε κλικ στην επιλογή Κορδέλα - Επιφάνεια - Σχέδιο για να 

δημιουργήσετε μια επίπεδη επιφάνεια επιλέγοντας κλειστά αντικείμενα ή καθορίζοντας τις απέναντι γωνίες μιας 

ορθογώνιας επιφάνειας. Όταν οι γωνίες της επιφάνειας καθορίζονται από την εντολή, μπορείτε να δημιουργήσετε μια 

επιφάνεια παράλληλη με το επίπεδο εργασίας. 

 

 
SURFU / SURFV: Μεταβλητή συστήματος, καθορίζει τον αριθμό των γραμμών που 

εμφανίζονται στην επιφάνεια DELOBJ : Μεταβλητή συστήματος, αποφασίζει αν θα 

διαγραφούν τα αντικείμενα ορισμού. 
 

 

 
6.3.20. SURFOFFSET 

 
Μπορείτε να εισαγάγετε την εντολή SURFOFFSET για να δημιουργήσετε μια 

παράλληλη επιφάνεια σ ε  καθορισμένη απόσταση από την αρχική επιφάνεια. 

 
Αφού επιλέξετε την επιφάνεια και πατήσετε enter, θα λάβετε 4 επιλογές 

(Flip direction, Both sides, Solid, Expression) στη γραμμή εντολών και στο 

πλαίσιο δυναμικής εισαγωγής. 

 
⮚  Μπορείτε να μετατοπίσετε την επιφάνεια προς μία κατεύθυνση (τα βέλη θα εμφανίζονται στη μία πλευρά της 

επιφάνειας) εισάγοντας μια απόσταση ή επιλέγοντας το σημείο στο σχέδιο. 
 



Κεφάλαιο 6_ Δημιουργία αντικειμένων 
 

Σ ε λ ί δ α  118 | 296  

 
⮚  Αν πληκτρολογήσετε "Flip direction", τα βέλη θα γυρίσουν σε άλλη πλευρά. 

 
⮚  Αν πληκτρολογήσετε "Both sides", μπορείτε να μετατοπίσετε την επιφάνεια και προς τις δύο κατευθύνσεις (τα βέλη θα εμφανίζονται και στις 

δύο πλευρές των επιφανειών). 

⮚  Αν πληκτρολογήσετε "Solid", μπορείτε να δημιουργήσετε την επιφάνεια σε στερεό μετά την αντιστάθμιση. 

 

 
⮚  Εάν πληκτρολογήσετε "Expression", μπορείτε να εισαγάγετε έναν τύπο ή μια εξίσωση για να καθορίσετε την απόσταση της μετατόπισης της 

επιφάνειας. 
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SURFACEASSOCIATICITY: Μεταβλητή συστήματος, όταν η τιμή είναι 1, θα εμφανιστεί η επιλογή Expression. Αυτή η 

επιλογή δεν ενημερώνει την προεπιλεγμένη τιμή της απόστασης μετατόπισης την επόμενη φορά που θα εισαγάγετε την εντολή. 

SURFACEMODELINGMODE: Μεταβλητή συστήματος, όταν η τιμή είναι 1, η επιφάνεια θα είναι επιφάνεια NURBS. 
 
 

 
6.3.21. CONVTOMESH 

 
Μπορείτε να εισαγάγετε την εντολή CONVTOMESH ή να κάνετε κλικ στην επιλογή Ribbon- Mesh - Convert to MESH για να 

μετατρέψετε επιλέξιμα 3D αντικείμενα σε πλέγματα, τα αντικείμενα θα εξομαλυνθούν ταυτόχρονα κατά τη μετατροπή. 
 

 
Τα επιλέξιμα αντικείμενα περιλαμβάνουν: στερεά, κλειστές πολυγραμμές, περιοχές, τρισδιάστατες όψεις, τρισδιάστατες επιφάνειες, 
πολυγωνικά πλέγματα. 

Όταν οι τρισδιάστατες οντότητες που εξωθούνται, σαρώνονται, περιστρέφονται και περιστρέφονται με τόξα μετατρέπονται σε 

πλέγματα και ο αριθμός των επιφανειών και των κορυφών μετά τη μετατροπή δεν μπορεί να εμφανιστεί σωστά 

FACETERMESHTYPE: (Εάν ο τύπος πλέγματος δεν έχει οριστεί να είναι βελτιστοποιημένος, το αντικείμενο που 

μετατρέπεται δεν εξομαλύνεται). 

DELOBJ : Μεταβλητή συστήματος, αποφασίζει αν θα διαγραφούν τα αντικείμενα ορισμού. 
 

 
6.3.22. CONVTOSOLID 

Μπορείτε να εισαγάγετε την εντολή CONVTOSOLID για να μετατρέψετε επιλέξιμα 

αντικείμενα σε τρισδιάστατα στερεά. Τα επιλέξιμα αντικείμενα 

περιλαμβάνουν: 

⮚  Τρισδιάστατα πλέγματα που περικλείουν πλήρως έναν όγκο 

⮚  Επιφάνειες που περικλείουν πλήρως έναν όγκο 
⮚  Κλειστές πολυγραμμές και κύκλοι με μη μηδενικό πάχος- οι 

ευρείες πολυγραμμές πρέπει να έχουν ομοιόμορφο πλάτος 
 

 
Η εντολή έχει τους ακόλουθους περιορισμούς: 

⮚  Μπορείτε να επιλέξετε ένα ή περισσότερα αντικείμενα για μετατροπή σε στερεά, εάν κάποιο αντικείμενο στο σύνολο 
επιλογής σας είναι άκυρο για την εντολή, θα σας ζητηθεί ξανά να επιλέξετε τα αντικείμενα. 

⮚  Δεν είναι διαθέσιμο για τη μετατροπή επίπεδων επιφανειών ή περιοχών με συνεχόμενες ακμές σε στερεά 3D. 

⮚  Δεν είναι διαθέσιμο για τη μετατροπή ξεχωριστών αντικειμένων σε στερεά 3D. Εάν οι επιφάνειες περικλείουν μια 
στεγανή περιοχή, μπορείτε να μετατρέψετε σε στερεό σώμα με την εντολή SURFSCULPT. 

 
SMOOTHMESHCONVERT: Μεταβλητή συστήματος, υποστηρίζει μόνο την τιμή 3. Η ομαλότητα και το αποτέλεσμα βελτιστοποίησης δεν θα 
υποστηρίζονται σε την έκδοση. 

DELOBJ : Μεταβλητή συστήματος, αποφασίζει αν θα διαγραφούν τα αντικείμενα ορισμού. 
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6.3.23. CONVTOSURFACE 

 
Μπορείτε να εισαγάγετε την εντολή CONVTOSURFACE ή να κάνετε κλικ στην επιλογή Ribbon- Mesh - Convert to 

SURFACE για να μετατρέψετε επιλέξιμα αντικείμενα σε τρισδιάστατες επιφάνειες. 

 
Τα επιλέξιμα αντικείμενα περιλαμβάνουν: Πολυγραμμές με 

μηδενικό πλάτος και πάχος, Πολυγραμμές με συνολικό πλάτος, 

Γραμμές με πάχος, Τόξα με πάχος, Κλειστή επίπεδη καμπύλη. 

SMOOTHMESHCONVERT: Αυτή η μεταβλητή συστήματος υποστηρίζει μόνο την τιμή 3.  
Η ομαλότητα και το αποτέλεσμα βελτιστοποίησης δεν θα υποστηρίζονται. 

στην έκδοση. 

DEOBJ : Μεταβλητή συστήματος, όταν η τιμή είναι 0/3/-3, τα αντικείμενα ορισμού δεν θα διαγραφούν, όταν η τιμή είναι -1/-

2, θα υπάρχουν δύο επιλογές για τους χρήστες να επιλέξουν τη διαγραφή ή όχι, όταν είναι 1/2, τα αντικείμενα ορισμού 

θα διαγραφούν. 

 

 
6.3.24. CONVTONURBS 

 
Μπορείτε να εισαγάγετε την εντολή CONVTONURBS ή να κάνετε κλικ στην επιλογή Ribbon- Surface - Convert to NURBS 

για να μετατρέψετε στερεά και διαδικαστικές επιφάνειες σε επιφάνειες NURBS. Μπορείτε επίσης να μετατρέψετε 

πλέγματα σε επιφάνειες NURBS μετά τη μετατροπή τους σε στερεό ή επιφάνεια με την εντολή CONVTOSOLID ή 

CONVTOSURFACE. 

 

 
Υπάρχει μια σειρά νέων λειτουργιών για την επεξεργασία και εμφάνιση κορυφών ελέγχου NURBS, όπως 

• ΠΡΟΒΟΛΗ ΒΙΟΓΡΑΦΙΚΟΎ ΣΗΜΕΙΏΜΑΤΟΣ: Εμφανίζει τις κορυφές ελέγχου. Μπορείτε να προσαρμόσετε τις 

επιφάνειες NURBS κάνοντας κλικ στις κορυφές ελέγχου, θα λάβετε 4 επιλογές (Base, Copy, Undo, Exit) στη 

γραμμή εντολών και στο πλαίσιο δυναμικής εισαγωγής. 
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⮚  Βάση: Μετακινεί τις κορυφές ελέγχου σύμφωνα με το σημείο βάσης και το δεύτερο σημείο που επιλέγετε. 

⮚  Αντιγραφή: Αντιγράφει μια νέα επιφάνεια NURBS και τη μετακινεί, η αρχική επιφάνεια δεν θα διαγραφεί. 

⮚  Αναίρεση: Ακυρώνει το προηγούμενο βήμα. 

⮚  Έξοδος: Διακόπτει την προσαρμογή των κορυφών ελέγχου. 

 
• ΑΠΌΚΡΥΨΗ ΒΙΟΓΡΑΦΙΚΟΎ ΣΗΜΕΙΏΜΑΤΟΣ: Κρύβει τις κορυφές ελέγχου. 

 
• ADD: Προσθέτει κορυφές ελέγχου. Αφού επιλέξετε το 

αντικείμενο, θα έχετε 2 επιλογές (Κόμβοι, Κατεύθυνση) για να 

προσθέσετε κορυφές ελέγχου και να ορίσετε τη θέση. 

⮚  Κόμποι: Απενεργοποιεί την εμφάνιση των κορυφών ελέγχου και επιτρέπει 

μπορείτε να τοποθετήσετε ένα σημείο απευθείας σε μια 

επιφάνεια. Αυτή η επιλογή εμφανίζεται μόνο αν επιλέξετε 

μια επιφάνεια- δεν εμφανίζεται για splines. 

⮚  Κατεύθυνση: Καθορίζει αν θα προστεθούν κορυφές ελέγχου στο 

κατεύθυνση U ή V. Αυτή η επιλογή εμφανίζεται μόνο 

αν επιλέξετε μια επιφάνεια- δεν εμφανίζεται για 

splines. 

 
• REMOVE: Αφαιρεί τις κορυφές ελέγχου. Υπάρχουν τουλάχιστον 

2 κορυφές ελέγχου σε κάθε κατεύθυνση. 

 
DELOBJ : Αυτή η μεταβλητή συστήματος αποφασίζει αν θα διαγραφούν τα αντικείμενα ορισμού. 

 
 

 
6.4. Σύννεφο σημείων 

 
Το GstarCAD 2025 υποστηρίζει τις επεκτάσεις αρχείων νέφους σημείων (.rcp και .rcs) ως συνημμένο σε ένα σχέδιο. Το 

νέφος σημείων εισάγεται στις καθορισμένες συντεταγμένες, με βάση τη θέση του αντικειμένου Insertion snap. Οι χρήστες 

μπορούν να εφαρμόσουν χρώμα αντικειμένου και χρώματα σάρωσης RGB για την εμφάνιση δεδομένων νέφους σημείων. 
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Όταν οι χρήστες επισυνάπτουν τα δεδομένα νέφους σημείων, οι ακόλουθες επιλογές θα εμφανιστούν στο παράθυρο διαλόγου Επισύναψη νέφους 
σημείων: 

 

⚫  Όνομα: Προσδιορίζει το αρχείο νέφους σημείων προς επισύναψη. 

⚫  Περιηγηθείτε: Ανοίγει το παράθυρο διαλόγου Επιλογή νέφους σημείων, ένα τυπικό παράθυρο διαλόγου επιλογής 
αρχείου όπου μπορείτε να βρείτε και να επιλέξετε ένα αρχείο νέφους σημείων. 

⚫  Τύπος διαδρομής: 

⮚  Πλήρης διαδρομή: Χρησιμοποιεί την πλήρη διαδρομή του 
καθορισμένου αρχείου, συμπεριλαμβανομένου του ριζικού 
φακέλου και όλων των υποφακέλων που περιέχουν το αρχείο 
νέφους σημείων. 

⮚  Σχετική διαδρομή: Χρησιμοποιεί τη διαδρομή του αρχείου σχετικά με 
το τρέχον αρχείο σχεδίασης για την αναφορά του αρχείου 
νέφους σημείων. 

⮚  Δεν υπάρχει μονοπάτι: Χρησιμοποιεί μόνο το όνομα αρχείου του αρχείου νέφους σημείων για αναφορά. Το αρχείο 
πρέπει να βρίσκεται στον ίδιο φάκελο με το τρέχον αρχείο σχεδίασης. 

 

⚫  Εισαγωγή σημείου: Καθορίζει τη θέση στο σχέδιο όπου θα προσαρτηθεί το σημείο βάσης του νέφους σημείων. 

⮚  Καθορίστε στην οθόνη: Καθορίζει το σημείο εισαγωγής στο σχέδιο-στόχο ενώ το εισάγετε. 

⮚  X, Y, Z: Ορίζει τις τιμές συντεταγμένων του σημείου εισαγωγής. 

 

⚫  Κλίμακα: Καθορίζει τον συντελεστή κλίμακας για το εισαγόμενο νέφος σημείων. 

⮚  Καθορίστε στην οθόνη: Καθορίζει τη σχετική κλίμακα του νέφους σημείων καθώς το επισυνάπτετε. 

⮚  Κλίμακα: Ορίζει τον παράγοντα κλίμακας του νέφους σημείων. 

 

⚫  Περιστροφή: Καθορίζει τη γωνία περιστροφής για το εισαγόμενο νέφος σημείων. 

⮚  Καθορίστε On-Screen: Καθορίζει τη γωνία περιστροφής του νέφους σημείων από τη συσκευή κατάδειξης. 

⮚  Γωνία: Ορίζει τη γωνία περιστροφής του νέφους σημείων. 

 

⚫  Άλλες επιλογές: 

⮚  Χρήση Γεωγραφική τοποθεσία: Εισάγει το νέφος σημείων με βάση τα γεωγραφικά δεδομένα στο αρχείο νέφους σημείων. 

⮚  Lock Point Cloud: Ελέγχει αν ένα προσαρτημένο νέφος σημείων μπορεί να μετακινηθεί ή να περιστραφεί. 

⮚  Μεγέθυνση στο νέφος σημείων: Μεγέθυνση στα όρια του προσαρτημένου αντικειμένου νέφους σημείων αυτόματα. 

⚫  Εμφάνιση / Απόκρυψη λεπτομερειών: Περιλαμβάνει τον αριθμό των σημείων, τη μονάδα νέφους σημείων και τα δεδομένα νέφους σημείων. 
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6.5. Δημιουργία περιοχών 

 
Μπορείτε να μετατρέψετε ένα κλειστό αντικείμενο σε δισδιάστατη περιοχή. Αφού δημιουργήσετε μια περιοχή, μπορείτε να 

την τροποποιήσετε χρησιμοποιώντας τα διάφορα τρισδιάστατα εργαλεία. Μπορείτε να δημιουργήσετε περιοχές από 

κλειστά αντικείμενα, όπως πολυγραμμές, πολύγωνα, κύκλους, ελλείψεις, κλειστά splines και donuts. 

 
Για να δημιουργήσετε μια περιοχή: Περιοχή Γραμμή εντολών>ΠΕΡΙΟΧΗ 

 
1. Επιλέξτε Σχεδίαση > Περιοχή από το κύριο μενού. 

2. Επιλέξτε τα αντικείμενα για τη δημιουργία της περιοχής και πατήστε Enter. 

 
6.6. Δημιουργία σύννεφου αναθεώρησης 

 
Η εντολή REVCLOUD δημιουργεί ή τροποποιεί ένα σύννεφο αναθεώρησης Μπορείτε να δημιουργήσετε ένα νέο σύννεφο 

αναθεώρησης επιλέγοντας δύο γωνιακά σημεία ή πολυγωνικά σημεία, σύροντας τον κέρσορα ή μπορείτε επίσης να 

μετατρέψετε ένα υπάρχον αντικείμενο όπως κύκλο, έλλειψη, πολυγραμμή ή spline σε σύννεφο αναθεώρησης. 

 

 
6.7. Δημιουργία γραμμής διακοπής 

 
Δημιουργεί μια πολυγραμμή και εισάγει το σύμβολο της διαχωριστικής γραμμής. Για να χρησιμοποιήσετε το δικό σας μπλοκ για 

το σύμβολο της γραμμής θραύσης, βεβαιωθείτε ότι το μπλοκ περιέχει δύο σημειακά αντικείμενα στο επίπεδο Defpoints. 

 
Για να δημιουργήσετε ένα σύννεφο αναθεώρησης: Γραμμή εντολών>BREAKLINE 

 
1. Πληκτρολογήστε BREAKLINE στη γραμμή εντολών. 

2. Καθορίστε το πρώτο και το δεύτερο σημείο για τη γραμμή διακοπής. 

3. Καθορίστε τη θέση για το σύμβολο διακοπής. 

 
Για να δημιουργήσετε ένα σύννεφο αναθεώρησης: Γραμμή εντολών>REVCLOUD 
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6.8. Δημιουργία Wipeout 

 
Τα σβησίματα δημιουργούνται χρησιμοποιώντας υπάρχοντα πολύγωνα, κλειστές πολυγραμμές μηδενικού πλάτους που 

αποτελούνται μόνο από τμήματα γραμμών ή νέες πολυγραμμές που σχεδιάζετε χρησιμοποιώντας την εντολή WIPEOUT. 

Επίσης, μπορείτε να χρησιμοποιήσετε ένα αντικείμενο κύκλου για να γίνει wipeout ή ακόμα μπορείτε να πάρετε ένα 

αντικείμενο κλειστής πολυγραμμής που περιέχει τόξα. Για παράδειγμα, μπορείτε να ανατινάξετε και να σκιαγραφήσετε 

ένα σχήμα ορισμού μπλοκ (αυτοκίνητο) και στη συνέχεια να το ενώσετε ως πολυγραμμή, στη συνέχεια να σβήσετε αυτή 

την πολυγραμμή και να την ομαδοποιήσετε με τον ορισμό μπλοκ και να την τοποθετήσετε στο σχέδιό σας όπως φαίνεται 

παρακάτω. 

Για να τραβήξετε ένα wipeout: Γραμμή εντολών>WIPEOUT 

1. Επιλέξτε Draw > Wipeout από το κύριο μενού. 

2. Καθορίστε το σημείο έναρξης και το σημείο λήξης κάθε τμήματος. 

3. Αφού καθορίσετε το τελευταίο τελικό σημείο, πατήστε Enter. 
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6.9. Δημιουργία πίνακα 

 
Η νέα λειτουργία Πίνακας με την ομάδα εντολών TABLEDIT\TABLESTYLE\TABLEEXPORT επιτρέπει πλέον τη δημιουργία και την 

τροποποίηση του πίνακα καθώς και τον καθορισμό της μορφής του πίνακα. Είναι δυνατή η εξαγωγή του πίνακα σε 

αρχείο CVS και το άνοιγμά του στο Microsoft Excel. 

Για να τραβήξετε τραπέζι: Γραμμή εντολών>Πίνακας 

 
6.9.1. Παράθυρο διαλόγου Εισαγωγή πίνακα 

 
Εισάγετε την εντολή ΠΙΝΑΚΑΣ και πατήστε ENTER, και θα ανοίξει το παράθυρο διαλόγου "Εισαγωγή πίνακα". 

 

 

 
Στυλ τραπεζιού: Επιλέξτε ένα στυλ πίνακα από το τρέχον σχέδιο από το οποίο θα 

δημιουργήσετε έναν πίνακα. Μπορείτε να δημιουργήσετε ένα νέο στυλ πίνακα 

κάνοντας κλικ στο κουμπί δίπλα στην αναπτυσσόμενη λίστα. 

Προεπισκόπηση: Ελέγχει αν θα εμφανιστεί μια προεπισκόπηση. Εάν ξεκινήσετε από 

έναν κενό πίνακα, η προεπισκόπηση εμφανίζει ένα παράδειγμα του στυλ του 

πίνακα. 

 
 

 
Συμπεριφορά εισαγωγής: Καθορίζει τη θέση του πίνακα. 

Καθορίστε το σημείο εισαγωγής: Καθορίζει τη θέση της πάνω αριστερής 

γωνίας του πίνακα. Μπορείτε να χρησιμοποιήσετε τη συσκευή κατάδειξης ή 

να εισαγάγετε τιμές συντεταγμένων στη γραμμή εντολών. Εάν το στυλ πίνακα 

ορίζει την κατεύθυνση του πίνακα να διαβάζεται από κάτω προς τα πάνω, το 

σημείο εισαγωγής είναι η κάτω αριστερή γωνία του πίνακα. 

 

 
Καθορίστε το παράθυρο: Καθορίζει ένα μέγεθος και μια θέση για τον 

πίνακα. Μπορείτε να χρησιμοποιήσετε τη συσκευή κατάδειξης ή να 

εισαγάγετε τιμές συντεταγμένων στη γραμμή εντολών. Όταν είναι επιλεγμένη 

αυτή η επιλογή, ο αριθμός των στηλών και των γραμμών και το πλάτος στήλης  
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και το ύψος γραμμής εξαρτώνται από το μέγεθος του παραθύρου και τις 

ρυθμίσεις στήλης και γραμμής. 

 
 
 
 

 
Ρυθμίσεις στήλης και γραμμής: Ορίστε τον αριθμό και το μέγεθος των στηλών 

και των γραμμών. Εικονίδιο στηλών: Υποδεικνύει τις στήλες. 

Εικονίδιο σειρών: Υποδεικνύει σειρές. 
 
 
 
 
 

 
Στήλες: Καθορίζει τον αριθμό των στηλών. Όταν είναι επιλεγμένη η 

επιλογή Specify Window (Καθορισμός παραθύρου) και καθορίζετε ένα 

πλάτος στήλης, επιλέγεται η επιλογή Automatic (Αυτόματο) και ο αριθμός 

των στηλών ελέγχεται από το πλάτος του πίνακα. Εάν έχει καθοριστεί ένα 

στυλ πίνακα που περιέχει έναν αρχικό πίνακα, τότε μπορείτε να 

επιλέξετε τον αριθμό των πρόσθετων στηλών που θέλετε να προστεθούν 

σε αυτόν τον αρχικό πίνακα. 

 

 
Πλάτος στήλης: Καθορίζει το πλάτος των στηλών. Όταν είναι επιλεγμένη η 

επιλογή Specify Window (Καθορισμός παραθύρου) και καθορίζετε τον 

αριθμό των στηλών, επιλέγεται η επιλογή Auto (Αυτόματο) και το πλάτος 

των στηλών ελέγχεται από το πλάτος του πίνακα. Το ελάχιστο πλάτος 

στήλης είναι ένας χαρακτήρας. 

 
Σειρές: Καθορίζει τον αριθμό των γραμμών. Όταν είναι επιλεγμένη η 

επιλογή Specify Window (Καθορισμός παραθύρου) και καθορίζετε ύψος 

γραμμής, επιλέγεται η επιλογή Automatic (Αυτόματη) και ο αριθμός των 

γραμμών ελέγχεται από το ύψος του πίνακα. Ένα στυλ πίνακα με γραμμή 

τίτλου και γραμμή κεφαλίδας έχει τουλάχιστον τρεις γραμμές. Το ελάχιστο 

ύψος γραμμής είναι μία γραμμή. Εάν έχει καθοριστεί ένα στυλ πίνακα 

που περιέχει έναν αρχικό πίνακα, τότε μπορείτε να επιλέξετε τον αριθμό 

των πρόσθετων γραμμών δεδομένων που θέλετε να προστεθούν σε 

αυτόν τον αρχικό πίνακα. 

Ύψος σειράς: Καθορίζει το ύψος των γραμμών σε αριθμό γραμμών. Το 

ύψος μιας γραμμής βασίζεται στο ύψος κειμένου και στο περιθώριο 

κελιού, τα οποία ορίζονται και τα δύο στο στυλ πίνακα. Όταν είναι 

επιλεγμένη η επιλογή Specify Window (Καθορισμός παραθύρου) και 

καθορίζετε τον αριθμό των γραμμών, η επιλογή Auto (Αυτόματο) είναι 

επιλεγμένη και η γραμμή 

το ύψος ελέγχεται από το ύψος του τραπεζιού. 
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Ορισμός στυλ κελιών: Για στυλ πινάκων που δεν περιέχουν αρχικό πίνακα, καθορίζει ένα στυλ κελιών για τις 

γραμμές του νέου πίνακα. Στυλ κελιών πρώτης γραμμής: Καθορίζει ένα στυλ κελιών για την πρώτη γραμμή του 

πίνακα. Το 

Το στυλ κελιού τίτλου χρησιμοποιείται από προεπιλογή. 

Στυλ κελιού δεύτερης σειράς: Καθορίζει ένα στυλ κελιών για τη δεύτερη 

γραμμή του πίνακα. Από προεπιλογή χρησιμοποιείται το στυλ κελιών 

Header. 

Όλα τα άλλα στυλ κελιών γραμμής: Καθορίζει ένα στυλ κελιών για όλες 

τις άλλες γραμμές του πίνακα. Το στυλ κελιών Data χρησιμοποιείται 

από προεπιλογή. 

 

 
6.9.2. Πλαίσιο διαλόγου στυλ πίνακα 

 
Τρέχον στυλ τραπεζιού: Εμφανίζει το όνομα του στυλ πίνακα που εφαρμόζεται στους πίνακες 

που δημιουργείτε. Στυλ: Εμφανίζει μια λίστα με τα στυλ πινάκων. Το τρέχον στυλ 

επισημαίνεται. 

Λίστα: Ελέγχει τα περιεχόμενα της λίστας στυλ. 

 
Προεπισκόπηση: Εμφανίζει μια εικόνα προεπισκόπησης του στυλ που 

είναι επιλεγμένο στη λίστα στυλ. 

Set Current :Ορίζει το στυλ πίνακα που έχει επιλεγεί στη λίστα 

Styles ως το τρέχον στυλ. Όλοι οι νέοι πίνακες δημιουργούνται 

χρησιμοποιώντας αυτό το στυλ πίνακα. New: Εμφανίζει το 

παράθυρο διαλόγου Δημιουργία νέου στυλ πίνακα, στο οποίο 

μπορείτε να ορίσετε νέα στυλ πίνακα. 

Τροποποίηση: Εμφανίζει το παράθυρο διαλόγου Τροποποίηση στυλ 

πίνακα, στο οποίο μπορείτε να τροποποιήσετε τα στυλ πίνακα. 

Διαγραφή: Διαγράφει το στυλ πίνακα που είναι επιλεγμένο στη 

λίστα Στυλ. Ένα στυλ π ο υ  χρησιμοποιείται στο σχέδιο δεν 

μπορεί να διαγραφεί. 

 
 
 

 
6.9.3. Πλαίσιο διαλόγου Δημιουργία νέου στυλ πίνακα 

 
Καθορίζει ένα όνομα για το νέο στυλ πίνακα και καθορίζει το υπάρχον στυλ πίνακα στο οποίο θα βασίζεται το νέο στυλ 

πίνακα. Όνομα νέου στυλ: Ονομάζει το νέο στυλ πίνακα. 

Έναρξη με: Καθορίζει ένα υπάρχον στυλ πίνακα, οι ρυθμίσεις του οποίου 

είναι οι προεπιλεγμένες για το νέο στυλ πίνακα. 

Συνεχίστε: Εμφανίζει το παράθυρο διαλόγου Νέο στυλ πίνακα, στο 

οποίο ορίζετε το νέο στυλ πίνακα. 
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6.9.4. Πλαίσια διαλόγου για νέο και τροποποιημένο στυλ πίνακα 

 
Τραπέζι εκκίνησης: Σας επιτρέπει να καθορίσετε έναν πίνακα στο σχέδιό σας που θα 

χρησιμοποιηθεί ως παράδειγμα για τη μορφοποίηση αυτού του στυλ πίνακα. Αφού 

επιλέξετε έναν πίνακα, μπορείτε να καθορίσετε τη δομή και τα περιεχόμενα που 

θέλετε να αντιγραφούν από αυτόν τον πίνακα στο στυλ πίνακα. Με το εικονίδιο 

Κατάργηση πίνακα, μπορείτε να αφαιρέσετε έναν πίνακα από το τρέχον καθορισμένο 

στυλ πίνακα. 

Γενική κατεύθυνση τραπεζιού: Ορίζει ένα νέο στυλ πίνακα ή τροποποιεί ένα υπάρχον 

στυλ πίνακα. Ορίζει την κατεύθυνση ενός πίνακα. 

Κάτω: Η γραμμή τίτλου και η γραμμή κεφαλίδων των στηλών βρίσκονται 

στην κορυφή του πίνακα. Πάνω: Η σειρά τίτλου και η σειρά κεφαλών στηλών 

βρίσκονται στο κάτω μέρος του πίνακα. Προεπισκόπηση: Εμφανίζει ένα 

παράδειγμα της επίδρασης των τρεχουσών ρυθμίσεων στυλ πίνακα. 

Στυλ κυττάρων: Ορίζει ένα νέο στυλ κελιών ή τροποποιεί ένα υπάρχον στυλ κελιών. Μπορείτε να δημιουργήσετε 

οποιονδήποτε αριθμό στυλ κελιών. Κουμπί Δημιουργία στυλ κελιών: Εκκινεί το παράθυρο διαλόγου Create New 

Cell Style (Δημιουργία νέου στυλ κελιού). 

Διαχείριση στυλ κελιών Κουμπί: Εκκινεί το παράθυρο διαλόγου Διαχείριση στυλ κελιών. 
 



Κεφάλαιο 6_ Δημιουργία αντικειμένων 
 

Σ ε λ ί δ α  129 | 296  

 
Γενικές ιδιότητες 

καρτέλας 

Χρώμα γεμίσματος: Καθορίζει το χρώμα φόντου του κελιού. 

Ευθυγράμμιση: Καθορίζει τη στοίχιση και την ευθυγράμμιση του κειμένου 

στο κελί του πίνακα. Μορφοποίηση: Ορίζει τύπο δεδομένων και μορφοποίηση 

για τις γραμμές Δεδομένα, Επικεφαλίδα στήλης ή Τίτλος σε έναν πίνακα. 

Κάνοντας κλικ σε αυτό το κουμπί εμφανίζεται το παράθυρο διαλόγου 

Μορφοποίηση κελιών πίνακα, όπου μπορείτε να ορίσετε περαιτέρω 

επιλογές μορφοποίησης. 

Τύπος: Καθορίζει το στυλ κελιού είτε ως ετικέτα είτε 

ως δεδομένα. Περιθώρια 

Οριζόντια: Ορίζει την απόσταση μεταξύ του κειμένου ή του μπλοκ στο κελί και 

των αριστερών και δεξιών ορίων του κελιού. 

Κατακόρυφο: Ορίζει την απόσταση μεταξύ του κειμένου ή του μπλοκ στο κελί και των 

άνω και κάτω ορίων του κελιού. 

Συγχώνευση κελιών κατά τη δημιουργία γραμμής/στήλης: Συγχωνεύει κάθε νέα γραμμή ή στήλη που δημιουργείται 

με το τρέχον στυλ κελιού σε ένα κελί. Μπορείτε να χρησιμοποιήσετε αυτή την επιλογή για να δημιουργήσετε μια γραμμή τίτλου στην κορυφή του 
πίνακα. 

 
Καρτέλα κειμένου 

 
Στυλ κειμένου: Εμφανίζει τα διαθέσιμα στυλ κειμένου. 

Στυλ κειμένου Κουμπί: Εμφανίζει το πλαίσιο διαλόγου Στυλ κειμένου όπου 

μπορείτε να δημιουργήσετε ή να τροποποιήσετε στυλ κειμένου. 

Ύψος κειμένου: Ορίζει το ύψος του κειμένου. 

Χρώμα κειμένου: Καθορίζει το χρώμα του κειμένου. Επιλέξτε Select Color 

(Επιλογή χρώματος) στο κάτω μέρος της λίστας για να εμφανιστεί το 

παράθυρο διαλόγου Select Color (Επιλογή χρώματος). 

Γωνία κειμένου: Ορίζει τη γωνία του κειμένου. Η προεπιλεγμένη γωνία κειμένου 

είναι 0 μοίρες. Μπορείτε να εισαγάγετε οποιαδήποτε γωνία μεταξύ -359 και 

+359 μοιρών. 

 

Καρτέλα "Σύνορα 

Βάρος γραμμής: Ορίζει το βάρος γραμμής που θα εφαρμοστεί στα όρια που 

καθορίζετε κάνοντας κλικ σε ένα κουμπί πλαισίου. Εάν χρησιμοποιήσετε μεγάλο 

βάρος γραμμής, ενδέχεται να χρειαστεί να αυξήσετε τα περιθώρια των 

κελιών. 

Τύπος γραμμής: Ορίζει το είδος γραμμής που θα εφαρμοστεί στα όρια που 

καθορίζετε. Επιλέξτε Άλλο για να φορτώσετε ένα προσαρμοσμένο τύπο 

γραμμών. 

Χρώμα: Ορίζει το χρώμα που θα εφαρμοστεί στα όρια που καθορίζετε 

κάνοντας κλικ σε ένα κουμπί πλαισίου. 

Διπλή γραμμή: Εμφανίζει τα όρια του πίνακα ως διπλές 

γραμμές. Διάστημα: Καθορίζει την απόσταση για τα όρια 

διπλής γραμμής. 
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7. Τροποποίηση αντικειμένων 

 
Μπορείτε εύκολα να τροποποιήσετε το μέγεθος, το σχήμα και τη θέση των αντικειμένων. Μπορείτε είτε να εισαγάγετε πρώτα 

μια εντολή και στη συνέχεια να επιλέξετε τα αντικείμενα που θέλετε να τροποποιήσετε είτε να επιλέξετε πρώτα τα 

αντικείμενα και στη συνέχεια να εισαγάγετε μια εντολή για να τα τροποποιήσετε. 

 
7.1. Αφαίρεση αντικειμένων 

 
Μπορείτε να χρησιμοποιήσετε την εντολή ERASE για να διαγράψετε αντικείμενα, ανεξάρτητα από τις μεθόδους που 

χρησιμοποιείτε για την επιλογή αντικειμένων. Για να επαναφέρετε τα διαγραμμένα αντικείμενα, χρησιμοποιήστε την εντολή 

UNDO. Μπορείτε να διαγράψετε αντικείμενα χρησιμοποιώντας μία από τις ακόλουθες μεθόδους: Διαγραφή αντικειμένων 

με την εντολή ERASE, αποκοπή των επιλεγμένων αντικειμένων στο πρόχειρο ή πατήστε DELETE για να αφαιρέσετε τα 

επιλεγμένα αντικείμενα. 

 
7.2. Αντιγραφή αντικειμένων 

 
Μπορείτε να αντιγράψετε αντικείμενα εντός του τρέχοντος σχεδίου. Η προεπιλεγμένη μέθοδος είναι η δημιουργία ενός 

συνόλου επιλογής και, στη συνέχεια, ο καθορισμός ενός σημείου βάσης και ενός σημείου μετατόπισης για το αντίγραφο. Για 

να αντιγράψετε αντικείμενα σε καθορισμένη απόσταση, μπορείτε να καθορίσετε την απόσταση απευθείας όταν είναι 

ενεργοποιημένη η λειτουργία Ortho Mode ή Polar Tracking. 

 
Δημιουργήστε μόνο ένα αντίγραφο του αντικειμένου μία φορά: 

 
1. Επιλέξτε Τροποποίηση > Αντιγραφή από το κύριο μενού. 

2. Επιλέξτε τα αντικείμενα και, στη συνέχεια, πατήστε Enter. 

3. Στη γραμμή εντολών, πληκτρολογήστε O (mOde). 

4. Στη γραμμή εντολών, πληκτρολογήστε S (Single). 

5. Καθορίστε τη βάση και το σημείο μετατόπισης. 

 
Δημιουργήστε πολλαπλά αντίγραφα για το επιλεγμένο αντικείμενο μία φορά: 

 
1. Επιλέξτε Τροποποίηση > Αντιγραφή από το κύριο μενού. 

2. Επιλέξτε τα αντικείμενα και, στη συνέχεια, πατήστε Enter. 

3. Στη γραμμή εντολών, πληκτρολογήστε O (mOde). 

4. Στη γραμμή εντολών, πληκτρολογήστε M (Multiple). 

5. Καθορίστε τη βάση και το σημείο μετατόπισης του πρώτου αντιγράφου. 

6. Καθορίστε το σημείο μετατόπισης του επόμενου αντιγράφου. 

7. Για να ολοκληρώσετε την εντολή, πατήστε Enter. 

 
7.3. Αντικείμενα καθρέφτη 

 
Μπορείτε να καθορίσετε μια γραμμή βάσης για τη δημιουργία μιας κατοπτρικής εικόνας χρησιμοποιώντας την εντολή 

MIRROR. Η κατοπτρική εικόνα είναι συμμετρική με την αρχική. Έτσι, αν θέλετε να δημιουργήσετε ένα συμμετρικό 

αντικείμενο, χρειάζεται μόνο να σχεδιάσετε ένα μισό και στη συνέχεια να δημιουργήσετε ένα πλήρες χρησιμοποιώντας  
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την εντολή MIRROR. Εκτός από την επιλογή του σημείου έναρξης και του σημείου λήξης για τον ορισμό του άξονα καθρέφτη, 

μπορείτε επίσης να επιλέξετε απευθείας αντικείμενα ως άξονα καθρέφτη, όπως μια γραμμή, μια πολυγραμμή, μια γραμμή 

μπλοκ ή ένα εξωτερικό σχέδιο αναφοράς. 

 
 

Για να καθρεφτίζει αντικείμενα: 

 
1. Επιλέξτε Τροποποίηση > Καθρέφτης από το κύριο μενού. 

2. Επιλέξτε το αντικείμενο και, στη συνέχεια, πατήστε Enter. 

3. Καθορίστε το πρώτο και το δεύτερο σημείο της γραμμής καθρέφτη. 

4. Στη γραμμή εντολών, αν θέλετε να διατηρήσετε τα αρχικά αντικείμενα, πληκτρολογήστε N- αν θέλετε να διαγράψετε τα αρχικά αντικείμενα, 
πληκτρολογήστε Y. 

 
7.4. Μετατόπιση ενός αντικειμένου 

 
Μπορείτε να χρησιμοποιήσετε τη μετατόπιση για να αντιγράψετε επιλεγμένα αντικείμενα και να τα ευθυγραμμίσετε 

μετατοπισμένα ως προς τα αρχικά αντικείμενα σε μια καθορισμένη απόσταση. Μπορείτε να δημιουργήσετε αντικείμενα 

μετατόπισης χρησιμοποιώντας τόξα, κύκλους, ελλείψεις, ελλειπτικά τόξα, γραμμές, δισδιάστατες πολυγραμμές, 

ακτίνες και άπειρες γραμμές. 

 
Για να δημιουργήσετε ένα αντίγραφο μετατόπισης καθορίζοντας την απόσταση: 

 
1. Επιλέξτε Τροποποίηση > Μετατόπιση από το κύριο μενού. 

2. Καθορίστε την απόσταση (επιλέξτε δύο σημεία ή πληκτρολογήστε μια απόσταση). 

3. Επιλέξτε το αντικείμενο για αντιστάθμιση. 

4. Καθορίστε σε ποια πλευρά του αντικειμένου θα τοποθετηθεί το παράλληλο αντίγραφο. 

5. Πατήστε Enter για να ολοκληρώσετε την εντολή. 

 
Για να δημιουργήσετε ένα αντίγραφο μετατόπισης που διέρχεται από ένα σημείο: 

 
1. Επιλέξτε Τροποποίηση > Μετατόπιση από το κύριο μενού. 

2. Στη γραμμή εντολών, πληκτρολογήστε T (Through). 

3. Επιλέξτε το αντικείμενο για αντιστάθμιση. 

4. Καθορίστε το σημείο από το οποίο θα περάσει το αντικείμενο. 

5. Πατήστε Enter για να ολοκληρώσετε την εντολή. 
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7.5. Δημιουργία μιας συστοιχίας αντικειμένων 

 
Νέες επιλογές συστοιχιών είναι διαθέσιμες για τη δημιουργία αντιγράφων αντικειμένων τοποθετημένων σε ορθογώνιο, πολικό 

ή μοτίβο διαδρομής. Ο νέος πίνακας είναι ως σύνολο (δυναμικό μπλοκ). Μπορεί να ρυθμιστεί δυναμικά ο αριθμός των σειρών, 

η απόσταση και άλλες σχετικές παράμετροι μέσω του Ribbon Panel, των Properties και του Grip. 

 
Για να δημιουργήσετε έναν ορθογώνιο πίνακα: 

 

 
1. Στο χώρο εργασίας "2D Drafting", κάντε κλικ στο 

 
"Home">"Modify">"Rectangular Array" με τη σειρά. 

2. Επιλέξτε το αντικείμενο που θέλετε να τοποθετήσετε σε σειρά και πατήστε "ENTER". 

3. Στην προεπισκόπηση της συστοιχίας, σύρετε τις λαβές για να 

ρυθμίσετε την απόσταση και τον αριθμό των γραμμών και 

των στηλών. 

 
 

Μπορείτε επίσης να τροποποιήσετε τις τιμές 

στην Κορδέλα "Array" . Για να 

δημιουργήσετε έναν πολικό πίνακα: 

1. Στο χώρο εργασίας "2D Drafting", κάντε κλικ στο 

"Home">"Modify">"Polar Array" με τη σειρά. 

2. Επιλογή αντικειμένων σε συστοιχία. 

3. Καθορίστε το κεντρικό σημείο της συστοιχίας (θα 

εμφανιστεί η προεπισκόπηση της συστοιχίας). 

4. Εισάγετε "i" (αντικείμενα) και στη συνέχεια εισάγετε τον αριθμό των αντικειμένων. 

σε συστοιχία. 

5. Εισάγετε "a" (γωνία) και, στη συνέχεια, εισάγετε τη γωνία πλήρωσης. 

 
Μπορείτε επίσης να επιλέξετε λαβές για να επεξεργαστείτε τη σειρά. 

 

 
Για να δημιουργήσετε έναν πίνακα διαδρομών 

 
Ο καλύτερος τρόπος για να χρησιμοποιήσετε τις Path 

Array είναι να τις δημιουργήσετε αρχικά. Και στη 

συνέχεια μπορείτε να χρησιμοποιήσετε τα εργαλεία ή 

τις "Ιδιότητες" της Κορδέλας για να τις 

τροποποιήσετε. 

1. Στο χώρο εργασίας "2D Drafting", κάντε κλικ στο 

"Home">"Modify">"Path Array" με τη σειρά. 
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2. Επιλέξτε το αντικείμενο για τη συστοιχία και "ENTER". 

3 Επιλέξτε ένα αντικείμενο (όπως μια γραμμή, μια 

πολύγραμμη γραμμή, μια τρισδιάστατη πολύγραμμη 

γραμμή, μια spline, μια έλικα, ένα τόξο, έναν κύκλο ή 

μια έλλειψη) που θα αποτελέσει διαδρομή προς 

διάταξη. 

4. Καθορίστε τον τρόπο διανομής των στοιχείων κατά μήκος της διαδρομής: 

Εάν θέλετε να κατανέμετε τα στοιχεία ομοιόμορφα σε όλο το μήκος της διαδρομής, κάντε κλικ στον πίνακα "Ιδιότητες" στην 

Κορδέλα > "Διαίρεση" με τη σειρά. Ε ά ν  θέλετε να διανείμετε τα στοιχεία σε μια συγκεκριμένη απόσταση, μπορείτε να 

κάνετε κλικ στο κουμπί "Ιδιότητες">"Μέτρηση" με τη σειρά. 

5. Μετακινήστε το δρομέα κατά μήκος της διαδρομής για να ρυθμίσετε τα στοιχεία. 

6. Πατήστε "ENTER" για να ολοκληρώσετε τη διάταξη. 

 
7.6. Μετακίνηση αντικειμένων 

 
Μπορείτε να μετακινήσετε αντικείμενα σε νέα θέση χωρίς να αλλάξετε τα αντικείμενα. Μπορείτε να εκτελέσετε την εντολή 

MOVE και στη συνέχεια να επιλέξετε το αντικείμενο (1) προς μετακίνηση, να καθορίσετε ένα σημείο βάσης (2) και ένα σημείο 

μετατόπισης (3). Το αντικείμενο μετακινείται από το σημείο 2 στο σημείο 3. 

 
Για να μετακινήσετε οντότητες: 

 
1. Επιλέξτε Τροποποίηση > Μετακίνηση από το κύριο μενού. 

2. Επιλέξτε τα αντικείμενα και, στη συνέχεια, πατήστε Enter. 

3. Καθορίστε τη βάση και το σημείο μετατόπισης. 

 

 

 

 

 

 
 

Για να μετακινήσετε ένα αντικείμενο χρησιμοποιώντας λαβές: 

 
1. Επιλέξτε το αντικείμενο. 

2. Κάντε κλικ σε μια λαβή για να την επιλέξετε. 

3. Σύρετε το αντικείμενο στο σημείο που θέλετε να το μετατοπίσετε και πατήστε κλικ για να το αφήσετε. 

 
7.7. Περιστροφή αντικειμένων 

 
Μπορείτε να περιστρέψετε τα επιλεγμένα αντικείμενα γύρω από ένα καθορισμένο σημείο. Μπορείτε να καθορίσετε τη γωνία 

περιστροφής καθορίζοντας ένα σημείο στο σ χ έ δ ι ο  ή εισάγοντας απευθείας την τιμή της γωνίας. Η κατεύθυνση προς την 

οποία περιστρέφονται τα αντικείμενα εξαρτάται από την τιμή που εισάγετε είναι θετική ή αρνητική. 

 
Για να περιστρέψετε αντικείμενα: 

 
1. Επιλέξτε Τροποποίηση > Περιστροφή από το κύριο μενού. 

2. Επιλέξτε τα αντικείμενα και, στη συνέχεια, πατήστε Enter. 



Κεφάλαιο7_ Τροποποίηση αντικειμένων 
 

Σ ε λ ί δ α  134 | 296  

 

3. Καθορίστε το σημείο βάσης και τη γωνία περιστροφής. 

 
Για να περιστρέψετε ένα σύνολο επιλογής σε σχέση με μια απόλυτη γωνία: 

 
1. Επιλέξτε Τροποποίηση > Περιστροφή από το κύριο μενού. 

2. Επιλέξτε τα αντικείμενα και, στη συνέχεια, πατήστε Enter. 

3. Καθορίστε το σημείο βάσης. 

4. Στη γραμμή εντολών, πληκτρολογήστε R (Reference). 

5. Καθορίστε τη γωνία αναφοράς και τη νέα γωνία. 

 
7.8. Ευθυγράμμιση αντικειμένων 

 
Μπορείτε να ευθυγραμμίσετε αντικείμενα με άλλα μέσω μετακίνησης ή 

περιστροφής με την εντολή ALIGN. Για να ευθυγραμμίσετε ένα αντικείμενο με 

ένα άλλο ως αναφορά: 

1. Επιλέξτε Modify >Align (Τροποποίηση > Ευθυγράμμιση) από το κύριο μενού. 

2. Επιλέξτε το αντικείμενο και, στη συνέχεια, πατήστε Enter. 

3. Καθορίστε το πρώτο σημείο πηγής. 

4. Καθορίστε το σημείο προορισμού. 

5. Πατήστε Enter για να ολοκληρώσετε την εντολή. 

 
7.9. Αντικείμενα κλίμακας 

 
Μπορείτε να χρησιμοποιήσετε την εντολή SCALE για να κλιμακώσετε την αναλογικότητα των επιλεγμένων αντικειμένων. 

Μπορείτε να πληκτρολογήσετε έναν συντελεστή κλίμακας ή να καθορίσετε ένα σημείο βάσης και μια απόσταση για τη 

μεγέθυνση των αντικειμένων. Ένας συντελεστής κλίμακας που είναι μεγαλύτερος από 1 μεγεθύνει το αντικείμενο και ένας 

συντελεστής κλίμακας που είναι μικρότερος από 1 συρρικνώνει το αντικείμενο. 

 
 

Για να κλιμακώσετε ένα σύνολο επιλογής με έναν συντελεστή κλίμακας: 

 
1. Επιλέξτε Τροποποίηση > Κλίμακα από το κύριο μενού. 

2. Επιλέξτε τα αντικείμενα και, στη συνέχεια, πατήστε Enter. 

3. Καθορίστε το σημείο βάσης. 

4. Καθορίστε τον συντελεστή κλίμακας. 
 
 
 

 
7.10. Επιμήκυνση αντικειμένων 

 
Μπορείτε να αλλάξετε το μήκος των οντοτήτων ή την περιεχόμενη γωνία των τόξων. Τα αποτελέσματα είναι παρόμοια με την 

επέκταση και το κλάδεμα.Αυτή η εντολή δεν επηρεάζει τις κλειστές οντότητες. 



Κεφάλαιο7_ Τροποποίηση αντικειμένων 
 

Σ ε λ ί δ α  135 | 296  

 
Για να αλλάξετε το μήκος ενός αντικειμένου με σύρσιμο: 

 
1. Στη γραμμή εντολών πληκτρολογήστε LENGTHEN. 

2. Στη γραμμή εντολών, πληκτρολογήστε DY (DYnamic). 

3. Επιλέξτε το αντικείμενο που θέλετε να αλλάξετε. 

4. Καθορίστε το νέο τελικό σημείο ή τη νέα γωνία που περιλαμβάνεται. 
 
 
 

 
7.11. Αντικείμενα Stretch 

 
Όταν τεντώνετε αντικείμενα, πρέπει να καθορίσετε ένα σημείο βάσης και ένα σημείο μετατόπισης. Θα πρέπει να 

χρησιμοποιήσετε τη διασταυρούμενη επιλογή για να επιλέξετε τα επιθυμητά αντικείμενα. Με τη χρήση της έκδοσης λαβής, 

μπορείτε επίσης να τεντώσετε αντικείμενα. 

 
Να τεντώσετε ένα αντικείμενο: 

 
1. Επιλέξτε Modify > Stretch από το κύριο μενού. 

2. Επιλέξτε τα αντικείμενα χρησιμοποιώντας είτε ένα 

παράθυρο διασταύρωσης είτε ένα πολύγωνο 

διασταύρωσης και, στη συνέχεια, πατήστε Enter. 

3. Καθορίστε το σημείο βάσης. 

4. Καθορίστε το δεύτερο σημείο μετατόπισης. 

 
Για να τεντώσετε ένα αντικείμενο χρησιμοποιώντας λαβές: 

 
1. Επιλέξτε το αντικείμενο. 

2. Κάντε κλικ σε μια λαβή για να την ενεργοποιήσετε. 

3. Σύρετε τη λαβή. 

4. Κάντε κλικ για να απελευθερώσετε. 

 

 

 

 
 

7.12. Περικοπή αντικειμένων 

 
Μπορείτε να κόψετε ή να περικόψετε αντικείμενα 

έτσι ώστε να καταλήγουν σε μία ή περισσότερες 

υπονοούμενες ακμές κοπής που ορίζονται από άλλα 

αντικείμενα. Μπορείτε να κόψετε τόξα, κύκλους, 

γραμμές, μη κλειστές πολυγραμμές και ακτίνες. 
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Για να κόψετε ένα αντικείμενο: 

 
1. Επιλέξτε Τροποποίηση > Περικοπή από το κύριο μενού. 

2. Επιλέξτε μία ή περισσότερες ακμές κοπής και, στη συνέχεια, πατήστε Enter. 

3. Επιλέξτε το αντικείμενο προς περικοπή. 

4. Πατήστε Enter για να ολοκληρώσετε την εντολή. 

 
Για να κόψετε πολλά αντικείμενα χρησιμοποιώντας τη μέθοδο επιλογής φράχτη: 

 
1. Επιλέξτε Τροποποίηση > Περικοπή από το κύριο μενού. 

2. Επιλέξτε μία ή περισσότερες ακμές κοπής και, στη συνέχεια, πατήστε Enter. 

3. Στη γραμμή εντολών, πληκτρολογήστε F (Fence). 

4. Καθορίστε το πρώτο σημείο της περίφραξης. 

5. Καθορίστε το δεύτερο σημείο της περίφραξης. 

6. Πατήστε Enter για να ολοκληρώσετε την εντολή. 
 
 
 

 
7.13. Επέκταση αντικειμένων 

 
Μπορείτε να επεκτείνετε τα αντικείμενα έτσι ώστε να καταλήγουν σε ένα όριο που ορίζεται από άλλα αντικείμενα. Μπορείτε 

να επεκτείνετε τόξα, γραμμές, δισδιάστατες πολυγραμμές και ακτίνες. Τα τόξα, οι κύκλοι, οι ελλείψεις, οι γραμμές, οι 

splines, οι πολυγραμμές, οι ακτίνες, οι άπειρες γραμμές και τα παράθυρα προβολής σε μια καρτέλα διάταξης μπορούν να 

λειτουργήσουν ως ακμές ορίων. 

 
Για να επεκτείνετε ένα αντικείμενο: 

 
1. Επιλέξτε Τροποποίηση > Επέκταση από το κύριο μενού. 

2. Επιλέξτε ένα ή περισσότερα αντικείμενα ως οριακές ακμές και, στη συνέχεια, πατήστε Enter. 

3. Επιλέξτε το αντικείμενο προς επέκταση και πατήστε Enter για να 

ολοκληρώσετε την εντολή. Για να επεκτείνετε ένα αντικείμενο σε 

ένα υπονοούμενο όριο: 

1. Επιλέξτε Τροποποίηση > Επέκταση από το κύριο μενού. 

2. Επιλέξτε μία ή περισσότερες οριακές ακμές και, στη συνέχεια, πατήστε Enter. 

3. Στη γραμμή εντολών, πληκτρολογήστε E (Edge). 

4. Στη γραμμή εντολών, πληκτρολογήστε E (Extend). 

5. Επιλέξτε το αντικείμενο προς επέκταση και πατήστε Enter για να ολοκληρώσετε. 
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Για να επεκτείνετε πολλά αντικείμενα χρησιμοποιώντας τη μέθοδο επιλογής φράχτη: 

 
1. Επιλέξτε Τροποποίηση > Επέκταση από το κύριο μενού. 

2. Επιλέξτε μία ή περισσότερες οριακές ακμές και, στη συνέχεια, πατήστε Enter. 

3. Στη γραμμή εντολών, πληκτρολογήστε F (Fence). 

4. Καθορίστε το πρώτο και το δεύτερο σημείο της περίφραξης. 

5. Πατήστε Enter για να ολοκληρώσετε την εντολή. 

 
7.14. Δημιουργία διαλειμμάτων 

 
Μπορείτε να σπάσετε τόξα, κύκλους, ελλείψεις, γραμμές, πολυγραμμές, ακτίνες και άπειρες γραμμές. Κατά το σπάσιμο 

οντοτήτων, πρέπει να καθορίσετε δύο σημεία για το σπάσιμο. Από προεπιλογή, το σημείο που χρησιμοποιείτε για την 

επιλογή της οντότητας γίνεται το πρώτο σημείο θραύσης- ωστόσο, μπορείτε να χρησιμοποιήσετε την επιλογή πρώτο σημείο 

θραύσης για να επιλέξετε ένα σημείο θραύσης διαφορετικό από αυτό που επιλέγει την οντότητα. 

 
Να σπάσετε ένα αντικείμενο: 

 
1. Επιλέξτε Τροποποίηση > Διάλειμμα από το κύριο μενού. 

2. Επιλέξτε το αντικείμενο. 

3. Καθορίστε το δεύτερο σημείο διακοπής. 

 
Για να επιλέξετε ένα αντικείμενο και στη συνέχεια να καθορίσετε τα δύο σημεία διακοπής: 

 
1. Επιλέξτε Τροποποίηση > Διάλειμμα από το κύριο μενού. 

2. Επιλέξτε το αντικείμενο. 

3. Στη γραμμή εντολών, πληκτρολογήστε F (Πρώτο σημείο). 

4. Καθορίστε το πρώτο και το δεύτερο σημείο διακοπής. 

 
7.15. Δημιουργήστε λοξότμηση 

 
Μπορείτε να συνδέσετε δύο μη παράλληλα αντικείμενα επεκτείνοντάς τα ή περικόπτοντάς τα και στη συνέχεια ενώνοντάς τα 

με μια γραμμή για να δημιουργήσετε μια λοξή ακμή. Μπορείτε να λοξοτμήσετε γραμμές, πολυγραμμές, ακτίνες και άπειρες 

γραμμές. Κατά τη δημιουργία μιας λοξότμησης, μπορείτε να καθορίσετε πόσο μακριά θα περικόψετε τα αντικείμενα από την 

τομή τους (μέθοδος απόστασης απόστασης) ή μπορείτε να καθορίσετε το μήκος της λοξότμησης και τη γωνία που σχηματίζει 

κατά μήκος του πρώτου αντικειμένου (μέθοδος γωνίας απόστασης). 

 
Όταν λοξοτομείτε μια πολυγραμμή, μπορείτε να λοξοτομήσετε πολλαπλά τμήματα μεταξύ δύο επιλεγμένων τμημάτων 

πολυγραμμής ή να λοξοτομήσετε ολόκληρη την πολυγραμμή. 
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Για να λοξοτομήσετε δύο αντικείμενα χρησιμοποιώντας τη μέθοδο απόστασης-απόστασης: 

 
1. Επιλέξτε Modify > Chamfer από το κύριο μενού. 

2. Στη γραμμή εντολών, πληκτρολογήστε D (Απόσταση). 

3. Καθορίστε την πρώτη απόσταση λοξότητας. 

4. Καθορίστε την απόσταση της δεύτερης λοξοτομής. 
 

5. Επιλέξτε το πρώτο αντικείμενο προς λοξότμηση. 

6. Επιλέξτε το δεύτερο αντικείμενο για λοξότμηση. 

 

 

 

 

 
Για να λοξοτομήσετε δύο αντικείμενα χρησιμοποιώντας τη μέθοδο γωνίας απόστασης: 

 
1. Επιλέξτε Modify > Chamfer από το κύριο μενού. 

2. Στη γραμμή εντολών, πληκτρολογήστε A (Angle). 

3. Καθορίστε το μήκος της λοξοτομής στην πρώτη γραμμή. 

4. Καθορίστε τη γωνία λοξοτομής από την πρώτη γραμμή. 

5. Επιλέξτε το πρώτο αντικείμενο προς λοξότμηση. 

6. Επιλέξτε το δεύτερο αντικείμενο για λοξότμηση. 

 
Για να λοξοτμήσετε επιλεγμένες κορυφές σε μια πολυγραμμή: 

 
1. Επιλέξτε Modify > Chamfer από το κύριο μενού. 

2. Επιλέξτε ένα τμήμα πολυγραμμής από όπου 

θέλετε να ξεκινήσετε την λοξοτομή. 

3. Επιλέξτε το άλλο τμήμα πολυγραμμής όπου 

θέλετε να τελειώσει η λοξοτομή. 

 
Για να λοξοτμήσετε όλες τις κορυφές μιας πολυγραμμής: 

 
1. Επιλέξτε Modify > Chamfer από το κύριο μενού. 

2. Στη γραμμή εντολών, πληκτρολογήστε P (Polyline). 

3. Επιλέξτε την πολυγραμμή. 

 
7.16. Δημιουργήστε φιλέτα 

 
Μπορείτε να δημιουργήσετε ένα φιλέτο χρησιμοποιώντας την εντολή FILLET. Αυτή η εντολή μπορεί να εφαρμοστεί σε 

αντικείμενα όπως τόξα, κύκλους, ελλείψεις, γραμμές, πολυγραμμές, ακτίνες, splines ή γραμμές κατασκευής. Ένα φιλέτο 

είναι ένα τόξο που συνδέει ομαλά δύο αντικείμενα και έχει καθορισμένη ακτίνα. Μια εσωτερική γωνία ονομάζεται  

 

φιλέτο- μια εξωτερική γωνία ονομάζεται στρογγυλό. Πριν δημιουργήσετε φιλέτα, θα πρέπει να βεβαιωθείτε ότι η 

απόσταση μεταξύ κάθε κορυφής είναι αρκετά μεγάλη ώστε να χωράει την ακτίνα φιλέτου, προκειμένου να εισαχθεί ένα τόξο  
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φιλέτου. Όταν η ακτίνα φιλέτου ορίζεται σε 0, δεν εισάγονται τόξα φιλέτου. Εάν δύο τμήματα πολυγραμμής χωρίζονται από ένα 

τμήμα τόξου, το σύστημα διαγράφει αυτό το τμήμα τόξου και επεκτείνει τις γραμμές ώστε να τέμνονται μεταξύ τους. 

 
Για να φιλετάρετε δύο αντικείμενα: 

 
1. Επιλέξτε Τροποποίηση > Φιλέτο από το κύριο μενού. 

2. Στη γραμμή εντολών, πληκτρολογήστε R (Radius). 

3. Καθορίστε την ακτίνα σμίλευσης. 

4. Επιλέξτε το πρώτο και το δεύτερο αντικείμενο. 

 

 

 
 

Για να φιλέψετε μια ολόκληρη πολυγραμμή: 

 
1. Επιλέξτε Τροποποίηση > Φιλέτο από το κύριο μενού. 

2. Στη γραμμή εντολών, πληκτρολογήστε P (Polyline). 

3. Επιλέξτε την πολυγραμμή. 

 
Για να φιλέψετε επιλεγμένες κορυφές σε μια πολυγραμμή: 

 
1. Επιλέξτε Τροποποίηση > Φιλέτο από το κύριο μενού. 

2. Επιλέξτε ένα τμήμα πολυγραμμής από όπου θέλετε να ξεκινήσετε το φιλέτο. 

3. Επιλέξτε το άλλο τμήμα της πολυγραμμής όπου θέλετε να 

τελειώσει το φιλέτο. 

 
 
 

 
7.16.1. Περικοπή και επέκταση φιλεταρισμένων αντικειμένων 

 
Κατά την εκτέλεση της σμίλευσης, μπορείτε να επιλέξετε την επιλογή 

Περικοπή για να αποφασίσετε αν οι επιλεγμένες ακμές επεκτείνονται στα 

τελικά σημεία των τόξων σμίλευσης. Από προεπιλογή, όλα τα 

τα αντικείμενα εκτός από κύκλους, ελλείψεις, κλειστές πολυγραμμές και splines περικόπτονται ή επεκτείνονται κατά την εκτέλεση της σμίκρυνσης. 
 
 

7.16.2. Συνδυασμοί Γραμμών και Πολυγραμμών 

 
Εάν τα αντικείμενα προς σμίλευση είναι μια γραμμή και μια πολυγραμμή, η 

γραμμή ή η προέκτασή της πρέπει να τέμνει ένα από τα τμήματα της 

πολυγραμμής. Με ενεργοποιημένη την επιλογή Trim, τα αντικείμενα που 

φιλτράρονται ενώνονται με το τόξο που φιλτράρεται για να 

σχηματίσουν μια νέα πολυγραμμή. 
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7.16.3. Φιλέτο παράλληλων γραμμών 

 
Μπορείτε να φιλέψετε παράλληλες γραμμές, ακτίνες και άπειρες γραμμές. Η πρώτη οντότητα πρέπει να είναι γραμμή ή 

ακτίνα, η δεύτερη οντότητα μπορεί να είναι γραμμή, ακτίνα ή άπειρη γραμμή. Η διάμετρος του τόξου φιλέτου είναι πάντα ίση 

με την απόσταση μεταξύ των παράλληλων οντοτήτων. Η τρέχουσα ακτίνα φιλέτου αγνοείται. 

 

7.16.4. Ανάποδο φιλέτο 

 
Το Invert Fillet έχει ένα πολύ ευρύ φάσμα χρήσης, ιδιαίτερα στις κατασκευές 

και στη βιομηχανία επίπλων. Η εντολή FILLET προσφέρει τώρα μια νέα 

επιλογή που ονομάζεται Invert. Με την επιλογή αυτή μπορείτε να 

δημιουργήσετε ένα αντίστροφο φιλέτο. 

 

 
7.17. Αποσύνδεση σύνθετων αντικειμένων 

 
Μπορείτε να μετατρέψετε μια σύνθετη οντότητα, όπως ένα μπλοκ ή μια πολυγραμμή, από μια ενιαία οντότητα στα 

συστατικά της μέρη. Η αναδίπλωση μιας πολυγραμμής, ενός ορθογωνίου, ενός ντόνατ, ενός πολυγώνου, μιας διάστασης ή 

ενός οδηγού την ανάγει σε μια συλλογή από μεμονωμένες οντότητες γραμμών και τόξων που μπορείτε στη συνέχεια να 

τροποποιήσετε μεμονωμένα. Τα μπλοκ μετατρέπονται στις επιμέρους οντότητες, ενδεχομένως συμπεριλαμβανομένων 

άλλων, εμφωλευμένων μπλοκ που συνέθεταν την αρχική οντότητα. 
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Με τις ακόλουθες εξαιρέσεις, η έκρηξη μιας οντότητας συνήθως δεν έχει ορατό αποτέλεσμα σε ένα σχέδιο: 

 
-Αν η αρχική πολυγραμμή είχε πλάτος, η πληροφορία για το πλάτος χάνεται κατά την έκρηξη. 

-Αν ανατινάξετε ένα μπλοκ που περιέχει χαρακτηριστικά, τα χαρακτηριστικά χάνονται, αλλά οι αρχικοί ορισμοί των χαρακτηριστικών διατηρούνται. 

-Τα χρώματα, οι τύποι γραμμών, τα βάρη γραμμών και τα στυλ εκτύπωσης που εκχωρούνται BYBLOCK μπορεί να είναι 

διαφορετικά μετά την έκρηξη μιας οντότητας, επειδή θα υιοθετήσουν το προεπιλεγμένο χρώμα, τον τύπο γραμμών, το βάρος 

γραμμών και το στυλ εκτύπωσης μέχρι να εισαχθούν σε άλλο μπλοκ. 

7.18. Τροποποίηση πολυγραμμών 

 
Αντικείμενα όπως ορθογώνια, πολύγωνα και ντόνατς, καθώς και τρισδιάστατα αντικείμενα όπως πυραμίδες, κύλινδροι 

και σφαίρες, είναι όλα επεξεργάσιμες πολυγραμμές. Για να τροποποιήσετε μια πολυγραμμή, εκτελέστε την εντολή PEDIT. 

Οι διαθέσιμες επιλογές διαφέρουν ανάλογα με το αν η επιλεγμένη πολυγραμμή είναι δισδιάστατο ή τρισδιάστατο αντικείμενο. 

Εάν το επιλεγμένο αντικείμενο δεν είναι πολυγραμμή, το εργαλείο Επεξεργασία πολυγραμμής παρέχει τη δυνατότητα 

μετατροπής του σε πολυγραμμή. Μπορείτε να μετατρέψετε μόνο τόξα και γραμμές σε πολυγραμμές. Εάν πολλά τόξα ή γραμμές 

είναι ενωμένα από άκρο σε άκρο, μπορούν να επιλεγούν όλα και να μετατραπούν σε μία πολυγραμμή. 

 

 
 

7.19. Τροποποίηση πολλαπλών γραμμών 

 
Μπορείτε να χρησιμοποιήσετε τις μεθόδους όπως οι κοινές εντολές επεξεργασίας, μια εντολή επεξεργασίας 

πολλαπλών γραμμών και τα στυλ πολλαπλών γραμμών για να επεξεργαστείτε πολλαπλές γραμμές ή τα στοιχεία τους. 

Μπορείτε να χρησιμοποιήσετε την εντολή MLEDIT για να προσθέσετε ή να διαγράψετε κορυφές για μια πολυγραμμή, να 

ελέγξετε τον τρόπο με τον οποίο τέμνονται δύο πολυγραμμές (σχήμα σταυρού και Τ που μπορεί να είναι κλειστό, ανοιχτό ή  
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συγχωνευμένο), να προσθέσετε στυλ πολυγραμμής ή να ορίσετε πολυγραμμές από το υπάρχον στυλ πολυγραμμής, όπως 

τον αριθμό των στοιχείων, το χρώμα, το είδος γραμμής, το βάρος γραμμής και τη μετατόπιση κάθε στοιχείου. 

 

7.20. Κλιπ 

 
Η νέα εντολή CLIP αποκόπτει ένα μπλοκ, μια εξωτερική αναφορά, μια εικόνα, ένα παράθυρο προβολής και ένα υπόστρωμα (PDF ή DGN)  

σε ένα καθορισμένο όριο. Μπορεί να χρησιμοποιηθεί για να αντικαταστήσει τις εντολές XCLIP, IMAGECLIP, VPCLIP, PDFCLIP, 

DGNCLIP. 

7.21. Προσθήκη επιλεγμένου 

 
Μπορείτε να χρησιμοποιήσετε αυτή τη λειτουργία για να δημιουργήσετε ένα νέο αντικείμενο με τον ίδιο τύπο και τις ίδιες 

ιδιότητες (όπως χρώματα, στρώματα, βάρος γραμμής, τύπο γραμμής και συντελεστή κλίμακας) με το επιλεγμένο 

αντικείμενο, αλλά με διαφορετικές γεωμετρικές τιμές. 

Για παράδειγμα, η δημιουργία αντικειμένων με βάση επιλεγμένους κύκλους χρησιμοποιεί τις γενικές ιδιότητες του κύκλου, 

όπως τα χρώματα και τα επίπεδα, αλλά σας ζητά να εισαγάγετε το κέντρο και την ακτίνα του νέου κύκλου. 

 

 
Βήματα χρήσης του ADDSELECTED 

1. Επιλέξτε το αντικείμενο στο οποίο βασίζεται το νέο αντικείμενο. 

2. Κάντε δεξί κλικ και επιλέξτε "Add Selected". 

3. Δημιουργήστε ένα αντικείμενο παρόμοιο με το επιλεγμένο αντικείμενο σύμφωνα με τις οδηγίες. 

 
7.22. Πολλαπλές 

 
Εκτελεί μια εντολή επαναλαμβανόμενα, αποφεύγοντας το πάτημα του πλήκτρου enter ή του πλήκτρου space bar. Επειδή αυτή η 

εντολή επαναλαμβάνει μόνο τα ονόματα των εντολών, όλες οι παράμετροι πρέπει να καθορίζονται κάθε φορά. Αν θέλουμε να 

σχεδιάσουμε περισσότερους από έναν κύκλους, μπορείτε να εισάγετε ΠΟΛΛΑΠΛΕΣ, χτυπήστε το "ENTER", και στη συνέχεια 

εισάγετε τον ΚΥΚΛΟ, "ENTER", μπορείτε να σχεδιάσετε έναν κύκλο χωρίς να χρειάζεται να πατήσετε την κλήση για να 

επαναλάβετε τον κύκλο της παραγγελίας στη διαδικασία. 
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7.23. Ορισμός ανά στρώμα 

 
Αλλάζει τις παρακάμψεις ιδιοτήτων των επιλεγμένων αντικειμένων σε ByLayer, συμπεριλαμβανομένων των χρωμάτων, του τύπου γραμμής, του 
βάρους γραμμής και των υλικών. 

 
7.24. Εντολή MKSHAPE 

 
Η εντολή MKSHAPE δημιουργεί έναν ορισμό σχήματος με βάση επιλεγμένα αντικείμενα. Μπορείτε να δημιουργήσετε εύκολα 

προσαρμοσμένους τύπους γραμμών. Εάν δημιουργήσετε ένα σχήμα που υπερβαίνει τα 2200 byte δεδομένων, η εντολή 

MKSHAPE δημιουργεί σύνθετα γεωμετρικά σχήματα για να σχηματίσει ένα ενιαίο σχήμα. 

1. Δημιουργήστε ένα αντικείμενο πολυγραμμής, όπως μια γραμμή, ένα ορθογώνιο, έναν κύκλο ή ένα κλειστό αντικείμενο. 

2. Πληκτρολογήστε την εντολή MKSHAPE για να αποθηκεύσετε ένα αρχείο .shp με ένα κατάλληλο όνομα για το σχήμα σας. 

 

3. Εισάγετε το όνομα του σχήματος και εισάγετε μια τιμή ανάλυσης (η εισαγωγή χαμηλότερης τιμής ισοδυναμεί με 

υποβαθμισμένο σχήμα πολυγραμμής, η εισαγωγή υψηλότερης τιμής ισοδυναμεί με παρόμοιο σχήμα με την αρχική 

πολυγραμμή που έχει επιλεγεί). 

4. Καθορίστε ένα σημείο εισαγωγής στην περιοχή σχεδίασης, επιλέξτε την πολυγραμμή που δημιουργήθηκε και πατήστε Enter. 

5. Αν θέλετε να εισαγάγετε το νέο σχήμα που δημιουργήσατε, εκτελέστε την εντολή SHAPE και εισαγάγετε το όνομά του. 

 
 

6. Καθορίστε ένα σημείο εισαγωγής, κλίμακα και περιστροφή. 
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8. Σημειώσεις και ετικέτες 

 
 

8.1. Δημιουργία κειμένου 

 
Δημιουργία κειμένου, κειμένου πολλαπλών γραμμών (mtext) και κειμένου που περιλαμβάνει μία ή περισσότερες γραμμές αρχηγού. 

 
8.1.1. Κείμενο μιας γραμμής 

 
Μπορείτε να χρησιμοποιήσετε την εντολή TEXT για να δημιουργήσετε ένα μονόγραμμο ή πολύγραμμο κείμενο. Κάθε γραμμή 

κειμένου είναι ένα ανεξάρτητο αντικείμενο που μπορεί να τροποποιηθεί. Πριν από την πληκτρολόγηση του κειμένου, 

μπορείτε να καθορίσετε το στυλ του κειμένου και τον τρόπο στοίχισης στην προτροπή δημιουργίας κειμένου. 

 
Πιέστε ENTER αν έχετε πληκτρολογήσει κάποιους χαρακτήρες, και στη συνέχεια η γραμμή εντολών σας ζητά να εισαγάγετε 

χαρακτήρες για την επόμενη σειρά κειμένου. Κατά τη δημιουργία κειμένου μονής γραμμής, σας δίνεται επίσης η δυνατότητα 

να επεκτείνετε ή να συμπιέσετε ορισμένα αντικείμενα κειμένου μονής γραμμής σε καθορισμένο χώρο για να 

ικανοποιήσετε τις ανάγκες σας, επιλέγοντας την επιλογή Ευθυγράμμιση ή Προσαρμογή από την προτροπή της γραμμής 

εντολών TEXT. 

 
Για να δημιουργήσετε κείμενο: 

 
1. Επιλέξτε Σχεδίαση > Κείμενο > Κείμενο μονής γραμμής από το κύριο μενού. 

2. Καθορίστε το σημείο έναρξης του κειμένου. 

3. Καθορίστε το ύψος του κειμένου. 

4. Καθορίστε τη γωνία περιστροφής του κειμένου. 

5. Πληκτρολογήστε το κείμενο και, στη συνέχεια, πατήστε Enter στο τέλος κάθε νέας γραμμής. 

6. Για να ολοκληρώσετε την εντολή, πατήστε 

ξανά Enter. Για να καθορίσετε τη στοίχιση 

του κειμένου της γραμμής: 

1. Επιλέξτε Σχεδίαση > Κείμενο > Κείμενο μονής γραμμής από το κύριο μενού. 

2. Στη γραμμή εντολών, πληκτρολογήστε J (Justify) και πατήστε ENTER. 

3. Πληκτρολογήστε μια επιλογή ευθυγράμμισης BR για την ευθυγράμμιση του κειμένου στην κάτω δεξιά γωνία του. 

4. Πληκτρολογήστε το κείμενο και, στη συνέχεια, πατήστε Enter στο τέλος κάθε νέας γραμμής. 

5. Για να ολοκληρώσετε την εντολή, πατήστε ξανά Enter. 

 
8.1.2. Κείμενο πολλαπλών γραμμών 

 
Το πολυγραμμικό κείμενο αποτελείται από μία ή περισσότερες γραμμές 

κειμένου ή παραγράφους που χωράνε μέσα σε ένα πλάτος ορίου που 

καθορίζετε. Όταν δημιουργείτε πολυγραμμικό κείμενο, καθορίζετε πρώτα 

το πλάτος ορίου της παραγράφου καθορίζοντας τις απέναντι γωνίες ενός  
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ορθογωνίου. Το κείμενο πολλαπλών γραμμών τυλίγεται αυτόματα έτσι ώστε 

να χωράει μέσα σε αυτό το ορθογώνιο. Αφού καθορίσετε το πλαίσιο 

κειμένου, το σύστημα ανοίγει τον Επεξεργαστή κειμένου επί τόπου, ο 

οποίος αποτελείται από ένα πλαίσιο κειμένου και τη γραμμή εργαλείων 

μορφοποίησης κειμένου. 

Μπορείτε να πληκτρολογήσετε κείμενο στο πλαίσιο κειμένου και να αλλάξετε το στυλ από την επιλογή Κείμενο 

 
Γραμμή εργαλείων μορφοποίησης. 

 
Για να δημιουργήσετε κείμενο πολλών γραμμών: 

 
1. Επιλέξτε Draw > Text > Multiline Text από το κύριο μενού. 

2. Επιλέξτε την πρώτη και τη δεύτερη γωνία της περιοχής κειμένου. 

3. Στο παράθυρο Πολυσέλιδο κείμενο, πληκτρολογήστε το κείμενο που θέλετε. 

4. Για να δημιουργήσετε παραγράφους, πατήστε Enter και συνεχίστε την πληκτρολόγηση. 

 
Παρατήρηση: Ανατρέξτε στον οδηγό του εργαλείου express. Στη 

γραμμή εργαλείων, πραγματοποιήστε αλλαγές μορφής ως 

εξής: 

1. Για να αλλάξετε τη γραμματοσειρά του επιλεγμένου 

κειμένου, επιλέξτε μια γραμματοσειρά από τη λίστα. 

2. Για να αλλάξετε το ύψος του επιλεγμένου κειμένου, 

εισαγάγετε μια νέα τιμή στο πλαίσιο Ύψος.3.Για να 

εφαρμόσετε χρώμα στο επιλεγμένο κείμενο, επιλέξτε 

ένα χρώμα από τη λίστα Χρώμα. 

4.Κάντε κλικ στο OK στη γραμμή εργαλείων ή πατήστε <Ctrl + Enter>. 

 
Ευθυγράμμιση κειμένου πολλαπλών γραμμών: Μπορείτε να καθορίσετε το 

σημείο προσάρτησης στο επάνω αριστερό, επάνω κεντρικό, επάνω δεξιό, μεσαίο 

αριστερό, μεσαίο κεντρικό, μεσαίο δεξιό, κάτω αριστερά, κάτω κεντρικό ή κάτω 

δεξιό. Το κείμενο πολλαπλών γραμμών μπορεί να ρέει από αριστερά προς τα 

δεξιά, από δεξιά προς τα αριστερά, από πάνω προς τα κάτω ή από κάτω προς τα 

πάνω. 

 
Μορφοποίηση χαρακτήρων μέσα σε κείμενο πολλών γραμμών: Κατά τη 

διάρκεια της δημιουργίας πολυγραμμικού κειμένου, μπορείτε να εκχωρήσετε μια 

νέα τιμή στα επιλεγμένα αντικείμενα για να επικαλύψετε την προεπιλεγμένη 

ρύθμιση. Μπορείτε να καθορίσετε υπογραμμίσεις, έντονη γραφή, χρώμα και 

γραμματοσειρές για έναν ή περισσότερους χαρακτήρες ή διαφορετικό ύψος 

κειμένου. 

 
Εσοχή πολυγραμμικού κειμένου και χρήση καρτελών: Μπορείτε να ελέγξετε την 

εμφάνιση των αντικειμένων κειμένου και να δημιουργήσετε μια λίστα,  
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καθορίζοντας τις στάσεις πατήματος και την εσοχή του κειμένου. Οι κεφαλές 

βέλους στον χάρακα χρησιμοποιούνται για τον καθορισμό της εσοχής του 

κειμένου (πρώτη γραμμή και παράγραφος). 

 
Καθορίστε την απόσταση γραμμών: Είναι η απόσταση μεταξύ της βασικής 

γραμμής μιας γραμμής κειμένου και της βασικής γραμμής της επόμενης γραμμής 

κειμένου. Μπορείτε να κάνετε δεξί κλικ στο πλαίσιο κειμένου και να επιλέξετε 

Παράγραφος για να καθορίσετε το επιθυμητό διάστημα γραμμών όταν ο 

δρομέας παραμένει στο πλαίσιο κειμένου. 

 
 

 
Δημιουργία στοιβαγμένων χαρακτήρων: Το στοιβαγμένο κείμενο είναι κείμενο 

ή κλάσμα που εφαρμόζεται για τη σήμανση ανοχής ή μονάδων μέτρησης. Πριν από 

τη δημιουργία στοιβαγμένου κειμένου, πρέπει να χρησιμοποιήσετε ειδικά 

χαρακτήρες για να υποδείξετε τη θέση στοίβαξης του επιλεγμένου κειμένου. Τα παρακάτω περιεχόμενα παρουσιάζουν τους 

ειδικούς χαρακτήρες και απεικονίζουν τον τρόπο δημιουργίας στοιβαγμένου κειμένου: 

 
-Slash (/): Στοιβάζει το κείμενο κάθετα και το χωρίζει με μια οριζόντια γραμμή. 

-Σημείο λίρας (#): -Καράτι (^): Δημιουργεί μια στοίβα ανοχής, η οποία στοιβάζεται κάθετα καθώς και δεν διαχωρίζεται με 

γραμμή. Μπορείτε επίσης να χρησιμοποιήσετε το κουμπί Στοίβα στη γραμμή εργαλείων για να δημιουργήσετε 

στοιβαγμένο κείμενο. 

 
8.2. Εργασία με στυλ κειμένου 

 
Το στυλ κειμένου εφαρμόζεται στα αντικείμενα κειμένου. Μπορείτε να χρησιμοποιήσετε το στυλ κειμένου για να ελέγξετε τη 

γραμματοσειρά, το μέγεθος, τη γωνία, την κατεύθυνση και άλλα χαρακτηριστικά του κειμένου. Από προεπιλογή, το τρέχον στυλ 

κειμένου είναι STANDARD και πρέπει να κάνετε τρέχον άλλα στυλ κειμένου όταν θέλετε να τα εφαρμόσετε. Το στυλ κειμένου 

STANDARD έχει τις ακόλουθες προεπιλεγμένες ιδιότητες: 
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Για να δημιουργήσετε ένα στυλ κειμένου: 

 
1. Επιλέξτε Μορφή > Στυλ κειμένου από το κύριο μενού. 

2. Κάντε κλικ στο Νέο, πληκτρολογήστε ένα νέο 

όνομα στυλ κειμένου και, στη συνέχεια, κάντε 

κλικ στο OK. 

3. Στην ενότητα Μετρήσεις κειμένου, καθορίστε το 

Ύψος κειμένου, τον Συντελεστή πλάτους και την 

λοξή γωνία. 

4. Στην περιοχή Γραμματοσειρά κειμένου, επιλέξτε 

το όνομα, το στυλ, που θέλετε να 

χρησιμοποιήσετε. 

5. Κάντε κλικ στο κουμπί Εφαρμογή και, στη συνέχεια, κάντε κλικ στο κουμπί OK. 
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8.3. Δημιουργία Leader 

 

 
8.3.1. Ηγέτες 

 
Ο οδηγός είναι μια γραμμή ή μια γραμμή με βέλη στο ένα άκρο 

και σημειώσεις (Mtext, μπλοκ και ανοχές) στο άλλο άκρο. Γενικά, 

τοποθετείτε μια κεφαλή βέλους στο πρώτο σημείο. Μια σημείωση, 

που δημιουργείται ως κείμενο διαστάσεων, τοποθετείται 

αμέσως δίπλα στο τελευταίο σημείο. 

 
Για να δημιουργήσετε έναν αρχηγό και ένα σχόλιο: 

 
1. Επιλέξτε Διάσταση > Αρχηγός από το κύριο μενού. 

2. Καθορίστε το σημείο εκκίνησης του αρχηγού. 

3. Καθορίστε το τελικό σημείο του τμήματος γραμμής αρχηγού. 

4. Καθορίστε πρόσθετα τελικά σημεία τμημάτων γραμμής ηγέτη. 

5. Αφού καθορίσετε το τελευταίο τελικό σημείο, πατήστε Enter. 

6. Πληκτρολογήστε το σχόλιο και πατήστε Enter για να εισαγάγετε την επόμενη γραμμή του κειμένου σχολιασμού. 

7. Πατήστε ENTER για να ολοκληρώσετε την εντολή. 

 
8.3.2. Mleader 

 
Το Multileader χρησιμοποιείται για την προσάρτηση σχολίων σε πολλαπλές γραμμές αρχηγού. Το Multileader θα μπορούσε να 

χρησιμοποιηθεί για να δώσει πρόσθετες πληροφορίες ή ειδικές οδηγίες σε ένα σημείο ή σε μια συγκεκριμένη περιοχή στο 

σχέδιό σας.Έχει επίσης περισσότερες δυνατότητες όπως η χρήση κειμένου πολλαπλών γραμμών ή μπλοκ ως περιεχόμενο 

leader στο σχέδιό μας. Αυτή η έκδοση υποστηρίζει τις πλήρεις επιλογές του συνόλου multileader, όπως Add Leader, Remove 

Leader, Align and Collect. 
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8.4. Τροποποίηση κειμένου 

 

 
8.4.1. Αλλαγή κειμένου 

 
Όλα τα αντικείμενα κειμένου μπορούν να μετακινηθούν, να περιστραφούν, να διαγραφούν και να αντιγραφούν, όπως και 

άλλα αντικείμενα. Μπορείτε να αλλάξετε τις ιδιότητές τους στον πίνακα Ιδιότητες. Έχετε δύο μεθόδους για να 

τροποποιήσετε κείμενο μιας γραμμής: 

 
-Για να τροποποιήσετε μόνο το περιεχόμενο του κειμένου, χρησιμοποιήστε την εντολή DDEDIT. 

-Για να αλλάξετε το στυλ, τη θέση, το μέγεθος και το περιεχόμενο του κειμένου, χρησιμοποιήστε την εντολή ΙΔΙΟΤΗΤΕΣ για να 

ανοίξετε την παλέτα Ιδιότητες, από την οποία μπορείτε να κάνετε τις σχετικές ρυθμίσεις. 

 
Για να επεξεργαστείτε μονόγραμμο ή πολύγραμμο κείμενο: 

 
1. Πληκτρολογήστε DDEDIT και στη συνέχεια πατήστε Enter. 

2. Επιλέξτε το κείμενο μιας ή περισσότερων γραμμών. 

3. Αν επιλέξετε το κείμενο μιας γραμμής, θα εμφανιστεί το πλαίσιο Επεξεργασία κειμένου, επεξεργαστείτε το κείμενο και πατήστε Enter. 

4. Αν επιλέξετε το πολυγραμμοποιημένο κείμενο, θα εμφανιστεί το πρόγραμμα επεξεργασίας κειμένου επί τόπου, επεξεργαστείτε το κείμενο όπως 
χρειάζεστε. 

 

 
Για να αλλάξετε τις ιδιότητες του κειμένου μίας ή περισσότερων γραμμών: 

 
1. Επιλέξτε ένα αντικείμενο κειμένου μονής γραμμής ή πολλαπλών γραμμών. 

2. Κάντε δεξί κλικ στο επιλεγμένο αντικείμενο και, στη συνέχεια, επιλέξτε Ιδιότητες στο μενού συντόμευσης. 

3. Στην παλέτα Ιδιότητες, εισαγάγετε οποιοδήποτε νέο κείμενο στα Περιεχόμενα κειμένου και, 

στη συνέχεια, αλλάξτε τη μορφοποίηση και άλλες ιδιότητες όπως απαιτείται. 4. Μπορείτε 

επίσης να κάνετε διπλό κλικ στο πολυγραμμοποιημένο κείμενο για να ανοίξετε τον 

Επεξεργαστή κειμένου επί τόπου, από τον οποίο, μπορείτε να τροποποιήσετε τα περιεχόμενα 

και τις μορφές του κειμένου. 
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9. Διαστάσεις και ανοχές 

 
Οι διαστάσεις υποδεικνύουν τις τιμές μέτρησης των αντικειμένων (π.χ. μήκος ή 

πλάτος), την απόσταση ή τις γωνίες μεταξύ των αντικειμένων ή την απόσταση 

μεταξύ του σημείου χαρακτηριστικών και της καθορισμένης αρχής. Μπορείτε να 

δημιουργήσετε πέντε βασικούς τύπους διαστάσεων: γραμμικές, γωνιακές, ακτινικές, 

διαμετρικές και διατακτικές. Οι διαστάσεις έχουν διάφορα διακριτά στοιχεία: 

κείμενο διάστασης, γραμμές διάστασης, κεφαλές βελών και γραμμές επέκτασης. 

 
1. Κείμενο διάστασης: περιλαμβάνει προθέματα, επιθήματα, ανοχές κ.λπ. 

2. Γραμμή διαστάσεων: Δείχνει την κατεύθυνση και την έκταση μιας διάστασης. Για γραμμικές διαστάσεις, εμφανίζεται ως 

γραμμή, ενώ για γωνιακές διαστάσεις, εμφανίζεται ως τμήμα τόξου. 

3. Arrowhead: Συνήθως εμφανίζεται και στα δύο άκρα της γραμμής διάστασης. Μπορείτε να καθορίσετε διάφορα μεγέθη και 

σχήματα για τις κεφαλές βελών ή τα σημάδια επιλογής. 

4. Γραμμές επέκτασης: Επεκτείνονται από το αντικείμενο μέχρι τη γραμμή διαστάσεων, για να ορίσουν περιοχές διαστάσεων. 

 
9.1. Δημιουργία διαστάσεων 

 
Μπορείτε να δημιουργήσετε διαστάσεις επιλέγοντας την οντότητα προς διαστασιολόγηση και καθορίζοντας τη θέση της 

γραμμής διάστασης ή καθορίζοντας την προέλευση της γραμμής επέκτασης και τη θέση της γραμμής διάστασης. 

 
 

 
9.1.1. Οριζόντιες και κάθετες διαστάσεις 

 
Καθώς δημιουργείτε γραμμικές διαστάσεις, το σύστημα εφαρμόζει αυτόματα μια 

οριζόντια ή κατακόρυφη διάσταση ανάλογα με την καθορισμένη προέλευση της 

γραμμής επέκτασης ή τη θέση στην οποία επιλέγετε ένα αντικείμενο. Ωστόσο, 

μπορείτε να δημιουργήσετε μια διάσταση καθορίζοντας ότι θα είναι οριζόντια 

ή κατακόρυφη. 

 
Για να δημιουργήσετε μια οριζόντια ή κάθετη διάσταση: 

 
1. Επιλέξτε Διάσταση > Γραμμική από το κύριο μενού. 

2. Πατήστε Enter και, στη συνέχεια, επιλέξτε το αντικείμενο προς διαστασιολόγηση. Ή, μπορείτε να καθορίσετε την πρώτη και τη δεύτερη προέλευση 
της γραμμής επέκτασης. 

3. Καθορίστε τη θέση της γραμμής διαστάσεων. 
 

 
9.1.2. Δημιουργία ευθυγραμμισμένων διαστάσεων 

 
Στις ευθυγραμμισμένες διαστάσεις, η γραμμή διαστάσεων είναι παράλληλη 

προς την ευθεία που διέρχεται από τις αφετηρίες της γραμμής επέκτασης. Η 

ευθυγραμμισμένη διάσταση είναι επίσης παράλληλη με τα αντικείμενα που 

καθορίζετε. Το σύστημα δημιουργεί αυτόματα τις γραμμές επέκτασης. 
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Για να δημιουργήσετε μια ευθυγραμμισμένη διάσταση: 

 
1. Επιλέξτε Διάσταση > Στοίχιση από το κύριο μενού. 

2. Πατήστε Enter και, στη συνέχεια, επιλέξτε το αντικείμενο προς διαστασιολόγηση. Ή, μπορείτε να καθορίσετε την πρώτη και τη 
δεύτερη προέλευση της γραμμής επέκτασης. 

3. Καθορίστε τη θέση της γραμμής διαστάσεων. 

 
9.1.3. Δημιουργία βασικών και συνεχιζόμενων διαστάσεων 

 
Τόσο η βασική όσο και η συνεχιζόμενη διάσταση είναι πολλαπλές γραμμικές διαστάσεις. Οι βασικές διαστάσεις 

μετρώνται από την ίδια βασική γραμμή και οι συνεχείς διαστάσεις τοποθετούνται από άκρο σε άκρο. Πριν από τη δημιουργία 

είτε της βασικής είτε της συνεχιζόμενης διάστασης, πρέπει να δημιουργήσετε μια γραμμική, ευθυγραμμισμένη ή γωνιακή 

διάσταση. 

 
Για να δημιουργήσετε μια γραμμική βασική διάσταση: 

 
1. Επιλέξτε Διάσταση > Γραμμή βάσης από το κύριο μενού. 

2. Καθορίστε μια δεύτερη προέλευση γραμμής επέκτασης3.Επιλέξτε την επόμενη προέλευση γραμμής επέκτασης. 

4. Συνεχίστε να επιλέγετε την προέλευση της γραμμής επέκτασης όπως απαιτείται. 

5. Για να τερματίσετε την εντολή, πατήστε Enter δύο φορές. 

 
Για να δημιουργήσετε μια γραμμική συνεχή διάσταση: 

 
1. Επιλέξτε Διάσταση > Συνέχεια από το κύριο μενού. 

2. Για να επιλέξετε μια αρχική διάσταση, πατήστε Enter. 

3. Επιλέξτε την προέλευση της επόμενης γραμμής επέκτασης και, στη συνέχεια, 

πατήστε Enter. Ή πατήστε Enter και, στη συνέχεια, επιλέξτε μια υπάρχουσα 

διάσταση για να συνεχίσετε. 5. Για να προσθέσετε συνεχείς διαστάσεις, 

συνεχίστε να επιλέγετε τις αφετηρίες των γραμμών προέκτασης. 

6. Για να τερματίσετε την εντολή, πατήστε Enter δύο φορές. 
 
 
 

 
9.1.4. Δημιουργία περιστρεφόμενων διαστάσεων 

 
Μπορείτε να δημιουργήσετε περιστρεφόμενες διαστάσεις σε μια περιστρεφόμενη 

γωνία που καθορίζετε χρησιμοποιώντας την επιλογή DIMLINEAR Rotated. Ένα 

παράδειγμα μιας περιστρεφόμενης διάστασης φαίνεται στην ακόλουθη εικόνα. 

Σε αυτή την εικόνα, η καθορισμένη γωνία της περιστρεφόμενης διάστασης είναι ίση με τη γωνία της σχισμής. 
 

 
9.1.5. Δημιουργία γωνιακών διαστάσεων 

 
Οι γωνιακές διαστάσεις χρησιμοποιούνται για τη μέτρηση της γωνίας μεταξύ 

γραμμών ή τριών σημείων. Μπορείτε να διαστασιολογήσετε αντικείμενα όπως 
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κύκλους, τόξα και γραμμές. Όταν δημιουργείτε τη γωνιακή διάσταση, μπορείτε να 

τροποποιήσετε το περιεχόμενο και την ευθυγράμμιση του κειμένου πριν 

τοποθετήσετε τη γραμμή διάστασης. 

 
Για να διαστασιολογήσετε μια γωνία μεταξύ δύο γραμμών: 

 
1. Επιλέξτε Διάσταση > Γωνιακή από το κύριο μενού. 

2. Επιλέξτε μια γραμμή. 

3. Επιλέξτε την άλλη γραμμή. 

4. Καθορίστε τη θέση της γραμμής διαστάσεων. 
 
 

 
Για να διαστασιολογήσετε μια γωνία που περικλείεται από ένα τόξο: 

 
1. Επιλέξτε Διάσταση > Γωνιακή από το κύριο μενού. 

2. Επιλέξτε το τόξο. 

3. Καθορίστε τη θέση του τόξου διάστασης. 

 
9.1.6. Δημιουργία ακτινικών διαστάσεων 

 
Μπορείτε να δημιουργήσετε ακτινικές διαστάσεις για κύκλους ή τόξα για να 

μετρήσετε την ακτίνα τους. Η ακτινική διάσταση είναι μια γραμμή με μια κεφαλή 

βέλους που δείχνει σε έναν κύκλο ή ένα τόξο. 

 
Για να δημιουργήσετε μια ακτινική διάσταση: 

 
1. Επιλέξτε Διάσταση > Ακτίνα από το κύριο μενού. 

2. Επιλέξτε το τόξο ή τον κύκλο. 

3. Καθορίστε τη θέση της γραμμής διαστάσεων. 

 
9.1.7. Τρέχοντας διάσταση 

 
Η διάσταση με τζόγο είναι δηλαδή η διάσταση με τζόγο ακτίνας, η οποία ονομάζεται επίσης "διάσταση ακτίνας με 

κλίμακα". Ο χρήστης μπορεί να καθορίσει την κεντρική θέση για να τοποθετήσει την αρχή της διάστασης για την 

αντικατάσταση του κεντρικού σημείου του κύκλου ή του τόξου εντός της διάστασης ακτίνας. Η εντολή DIMJOGGED είναι 

χρήσιμη για τη δημιουργία διαστάσεων στην περίπτωση που το κέντρο του κύκλου ή του τόξου που πρόκειται να 

διαστασιολογηθεί βρίσκεται εκτός της διάταξης και δεν μπορεί να εμφανιστεί ούτε στην πραγματική του θέση. 

 
Για να δημιουργήσετε μια διάσταση ακτίνας με τζόγο: 

 
1. Επιλέξτε Διάσταση > Τρέξιμο από το κύριο μενού. 

2. Επιλέξτε έναν κύκλο ή ένα τόξο. 

3. Επιλέξτε την κεντρική θέση ως αρχή της διάστασης. 

4. Καθορίστε ένα σημείο για την τοποθέτηση του συμβόλου τζόγου. 
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9.1.8. Δημιουργία διαστάσεων διαμέτρου 

 
Μπορείτε να δημιουργήσετε διαστάσεις διαμέτρου για κύκλους ή τόξα για να μετρήσετε τις διαμέτρους τους. Η 

δημιουργία διαστάσεων διαμέτρου μοιάζει με τη δημιουργία ακτινικών διαστάσεων. Μπορείτε να δημιουργήσετε διάφορες 

διαστάσεις διαμέτρου με βάση τη θέση και το μέγεθος των κύκλων ή των τόξων και τις ρυθμίσεις του στυλ διάστασης. 

 
Για να δημιουργήσετε μια διάσταση διαμέτρου: 

 
1. Επιλέξτε Διάσταση > Διάμετρος από το κύριο μενού. 

2. Επιλέξτε το τόξο ή τον κύκλο. 

3. Καθορίστε τη θέση της γραμμής διαστάσεων. 
 
 
 

 
9.1.9. Δημιουργία διαστάσεων Ordinate 

 
Οι διαστάσεις της διαταγής χρησιμοποιούνται για τη μέτρηση της κάθετης απόστασης από ένα αρχικό σημείο που ονομάζεται 

σημείο αναφοράς σε ένα χαρακτηριστικό, όπως μια οπή σε ένα τεμάχιο. Οι διαστάσεις διατάξεως αποτελούνται από μια 

γραμμή οδηγού με τιμή Χ ή Υ και οι οδηγοί σχεδιάζονται κατά μήκος της ορθογραφικής κατεύθυνσης στο τρέχον UCS. 

 
Για να δημιουργήσετε μια διάσταση με συντεταγμένες: 

 
1. Επιλέξτε Dimension > Ordinate από το κύριο μενού. 

2. Επιλέξτε το σημείο για τη διάσταση της διατάξεως. 

3. Καθορίστε το ακραίο σημείο του ηγέτη της ακροτάτης. 

 
9.1.10. Δημιουργία γρήγορης διάστασης 

 
Δημιουργεί ή επεξεργάζεται μια σειρά διαστάσεων γρήγορα 

πληκτρολογώντας την εντολή QDIM. Για να δημιουργήσετε μια 

γρήγορη διάσταση: 

1. Επιλέξτε Διάσταση > Γρήγορη διάσταση από το κύριο μενού. 

2. Επιλέξτε τη γεωμετρία προς διαστασιολόγηση και, στη συνέχεια, πατήστε Enter. 

3. Στη γραμμή εντολών, θα εμφανιστεί η ένδειξη "Specify dimension 

line position, 

or[Continuous/Staggered/Baseline/Ordinate/Radius/Diameter/datumPoint 

/Edit/seTtings] <Continuous>:".Μπορείτε να εκτελέσετε τη 

λειτουργία όπως επιθυμείτε. Η προεπιλογή είναι Continuous 

(Συνεχής). 
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9.1.11. Δημιουργία διάστασης μήκους τόξου 

 
Η διάσταση μήκους τόξου είναι διαθέσιμη για τη μέτρηση του μήκους τόξου ενός τόξου ή ενός τμήματος τόξου 

πολυγραμμής. Το GstarCAD δημιουργεί διάσταση μήκους τόξου καθορίζοντας τη θέση της γραμμής επέκτασης απευθείας 

μετά την επιλογή τόξου από προεπιλογή. Και χρησιμοποιεί ένα σύμβολο τόξου ως διάσταση μήκους τόξου, η οποία 

διαφέρει από τη γραμμική διάσταση και τη γωνιακή διάσταση. 

 
Για να δημιουργήσετε μια διάσταση μήκους τόξου: 

 
1. Επιλέξτε Διάσταση > Μήκος τόξου από το κύριο μενού. 

2. Επιλέξτε ένα τμήμα τόξου ή πολυγραμμικού τόξου. 

3. Καθορίστε ένα σημείο για την τοποθέτηση της διάστασης μήκους τόξου. 
 
 

 
9.1.12. DIMREASSOCIATE 

 
Μπορείτε να εισαγάγετε την εντολή 

DIMREASSOCIATE για να συνδέσετε ή να 

επανασυνδέσετε επιλεγμένες διαστάσεις με 

αντικείμενα ή σημεία σε αντικείμενα. 

 

 
Αφού ενεργοποιήσετε την εντολή DIMREASSOCIATE, θα σας ζητηθεί να επιλέξετε τη 

συσχέτιση συγκεκριμένων αντικειμένων διαστάσεων ή τη συσχέτιση όλων των 

αποσυνδεδεμένων αντικειμένων του σχεδίου ένα προς ένα. 

 
Εάν επιλέξετε την επιλογή Αποσύνδεση 

Όλες οι διαστάσεις που έχουν οποιοδήποτε αποσυνδεδεμένο καθοριστικό σημείο με γεωμετρίες στο σχέδιο θα επιλεγούν για 

να συνδεθούν ή να επανασυνδεθούν μία προς μία. Μπορείτε να πατήσετε 'Esc' για να σταματήσετε την εντολή, αλλά οι 

συσχετίσεις που έχετε κάνει θα διατηρηθούν. 

 

 
Εάν επιλέξετε αντικείμενα διαστάσεων 

⮚  Όταν το σημείο ορισμού του επιλεγμένου αντικειμένου διάστασης δεν συσχετίζεται με τη γεωμετρία, εμφανίζεται το σήμα Χ. 

 

 
⮚  Όταν το σημείο ορισμού του επιλεγμένου αντικειμένου διάστασης συσχετιστεί με τη γεωμετρία, εμφανίζεται το σήμα ⊠. 
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-Αν πατήσετε Enter ή επιλέξετε την επιλογή "Επόμενο", μπορείτε να μεταβείτε στο επόμενο σημείο αφετηρίας γραμμής επέκτασης". 

 

-Εάν επιλέξετε την επιλογή "Επιλογή αντικειμένου", μπορείτε να επιλέξετε ένα γεωμετρικό αντικείμενο για να το συσχετίσετε με τη διάσταση. 

 
-Αν πατήσετε 'Esc', θα σταματήσετε την εντολή, αλλά οι συσχετίσεις που έχετε κάνει θα διατηρηθούν. 

 
 
 

 
9.2. Χρήση στυλ διαστάσεων 

 
Μπορείτε να ελέγχετε την εμφάνιση των διαστάσεων αλλάζοντας τις ρυθμίσεις για να βοηθήσετε στη διατήρηση των 

προτύπων διαστασιολόγησης, μπορείτε να αποθηκεύσετε αυτές τις ρυθμίσεις σε στυλ διαστάσεων. 

 
 
 

 
9.2.1. Στυλ διαστάσεων 

 
Μπορείτε να δημιουργείτε, να αποθηκεύετε, να επαναφέρετε και να διαγράφετε ονομαστικά στυλ διαστάσεων. Τα στυλ 

διαστάσεων παρέχουν έναν τρόπο να αλλάζετε διάφορες ρυθμίσεις που ελέγχουν την εμφάνιση των διαστάσεων. 

Μπορείτε να αλλάξετε τις ακόλουθες ρυθμίσεις: 

-Γραμμές επέκτασης, γραμμές διαστάσεων, κεφαλές βελών, κεντρικά σήματα ή γραμμές και οι μετατοπίσεις μεταξύ τους. 

-Η τοποθέτηση των τμημάτων της διάστασης σε σχέση μεταξύ τους και ο προσανατολισμός του κειμένου της διάστασης. 

-Το περιεχόμενο και η εμφάνιση του κειμένου της διάστασης και των μονάδων της τιμής της διάστασης. 
 

 
Για να δημιουργήσετε ένα στυλ διάστασης: 

 
1. Επιλέξτε Διάσταση > Στυλ από το κύριο μενού. 

2. Στο παράθυρο διαλόγου Διαχείριση στυλ διαστάσεων, κάντε κλικ στο κουμπί Νέο. 

3. Πληκτρολογήστε το όνομα του νέου στυλ διάστασης και 

επιλέξτε με ποιο στυλ ξεκίνησε και για ποιο είδος διάστασης 

χρησιμοποιείται. Στη συνέχεια, κάντε κλικ στο κουμπί Συνέχεια. 

5. Στο παράθυρο διαλόγου Νέο στυλ διάστασης, αλλάξτε τις 

ρυθμίσεις διάστασης όπως απαιτείται. Επαναλάβετε αυτό το 

βήμα για κάθε καρτέλα, ανάλογα με τις ανάγκες. 

6. Για να τερματίσετε την εντολή, κάντε κλικ στο OK. 
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Για να μετονομάσετε ένα στυλ διάστασης: 

 
1. Επιλέξτε Διάσταση > Στυλ από το κύριο μενού. 

2. Στη λίστα Στυλ κάντε ένα από τα εξής: 

-Κάντε διπλό κλικ στο απαιτούμενο στυλ. 

-Κάντε δεξί κλικ στο όνομα του απαιτούμενου στυλ και, στη 

συνέχεια, επιλέξτε Μετονομασία. 

3. Πληκτρολογήστε το νέο όνομα. 

4. Κάντε κλικ στο κουμπί Κλείσιμο για έξοδο. 

 
Για να διαγράψετε ένα στυλ διάστασης με όνομα 

 
1. Επιλέξτε Διάσταση > Στυλ από το κύριο μενού. 

2. Στη λίστα Στυλ, κάντε δεξί κλικ στο όνομα του απαιτούμενου στυλ 

και, στη συνέχεια, επιλέξτε Διαγραφή. 

3. Κάντε κλικ στο κουμπί Κλείσιμο για να κλείσετε. 
 
 

 
Για να εμφανίσετε πληροφορίες σχετικά με το τρέχον στυλ: 

 
1. Επιλέξτε Διάσταση > Στυλ από το κύριο μενού. 

2. Στο παράθυρο διαλόγου Διαχείριση στυλ διαστάσεων, κάντε κλικ στην επιλογή Σύγκριση. 

3. Στο παράθυρο διαλόγου Compare Dimension Style (Σύγκριση στυλ 

διάστασης), επιλέξτε το ίδιο στυλ διάστασης από την πτυσσόμενη λίστα 

Compare and With (Σύγκριση και με). Θα εμφανιστούν όλες οι ιδιότητες 

για το συγκεκριμένο στυλ διάστασης. 

4. Αν θέλετε να μάθετε τις διαφορετικές πληροφορίες μεταξύ δύο στυλ, 

επιλέξτε ένα στυλ στο πλαίσιο Σύγκριση, επιλέξτε το άλλο στο πλαίσιο 

Με και τότε θα δείτε τη διαφορά στην επόμενη καρτέλα. 

5. Κάντε κλικ στο κουμπί Κλείσιμο για να κλείσετε. 
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9.2.2. Τροποποίηση γραμμών διαστάσεων 

 
Στην καρτέλα Γραμμή του παραθύρου διαλόγου Τροποποίηση στυλ 

διάστασης, μπορείτε να ορίσετε το χρώμα των γραμμών 

διάστασης, το βάρος γραμμής, τα τσιμπούρια πέραν της 

γραμμής επέκτασης, την απόσταση μεταξύ των γραμμών 

βάσης και την ορατότητα. 

 
9.2.3. Τροποποίηση γραμμών επέκτασης 

 
Οι γραμμές επέκτασης έχουν τις ακόλουθες ιδιότητες: χρώμα, 

βάρος γραμμής, απόσταση πέρα από τις γραμμές επέκτασης, 

μετατόπιση από την αρχή των γραμμών επέκτασης και ορατότητα. 

Μπορείτε να ορίσετε αυτές τις ιδιότητες στην καρτέλα Line του 

πλαισίου Modify Dimension Style (Τροποποίηση στυλ 

διάστασης): 

-Η απόσταση πέρα από τις γραμμές επέκτασης σημαίνει πόσο μακριά 

εκτείνονται οι γραμμές επέκτασης πέρα από τη γραμμή διάστασης. 

-Η μετατόπιση αρχής είναι η απόσταση μεταξύ της αρχής της γραμμής 

επέκτασης και της αρχής της γραμμής επέκτασης, που ονομάζεται 

επίσης μετατόπιση αρχής επέκτασης. 

 
9.2.4. Επιλέξτε βέλη διαστάσεων 

 
Μπορείτε να ελέγξετε την εμφάνιση και το μέγεθος των αιχμών βέλους ή 

των σημείων γάντζου που τοποθετούνται στα άκρα των γραμμών 

διαστάσεων. Μπορείτε να καθορίσετε διαφορετικές κεφαλές βελών και για 

τα δύο άκρα μιας διάστασης ή γραμμών οδηγού. Το Πρώτο βέλος είναι 

προς την πρώτη γραμμή επέκτασης- Το Δεύτερο βέλος είναι προς τη 

δεύτερη γραμμή επέκτασης. 

 
Για να επιλέξετε μια κεφαλή βέλους: 

 
1. Επιλέξτε Διάσταση > Στυλ από το κύριο μενού. 

2. Στο παράθυρο διαλόγου Διαχείριση στυλ διαστάσεων, επιλέξτε το στυλ που θέλετε να αλλάξετε και κάντε κλικ στο κουμπί Τροποποίηση. 

3. Στο παράθυρο διαλόγου Τροποποίηση στυλ διάστασης, κάντε κλικ στην καρτέλα Σύμβολα και βέλη. 

4. Κάντε τις επιλογές σας κάτω από τα βέλη. 

5. Κάντε κλικ στο OK και, στη συνέχεια, επιλέξτε ΚΛΕΙΣΙΜΟ για έξοδο. 
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9.2.5. Προσαρμογή κειμένου διάστασης εντός γραμμών επέκτασης 

 
Όταν δεν υπάρχει αρκετός χώρος μεταξύ των γραμμών 

επέκτασης για να δεχτεί τόσο το κείμενο διάστασης όσο και τις 

κεφαλές βελών, πρέπει να προσαρμόσετε τη μία ή και τις δύο 

θέσεις τους. Από προεπιλογή, το σύστημα τα τοποθετεί 

καλύτερα ανάλογα με τον διαθέσιμο χώρο. Μπορείτε να 

καθορίσετε άλλες μεθόδους για την τοποθέτησή τους στην 

καρτέλα Adjust (Προσαρμογή) του πλαισίου διαλόγου Modify 

Dimension Style (Τροποποίηση στυλ διάστασης). 

 
Για να μορφοποιήσετε τις διαστάσεις: 

 
1. Επιλέξτε Διάσταση > Στυλ. 

2. Στο παράθυρο διαλόγου Διαχείριση στυλ διαστάσεων, επιλέξτε το στυλ που θέλετε να αλλάξετε και επιλέξτε Τροποποίηση. 

3. Στο παράθυρο διαλόγου Τροποποίηση στυλ διάστασης, κάντε κλικ στην καρτέλα Προσαρμογή. 

4. Στην περιοχή Επιλογές προσαρμογής και τοποθέτηση κειμένου, επιλέξτε μια επιλογή.5.Κάντε κλικ στο OK και επιλέξτε Κλείσιμο για έξοδο. 

 
9.2.6. Διάμετρος Διάσταση Κείμενο 

 
Μπορείτε να δημιουργήσετε διάφορες διαστάσεις διαμέτρου με βάση την τοποθέτηση του κειμένου, τις επιλογές προσαρμογής 

και την επιλογή "Να διατηρείται πάντα το κείμενο ανάμεσα σε γραμμές ext" στην καρτέλα Προσαρμογή. 

 
 
 
 
 
 
 
 
 

 

 

 

 

 



Κεφάλαιο 9_ Διαστάσεις και ανοχές 
 

Σ ε λ ί δ α  159 | 296  

 

9.2.7. Ευθυγράμμιση κειμένου διάστασης 

 
Αν το κείμενο βρίσκεται εντός ή εκτός της γραμμής 

επέκτασης, δεν έχει καμία επίδραση στην 

αιτιολόγηση του κειμένου διάστασης. Μπορείτε να 

επιλέξετε αν το κείμενο ευθυγραμμίζεται με τις 

γραμμές διάστασης ή παραμένει οριζόντιο. 

 
Για να ευθυγραμμίσετε το κείμενο διάστασης με τη γραμμή διάστασης: 

 
1. Επιλέξτε Διάσταση > Στυλ. 

2. Στο παράθυρο διαλόγου Διαχείριση στυλ 

διαστάσεων, επιλέξτε το στυλ που θέλετε να 

αλλάξετε και επιλέξτε Τροποποίηση. 

3. Στο παράθυρο διαλόγου Τροποποίηση στυλ 

διάστασης, κάντε κλικ στην καρτέλα Κείμενο. 

4. Κάντε τις επιλογές σας. 

5. Κάντε κλικ στο OK και επιλέξτε Κλείσιμο για έξοδο. 

 
9.2.8. Τοποθέτηση κειμένου διάστασης κάθετα 

 
Η κάθετη τοποθέτηση κειμένου είναι η θέση του 

κειμένου σε σχέση με τη διάσταση. Μπορείτε να 

τοποθετήσετε το κείμενο πάνω, κάτω ή στο 

κέντρο της γραμμής διάστασης ή να 

χρησιμοποιήσετε τις διαστάσεις JIS. 

 

 

9.2.9. Θέση κειμένου διάστασης οριζόντια 

Η θέση του κειμένου κατά μήκος του ορίζοντα 

είναι σχέση 

στις γραμμές επέκτασης. Οι ρυθμίσεις περιλαμβάνουν τις εξής: Centered, At Ext Line 1, At Ext Line 2, Over Ext Line1 και Over Ext Line2. 
 
 
 

 
9.2.10. Μονάδες διάστασης 

 
Μπορείτε να καθορίσετε την εμφάνιση και τη μορφή 

των κύριων και εναλλακτικών μονάδων 

διαστάσεων. Μπορείτε να ορίσετε τις πρωτεύουσες 
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 μονάδες για γραμμικές και γωνιακές διαστάσεις, 

συμπεριλαμβανομένης της μορφής μονάδας, της 

αριθμητικής ακρίβειας κ.ο.κ. Αυτές οι ρυθμίσεις 

ελέγχουν την εμφάνιση των τιμών των 

διαστάσεων. 

 
Για να στρογγυλοποιήσετε τις διαστάσεις: 

 
1. Επιλέξτε Διάσταση > Στυλ από το κύριο μενού. 

2. Στο παράθυρο διαλόγου Διαχείριση στυλ διαστάσεων, επιλέξτε το στυλ που θέλετε να αλλάξετε και επιλέξτε Τροποποίηση. 

3. Στο παράθυρο διαλόγου Τροποποίηση στυλ διάστασης, κάντε κλικ στην καρτέλα Πρωτογενείς μονάδες. 

4. Στα πεδία Γραμμικές διαστάσεις και Γωνιακές διαστάσεις, πληκτρολογήστε ή επιλέξτε την πλησιέστερη τιμή στην οποία 

θέλετε να στρογγυλοποιήσετε τις διαστάσεις. 

5. Κάντε κλικ στο OK και επιλέξτε Κλείσιμο για έξοδο. 
 
 
 

 
9.2.11. Εναλλακτικές μονάδες 

 
Μπορείτε να δημιουργήσετε μια διάσταση σε δύο συστήματα μέτρησης ταυτόχρονα σε ένα σχέδιο. Αυτή η λειτουργία είναι 

χρήσιμη όταν θέλετε να προσθέσετε διαστάσεις σε πόδια και ίντσες σε ένα σχέδιο που έχει δημιουργηθεί με μετρικές μονάδες. 

Οι εναλλακτικές μονάδες εμφανίζονται σε αγκύλες ([]) στο κείμενο της διάστασης. Οι εναλλακτικές μονάδες μπορούν να 

εφαρμοστούν μόνο σε γραμμικές διαστάσεις.η ακρίβεια για τις εναλλακτικές μονάδες καθορίζει τον αριθμό των δεκαδικών 

ψηφίων. 

 
Για να δημιουργήσετε μια εναλλακτική διάσταση: 

 
1. Επιλέξτε Διάσταση > Στυλ. 

2. Στο παράθυρο διαλόγου Διαχείριση 

στυλ διαστάσεων, επιλέξτε το στυλ που 

θέλετε να αλλάξετε και επιλέξτε 

Τροποποίηση. 

3. Στο παράθυρο διαλόγου Τροποποίηση 

στυλ διάστασης, κάντε κλικ στην καρτέλα 

Εναλλακτικές μονάδες. 

4. Κάντε κλικ στο πλαίσιο ελέγχου 

Εμφάνιση εναλλακτικών μονάδων. 

5. Κάντε τις επιλογές σας. 

6. Κάντε κλικ στο OK και επιλέξτε Κλείσιμο για έξοδο. 
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9.2.12. Εμφάνιση πλευρικών ανοχών 

 
Η πλευρική ανοχή αντιπροσωπεύει μια τιμή που το ποσό μιας μετρούμενης απόστασης μπορεί να διαφέρει. Μπορείτε να 

ελέγξετε το βαθμό ακρίβειας που απαιτείται για ένα μέλλον καθορίζοντας ανοχές κατά την κατασκευή. Αυτές οι ανοχές 

διαστάσεων υποδεικνύουν το μεγαλύτερο και το μικρότερο επιτρεπόμενο μέγεθος. Μπορείτε επίσης να εφαρμόσετε 

γεωμετρικές ανοχές για να υποδείξετε αποκλίσεις της μορφής, του προφίλ, της θέσης, του προσανατολισμού και της 

εξομάλυνσης. 

 
Οι ανοχές απόκλισης αντιπροσωπεύουν τις τιμές συν και πλην που προστίθενται στις τιμές των διαστάσεων. Εάν οι ανοχές 

απόκλισης είναι ίσες, προηγούνται τα σύμβολα ± και είναι γνωστές ως συμμετρικές. Διαφορετικά, η τιμή συν βρίσκεται πάνω 

από την τιμή μείον. 

 
Μπορεί να καθοριστεί η κατακόρυφη τοποθέτηση των τιμών ανοχής σε σχέση με το κείμενο της κύριας διάστασης. Για 

παράδειγμα, μπορείτε να ευθυγραμμίσετε τις ανοχές με την κορυφή, τη μέση ή το κάτω μέρος του κειμένου της 

διάστασης. 
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9.2.13. Ορισμός της κλίμακας για τις διαστάσεις 

 
Ο καθορισμός της κλίμακας διαστάσεων εξαρτάται από τη μέθοδο που χρησιμοποιείτε για τη χάραξη και τη σχεδίαση των 

σχεδίων. Η κλίμακα διαστάσεων έχει επιπτώσεις στο μέγεθος της γεωμετρίας διαστάσεων σε σχέση με τα αντικείμενα στο 

σχέδιο. Εκτός από το ύψος του κειμένου και το μέγεθος της κεφαλής βέλους, η κλίμακα διάστασης επηρεάζει και τις 

μετατοπίσεις στη διάσταση, όπως η μετατόπιση της αρχής της γραμμής επέκτασης. Όταν δημιουργείτε διαστάσεις, συνιστάται να 

ορίζετε το μέγεθος και τη μετατόπιση σε τιμές που αντιπροσωπεύουν το πραγματικό τους μέγεθος στο σχέδιο. Ωστόσο, οι 

ανοχές, τα μετρούμενα μήκη, οι συντεταγμένες και οι γωνίες δεν μπορούν να εφαρμοστούν στο συνολικό συντελεστή 

κλίμακας. Η μέθοδος δημιουργίας διαστάσεων σε μια διάταξη σχεδίασης παρουσιάζεται ως εξής: 

 
-Διάσταση στο χώρο του μοντέλου για την απεικόνιση στο χώρο του μοντέλου. Εάν θέλετε να δημιουργήσετε διαστάσεις που 

να είναι σωστά κλιμακωμένες για τη σχεδίαση, πρέπει να ορίσετε τη μεταβλητή συστήματος DIMSCALE στο αντίστροφο της 

επιθυμητής κλίμακας σχεδίασης. Για παράδειγμα, εάν η κλίμακα σχεδίασης είναι 1/4, π ρ έ π ε ι  να ορίσετε τη 

μεταβλητή DIMSCALE σε 4. 

 
-Διάσταση στο χώρο του μοντέλου για σχεδίαση στο χώρο του χαρτιού. Εάν θέλετε να δημιουργήσετε διαστάσεις που 

κλιμακώνονται αυτόματα για την απεικόνιση σε διάταξη σε χώρο χαρτιού, πρέπει να ορίσετε το DIMSCALE σε 0. Αυτή η 

μέθοδος είναι χρήσιμη όταν αντιμετωπίζετε τις ακόλουθες καταστάσεις: οι διαστάσεις σε ένα σχέδιο πρέπει να αναφέρονται 

από άλλα σχέδια (xrefs)- όταν δημιουργείτε ισομετρικές διαστάσεις σε τρισδιάστατες ισομετρικές προβολές. Για να αποτρέψετε 

την εμφάνιση των διαστάσεων σε ένα παράθυρο προβολής διάταξης σε άλλα παράθυρα προβολής διάταξης, συνιστάται η 

δημιουργία ενός επιπέδου διαστασιολόγησης για κάθε παράθυρο προβολής διάταξης που είναι παγωμένο σε όλα τα άλλα 

παράθυρα προβολής διάταξης. 

 
-Διάσταση σε διατάξεις. Μπορείτε να δημιουργήσετε διαστάσεις στο χώρο χαρτιού επιλέγοντας αντικείμενα του χώρου 

μοντέλων ή καθορίζοντας θέσεις σύλληψης αντικειμένων σε αντικείμενα του χώρου μοντέλων. Οι διαστάσεις που 

δημιουργούνται σε μια διάταξη χώρου χαρτιού δεν χρειάζονται πρόσθετη κλιμάκωση: δεν χρειάζεται να αλλάξετε την 

προεπιλεγμένη τιμή των DIMLFAC και DIMSCALE. 

 

 
9.3. Τροποποίηση υφιστάμενων διαστάσεων 

 
Μπορείτε να τροποποιήσετε όλα τα στοιχεία των υπαρχόντων αντικειμένων διαστάσεων σε ένα σχέδιο είτε μεμονωμένα είτε 
χρησιμοποιώντας στυλ διαστάσεων. 

 
 

 

9.3.1. Τροποποίηση του στυλ 

διάστασης Μπορείτε να 

τροποποιήσετε όλες τις ιδιότητες του 

υπάρχοντα αντικείμενα διαστάσεων σε 

ένα σχέδιο χρησιμοποιώντας στυλ 
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διαστάσεων. Μπορείτε επίσης να 

δημιουργήσετε μια παράκαμψη στυλ 

διάστασης για να αλλάξετε προσωρινά μια 

μεταβλητή του συστήματος 

διαστασιολόγησης 

χωρίς να αλλάξετε το τρέχον στυλ διάστασης. 

Εάν αλλάξει ένα στυλ διάστασης, η διάσταση που σχετίζεται με αυτό το στυλ διάστασης ενημερώνεται αυτόματα. 

 
9.3.2. Κάντε Διαστάσεις λοξές 

 
Οι γραμμές επέκτασης δημιουργούνται συνήθως σε κάθετη γωνία προς 

τη γραμμή διάστασης. Ωστόσο, μπορείτε να αλλάξετε τη γωνία των γραμμών 

επέκτασης, ώστε να έχουν κλίση σε σχέση με τη γραμμή διαστάσεων. 

 
Για να φτιάξετε λοξές γραμμές επέκτασης: 

 
1. Επιλέξτε Διάσταση > Οβελιαία από το κύριο μενού. 

2. Επιλέξτε τη γραμμική διάσταση και, στη συνέχεια, πατήστε Enter. 

3. Πληκτρολογήστε τη γωνία λοξότητας και, στη συνέχεια, πατήστε Enter. 

 
Παρατήρηση: Για να ευθυγραμμίσετε την λοξή γωνία, αν δεν γνωρίζετε την ακριβή μέτρηση, χρησιμοποιήστε κουμπώματα για να επιλέξετε δύο 
σημεία της οντότητας. 

 

 
9.3.3. Διάσταση Τρέξιμο γραμμικό 

 
Η εντολή DIMJOGLINE είναι διαθέσιμη για την προσθήκη ή την 

αφαίρεση συμβόλου jog για γραμμικές διαστάσεις. Το σύμβολο jog 

τοποθετείται εξ ορισμού στο κεντρικό σημείο μεταξύ της πρώτης 

γραμμής επέκτασης και του κειμένου. Για να επανατοποθετήσετε το 

σύμβολο jog, μπορείτε να προσαρμόσετε τη θέση του κειμένου της 

διάστασης ή να καθορίσετε νέα θέση για την τοποθέτηση του jog 

μετά την επανεπιλογή της διάστασης. 

 
Για να προσθέσετε ένα τζόγο στη γραμμική διάσταση: 

 
1. Επιλέξτε Dimension > Jogged Linear από το κύριο μενού. 

2. Επιλέξτε μια γραμμική διάσταση. 

3. Καθορίστε ένα σημείο στη γραμμή διαστάσεων για τον καθορισμό του 

συμβόλου τζόγου ή πατήστε απευθείας ENTER για να τοποθετήσετε 

το σύμβολο τζόγου στην προεπιλεγμένη θέση. 
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9.3.4. Επιθεώρηση διαστάσεων 

 
Η επιθεώρηση διαστάσεων δημιουργείται για να μεταδίδει τη συχνότητα 

επιθεώρησης του εξαρτήματος που διαστασιολογείται, η τιμή της διάστασης 

και η ανοχή των εξαρτημάτων διασφαλίζεται ότι βρίσκονται εντός του 

καθορισμένου εύρους. Η επιθεώρηση διαστάσεων αποτελείται από ένα πλαίσιο και 

εσωτερικό κείμενο και περιέχει σχεδόν τρία είδη πεδίου πληροφοριών: ετικέτα 

επιθεώρησης, τιμή διάστασης και ρυθμός επιθεώρησης. 

 
Η ετικέτα επιθεώρησης, που χρησιμοποιείται για τη σήμανση του κειμένου της 

επιθεώρησης διαστάσεων, βρίσκεται στην αριστερή πλευρά εντός του πλαισίου 

επιθεώρησης. Η τιμή διάστασης είναι η τιμή πριν 

από την προσθήκη της επιθεώρησης διάστασης, η οποία βρίσκεται στο κεντρικό 

τμήμα της διάστασης επιθεώρησης, συμπεριλαμβανομένης της ανοχής, του 

κειμένου και της τιμής μέτρησης. 

Το ποσοστό επιθεώρησης εκφράζεται με ποσοστό, το οποίο βρίσκεται στη δεξιά πλευρά εντός του 

 
το πλαίσιο επιθεώρησης, υποδεικνύει την απαιτούμενη συχνότητα του 

δημιουργούμενου τμήματος. Για να δημιουργήσετε μια διάσταση 

επιθεώρησης: 

1. Επιλέξτε Διάσταση > Επιθεώρηση από το κύριο μενού. 

2. Στο παράθυρο διαλόγου Inspection Dimension (Διάσταση επιθεώρησης), κάντε κλικ στο κουμπί Select Dimensions (Επιλογή διαστάσεων). 

3. Επιλέξτε διαστάσεις για να προσθέσετε επιθεώρηση διαστάσεων και, στη συνέχεια, πατήστε ENTER για να 

ολοκληρώσετε την επιλογή και να επιστρέψετε στο παράθυρο διαλόγου.4.Επιλέξτε ένα σχήμα για το πλαίσιο από την 

επιλογή Σχήμα.5.Κάντε κλικ στην επιλογή Ετικέτα για να εισαγάγετε την ετικέτα στο πλαίσιο κειμένου.6.Κάντε κλικ στην επιλογή 

Ποσοστό επιθεώρησης για να εισαγάγετε μια τιμή στο πλαίσιο κειμένου.7.Κάντε κλικ στο OK. 

 
Για να αφαιρέσετε μια διάσταση επιθεώρησης: 

 
1. Επιλέξτε Διάσταση > Επιθεώρηση από το κύριο μενού. 

2. Στο παράθυρο διαλόγου Inspection Dimension (Διάσταση επιθεώρησης), κάντε κλικ στο κουμπί Select Dimensions (Επιλογή διαστάσεων). 

3. Επιλέξτε διαστάσεις για να καταργήσετε την επιθεώρηση διαστάσεων και, στη 

συνέχεια, πατήστε ENTER για να ολοκληρώσετε την επιλογή και να 

επιστρέψετε στο παράθυρο διαλόγου. 4.Κάντε κλικ στο κουμπί Remove 

Inspection (Κατάργηση επιθεώρησης διαστάσεων). 5.Κάντε κλικ στο 

κουμπί OK. 
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9.3.5. Ρύθμιση χώρου διάστασης 

 
Αφού δημιουργήσετε πολλαπλές 

παράλληλες γραμμικές 

διαστάσεις ή γωνιακές 

διαστάσεις, μπορείτε να 

προσαρμόσετε το διάστημα 

μεταξύ αυτών των 

παράλληλων γραμμών με μια 

ίση τιμή είτε προεπιλεγμένη 

είτε καθορισμένη. Εντολή 

DIMSPACE προσαρμογή του 

διαστήματος μεταξύ 

παράλληλων γραμμικών ή 

γωνιακών διαστάσεων ή 

αλληλεπικαλυπτόμενων 

διαστάσεων 

αυτόματα σε περίπτωση που ο αρχικός χώρος δεν έχει ίσες τιμές. Εάν ορίσετε την τιμή διαστήματος σε 0 κατά τη ρύθμιση του 

διαστήματος μεταξύ των διαστάσεων, μπορείτε να ευθυγραμμίζετε τις επιλεγμένες διαστάσεις και στη γραμμή 

διαστάσεων. 

 

 
9.4. Προσθήκη γεωμετρικών ανοχών 

 
Οι γεωμετρικές ανοχές δείχνουν τις αποδεκτές αποκλίσεις της 

μορφής, του προφίλ, του προσανατολισμού, της θέσης και της 

απόκλισης ενός χαρακτηριστικού. Προσθέτετε γεωμετρικές ανοχές 

σε πλαίσια ελέγχου χαρακτηριστικών. Αυτά τα πλαίσια 

περιέχουν όλες τις πληροφορίες ανοχής για μια μόνο διάσταση. Οι 

γεωμετρικές ανοχές μπορούν να δημιουργηθούν με ή χωρίς 

γραμμές οδηγού, μπορείτε να τις δημιουργήσετε 

με την εντολή TOLERANCE ή LEADER. 

 
Ένα πλαίσιο ελέγχου χαρακτηριστικών αποτελείται από δύο ή περισσότερα στοιχεία. Το πρώτο πλαίσιο ελέγχου 

χαρακτηριστικών περιέχει ένα σύμβολο που αντιπροσωπεύει το γεωμετρικό χαρακτηριστικό στο οποίο εφαρμόζεται μια 

ανοχή, για παράδειγμα, θέση, προφίλ, μορφή, προσανατολισμός ή ολίσθηση. Οι ανοχές μορφής ελέγχουν την ευθύτητα, την 

επιπεδότητα, την κυκλικότητα και την κυλινδρικότητα- τα προφίλ ελέγχουν τη γραμμή και την επιφάνεια. Στην εικόνα, το 

χαρακτηριστικό είναι η θέση. 
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9.4.1. Πλαίσιο διαλόγου γεωμετρικής ανοχής 

 
Καθορίζει τα σύμβολα και τις τιμές για ένα πλαίσιο ελέγχου χαρακτηριστικών. 

 
1. Σύμβολο γεωμετρικών χαρακτηριστικών (μενού) 

2. Φόρμα ζώνης ανοχής (εναλλαγή) 

3. Τιμή ζώνης ανοχής 

4. Σύμβολο κατάστασης υλικού (μενού) 

5. Ημερομηνία αναφοράς 1 από 3 

6. Αναφορά αναφοράς 2 από 3 

7. Σύμβολο προβαλλόμενης ζώνης ανοχής (εναλλαγή) 

8. Προβλεπόμενη τιμή ζώνης ανοχής 

9. Αναγνωριστικό Datum 
 
 

 
9.4.2. Σύμβολα γεωμετρικής ανοχής 

 
Τα σύμβολα γεωμετρικής ανοχής και τα χαρακτηριστικά τους παρουσιάζονται στα ακόλουθα. 

 

1. Θέση (τοποθεσία) 

2. Ομόκεντροτητα ή ομοαξονικότητα 
(θέση) 

3. Συμμετρία (τοποθεσία) 

4. Παραλληλισμός 
(προσανατολισμός) 

5. Ορθογωνιότητα 
(Προσανατολισμός) 

6. Γωνιακότητα (Προσανατολισμός) 

7. Κυλινδρικότητα 
(προσανατολισμός) 

8. Επιπεδότητα (προσανατολισμός) 

9. Κυκλικότητα ή στρογγυλότητα (Μορφή) 

10. Ευθυβολία (μορφή) 

11. Προφίλ μιας επιφάνειας (Profile) 

12. Προφίλ γραμμής (Profile) 

13. Κυκλική εξομάλυνση (Runout) 

14. Συνολική διαρροή (Runout) 
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9.4.3. Υλικές συνθήκες 

 
Ανάλογα με τον τύπο ελέγχου, μπορείτε να προσθέσετε ένα σύμβολο διαμέτρου πριν από την τιμή ανοχής και να καθορίσετε 

ένα σύμβολο κατάστασης υλικού πίσω από αυτή την τιμή. Μπορείτε να εφαρμόσετε συνθήκες υλικού σε 

χαρακτηριστικά που μπορούν να διαφέρουν σε μέγεθος. 

 
9.4.4. Πλαίσια αναφοράς ημερομηνίας 

 
Μια αναφορά αναφοράς δεδομένων αποτελείται από τιμές και σύμβολα τροποποίησης. Ένα σημείο αναφοράς είναι μια 

θεωρητικά ακριβής γεωμετρική αναφορά που μετρά και επαληθεύει ένα θεωρητικά ακριβές σημείο, άξονα ή επίπεδο. Το 

σύστημα παρέχει έως και τρία γράμματα αναφοράς σημείου αναφοράς και σχετικά σύμβολα, ακολουθούμενα από την 

τιμή ανοχής. 

 
9.4.5. Προβλεπόμενες ζώνες ανοχής 

 
Οι προβαλλόμενες ζώνες ανοχής ελέγχουν το ύψος του σταθερού κάθετου τμήματος της περιοχής επέκτασης και ελέγχουν την 

ακρίβεια της ανοχής με ανοχές θέσης. Πριν ορίσετε το σύμβολο σε προβαλλόμενες ζώνες ανοχής, ορίζετε μια τιμή ύψους για 

να καθορίσετε την ελάχιστη προβαλλόμενη ζώνη ανοχής. 

 
9.4.6. Ανοχές σύνθετων υλικών 

 
Μια σύνθετη ανοχή αποτελείται από δύο ανοχές που εφαρμόζονται στο ίδιο γεωμετρικό χαρακτηριστικό ενός χαρακτηριστικού 

ή για χαρακτηριστικά που έχουν διαφορετικές απαιτήσεις αναφοράς. Πριν δημιουργήσετε μια διάσταση και προσθέσετε μια 

σύνθετη ανοχή για ένα σχέδιο, πρέπει να καθορίσετε την πρώτη γραμμή ενός πλαισίου ελέγχου χαρακτηριστικών και στη 

συνέχεια να επιλέξετε το ίδιο σύμβολο γεωμετρικού χαρακτηριστικού για τη δεύτερη γραμμή του πλαισίου ελέγχου 

χαρακτηριστικών. Το καθορισμένο διαμέρισμα γεωμετρικού συμβόλου επεκτείνεται και στις δύο γραμμές. Στη συνέχεια, 

μπορείτε να δημιουργήσετε μια δεύτερη γραμμή συμβόλων ανοχής. 

 
Για να προσθέσετε μια γεωμετρική ανοχή: 

 
1. Επιλέξτε Διάσταση > Ανοχή από το κύριο μενού. 

2. Στο πλαίσιο διαλόγου Geometric Tolerance, κάντε κλικ στο πρώτο τετράγωνο κάτω από το Sym και επιλέξτε ένα σύμβολο για εισαγωγή. 

3. Στην περιοχή Ανοχή 1, κάντε κλικ στο πρώτο μαύρο πλαίσιο για να εισαγάγετε ένα σύμβολο διαμέτρου. 

4. Στο πλαίσιο κειμένου, πληκτρολογήστε την πρώτη τιμή ανοχής. 

5. Για να προσθέσετε μια συνθήκη υλικού, κάντε κλικ στο δεύτερο μαύρο πλαίσιο και κάντε κλικ σε ένα σύμβολο για να το εισαγάγετε. 

6. Στην περιοχή Tolerance 2, επαναλάβετε τα βήματα 3 έως 5 για να προσθέσετε μια δεύτερη τιμή ανοχής. 

7. Στην περιοχή Datum 1, Datum 2 και Datum 3, πληκτρολογήστε το γράμμα αναφοράς του datum. 

8. Κάντε κλικ στο μαύρο πλαίσιο για να εισαγάγετε ένα σύμβολο κατάστασης υλικού για κάθε αναφορά αναφοράς αναφοράς. 

9. Στο πλαίσιο Ύψος, πληκτρολογήστε μια τιμή ύψους προβαλλόμενης ζώνης ανοχής, εάν χρειάζεται. 

10. Για να εισαγάγετε ένα σύμβολο προβαλλόμενης ζώνης ανοχής, κάντε κλικ στο πλαίσιο Projected Tolerance Zone (προβαλλόμενη ζώνη ανοχής). 

11. Στο πλαίσιο Datum Identifier, προσθέστε μια τιμή αναφοράς και, στη συνέχεια, κάντε κλικ στο OK. 

12. Στο σχέδιο, καθορίστε τη θέση του πλαισίου χαρακτηριστικών. 
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10. Μπλοκ, χαρακτηριστικό και αναφορά 

 
 

10.1. Δημιουργία και εισαγωγή μπλοκ 

 
Συνήθως, τα μπλοκ είναι διάφορα αντικείμενα που 

συνδυάζονται σε ένα, τα οποία μπορείτε να εισάγετε σε 

ένα σχέδιο και να τα χειρίζεστε ως ένα ενιαίο 

αντικείμενο. Τα μπλοκ μπορούν να σας βοηθήσουν να 

οργανώσετε καλύτερα την εργασία σας, να 

δημιουργήσετε και να αναθεωρήσετε γρήγορα σχέδια και να 

μειώσετε το μέγεθος του αρχείου σχεδίου. 

 
10.1.1. Δημιουργία μπλοκ 

 
Συνήθως, τα μπλοκ είναι διάφορα αντικείμενα που συνδυάζονται σε ένα, τα οποία μπορείτε να εισάγετε σε ένα σχέδιο και 

να τα χειρίζεστε ως ένα ενιαίο αντικείμενο. Ένα μπλοκ μπορεί να αποτελείται από ορατά αντικείμενα, όπως γραμμές, τόξα 

και κύκλους, καθώς και από ορατά ή αόρατα δεδομένα που ονομάζονται χαρακτηριστικά. Τα μπλοκ αποθηκεύονται ως 

μέρος του αρχείου σχεδίασης. Μπορείτε να χρησιμοποιήσετε διάφορες μεθόδους για να δημιουργήσετε μπλοκ: 

 
-Συνδυάστε αντικείμενα για να δημιουργήσετε έναν ορισμό μπλοκ στο τρέχον σχέδιό σας. 

-Δημιουργήστε ένα αρχείο σχεδίασης και εισάγετε το αργότερα ως μπλοκ σε άλλα σχέδια. 
 
 

 
Για να δημιουργήσετε ένα μπλοκ για χρήση σε ένα τρέχον σχέδιο: 

 
1. Επιλέξτε Draw>Block> Make από το κύριο μενού. 

2. Στο πλαίσιο διαλόγου Ορισμός μπλοκ, εισαγάγετε ένα όνομα 

μπλοκ στο πλαίσιο Όνομα. 

3. Κάντε κλικ στο κουμπί Pick point για να καθορίσετε το σημείο 

εισαγωγής του μπλοκ στην περιοχή σχεδίασης. 

4. Κάντε κλικ στο κουμπί Select objects (Επιλογή αντικειμένων) για να 

επιλέξετε τα αντικείμενα για το μπλοκ και, στη συνέχεια, πατήστε 

Enter μετά την επιλογή. Στη συνέχεια κάντε κλικ στο κουμπί OK. 

 
10.1.2. Δημιουργία εμφωλευμένων μπλοκ 

 
Μπορείτε να ορίσετε μπλοκ και άλλα μπλοκ ως ένθετα μπλοκ, ώστε να απλοποιήσετε την οργάνωση πολύπλοκων μπλοκ. Με τα 

ένθετα μπλοκ, μπορείτε να δημιουργήσετε ένα ενιαίο μπλοκ από διάφορα στοιχεία. Θα πρέπει όμως να παρατηρήσετε ότι 

τα μπλοκ που αναφέρονται στον εαυτό τους δεν μπορούν να εισαχθούν. 
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10.1.3. Δημιουργία αρχείων σχεδίασης για χρήση ως μπλοκ 

 
Μπορείτε να δημιουργήσετε ένα μπλοκ ως ξεχωριστό αρχείο 

σχεδίασης το οποίο μπορείτε να εισάγετε σε άλλα σχέδια. 

 
Για να αποθηκεύσετε ένα μπλοκ ως ξεχωριστό αρχείο σχεδίασης: 

 
1. Στη γραμμή εντολών, πληκτρολογήστε WBLOCK. 

2. Στην περιοχή Πηγή, επιλέξτε ένα από τα ακόλουθα: 

 
-Μπλοκ: Αποθηκεύει το υπάρχον αντικείμενο μπλοκ σε ξεχωριστό αρχείο σχεδίασης. 

-Αρχικό σχέδιο: Αποθηκεύει ολόκληρο το σχέδιο σε ξεχωριστό αρχείο σχεδίου. 

-Αντικείμενα: Αποθηκεύει τα αντικείμενα που επιλέγετε σε ξεχωριστό αρχείο σχεδίασης. 

 
3. Στην περιοχή Προορισμός, πληκτρολογήστε το όνομα του αρχείου σχεδίασης που θέλετε να δημιουργήσετε και επιλέξτε τη διαδρομή 

αποθήκευσης, κάντε κλικ στο OK για αποθήκευση. 

 
10.1.4. Αλλαγή του σημείου βάσης των σχεδίων που θα χρησιμοποιηθούν ως μπλοκ 

 
Όταν εισάγετε ένα αρχείο σχεδίου σε ένα άλλο σχέδιο ως μπλοκ, από προεπιλογή, το σύστημα χρησιμοποιεί την αρχή 

(0,0,0) του WCS ως βασικό σημείο εισαγωγής. Για να καθορίσετε διαφορετικό σημείο εισαγωγής, μπορείτε να 

χρησιμοποιήσετε την εντολή BASE. Την επόμενη φορά που θα εισαγάγετε το ίδιο μπλοκ, το σύστημα χρησιμοποιεί εξ ορισμού 

το νέο σημείο εισαγωγής. 

 
10.1.5. Ενημέρωση αλλαγών στο αρχικό σχέδιο 

 
Μόλις το αρχείο σχεδίου εισαχθεί σε άλλο σχέδιο ως μπλοκ, αλλάζει και το αρχικό σχέδιο. Αλλά το μπλοκ που έχει εισαχθεί 

δεν αλλάζει. Εάν το μπλοκ τυχαίνει να αλλάξει μαζί με το αρχικό σχέδιο, θα πρέπει να το επισυνάψετε ως εξωτερική 

αναφορά αλλά όχι ως μπλοκ. 

 
10.1.6. Χρήση αντικειμένων χώρου χαρτιού σε μπλοκ 

 
Τα αντικείμενα που δημιουργούνται στο χώρο χαρτιού δεν περιέχονται στο μπλοκ κατά την εισαγωγή του στο σχέδιο. 

Μπορείτε να μετατρέψετε τα αντικείμενα στο χώρο χαρτιού σε μπλοκ ή να τα αποθηκεύσετε ως μεμονωμένο αρχείο 

σχεδίου πριν από την εισαγωγή τους σε άλλα σχέδια. 

 
 
 
 

10.1.7. Μπλοκ εισαγωγής 

 
Μπορείτε να εισαγάγετε μπλοκ και άλλα σχέδια στο 

τρέχον σχέδιο. Όταν εισάγετε ένα μπλοκ, αυτό 

αντιμετωπίζεται ως ένα ενιαίο αντικείμενο. Όταν  
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εισάγετε ένα σχέδιο, αυτό προστίθεται στο τρέχον 

σχέδιο ως μπλοκ. Στη συνέχεια, μπορείτε να 

εισαγάγετε πολλαπλές περιπτώσεις του μπλοκ χωρίς 

επαναφόρτωση 

το αρχικό αρχείο σχεδίου. Εάν αλλάξετε το αρχικό αρχείο σχεδίασης, οι αλλαγές αυτές δεν έχουν καμία επίδραση στο τρέχον 

σχέδιο, εκτός εάν επαναπροσδιορίσετε το μπλοκ εισάγοντας εκ νέου το τροποποιημένο σχέδιο. 

 
Για να εισαγάγετε ένα μπλοκ: 

 
1. Επιλέξτε Εισαγωγή > Μπλοκ από το κύριο μενού. 

2. Στο παράθυρο διαλόγου Εισαγωγή μπλοκ, στην περιοχή Εισαγωγή, κάντε κλικ στην επιλογή Όνομα μπλοκ. 

3. Στο πλαίσιο Όνομα, επιλέξτε το όνομα του μπλοκ που θέλετε να εισαγάγετε. 

4. Αν θέλετε να χρησιμοποιήσετε τη συσκευή υπόδειξης για να καθορίσετε το σημείο εισαγωγής, την κλίμακα και την 

περιστροφή, επιλέξτε Καθορισμός στην οθόνη. Διαφορετικά, εισαγάγετε τιμές στα πλαίσια Insertion Point (Σημείο 

εισαγωγής), Scale (Κλίμακα) και Rotation (Περιστροφή). 

5. Κάντε κλικ στο OK για να εισαγάγετε. 

 
Για να εισαγάγετε ένα ολόκληρο σχέδιο στο τρέχον σχέδιο: 

 
1. Επιλέξτε Εισαγωγή > Μπλοκ από το κύριο μενού. 

2. Κάντε κλικ στο κουμπί Αναζήτηση για να καθορίσετε το αρχείο από το παράθυρο διαλόγου Εισαγωγή μπλοκ. 

3. Μπορείτε να χρησιμοποιήσετε το προεπιλεγμένο σημείο 

εισαγωγής, την κλίμακα και την περιστροφή ή να επιλέξετε 

Καθορισμός στην οθόνη και να εισαγάγετε τιμές στα πλαίσια 

Σημείο εισαγωγής, Κλίμακα και Περιστροφή. 

4. Αν θέλετε τα αντικείμενα στο μπλοκ να εισαχθούν ως 

μεμονωμένα αντικείμενα αντί για ένα ενιαίο μπλοκ, επιλέξτε 

Explode. Προϋπόθεση είναι το μπλοκ που δημιουργήσατε να 

επιτρέπεται να εκραγεί. 

5. Κάντε κλικ στο OK για να εισαγάγετε. 
 

 
10.1.8. Τροποποίηση ορισμού μπλοκ 

 
Μπορείτε να επαναπροσδιορίσετε όλες τις περιπτώσεις ενός μπλοκ στο τρέχον σχέδιο. Για να επαναπροσδιορίσετε ένα μπλοκ 

που δημιουργήθηκε στο τρέχον σχέδιο, δημιουργείτε ένα νέο μπλοκ με το ίδιο όνομα. Μπορείτε να ενημερώσετε όλα τα 

μπλοκ στο τρέχον σχέδιο επαναπροσδιορίζοντας το μπλοκ. Εάν το μπλοκ εισήχθη από ένα ξεχωριστό αρχείο σχεδίου που 

ενημερώθηκε στη συνέχεια, εισάγετε εκ νέου το μπλοκ αυτό για να ενημερώσετε όλες τις άλλες περιπτώσεις στο τρέχον 

σχέδιο. 
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Για να επαναπροσδιορίσετε ένα μπλοκ στο τρέχον σχέδιο: 

 
1. Επιλέξτε Draw > Block > Make από το κύριο μενού. 

2. Στο πλαίσιο διαλόγου Ορισμός μπλοκ, πληκτρολογήστε 

το όνομα του μπλοκ που θέλετε να 

επαναπροσδιορίσετε στο πλαίσιο Όνομα. 

3. Κάντε κλικ στο κουμπί Pick point για να καθορίσετε ένα 

σημείο ως σημείο εισαγωγής για το μπλοκ στην περιοχή 

σχεδίασης. 

4. Κάντε κλικ στο κουμπί Select objects (Επιλογή 

αντικειμένων) για να επιλέξετε τα αντικείμενα για το 

μπλοκ και, στη συνέχεια, πατήστε Enter μετά την 

επιλογή. 

5. Κάντε κλικ στο OK. 
6. Κάντε κλικ στο κουμπί Ναι στο πλαίσιο προτροπής που εμφανίζεται για να επαναπροσδιορίσετε το μπλοκ στο τρέχον σχέδιο. 

 
 
 
 
 
 

10.1.9. Αφαίρεση ορισμών μπλοκ 

 
Πάρα πολλοί ορισμοί μπλοκ σε ένα αρχείο 

σχεδίασης μπορεί να επηρεάσουν το μέγεθος της 

σχεδίασης. Για να μειώσετε το μέγεθος ενός 

σχεδίου, μπορείτε να αφαιρέσετε 

αχρησιμοποίητους ορισμούς μπλοκ. Η διαγραφή 

μιας αναφοράς μπλοκ από ένα σχέδιο μπορεί να 

διαγράψει την αναφορά μπλοκ αλλά να 

διατηρήσει τους ορισμούς μπλοκ στον πίνακα 

ορισμών μπλοκ. Η χρήση της εντολής PURGE 

μπορεί να βοηθήσει στην αφαίρεση 

αχρησιμοποίητων αναφορών μπλοκ από το σχέδιό 

σας, προκειμένου να μειώσετε το μέγεθος του 

σχεδίου. Θα πρέπει να διαγράψετε όλες τις 

αναφορές από ένα μπλοκ πριν μπορέσετε να 

καθαρίσετε τον ορισμό μπλοκ. 

 
10.1.10. Ορισμός και χρήση χαρακτηριστικών μπλοκ 

 
Ένα χαρακτηριστικό είναι ένα συγκεκριμένο αντικείμενο που μπορείτε να αποθηκεύσετε ως μέρος ενός ορισμού μπλοκ. Τα 

χαρακτηριστικά αποτελούνται από δεδομένα που βασίζονται σε κείμενο. Μπορείτε να χρησιμοποιήσετε τα χαρακτηριστικά 

για να παρακολουθείτε πράγματα όπως αριθμούς εξαρτημάτων και τιμές. Οι τιμές των χαρακτηριστικών είναι είτε σταθερές 

είτε μεταβλητές. 
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Για να ορίσετε ένα χαρακτηριστικό: 

 
1. Επιλέξτε Draw>Block> Define Attributes από το κύριο μενού. 

2. Κάτω από το Attribute, πληκτρολογήστε την ετικέτα, την προτροπή και το προεπιλεγμένο κείμενο. 

3. Στην περιοχή Σημείο εισαγωγής, καθορίστε τη θέση του 

χαρακτηριστικού ή κάντε κλικ στην επιλογή Καθορισμός στην 

οθόνη για να επιλέξετε ένα σημείο στο σχέδιο. 

4. Στην περιοχή Λειτουργία, επιλέξτε τις προαιρετικές λειτουργίες χαρακτηριστικών. 

5. Στην περιοχή Ρυθμίσεις κειμένου, καθορίστε τα χαρακτηριστικά του κειμένου. 

6. Για να προσθέσετε το χαρακτηριστικό στο σχέδιο, κάντε ένα από τα εξής: 

-Κάντε κλικ στο κουμπί Ορισμός για να προσθέσετε το 

χαρακτηριστικό και να διατηρήσετε το παράθυρο διαλόγου 

ενεργό, ώστε να μπορείτε να ορίσετε ένα άλλο 

χαρακτηριστικό. 

-Κάντε κλικ στο Define and Exit για να προσθέσετε το 

χαρακτηριστικό και να τερματίσετε την εντολή. 

 
 

 
Για να επεξεργαστείτε έναν ορισμό χαρακτηριστικών: 

 
1. Στη γραμμή εντολών, πληκτρολογήστε DDEDIT. 

2. Επιλέξτε το κείμενο ορισμού του χαρακτηριστικού για επεξεργασία. 
3. Τροποποιήστε την ετικέτα χαρακτηριστικών, την προτροπή και την προεπιλογή στην 

 οθόνη Edit Attribute Definition που εμφανίζεται. 

4. Κάντε κλικ στο OK. 
 

 
10.1.11. Τροποποίηση χαρακτηριστικών μπλοκ 

 
Μπορείτε να χρησιμοποιήσετε τη Διαχείριση χαρακτηριστικών 

μπλοκ για να τροποποιήσετε χαρακτηριστικά σε ορισμούς 

μπλοκ. Για παράδειγμα, μπορείτε να τροποποιήσετε τα ακόλουθα 

στοιχεία: 

 
-Τα χαρακτηριστικά των μπλοκ μπορούν να εμφανίζονται μετά την τροποποίηση. 

-Ιδιότητες κειμένου που καθορίζουν τον τρόπο εμφάνισης του κειμένου των χαρακτηριστικών στο 

σχέδιο. -Ιδιότητες που καθορίζουν τη στρώση στην οποία βρίσκεται το 
χαρακτηριστικό. 

και το χρώμα, το βάρος και τον τύπο της 

γραμμής χαρακτηριστικών Για να 

επεξεργαστείτε ένα χαρακτηριστικό που 

είναι προσαρτημένο σε ένα μπλοκ: 
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1. Στη γραμμή εντολών, πληκτρολογήστε DDATTE. 

2. Επιλέξτε το μπλοκ προς επεξεργασία. Το παράθυρο διαλόγου 

Edit Attributes (Επεξεργασία χαρακτηριστικών) εμφανίζει όλα τα 

χαρακτηριστικά που συνδέονται με το μπλοκ που επιλέξατε. 

3. Επεξεργαστείτε τις τιμές των χαρακτηριστικών όπως απαιτείται. Στη συνέχεια κάντε κλικ στο OK. 
 
 
 

 
10.1.12. Εξαγωγή δεδομένων χαρακτηριστικών μπλοκ 

 
Πληκτρολογήστε EATTEXT για να ξεκινήσετε την εξαγωγή 

χαρακτηριστικών εάν τα μπλοκ στο σχέδιο περιέχουν 

χαρακτηριστικά. Μπορείτε να εξαγάγετε πληροφορίες 

μπλοκ σύμφωνα με την προτροπή του οδηγού και να 

δημιουργήσετε λίστα ώστε να επισκοπήσετε τις 

πληροφορίες χαρακτηριστικών των μπλοκ. Μπορείτε 

να λάβετε πληροφορίες οδηγού από τον οδηγό μέχρι 

να ολοκληρώσετε την επιλογή σχεδίων, μπλοκ και 

χαρακτηριστικών μπλοκ. 

 
Με τη λειτουργία extract block attribute data, μπορείτε να 

δημιουργήστε εύκολα λίστα χρησιμοποιώντας δεδομένα σχεδίασης μέσω εξαγωγής πληροφοριών χαρακτηριστικών και εξαγωγής σε εξωτερικά 
αρχεία. 

 
10.1.13. Συγχρονισμός χαρακτηριστικών 

 
Η εντολή ATTSYNC εφαρμόζει τις αλλαγές χαρακτηριστικών στους ορισμούς μπλοκ σε όλες τις αναφορές μπλοκ με το ίδιο 

όνομα. Μπορείτε να χρησιμοποιήσετε αυτήν την εντολή για να ενημερώσετε περιπτώσεις μπλοκ που περιέχουν 

χαρακτηριστικά που επαναπροσδιορίστηκαν με τις εντολές BLOCK ή BEDIT. Η εντολή ATTSYNC δεν αλλάζει τις τιμές που 

έχουν εκχωρηθεί σε χαρακτηριστικά σε υπάρχοντα μπλοκ. Η εντολή ATTSYNC αφαιρεί όλες τις αλλαγές μορφής ή 

χαρακτηριστικών που πραγματοποιούνται με τις εντολές ATTEDIT ή EATTEDIT. Και διαγράφει επίσης όλα τα εκτεταμένα 

δεδομένα που σχετίζονται με τα μπλοκ και ενδέχεται να επηρεάσει τα δυναμικά μπλοκ και τα μπλοκ που δημιουργούνται 

από εφαρμογές τρίτων. 
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10.2. Αναφορά άλλων αρχείων σχεδίασης (Xrefs) 

 
Οι εξωτερικές αναφορές παρέχουν πρόσθετες δυνατότητες που δεν είναι διαθέσιμες όταν εισάγετε ένα σχέδιο ως μπλοκ. 

Ωστόσο, όταν επισυνάπτετε μια εξωτερική αναφορά, οποιεσδήποτε αλλαγές κάνετε στο αρχικό αρχείο σχεδίου 

αντικατοπτρίζονται στα σχέδια που το παραπέμπουν. Οι εξωτερικές αναφορές είναι χρήσιμες για τη συναρμολόγηση κύριων 

σχεδίων από σχέδια εξαρτημάτων. Χρησιμοποιήστε εξωτερικές αναφορές για να συντονίσετε την εργασία σας με άλλους σε μια 

ομάδα. Οι εξωτερικές αναφορές συμβάλλουν στη μείωση του μεγέθους του αρχείου σχεδίων και διασφαλίζουν ότι εργάζεστε 

πάντα με την πιο πρόσφατη έκδοση ενός σχεδίου. 

 
10.2.1. Επισυνάψτε εξωτερικές αναφορές 

 
Όταν ένα σχέδιο επισυνάπτεται στο τρέχον σχέδιο ως εξωτερική αναφορά, θα συνδέεται με το σχέδιο, τυχόν αλλαγές στο 

σχέδιο που αναφέρεται μπορεί να επηρεάσουν την εξωτερική αναφορά στο τρέχον σχέδιο. Οι εξωτερικές αναφορές 

εισάγονται στο σχέδιο ως ορισμοί μπλοκ και χρησιμοποιούνται ως μεμονωμένα αντικείμενα, αλλά θα πρέπει να 

διακρίνετε τις εξωτερικές αναφορές και τα μπλοκ. 

 
Για να επισυνάψετε μια εξωτερική αναφορά: 

 
1. Επιλέξτε Εισαγωγή>Εξωτερικές παραπομπές από το κύριο μενού. 

2. Κάντε κλικ στο εικονίδιο DWG στο επάνω αριστερό μέρος του παραθύρου. 

3. Στο παράθυρο διαλόγου Επιλογή αρχείου αναφοράς, καθορίστε το αρχείο σχεδίασης που θέλετε να επισυνάψετε και, στη συνέχεια, κάντε κλικ στο 
κουμπί Άνοιγμα. 

4. Στο παράθυρο διαλόγου Εξωτερική αναφορά, στην περιοχή Τύπος αναφοράς, επιλέξτε τον τρόπο με τον οποίο θέλετε να εισαγάγετε το σχέδιο: 

-Συναρμολόγηση: Εισάγει ένα αντίγραφο του σχεδίου και περιλαμβάνει οποιεσδήποτε άλλες αναφορές σε σχέδια. 

-Overlay: Τοποθετεί ένα αντίγραφο ενός σχεδίου πάνω από το αρχικό σας σχέδιο 

5. Πραγματοποιήστε τυχόν πρόσθετες επιλογές και, στη συνέχεια, κάντε κλικ στο OK. 

6. Αν σημειώσατε το στοιχείο Specify On-screen για οποιοδήποτε στοιχείο, ακολουθήστε τις οδηγίες για να επισυνάψετε την εξωτερική αναφορά. 
 
 
 
 
 

 
 
 
 
 



Κεφάλαιο 10_ Μπλοκ, χαρακτηριστικά και Xrefs 
 

Σ ε λ ί δ α  176 | 296  

 
10.2.2. Έλεγχος των ιδιοτήτων των αναφερόμενων επιπέδων 

 
Μπορείτε να ελέγξετε την ορατότητα, το χρώμα, το είδος 

γραμμής και άλλες ιδιότητες των επιπέδων ενός xref και να 

κάνετε αυτές τις αλλαγές προσωρινές ή μόνιμες. Εάν η 

μεταβλητή VISRETAIN έχει οριστεί σε 0, αυτές οι αλλαγές 

ισχύουν μόνο για την τρέχουσα συνεδρία σχεδίασης. Μπορείτε 

επίσης να ελέγξετε την εμφάνιση της εξασθένισης μέσω της 

XDWGFADECTL  μεταβλητή. Επιπλέον, μπορείτε να ελέγχετε τις 

ιδιότητες στρώματος Xref απευθείας στο παράθυρο διαλόγου 

Layer Manager Properties. 

 
 
 

 
10.2.3. Όρια αποκοπής Xref 

 
Μπορείτε να ελέγξετε αν θα εμφανίζεται το όριο αποκοπής του 

xref μέσω της ρύθμισης της μεταβλητής συστήματος 

XCLIPFRAME. Επίσης, μπορείτε να περικόψετε τα Xrefs 

επιλέγοντας την επιλογή στη γραμμή μενού: 

Τροποποίηση>Clip>Xref 

 
10.2.4. Φωλιά και επικάλυψη Εξωτερικές αναφορές 

 
 
 

 
Τα Xrefs μπορούν να φωλιάσουν σε ένα άλλο xref και να συνδεθούν με το τρέχον σχέδιο. Κατά τη διαδικασία της 

προσάρτησης, μπορείτε να επιλέξετε τη θέση εισαγωγής, τον παράγοντα κλιμάκωσης και τη γωνία περιστροφής για τα 

xrefs. 

 
 
 

 
10.2.5. Δέσμευση ενός Xref σε ένα σχέδιο 

 
Για να παρέχετε αντίγραφο ενός σχεδίου που περιέχει εξωτερικές αναφορές σε κάποιον 

άλλο, πρέπει να παρέχετε επίσης όλα τα αρχεία εξωτερικών αναφορών. Η δέσμευση των 

εξωτερικών αναφορών τις καθιστά μόνιμο μέρος του σχεδίου, κάτι που είναι παρόμοιο με 

την εισαγωγή ενός ξεχωριστού σχεδίου ως μπλοκ. 

Μπορείτε να δεσμεύσετε εξωτερικές αναφορές κάνοντας δεξί κλικ στο επιλεγμένο αρχείο Xref. 

 

 
 

file:///D:/WS1a9193826455f5ff-3a29af00119afd28e95-7ea6.htm%23WS1a9193826455f5ff-3a29af00119afd28e95-7ea5
file:///D:/WS1a9193826455f5ff-3a29af00119afd28e95-7ea6.htm%23WS1a9193826455f5ff-3a29af00119afd28e95-7ea5
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10.2.6. Ανανέωση Xrefs 

 
Μπορείτε να ανανεώσετε το Xref κάνοντας κλικ στο κουμπί ανανέωσης που βρίσκεται στο επάνω μέρος του πλαισίου διαλόγου 
Εξωτερική αναφορά. 
 
 
 
 
 

 
 
 

 
10.3. Υπόστρωμα DGN 

 
Στην έκδοση GstarCAD 2025, υποστηρίζονται τα πλήρη αρχεία 

DGN και είναι διαθέσιμες οι σχετικές εντολές όπως DGNIMPORT, 

DGNATTACH, DGNADJUST, DGNMAPING κ.λπ. Τώρα μπορείτε να 

εισαγάγετε και να επισυνάψετε ως υπόστρωμα μια εγγενή 

μορφή Microstation. 

 

 

 

 

 
10.4. Υποστρώματα DWF 

 
Το GstarCAD υποστηρίζει DWF Underlay, μπορείτε να εισάγετε ένα αρχείο DWF ως Underlay. 
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10.5. Υπόστρωμα PDF 

 
Εάν λάβετε σχέδια έργου με τη μορφή αρχείου PDF, μπορείτε να επαναχρησιμοποιήσετε τα δεδομένα PDF στα δικά σας αρχεία σχεδίων GstarCAD. 

 

 

 

 
Αφού εισαγάγετε το αρχείο PDF ως υπόστρωμα, τότε μπορείτε 

να αρχίσετε να σχεδιάζετε ή να τοποθετείτε γεωμετρία σε 

συγκεκριμένο σημείο του υπόστρωμα. 

 
 
 
 
 
 
 

 
Επιπλέον, μπορείτε να ρυθμίσετε την εμφάνιση της υποκείμενης οθόνης, όπως αντίθεση, εξασθένιση, μονοχρωμία και 

χρώματα για το φόντο, μέσω της παλέτας ιδιοτήτων. 
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10.6. Σχετικά με το Clipping Underlays 

 
Το όριο αποκοπής μπορεί να καθοριστεί ως 

ένα περιορισμένο τμήμα του εξωτερικού 

γραφήματος αναφοράς, της αναφοράς μπλοκ, των 

γραφικών, του παραθύρου προβολής και του 

υποστρώματος. 

Μπορείτε να αποκόψετε εξωτερική αναφορά, όπως το DGN、DWF、 

IMAGE、PDF και άλλες υποκείμενες ή μπλοκ αναφοράς. 

Μπορείτε να χρησιμοποιήσετε το όριο 

αποκοπής για να καθορίσετε το τμήμα 

εξωτερικής αναφοράς ή το τμήμα αναφοράς μπλοκ 

που θέλετε να εμφανίσετε ή να αποκρύψετε τα 

περιττά τμήματα της αναφοράς εντός ή εκτός του 

ορίου με τις ακόλουθες μεθόδους. 

Το όριο μπορεί να είναι μια πολυγραμμή, ένα ορθογώνιο ή ένα πολύγωνο του οποίου οι κορυφές περιορίζονται εντός της 

συνολικής εμβέλειας του υποστρώματος. Μπορείτε να τροποποιήσετε το όριο των γραφικών που θα περικοπούν. Όταν 

περικόπτετε τα γραφικά, δεν αλλάζετε το αντικείμενο στην εξωτερική αναφορά ή στο μπλοκ, αλλά μόνο τον τρόπο 

εμφάνισής τους. 

 

 
 
 

 
10.7. Καρτέλα Επεξεργασία αναφοράς 

 
Με τη λειτουργία REFEDIT σας επιτρέπει να επεξεργαστείτε μπλοκ ως αναφορά. Οι χρήστες μπορούν να έχουν 

πρόσβαση σε αυτή τη λειτουργία από τη γραμμή εργαλείων στην κλασική διεπαφή και επίσης υπάρχει ένας πίνακας 

επεξεργασίας αναφοράς στη διεπαφή κορδέλας. Στον πίνακα επεξεργασίας αναφοράς, οι χρήστες μπορούν να επιλέξουν τις 

επιλογές όπως αποθήκευση αλλαγών, απόρριψη αλλαγών, προσθήκη στο σύνολο εργασίας και αφαίρεση από το σύνολο 

εργασίας με βάση τις τροποποιήσεις των μπλοκ. Τώρα μπορείτε να επεξεργαστείτε ένα xref ή έναν ορισμό μπλοκ απευθείας 

μέσα στο τρέχον σχέδιο. 

http://help.autodesk.com/view/ACD/2018/ENU/?guid=GUID-095BAA52-1D04-4491-98DF-1B6BC5C61C6D
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Τα αντικείμενα που επιλέγετε από το επιλεγμένο xref ή μπλοκ εξάγονται προσωρινά και καθίστανται διαθέσιμα για επεξεργασία 

στο τρέχον σχέδιο. Το σύνολο των εξαχθέντων αντικειμένων ονομάζεται σύνολο εργασίας, το οποίο μπορεί να τροποποιηθεί και 

στη συνέχεια να αποθηκευτεί ξανά για να ενημερωθεί ο ορισμός του xref ή του μπλοκ. 

Παράθυρο διαλόγου Επεξεργασίας αναφοράς 

Προσδιορίστε την καρτέλα αναφοράς: Παρέχει οπτικά 

βοηθήματα για τον εντοπισμό του προς επεξεργασία και 

τον έλεγχο του τρόπου επιλογής. 

5Όνομα αναφοράς: Εμφανίζει την αναφορά που έχει 

επιλεγεί για επιτόπια επεξεργασία και τυχόν 

αναφορές που είναι φωλιασμένες μέσα στην 

επιλεγμένη αναφορά. Εάν εμφανίζονται πολλαπλές 

αναφορές, 

επιλέξτε ένα συγκεκριμένο xref ή μπλοκ για τροποποίηση. 

Μόνο ένα μπορεί να επεξεργαστεί στη θέση του κάθε 

φορά. 

Προεπισκόπηση: Εμφανίζει μια εικόνα προεπισκόπησης της 

τρέχουσας επιλεγμένης αναφοράς, όπως αυτή 

αποθηκεύτηκε στο τελευταίο σχέδιο. Η εικόνα 

προεπισκόπησης αναφοράς δεν ενημερώνεται όταν 

αποθηκεύονται αλλαγές. 

Μονοπάτι: Εμφανίζει τη θέση του αρχείου της επιλεγμένης αναφοράς. Εάν πρόκειται για μπλοκ, δεν εμφανίζεται διαδρομή. 

Αυτόματη επιλογή όλων των ένθετων αντικειμένων: Ελέγχει εάν τα φωλιασμένα αντικείμενα περιλαμβάνονται αυτόματα στη 

συνεδρία επεξεργασίας αναφοράς. 

Προτροπή για την επιλογή φωλιασμένων αντικειμένων: Ελέγχει αν τα ένθετα αντικείμενα πρέπει να επιλέγονται ξεχωριστά 

στη συνεδρία επεξεργασίας αναφοράς. 
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Καρτέλα Ρυθμίσεις 

Δημιουργήστε μοναδικά ονόματα στρώματος, στυλ και μπλοκ: 

Ελέγχει αν τα επίπεδα και άλλα ονομαστικά αντικείμενα που 

εξάγονται από την αναφορά τροποποιούνται μοναδικά. Εάν 

είναι επιλεγμένο, τα ονομαστικά αντικείμενα σε xrefs 

τροποποιούνται (τα ονόματα έχουν πρόθεμα $#$), παρόμοια 

με τον τρόπο που τροποποιούνται όταν δεσμεύετε xrefs. Εάν 

δεν επιλεγεί, τα ονόματα των επιπέδων και άλλων ονομαστικών 

αντικειμένων παραμένουν τα ίδια όπως στο σχέδιο 

αναφοράς. Τα ονομαστικά αντικείμενα που δεν 

τροποποιούνται για να γίνουν μοναδικά, λαμβάνουν τις 

ιδιότητες εκείνων του τρέχοντος σχεδίου υποδοχής που 

έχουν το ίδιο όνομα. 

Εμφάνιση ορισμών χαρακτηριστικών για επεξεργασία: 

Ελέγχει εάν όλοι οι ορισμοί χαρακτηριστικών μεταβλητών σε 

αναφορές μπλοκ εξάγονται και εμφανίζονται κατά την 

επεξεργασία της αναφοράς. Εάν Display Attribute 

Ορισμοί για επεξεργασία είναι επιλεγμένη, τα χαρακτηριστικά (εκτός από τα σταθερά χαρακτηριστικά) γίνονται αόρατα και οι 

ορισμοί των χαρακτηριστικών είναι διαθέσιμοι για επεξεργασία μαζί με την επιλεγμένη γεωμετρία αναφοράς. Όταν οι αλλαγές 

αποθηκεύονται πίσω στην αναφορά μπλοκ, τα χαρακτηριστικά της αρχικής αναφοράς παραμένουν αμετάβλητα. Οι νέοι ή 

τροποποιημένοι ορισμοί χαρακτηριστικών επηρεάζουν μόνο τις επόμενες εισαγωγές του μπλοκ- τα χαρακτηριστικά σε 

υπάρχουσες περιπτώσεις μπλοκ δεν επηρεάζονται. Οι αναφορές Xrefs και οι αναφορές μπλοκ χωρίς ορισμούς δεν 

επηρεάζονται από αυτήν την επιλογή. 

Κλείδωμα αντικειμένων που δεν ανήκουν στο σύνολο εργασίας: Κλειδώνει όλα τα αντικείμενα που δεν ανήκουν στο 

σύνολο εργασίας. Αυτό σας αποτρέπει από το να επιλέξετε και να επεξεργαστείτε κατά λάθος αντικείμενα στο σχέδιο 

υποδοχής ενώ βρίσκεστε σε κατάσταση επεξεργασίας αναφοράς. Η συμπεριφορά των κλειδωμένων αντικειμένων είναι 

παρόμοια με τα αντικείμενα σε κλειδωμένη στρώση. Εάν προσπαθήσετε να επεξεργαστείτε κλειδωμένα αντικείμενα, 

φιλτράρονται από το σύνολο επιλογής. 
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10.8. Εισαγωγή και εξαγωγή PDF 

 
 

 
Έχετε τη δυνατότητα να εισάγετε κείμενο TrueType, γεωμετρία και εικόνες ράστερ 

από ένα αρχείο PDF ή ένα υπόστρωμα σε ένα τρέχον σχέδιο ως αντικείμενα 

του GstarCAD. 
 

Το GstarCAD 2025 υποστηρίζει επίσης την εξαγωγή σε μορφή αρχείου PDF. Μπορείτε να αποκτήσετε πρόσβαση σε αυτή τη 

λειτουργία από το κουμπί Αρχείο - Εξαγωγή - PDF ή να εισαγάγετε EXPORTPDF από τη γραμμή εντολών. 
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11. Καταπακτές και εικόνες Raster 

 
 

11.1. Καταπακτές 
 

 
11.1.1. Ορισμός ορίου καταπακτής 

 
Για να δημιουργήσετε μια καρέκλα, θα πρέπει πρώτα να ορίσετε τα 

όρια της καρέκλας επιλέγοντας αντικείμενα προς καρέκλα ή 

επιλέγοντας ένα σημείο μέσα στο επιθυμητό αντικείμενο. Ένα όριο 

κατωφλίωσης μπορεί να είναι οποιοσδήποτε συνδυασμός 

αντικειμένων, όπως γραμμές, τόξα, κύκλοι και πολυγραμμές, 

που σχηματίζει μια κλειστή περιοχή. 

 
11.1.2. Έλεγχος της εκκόλαψης στα νησιά 

 
Μπορείτε να καθορίσετε τις μεθόδους των αντικειμένων καρέτα στο εξωτερικό όριο ως κανονική, εξωτερική και αγνόηση. Η 

κανονική είναι το προεπιλεγμένο μοτίβο χάραξης. Εκτός αυτού, μπορείτε να προβάλετε τα αποτελέσματα της χάραξης 

διαφορετικών τύπων στην περιοχή Islands (Νησίδες) στην καρτέλα Hatch (Χάραξη) του πλαισίου διαλόγου Hatch and 

Gradient (Χάραξη και κλίση). 

 
Κανονικό: Κλείστε το μοτίβο από το εξωτερικό όριο προς το εσωτερικό. Η διαδικασία εκκόλαψης θα σταματήσει όταν 

συναντήσει εσωτερικά σημεία διασταύρωσης και θα συνεχίσει την εκκόλαψη μέχρι να εμφανιστεί το δεύτερο εσωτερικό 

σημείο διασταύρωσης. 

 
Εξωτερικά: και κρατήστε το εσωτερικό κενό. Αγνοήστε: Αγνοεί τα εσωτερικά 

αντικείμενα, επωάζει μόνο τα εξωτερικά αντικείμενα. 

Για να επιλέξετε αντικείμενα για χάραξη: 

 
1. Επιλέξτε Draw > Hatch από το κύριο μενού. 

2. Από το παράθυρο διαλόγου Hatch and Gradient, κάντε κλικ στην επιλογή Ανίχνευση νησίδας και, στη συνέχεια, επιλέξτε 

μία από τις ακόλουθες νησίδες: Κανονική, Εξωτερική, Αγνόηση: 
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3. Για να διατηρήσετε τυχόν νέα αντικείμενα που δημιουργούνται για τη σχεδίαση της διαγράμμισης ορίων, επιλέξτε το πλαίσιο 

ελέγχου Διατήρηση ορίων στην ενότητα Άλλες επιλογές. Τα υπάρχοντα αντικείμενα διατηρούνται πάντα. 

4. Στα όρια, κάντε κλικ στο κουμπί Select Objects (Επιλογή αντικειμένων). 
5. Στο σχέδιο, κάντε κλικ στα αντικείμενα που θέλετε να διαγραμμιστούν ξεχωριστά και, στη συνέχεια, πατήστε Enter όταν τελειώσετε. 

6. Στο πλαίσιο διαλόγου Hatch and Gradient, 

κάντε κλικ στο OK. Επιλέξτε μια περιοχή για 

χάραξη: 

1. Επιλέξτε Draw > Hatch από το κύριο μενού. 

2. Από το παράθυρο διαλόγου Hatch and Gradient, κάντε κλικ στην επιλογή Ανίχνευση νησίδας και, στη συνέχεια, επιλέξτε 

μία από τις ακόλουθες νησίδες: Κανονική, Εξωτερική ή Αγνόηση. 

 

3. Για να διατηρήσετε τυχόν νέα αντικείμενα που δημιουργούνται για τη σχεδίαση της διαγράμμισης ορίων, επιλέξτε το πλαίσιο 

ελέγχου Διατήρηση ορίων στην ενότητα Άλλες επιλογές. Τα υπάρχοντα αντικείμενα διατηρούνται πάντα. 

4. Στα όρια, κάντε κλικ στο κουμπί Pick Points. 

5. Στο σχέδιο, κάντε κλικ στο εσωτερικό της κλειστής περιμέτρου ενός ορίου. Εάν θέλετε, συνεχίστε να κάνετε κλικ μέσα 

σε πρόσθετες κλειστές περιμέτρους. 

6. Για να ολοκληρώσετε την επιλογή, πατήστε Enter. Στη συνέχεια κάντε κλικ στο κουμπί OK. 
 
 
 

 
11.1.3. Επιλογή και ορισμός μοτίβων καταπακτής 

 
Το μοτίβο καταπακτής αποτελείται από ένα επαναλαμβανόμενο μοτίβο 

γραμμών, παύλας και κουκκίδων. Μπορείτε να επιλέξετε ένα μοτίβο 

διαγράμμισης από ένα σύνολο προκαθορισμένων μοτίβων ή να ορίσετε ένα 

δικό σας μοτίβο. Το μοτίβο διαγράμμισης που χρησιμοποιήσατε πιο πρόσφατα 

είναι το προεπιλεγμένο μοτίβο την επόμενη φορά που θα προσθέσετε 

διαγράμμιση. Το πρόγραμμα παρέχει προκαθορισμένα τυποποιημένα μοτίβα 

χάραξης, τα οποία είναι αποθηκευμένα στα αρχεία βιβλιοθήκης μοτίβων 

χάραξης ICAD.pat και ICADISO.pat. 
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Για να καθορίσετε ένα προκαθορισμένο μοτίβο διαγράμμισης: 

 
1. Επιλέξτε Draw > Hatch από το κύριο μενού. 

2. Στο παράθυρο διαλόγου Περσίδες και κλίσεις, κάντε κλικ στην καρτέλα Περσίδες. 

3. Δίπλα στο Type (Τύπος), κάντε κλικ στο Predefined (Προκαθορισμένο) για να εφαρμόσετε έναν συντελεστή κλίμακας ώστε το μοτίβο να είναι 
μεγαλύτερο ή μικρότερο από το προεπιλεγμένο μέγεθος. 

4. Εισάγετε τον συντελεστή κλίμακας ως ποσοστό της προεπιλεγμένης τιμής. 

5. Εισάγετε τη γωνία σε μοίρες (1-360). Η προεπιλεγμένη γωνία είναι δεξιόστροφη, μπορείτε να αλλάξετε τη γωνία οποιουδήποτε 

μοτίβου διαγράμμισης εισάγοντας μια αριθμητική τιμή. 

6. Εισάγετε το πλάτος της πένας ISO. Αυτή η επιλογή 

είναι διαθέσιμη μόνο αν έχετε επιλέξει υπάρχον μοτίβο 

χάραξης ISO στην επιλογή Μοτίβο. 

7. Για να αντιγράψετε τις ιδιότητες του μοτίβου από μια 

υπάρχουσα καταπακτή, επιλέξτε Κληρονομικές 

ιδιότητες. 

8. Για να συσχετίσετε το μοτίβο χάραξης με τα συνοριακά του αντικείμενα, στην ενότητα Άλλες επιλογές, επιλέξτε το πλαίσιο 

ελέγχου Associative. Μια συσχετιζόμενη διαγράμμιση ενημερώνεται αυτόματα εάν μετακινήσετε οποιοδήποτε από τα 

όριά της. 

9. Για να συνεχίσετε, προσθέστε μια οριοθέτηση επιλέγοντας αντικείμενα ή επιλέγοντας σημεία στην επιλεγμένη περιοχή ή στο όριο που θέλετε να 
οριοθετήσετε. 

 
Για να καθορίσετε ένα μοτίβο οριζόντιας διαγράμμισης που έχει οριστεί από το χρήστη: 

 
1. Επιλέξτε Draw > Hatch από το κύριο μενού. 

2. Από το παράθυρο διαλόγου Περσίδες και κλίσεις, κάντε κλικ στην καρτέλα Περσίδες. 

3. Δίπλα στον τύπο, στη λίστα Τύπος, κάντε κλικ στην επιλογή Ορισμός χρήστη. 

4. Για το Spacing, εισαγάγετε το διάστημα γραμμών για το μοτίβο. 

5. Για να αντιγράψετε τις ιδιότητες του μοτίβου από μια υπάρχουσα διαγράμμιση, επιλέξτε Κληρονομία ιδιοτήτων και 

επιλέξτε ένα μοτίβο διαγράμμισης από ένα αντικείμενο με διαγράμμιση στο σχέδιο. 

6. Για να συσχετίσετε το μοτίβο χάραξης με τα συνοριακά του αντικείμενα, στην ενότητα Άλλες επιλογές, επιλέξτε το πλαίσιο 

ελέγχου Associative. Μια συσχετιζόμενη διαγράμμιση ενημερώνεται αυτόματα εάν μετακινήσετε οποιοδήποτε από τα 

όριά της. 

7. Για να συνεχίσετε, προσθέστε μια οριοθέτηση επιλέγοντας αντικείμενα ή επιλέγοντας σημεία στην επιλεγμένη περιοχή ή στο όριο που θέλετε να 
οριοθετήσετε. 
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Για να χρησιμοποιήσετε ένα προκαθορισμένο μοτίβο βιβλιοθήκης: 

 
1. Επιλέξτε Draw > Hatch από το κύριο μενού. 

2. Κάντε κλικ στην καρτέλα Hatch. 

3. Επιλέξτε έναν προκαθορισμένο τύπο. 

4. Για να επιλέξετε ένα προκαθορισμένο μοτίβο, κάντε ένα από τα εξής: 

-Στη λίστα Pattern, κάντε κλικ στο όνομα του μοτίβου. 

-Κάντε κλικ στη γραφική αναπαράσταση του μοτίβου κατακόρυφου σχήματος. 

5. Για να συνεχίσετε, προσθέστε μια οριοθέτηση 

επιλέγοντας αντικείμενα ή επιλέγοντας σημεία στην 

επιλεγμένη περιοχή ή στο όριο που θέλετε να 

οριοθετήσετε. 

 
 

 
Επιλογές στην καρτέλα Gradient: 

 
Τραβήξτε τη σειρά: Αντιστοιχεί μια εντολή σχεδίασης σε μια 

καταπακτή ή ένα γέμισμα. Μπορείτε να τοποθετήσετε μια οριζόντια 

γραμμή ή ένα γέμισμα πίσω από όλα τα άλλα αντικείμενα, μπροστά από 

όλα τα άλλα αντικείμενα, πίσω από το όριο της οριζόντιας γραμμής ή 

μπροστά από το όριο της οριζόντιας γραμμής. 

Στρώμα: Αντιστοιχίζει νέα αντικείμενα κατακόρυφης όψης στο 

καθορισμένο επίπεδο, παρακάμπτοντας το τρέχον επίπεδο. 

Επιλέξτε Use Current (Χρήση τρέχουσας) για να χρησιμοποιήσετε 

την τρέχουσα στρώση. 

Διαφάνεια: Καθορίζει το επίπεδο διαφάνειας για νέες διαγράμμιση ή 

γεμίσματα, παρακάμπτοντας την τρέχουσα διαφάνεια του αντικειμένου. 

Επιλέξτε Χρήση τρέχουσας για να χρησιμοποιήσετε την τρέχουσα 

ρύθμιση διαφάνειας του αντικειμένου. 
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11.1.4. Καταπακτή προς τα πίσω 

 
Για να αποφύγετε ότι ένα μοτίβο πλήρωσης μπλοκάρει οποιοδήποτε κείμενο, ετικέτα ή άλλα γραφικά στο τρέχον σχέδιο, μπορείτε να  

ορίσετε τη σειρά εμφάνισης όλων των μοτίβων πλήρωσης σε θέση πίσω από όλα τα άλλα αντικείμενα με την εντολή HATCHTOBACK. 

 

 

 

11.2. Εργασία με εικόνες Raster 

 
Μπορείτε να προβάλλετε και να χειρίζεστε εικόνες ράστερ και σχετικές διαδρομές αρχείων στα σχέδιά σας. 

 
 
 
 

 
11.2.1. Προσάρτηση, κλιμάκωση και αποκόλληση εικόνων Raster 

 
Οι εικόνες Raster αποτελούνται από ένα 

ορθογώνιο πλέγμα μικρών τετραγώνων ή 

κουκκίδων, γνωστών ως εικονοστοιχεία. Οι εικόνες 

Raster μπορούν να αντιγραφούν, να μετακινηθούν 

ή να περικοπούν όπως και ένα κανονικό 

αντικείμενο στο σχέδιο. Μπορείτε επίσης να 

ρυθμίσετε την αντίθεση, τη διαφάνεια, την 

ποιότητα της εικόνας και την ορατότητα του 

πλαισίου της εικόνας. Επιπλέον, κατά την 

εισαγωγή εικόνων ράστερ, η μορφή αρχείου 

εξαρτάται από το περιεχόμενο του 

το αρχείο και όχι το όνομα της επέκτασης. Στον ακόλουθο πίνακα εμφανίζονται όλες οι μορφές αρχείων εικόνας που υποστηρίζονται: 

 
11.2.2. Επισύναψη εικόνων Raster 

 
Χρησιμοποιήστε την εντολή 

IMAGEATTACH για να επιλέξετε και να 

επισυνάψετε σε ένα σχέδιο εικόνες 

ράστερ ή αρχεία εικόνων σε bitonal, 8-bit 

gray, 8-bit color ή 24-bit color. Το αρχείο  

Τύπος: Περιγραφή και εκδόσεις: Επέκταση: 

BMP Μορφή bitmap για Windows και OS/2 .bmp 

ECW Ενισχυμένη συμπίεση Wavelet .ecw 

JFIF ή JPEG Κοινή ομάδα εμπειρογνωμόνων 
φωτογραφίας 

.jpg ή .jpeg 

PCX Εικόνα PC Paintbrush Εικόνα .pcx 

PNG Φορητό γραφικό δίκτυο .png 

TGA True Vision Μορφή δεδομένων με βάση 
το Raster 

.tga 

TIFF Κολλημένη μορφή αρχείου εικόνας .tif ή .tiff 
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εικόνας μπορεί να εισαχθεί ως μπλοκ 

όσες φορές θέλετε αφού προσαρτηθεί 

στο τρέχον σχέδιο, μπορείτε να κόψετε την 

προσαρτημένη εικόνα ράστερ και να 

ρυθμίσετε την φωτεινότητα, αντίθεση, 

ξεθώριασμα και διαφάνεια. Για να 

επισυνάψετε μια εικόνα ράστερ: 

1. Επιλέξτε Insert > Raster Image reference από το κύριο μενού. 

2. Καθορίστε ένα αρχείο προς επισύναψη και, στη συνέχεια, κάντε κλικ στο  

κουμπί Άνοιγμα. 

3. Στο παράθυρο διαλόγου Εικόνα, στο σημείο εισαγωγής και 

στην κλίμακα, κάντε κλικ στην επιλογή Καθορισμός στην 

οθόνη. Καθορίστε μια τιμή γωνίας στο πεδίο Περιστροφή 

και, στη συνέχεια, κάντε κλικ στο κουμπί OK. 

4. Καθορίστε ένα σημείο εισαγωγής. 

5. Καθορίστε μια κλίμακα. 

 
11.2.3. Κλίμακα εικόνων Raster 

 
Μπορείτε να καθορίσετε συντελεστή κλίμακας στο πλαίσιο διαλόγου Εικόνα, διαφορετικά να το επισυνάψετε με το αρχικό 

του μέγεθος. Η εικόνα ράστερ θα κλιμακωθεί κατά τον καθορισμένο παράγοντα, ο παράγοντας κλίμακας χρησιμοποιείται 

χωρίς μονάδα από προεπιλογή. 

 
11.2.4. Αποσύνδεση εικόνων Raster 

 
Οι εικόνες Raster μπορούν να αποσπαστούν εάν δεν χρειάζεται πλέον να χρησιμοποιηθούν στο σχέδιο, μια συγκεκριμένη 

εικόνα αποσπάται από το σχέδιο μαζί με τα πολλαπλά αντίγραφα, τις συνδέσεις και τους ορισμούς της, αλλά το αρχικό 

αρχείο εικόνας δεν θα επηρεαστεί. 

 
11.2.5. Τροποποίηση και διαχείριση εικόνων Raster 

 
Ελέγχει τις ιδιότητες, όπως η απεικόνιση και το όριο αποκοπής των εικόνων ράστερ. Μπορείτε να προβάλετε και να χειριστείτε τη 

συνημμένη εικόνα ράστερ και να αλλάξετε τη διαδρομή αποθήκευσής της στο Image Manager. Οι χρήστες μπορούν να 

ενεργοποιήσουν/απενεργοποιήσουν το όριο της εικόνας στην τρέχουσα προβολή χρησιμοποιώντας την εντολή IMAGEFRAME και 

ρυθμίζοντας τις τιμές 0 (off) 1(on). 
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Για να ενεργοποιήσετε ή να απενεργοποιήσετε τα πλαίσια εικόνας για όλες τις εικόνες: 

 
1. Επιλέξτε Τροποποίηση>Αντικείμενο> Εικόνα> Πλαίσιο 

2. Κάντε ένα από τα παρακάτω για να ενεργοποιήσετε και να απενεργοποιήσετε τα πλαίσια: 

-Τοποθετήστε την τιμή 1 για να εμφανίσετε και να εκτυπώσετε πλαίσια για όλες τις εικόνες σε ένα σχέδιο. 

-Τοποθετήστε την τιμή 0 για να αποκρύψετε όλα τα πλαίσια στην οθόνη και κατά την εκτύπωση. 
 

 
Για να κόψετε μια εικόνα σε σχήμα ορθογωνίου και πολυγώνου: 

 
1. Επιλέξτε Modify>Clip> Image 

2. Επιλέξτε την άκρη της εικόνας που θέλετε να κόψετε. 

3. Πληκτρολογήστε N (Νέο όριο) για να δημιουργήσετε ένα νέο όριο αποκοπής. 

4. Εάν επιλέξετε Ορθογώνια: 

-Ορίστε την πρώτη γωνία του ορθογωνίου αποκοπής. 

-Ορίστε τη δεύτερη γωνία του ορθογωνίου αποκοπής. Η επιλεγμένη εικόνα 

περικόπτεται έτσι ώστε να είναι ορατό μόνο το εσωτερικό του 

ορθογωνίου. 

5. Εάν επιλέξετε Polygon: 

-Επιλέξτε τα σημεία για το πολύγωνο και, στη συνέχεια, 

πατήστε Enter όταν ολοκληρωθεί το πολύγωνο. Η 

επιλεγμένη εικόνα περικόπτεται έτσι ώστε να είναι 

ορατό μόνο το εσωτερικό του πολυγώνου. 

 
11.2.6. Αλλαγή φωτεινότητας, αντίθεσης και εξασθένισης εικόνας Raster 

 
Χρησιμοποιήστε το IMAGEADJUST για να ρυθμίσετε το αποτέλεσμα εμφάνισης και την φωτεινότητα, την αντίθεση και την 

εξασθένιση που σχετίζονται με το αποτέλεσμα εμφάνισης και σχεδίασης κατά τη σχεδίαση σχεδίων. Το IMAGEADJUST δεν 

επηρεάζει την αρχική εικόνα ράστερ καθώς και άλλες περιπτώσεις της εικόνας. 
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11.2.7. Βελτίωση της ταχύτητας εμφάνισης εικόνων Raster 

 
Μπορείτε να προσαρμόσετε την ταχύτητα εμφάνισης ρυθμίζοντας την ποιότητα της εικόνας ράστερ. Η ποιότητα εικόνας 

ταξινομείται σε υψηλά και draft επίπεδα, Εάν η ποιότητα έχει οριστεί σε draft, η εικόνα θα εμφανιστεί με κάποια κοκκώδη 

υλικά, ωστόσο με ταχύτερη ταχύτητα εμφάνισης. 

 
12. Διάταξη, σχεδίαση και δημοσίευση σχεδίων 

 

 
12.1. Δημιουργία διατάξεων σχεδίασης πολλαπλών προβολών 

 

 
12.1.1. Επισκόπηση της διάταξης 

 
Μια διάταξη αναπαριστά μια σχεδιασμένη σελίδα στην οποία 

εμφανίζονται μία ή περισσότερες προβολές μοντέλων. Το GstarCAD παρέχει 

δύο παράπλευρα περιβάλλοντα εργασίας ως καρτέλα Μοντέλο και Διάταξη. 

Μπορείτε να δημιουργήσετε θεματικά μοντέλα στην καρτέλα Μοντέλο. 

Μπορείτε να ορίσετε πολλαπλές δ ι α φ ά ν ε ι ε ς  του μοντέλου στην 

καρτέλα Διάταξη. Χρησιμοποιήστε αυτά τα γενικά βήματα για να 

προετοιμάσετε το σχέδιό σας για την εκτύπωση πολλαπλών διατάξεων: 

 
1. Στην καρτέλα Μοντέλο, δημιουργήστε το σχέδιό σας. 

2. Δημιουργήστε μια νέα διάταξη. Μπορείτε να χρησιμοποιήσετε μια υπάρχουσα 

καρτέλα Διάταξη1 ή Διάταξη2 ή να δημιουργήσετε μια νέα καρτέλα Διάταξη. 3. 

Δημιουργήστε τουλάχιστον ένα παράθυρο προβολής διάταξης στην καρτέλα Διάταξη. 

Χρησιμοποιήστε κάθε παράθυρο προβολής για να ελέγξετε ποιο τμήμα του σχεδίου 

εκτυπώνεται και σε ποια κλίμακα. 

4. Καθορίστε πρόσθετες ρυθμίσεις για τη διάταξη, όπως η κλίμακα του σχεδίου, η περιοχή εκτύπωσης, οι πίνακες στυλ εκτύπωσης και άλλα. 

5. Εκτυπώστε ή σχεδιάστε το σχέδιό σας. 

 
Μπορείτε να κάνετε δεξί κλικ στην καρτέλα Διάταξη και να επιλέξετε "Νέα διάταξη" για να δημιουργήσετε μια νέα διάταξη, 

καθώς και να εισαγάγετε διάταξη από πρότυπο. Παρατίθενται οι επιλογές στο μενού συντόμευσης: 

 
12.1.2. Εργασία με χώρο μοντέλου και χώρο χαρτιού 

 
Ο χώρος μοντέλων χρησιμοποιείται γενικά για τη δημιουργία και την επεξεργασία σχεδίων. Οι προετοιμασίες για τη χάραξη 

συνήθως εργάζονται στο χώρο χαρτιού για τα σχέδια στις διατάξεις είναι κοντά στα αποτελέσματα της χάραξης. 

 
Ο χώρος μοντέλων είναι μια περιοχή στην οποία δημιουργείτε 

δισδιάστατα και τρισδιάστατα αντικείμενα με βάση είτε το Παγκόσμιο 

Σύστημα Συντεταγμένων (WCS) είτε ένα σύστημα συντεταγμένων χρήστη 

(UCS). Τα περιεχόμενα του χώρου χαρτιού αντιπροσωπεύουν τη διάταξη 

χαρτιού του σχεδίου σας. Σε αυτή την περιοχή εργασίας, μπορείτε να  
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δημιουργήσετε και να διατάξετε διαφορετικές όψεις του μοντέλου σας, 

παρόμοια με τον τρόπο που διατάσσετε σχέδια λεπτομερειών ή ορθογώνιες 

όψεις ενός μοντέλου σε ένα φύλλο χαρτιού. 

 
Η καρτέλα Διάταξη είναι ενεργοποιημένη για να κάνετε τις σχετικές 

ρυθμίσεις του οικόπεδου. Σε κάθε επιλογή διάταξης παρέχεται χώρος για 

χαρτί και σας επιτρέπεται να δημιουργήσετε παράθυρα προβολής και να 

καθορίσετε ρυθμίσεις σελίδας, όπως μέγεθος χαρτιού, προσανατολισμό 

και θέση, οι οποίες μπορούν να αποθηκευτούν μαζί με τη διάταξη. 

 
Μπορείτε να αποθηκεύσετε και να ονομάσετε τη ρύθμιση σελίδας και να την εφαρμόσετε σε άλλες διατάξεις όταν 

ρύθμιση σελίδων. Μπορείτε επίσης να δημιουργήσετε νέες διατάξεις χρησιμοποιώντας υπάρχον αρχείο προτύπου διάταξης 

(DWT ή DWG). Κάντε κλικ στην καρτέλα Μοντέλο, μπορείτε να προβάλετε και να επεξεργαστείτε αντικείμενα στο 

χώρο του μοντέλου. 

 

 

 

 

 

 
12.1.3. Καθορισμός ρυθμίσεων διάταξης 

 
Αφού δημιουργήσετε ένα σχέδιο στην καρτέλα Μοντέλο, μπορείτε να μεταβείτε στην καρτέλα Διάταξη και να 

ρυθμίσετε τη διάταξη για τη σχεδίαση, όπως το μέγεθος χαρτιού, τον προσανατολισμό του σχεδίου και ούτω καθεξής. 

Μπορείτε να κάνετε δεξί κλικ στην καρτέλα Διάταξη για να δημιουργήσετε νέες διατάξεις ή να εισαγάγετε από αρχεία 

προτύπων και, στη συνέχεια, να κάνετε κλικ στο κουμπί Τροποποίηση στο παράθυρο διαλόγου Διαχείριση ρυθμίσεων 

σελίδας για να ορίσετε τη σελίδα. 

 
12.1.4. Επιλογή μεγέθους χαρτιού για μια διάταξη 

 
Το μέγεθος χαρτιού εδώ αναφέρεται στο μέγεθος του σχεδίου. Όταν ξεκινάτε το παράθυρο διαλόγου Σχεδίαση στην 

καρτέλα Διάταξη, μπορείτε να ορίσετε τον τύπο χαρτιού από την πτυσσόμενη λίστα του πλαισίου κειμένου Μέγεθος 

χαρτιού. Το μέγεθος χαρτιού εμφανίζεται απευθείας σε προεπισκόπηση από το σκίτσο με το μέγεθος και τις μονάδες του. Οι 

διαθέσιμοι τύποι χαρτιού που παρέχονται στην πτυσσόμενη λίστα αποφασίζονται από την τρέχουσα διαμόρφωση. Εάν θέλετε 

να ρυθμίσετε τα πλόττερ για την εξαγωγή εικόνων ράστερ, πρέπει να καθορίσετε το μέγεθος εξόδου με pixels. Το 

μέγεθος χαρτιού μπορεί να προσαρμοστεί στο πρόγραμμα επεξεργασίας διαμόρφωσης πλόττερ. 
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12.1.5. Καθορισμός του προσανατολισμού σχεδίασης μιας διάταξης 

 
Ο προσανατολισμός του σχεδίου ταξινομείται σε Οριζόντιο και 

Πορτραίτο, οι οποίοι καθορίζουν τον προσανατολισμό σχεδίασης 

του σχεδίου που θα εμφανιστεί σε ένα χαρτί. Αφού καθορίσετε 

τον προσανατολισμό του σχεδίου, μπορείτε να ελέγξετε αν θα 

σχεδιάσετε το πάνω ή το κάτω μέρος του σχεδίου επιλέγοντας την 

επιλογή Plot Upsize-down (Σχεδίαση σε μεγέθυνση προς τα 

κάτω). Οι αλλαγές που ρυθμίζονται στο παράθυρο διαλόγου 

Page Setup εξακολουθούν να αποθηκεύονται στις διατάξεις. 

Ορισμένες ρυθμίσεις σελίδας μπορούν να αντικατασταθούν 

από προσαρμοσμένες ρυθμίσεις σχεδίασης, αλλά οι ρυθμίσεις 

δεν θα αποθηκευτούν στη διάταξη, εκτός εάν επιλέξετε την 

επιλογή Apply to Layout (Εφαρμογή στη διάταξη). 

 
12.1.6. Ρύθμιση της μετατόπισης του Plot μιας διάταξης 

 
Μπορείτε να μετατοπίσετε τη γεωμετρία στο χαρτί εισάγοντας μια θετική ή αρνητική τιμή στα πεδία X και Y Offset. Η 

αλλαγή της αρχής σχεδίασης μπορεί να αλλάξει τη θέση της σχεδίασης στα χαρτιά. Η αρχή σχεδίασης εντοπίζεται στην 

αριστερή κάτω γωνία της περιοχής σχεδίασης με τιμή μετατόπισης 0 σε σχέση με την κατεύθυνση X και Y. Επιλέξτε Center on 

Paper (Κέντρο στο χαρτί) εάν η καθορισμένη περιοχή σχεδίασης είναι μέρος του σχεδίου και όχι ολόκληρη η διάταξη, γεγονός 

που αλλάζει τη θέση της αρχής σχεδίασης. 

 
 

Γραφική παράσταση με αρχή (0,0) Διάγραμμα με αρχή (10,10) 
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12.1.7. Ορισμός της περιοχής σχεδίασης μιας διάταξης 

 
Μπορείτε να ορίσετε την περιοχή που θα σχεδιαστεί στο παράθυρο διαλόγου Plot. Κατά τη δημιουργία νέων διατάξεων, η 

προεπιλεγμένη επιλογή σχεδίασης είναι τα όρια σχεδίασης που σημαίνει ότι σχεδιάζονται όλα τα αντικείμενα εντός του χαρτιού 

σχεδίασης. Η αρχή σχεδίασης είναι (0,0), που βρίσκεται στην αριστερή κάτω γωνία της σελίδας. Κάντε τις ακόλουθες μεθόδους 

για να επιλέξετε μια περιοχή σχεδίασης: 

 
-Διαμόρφωση: Τοποθετεί όλα τα αντικείμενα στο χαρτί σχεδίασης. 

-Παράθυρο: Ορίζει την κλίμακα σχεδίασης για μια διάταξη, 

Σχεδιάζει οποιοδήποτε τμήμα του σχεδίου που καθορίζετε 

εντός του ορθογώνιου παραθύρου. Κάντε κλικ στο κουμπί 

Window (Παράθυρο) για να χρησιμοποιήσετε μια συσκευή 

υπόδειξης για να καθορίσετε τις απέναντι γωνίες της περιοχής 

που θα σχεδιαστεί και, στη συνέχεια, επιστρέψτε στο παράθυρο 

διαλόγου Plot (Σχεδίαση). 

-Εκτάσεις: Σχεδιάζει το τμήμα του τρέχοντος χώρου του σχεδίου 

που περιέχει αντικείμενα. 

-Οθόνη: Απεικονίζει τα περιεχόμενα που εμφανίζονται στην τρέχουσα προβολή. 

 
12.1.8. Ρύθμιση της κλίμακας σχεδίασης και βάρους γραμμής για μια διάταξη 

 
Όταν καθορίζετε μια κλίμακα για την έξοδο του σχεδίου σας, μπορείτε να επιλέξετε Προσαρμογή στο χαρτί για να 

κλιμακώσετε το σχέδιο ώστε να χωρέσει στο επιλεγμένο μέγεθος χαρτιού. Συνήθως, τα αντικείμενα στο χώρο του 

μοντέλου εμφανίζονται στην κλίμακα που έχει οριστεί στα παράθυρα προβολής διάταξης. Για να σχεδιάσετε τα 

αντικείμενα στο χώρο του μοντέλου με την κλίμακα που καθορίζεται στις προβολές διάταξης, αναθέτετε την κλίμακα σε 

1:1. Ακόμα και αν έχει ανατεθεί η κλίμακα σχεδίασης των προβολών διάταξης, είναι ενεργοποιημένη η κλίμακα του βάρους 

γραμμής σε μια συγκεκριμένη κλίμακα. Η κλιμάκωση του βάρους γραμμής δεν έχει καμία σχέση με την κλίμακα σχεδίασης κατά 

τη σχεδίαση σχεδίων, η ο π ο ί α  χρησιμοποιείται κυρίως για τις γραμμές που περιλαμβάνονται στα αντικείμενα προς 

σχεδίαση. 

 
 

 
12.1.9. Μετακίνηση και αντιγραφή διατάξεων 

 
Μπορείτε να κάνετε δεξί κλικ στην καρτέλα Διάταξη για 

να επιλέξετε την επιλογή Μετακίνηση ή Αντιγραφή, στο 

παράθυρο διαλόγου Μετακίνηση ή Αντιγραφή. Μπορείτε 

να επιλέξετε μια διάταξη που θέλετε να τοποθετήσετε 

μετά την τρέχουσα διάταξη. Για να δημιουργήσετε ένα 

αντίγραφο της τρέχουσας διάταξης, μπορείτε να επιλέξετε 

μια διάταξη και να επιλέξετε την επιλογή Δημιουργία 

αντιγράφου, η αντιγραμμένη διάταξη θα 

θέση πριν από τη διάταξη που επιλέξατε. Θα πρέπει να παρατηρήσετε ότι η καρτέλα Μοντέλο δεν μπορεί να μετακινηθεί ή να αντιγραφεί. 
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12.1.10. Δημιουργία διάταξης από πρότυπο 

 
Κάντε δεξί κλικ στην καρτέλα Διάταξη για να επιλέξετε την 

επιλογή από πρότυπο για να εισαγάγετε απευθείας 

αρχείο DWG ή DWT, χρησιμοποιώντας τις πληροφορίες 

του υπάρχοντος προτύπου για να δημιουργήσετε νέες 

διατάξεις. Το σύστημα παρέχει αρχείο προτύπου με 

όνομα επέκτασης .dwt. Διάταξη 

πρότυπα από οποιαδήποτε πρότυπα σχεδίων μπορούν να εισαχθούν στο τρέχον 

σχέδιο. Για να δημιουργήσετε μια νέα διάταξη από ένα υπάρχον αρχείο: 

1. Επιλέξτε Εισαγωγή>Διάταξη>Διάταξη από πρότυπο 

2. Στο παράθυρο διαλόγου, επιλέξτε το επιθυμητό αρχείο προτύπου και, στη συνέχεια, κάντε κλικ στο κουμπί Άνοιγμα. Στο 

παράθυρο διαλόγου Insert Layout(s) (Εισαγωγή διάταξης(ων)), επιλέξτε τη διάταξη(ες) που θέλετε να εισαγάγετε και, στη 

συνέχεια, κάντε κλικ στο κουμπί OK. Μπορείτε να επιλέξετε πολλαπλές διατάξεις κρατώντας πατημένο το Ctrl ενώ 

επιλέγετε τα ονόματα των διατάξεων. 

 
12.1.11. Δημιουργία και τροποποίηση θυρίδων προβολής διάταξης 

 
Στην καρτέλα Διάταξη, πρέπει να δημιουργήσετε τουλάχιστον ένα παράθυρο προβολής διάταξης για να δείτε το μοντέλο σας. 

Κάθε παράθυρο προβολής διάταξης δημιουργείται ως ξεχωριστή οντότητα την οποία μπορείτε να μετακινήσετε, να 

αντιγράψετε ή να διαγράψετε. Οποιεσδήποτε αλλαγές κάνετε σε ένα παράθυρο προβολής διάταξης είναι αμέσως ορατές στα 

άλλα παράθυρα προβολής (εάν τα άλλα παράθυρα προβολής διάταξης εμφανίζουν αυτό το τμήμα του σχεδίου). Η μεγέθυνση 

ή η σάρωση στο τρέχον παράθυρο προβολής επηρεάζει μόνο αυτό το παράθυρο προβολής. 

 
Δημιουργήστε παράθυρα προβολής διάταξης: 

 
1. Στη γραμμή εντολών, πληκτρολογήστε MVIEW. 

2. Πληκτρολογήστε F (Προσαρμογή) ή δημιουργήστε 2, 3 ή 4 

παράθυρα προβολής πληκτρολογώντας 2, 3 ή 4 ξεχωριστά ή 

καθορίστε δύο αντίθετες γωνίες για να δημιουργήσετε ένα 

προσαρμοσμένο παράθυρο προβολής. 

3. Επιλέξτε τη διάταξη του παραθύρου προβολής, 

πληκτρολογώντας H (Οριζόντια) ή V (Κάθετη). 

4. Κάντε ένα από τα ακόλουθα: 

-Για να τοποθετήσετε τα παράθυρα προβολής ώστε να γεμίσουν 

την τρέχουσα περιοχή γραφικών, πληκτρολογήστε F 

(Προσαρμογή)。 -Για να τοποθετήσετε τα παράθυρα 

προβολής μέσα σε ένα ορθογώνιο πλαίσιο, καθορίστε τις 

γωνίες ενός ορθογωνίου. 
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Μπορείτε να δημιουργήσετε ένα ενιαίο παράθυρο προβολής διάταξης ή να χωρίσετε την περιοχή γραφικών σε πολλά 

παράθυρα προβολής διατεταγμένα [Οριζόντια/Κατακόρυφα/Πάνω/Κάτω/Αριστερά/Δεξιά]. 

 
Για να τροποποιήσετε τις ιδιότητες του παραθύρου προβολής διάταξης: 

 
1. Κάντε κλικ στο όριο του παραθύρου 

προβολής διάταξης, τις ιδιότητες του οποίου 

θέλετε να τροποποιήσετε. 

2. Ανοίξτε την παλέτα Ιδιότητες μέσω της 

επιλογής μενού "Εργαλεία >Παλέτες>Ιδιότητες" 

ή "Τροποποίηση > Ιδιότητες". 

3. Στην παλέτα Ιδιότητες, επιλέξτε Τυπική κλίμακα, 

και στη συνέχεια επιλέξτε μια νέα κλίμακα από τη λίστα. Η κλίμακα που επιλέγετε εφαρμόζεται στο παράθυρο προβολής. 
 

 
Ενεργοποίηση ή απενεργοποίηση των θυρών προβολής διάταξης: 

 
1. Κάντε κλικ στην επιθυμητή καρτέλα Διάταξη. 

2. Πληκτρολογήστε MVIEW και στη συνέχεια πατήστε Enter. 

3. Πληκτρολογήστε ON ή OFF. 

4. Επιλέξτε την άκρη του παραθύρου προβολής διάταξης που 

θέλετε να ενεργοποιήσετε ή να απενεργοποιήσετε και, στη 

συνέχεια, πατήστε Enter. 

 
Δημιουργία μη ορθογώνιων θυρίδων προβολής διάταξης: 

Χρησιμοποιήστε τις επιλογές Object και Polygonal του MVIEW για να δημιουργήσετε ακανόνιστα παράθυρα προβολής, 

Επιλέξτε την επιλογή Αντικείμενο για να μετατρέψετε τα αντικείμενα που δημιουργούνται 

στο χώρο χαρτιού σε παράθυρα προβολής. Ενώ επιλέγετε την επιλογή Πολυγωνική για να 

σχεδιάσετε ακανόνιστες πολυγραμμές, συμπεριλαμβανομένων τόξων και γραμμών, οι οποίες 

έχουν τη δυνατότητα είτε να τέμνονται είτε να έχουν τουλάχιστον τρεις κορυφές, η 

πολυγραμμή θα κλείσει αυτόματα. 

 
12.2. Σχέδια οικοπέδου 

 
Όταν ολοκληρωθεί ένα σχέδιο, μπορείτε να το εξάγετε χρησιμοποιώντας διάφορες μεθόδους. Μπορείτε να σχεδιάσετε το 

σχέδιο σε χαρτί ή να δημιουργήσετε ένα αρχείο για χρήση με άλλη εφαρμογή. 
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12.2.1. Ρυθμίσεις πλοκής 

 
Όταν δημιουργείτε ένα σχέδιο, κάνετε το μεγαλύτερο 

μέρος της εργασίας σας στην καρτέλα Μοντέλο. Ανά 

πάσα στιγμή μπορείτε να εκτυπώσετε το σχέδιό σας για 

να δείτε πώς φαίνεται στο χαρτί. Είναι εύκολο να 

ξεκινήσετε την εκτύπωση και στη συνέχεια να 

δημιουργήσετε αργότερα διατάξεις και προσαρμοσμένες 

ρυθμίσεις εκτύπωσης για να βελτιώσετε την 

εκτυπωμένη έκδοσή σας. 

Για να ξεκινήσετε την εκτύπωση: 

 
1. Επιλέξτε File > Plot από το κύριο μενού. 

2. Ορίστε τον εκτυπωτή και τις σχετικές παραμέτρους και, στη συνέχεια, κάντε κλικ στο OK. 
 
 

 
12.2.2. Ορισμός μεγέθους χαρτιού 

 
Μπορείτε να ορίσετε τον τύπο χαρτιού από την 

πτυσσόμενη λίστα του πλαισίου κειμένου Μέγεθος 

χαρτιού. Εάν θέλετε να ρυθμίσετε το μέγεθος χαρτιού, θα 

πρέπει πρώτα να ρυθμίσετε τα plotters, όλα τα διαθέσιμα 

plotters είναι τόσο τα plotters συστήματος των Windows που 

έχουν ρυθμιστεί όσο και τα μη συστημικά. 

 
Για να επιλέξετε εκτυπωτή ή plotter: 

 
1. Επιλέξτε File > Plot από το κύριο μενού. 

2. Από τη λίστα Name (Όνομα) στην περιοχή Printer/Plotter (Εκτυπωτής/Πλόττερ), επιλέξτε έναν εκτυπωτή ή plotter που θέλετε να χρησιμοποιήσετε 
και, στη συνέχεια, κάντε κλικ στο OK. 

 
 
 

 
12.2.3. Τοποθετήστε το σχέδιο στο χαρτί 

 
Μπορείτε να ρυθμίσετε τη θέση του σχεδίου που πρόκειται να σχεδιαστεί σε ένα 

χαρτί πριν από τη σχεδίαση. Για να καθορίσετε την προέλευση της περιοχής 

εκτύπωσης: 
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1. Εάν είναι απαραίτητο, κάντε κλικ στην επιθυμητή καρτέλα Διάταξη ή στην καρτέλα Μοντέλο. 

2. Επιλέξτε File > Plot από το κύριο μενού. 

3. Κάντε ένα από τα ακόλουθα στην περιοχή Plot Offset: 

-Για να κεντράρετε την καθορισμένη περιοχή 

εκτύπωσης στην εκτυπωμένη σελίδα, επιλέξτε το 

πλαίσιο ελέγχου Center the Plot. 

-Για να καθορίσετε μια αρχή για την περιοχή εκτύπωσης, πληκτρολογήστε τις συντεταγμένες Χ και Υ. 

4. Επιλέξτε OK και, στη συνέχεια, κάντε κλικ στο κουμπί Εφαρμογή στη διάταξη. 

 
12.2.4. Ορισμός προσανατολισμού σχεδίασης 

 
Ο προσανατολισμός του σχεδίου καθορίζει αν θα σχεδιάσετε ένα σχέδιο σε κατακόρυφο ή 

οριζόντιο προσανατολισμό. Εάν επιλέξετε Οριζόντιο, σχεδιάζει το σχέδιο 

χρησιμοποιώντας την άκρη μήκους ως οριζόντια. Ενώ επιλέγοντας Πορτραίτο για να 

σχεδιάσετε το σχέδιο χρησιμοποιώντας τη μικρή άκρη του ως οριζόντια Αλλάζοντας, 

οι προσανατολισμοί του σχεδίου είναι ακριβώς όπως η περιστροφή του χαρτιού κάτω 

από το σχέδιο. Εν τω μεταξύ, επιλέγοντας Plot upsize-down για να ελέγξετε αν θα 

εντοπίζεται το σχέδιο σε μεγέθυνση προς τα κάτω στο χαρτί. 

 
 
 
 

12.2.5. Ορισμός κλίμακας γραφικών παραστάσεων 

 
Η κλίμακα σχεδίασης του σχεδίου μπορεί να καθοριστεί 

απευθείας από την πτυσσόμενη λίστα Κλίμακα στην περιοχή 

Κλίμακα σχεδίασης του πλαισίου διαλόγου Σχεδίαση. 

Μπορείτε επίσης να 

επιλέξτε User define για να ορίσετε την επιθυμητή κλίμακα του σχεδίου 

ή επιλέξτε Fit to Paper (Προσαρμογή στο χαρτί) για να προσαρμόσετε 

το σχέδιο στο επιλεγμένο μέγεθος χαρτιού. Η κλίμακα σχεδίασης 

μαζί με τη μονάδα σχεδίασης και τη μονάδα σχεδίασης πρέπει να 

καθοριστούν πριν από τη σχεδίαση. Για παράδειγμα, εάν επιλέξετε 

το μέγεθος χαρτιού σε mm, εισάγοντας 1 κάτω από το mm και 10 

κάτω από το Units blank (Μονάδες σχεδίασης), παράγεται ένα σχέδιο 

σχεδίασης με κάθε μονάδα σχεδίασης να αντιπροσωπεύει 10 

πραγματικά χιλιοστά. 
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Για αυτόματη κλιμάκωση του σχεδίου για εκτύπωση: 

 
1. Εάν είναι απαραίτητο, κάντε κλικ στην επιθυμητή καρτέλα Διάταξη ή στην καρτέλα Μοντέλο. 

2. Επιλέξτε File > Plot από το κύριο μενού. 

3. Για να κλιμακώσετε το σχέδιο ώστε να χωρέσει σε μια εκτυπωμένη 

σελίδα, στην περιοχή Κλίμακα σχεδίασης, κάντε κλικ στην επιλογή 

Προσαρμογή στο χαρτί. 

4. Επιλέξτε Εφαρμογή στη διάταξη και κάντε κλικ στο OK. 

 
12.2.6. Ρύθμιση επιλογών γραφής 

 
Οι ακόλουθες επιλογές παρουσιάζουν μοτίβα σχεδίασης με οδηγίες για τον τρόπο σχεδίασης αντικειμένων. 

 
-Plot in Background. Καθορίζει την επεξεργασία της γραφικής παράστασης στο παρασκήνιο. 

-Plot Object Lineweights. Καθορίζει ότι σχεδιάζονται τα βάρη γραμμών που 

έχουν εκχωρηθεί σε αντικείμενα και στρώματα. 

-Plot με Plot Styles. Σχεδιάζει ένα σχέδιο με καθορισμένα στυλ σχεδίασης. 

Σχεδιάζει τα βάρη γραμμών αυτόματα μία φορά επιλέγοντας αυτήν την 

επιλογή αυτόματα. Εάν δεν επιλέξετε αυτήν την επιλογή, τα αντικείμενα 

σχεδιάζονται με τις ιδιότητες που τους έχουν εκχωρηθεί και όχι με τις 

παρακάμψεις του στυλ σχεδίασης. 

-Plot Paperspace Last. Σχεδιάζει πρώτα τη γεωμετρία του μοντέλου χώρου. 

Η γεωμετρία χώρου χαρτιού συνήθως σχεδιάζεται πριν από τη γεωμετρία 

χώρου μοντέλου. 

-Απόκρυψη αντικειμένων Paperspace. Καταστέλλει τη σχεδίαση αντικειμένων 

που βρίσκονται πίσω από άλλα αντικείμενα, ανεξάρτητα από τον τρόπο 

εμφάνισής τους στην οθόνη. Αυτή η επιλογή είναι διαθέσιμη μόνο στις 

καρτέλες Διάταξη. 

-Plot Stamp on. Τοποθετεί οριζόντια ή κατακόρυφα τις πληροφορίες σφραγίδας οικοπέδου σε μια καθορισμένη γωνία ενός 

σχεδίου. Οι ρυθμίσεις plot stamp μπορούν να αποθηκευτούν σε αρχείο καταγραφής, επίσης δεν μπορούν να 

αποθηκευτούν. 

-Αποθήκευση αλλαγών στη διάταξη. Όλες οι αλλαγές που κάνετε στο παράθυρο διαλόγου Plot θα αποθηκευτούν στη διάταξη αν κάνετε κλικ στο OK. 
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12.2.7. Καθορίστε την περιοχή που θα σχεδιάσετε 

 
Για να καθορίσετε ένα τμήμα του σχεδίου προς εκτύπωση, εάν είναι απαραίτητο, κάντε κλικ στην επιθυμητή καρτέλα Διάταξη ή στην καρτέλα 
Μοντέλο. 

 
1. Επιλέξτε File > Plot από το κύριο μενού. 

2. Στην περιοχή Περιοχή εκτύπωσης, κάντε κλικ σε ένα από τα ακόλουθα: 

-Εμφάνιση - Τοποθετεί την τρέχουσα προβολή στην οθόνη. 

-Εκτάσεις - Τοποθετεί τα περιεχόμενα εντός των καθορισμένων εκτάσεων σχεδίασης. 

-Όρια/Διάταξη - Τοποθετεί τα περιεχόμενα εντός των 

καθορισμένων ορίων σχεδίασης ή οντοτήτων στην εκτυπώσιμη 

περιοχή. 

-Window - Σχεδιάζει το τμήμα του σχεδίου που περιέχεται στο 

καθορισμένο παράθυρο. Κάντε κλικ στο κουμπί Window 

(Παράθυρο) για να χρησιμοποιήσετε μια συσκευή υπόδειξης για 

να καθορίσετε τις απέναντι γωνίες της περιοχής που θα σχεδιαστεί 

και, στη συνέχεια, επιστρέψτε στο παράθυρο διαλόγου Plot 

(Σχεδίαση). 

3. Επιλέξτε Εφαρμογή στη διάταξη και κάντε κλικ στο OK. 
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12.2.8. Προεπισκόπηση πλοκής 

 
Η προβολή ενός σχεδίου πριν από την εκτύπωση σας δίνει μια προεπισκόπηση του πώς θα είναι το σχέδιό 

σας όταν εκτυπωθεί. Για να κάνετε προεπισκόπηση ενός σχεδίου πριν από την εκτύπωση: 

1. Εάν είναι απαραίτητο, κάντε κλικ στην επιθυμητή καρτέλα Διάταξη ή στην καρτέλα Μοντέλο. 

2. Επιλέξτε File > Plot Preview από το κύριο μενού. 

3. Κάντε ένα από τα ακόλουθα: 

-Για να εκτυπώσετε το σχέδιο, κάντε κλικ στην προεπισκόπηση και 

κάντε κλικ στην επιλογή Σχέδιο στην επάνω αριστερή γωνία της 

προεπισκόπησης εκτύπωσης. 

-Για να επιστρέψετε στο σχέδιο, κάντε κλικ στο κουμπί απενεργοποίησης ή πατήστε Esc. 
 
 
 

 
12.2.9. Χρήση στυλ πλοκής 

 
Τα στυλ σχεδίασης σάς βοηθούν να ελέγχετε πώς θα φαίνεται το σχέδιό σας όταν εκτυπώνεται. Επειδή τα στυλ σχεδίασης 

αποθηκεύονται σε πίνακες στυλ σχεδίασης, τα οποία είναι αρχεία που βρίσκονται στον υπολογιστή σας, μπορείτε να τα 

επαναχρησιμοποιήσετε για να εξαλείψετε την ανάγκη επαναδιαμόρφωσης των ρυθμίσεων εκτύπωσης κάθε φορά που 

εκτυπώνετε ένα σχέδιο. Ένα σχέδιο μπορεί να χρησιμοποιεί έναν τύπο πίνακα στυλ σχεδίασης κάθε φορά. Υπάρχουν δύο 

τύποι πινάκων στυλ σχεδίασης: 

-Οι πίνακες στυλ σχεδίασης που εξαρτώνται από το χρώμα (CTB) περιέχουν μια συλλογή από 

στυλ σχεδίασης που βασίζονται σε καθένα από τα 255 χρώματα δείκτη που είναι διαθέσιμα σε 

ένα σχέδιο.-Οι πίνακες στυλ σχεδίασης με όνομα (STB) περιέχουν μια συλλογή από στυλ 

σχεδίασης που ορίζετε εσείς. Μπορούν να διαφέρουν ανεξάρτητα από το χρώμα. 

 
Για να εκχωρήσετε πίνακες στυλ σχεδίασης:1. Εάν είναι απαραίτητο, κάντε κλικ στην επιθυμητή καρτέλα Διάταξη ή κάντε κλικ στην καρτέλα Μοντέλο. 

2. Επιλέξτε File > Plot από το κύριο μενού. 

3. Στην περιοχή Πίνακας στυλ σχεδίασης (εκχωρήσεις στυλό), επιλέξτε έναν πίνακα στυλ σχεδίασης σε ένα από τα ακόλουθα: 

-Καμία: Εφαρμόζει κανέναν πίνακα στυλ σχεδίασης. Τα αντικείμενα σχεδιάζονται σύμφωνα με τις δικές τους ιδιότητες. 

-Μονοχρωμία: Μαύρο: Σχεδιάζει όλα τα χρώματα ως μαύρο. 

-Νέο: Δημιουργεί έναν νέο πίνακα στυλ σχεδίασης. 

4. Επιλέξτε Αποθήκευση αλλαγών στη διάταξη και, στη συνέχεια, κάντε κλικ στο κουμπί Εφαρμογή στη διάταξη. 

 

 

 

 

 

 

 

 

 



Κεφάλαιο 12_ Διάταξη, σχεδίαση και δημοσίευση σχεδίου 
 

Σ ε λ ί δ α  201 | 296  

 
Για να τροποποιήσετε τους πίνακες στυλ γραφικών παραστάσεων: 

 
1. Επιλέξτε File > Plot από το κύριο μενού. 

2. Στην περιοχή Πίνακας στυλ σχεδίασης (αναθέσεις στυλό), κάντε κλικ στον πίνακα στυλ σχεδίασης που θέλετε να 

τροποποιήσετε και, στη συνέχεια, κάντε κλικ στο κουμπί για να εμφανιστεί το "Plot Style Table Editor". 

3. Κάντε κλικ στην καρτέλα General (Γενικά) του Plot Style Table Editor και, στη συνέχεια, κάντε ένα από τα ακόλουθα: 

-Εισάγετε μια νέα περιγραφή στυλ πλοκής. 

-Επιλέξτε Apply global scale factor to non-ISO linetypes για να εφαρμόσετε τον συντελεστή κλίμακας. 

-Εισάγετε έναν συντελεστή κλίμακας για την εφαρμογή σε τύπους γραμμών μη 

ISO που χρησιμοποιούνται για οποιοδήποτε στυλ σχεδίασης στον τρέχοντα 

πίνακα στυλ σχεδίασης. 

 

 

 

 

 

 

 
4. Κάντε κλικ στην καρτέλα Προβολή φόρμας και, στη συνέχεια, κάντε ένα από τα ακόλουθα: 

-Πραγματοποιήστε αλλαγές σε ένα στυλ σχεδίασης που εξαρτάται από το χρώμα, 

επιλέγοντάς το στη λίστα Σχεδιάγραμμα και, στη συνέχεια, κάντε αλλαγές στο χρώμα, 

τον τύπο γραμμής ή το βάρος γραμμής για το στυλ σχεδίασης στην περιοχή Ιδιότητες. 

Οι αλλαγές σας αποθηκεύονται αυτόματα για το επιλεγμένο στυλ σχεδίασης. 

-Πραγματοποιήστε αλλαγές σε ένα στυλ σχεδίασης με όνομα επιλέγοντάς το στη 

λίστα Σχεδιάγραμμα και, στη συνέχεια, κάντε αλλαγές στο χρώμα, τον τύπο γραμμής 

ή το βάρος γραμμής για το στυλ σχεδίασης στην περιοχή Ιδιότητες. Οι αλλαγές σας 

αποθηκεύονται αυτόματα για το επιλεγμένο στυλ σχεδίασης. 

-Προσθέστε ένα νέο στυλ σχεδίασης κάνοντας κλικ στο κουμπί Προσθήκη στυλ. 

Εισάγετε ένα νέο όνομα και, στη συνέχεια, κάντε κλικ στο OK. Επιλέξτε τις 

επιλογές για το στυλ σχεδίασης. (Διαθέσιμο μόνο για στυλ σχεδίασης με όνομα). 

-Διαγράψτε ένα στυλ σχεδίασης επιλέγοντάς το στη λίστα σχεδίασης και, στη 

συνέχεια, κάντε κλικ στην επιλογή Διαγραφή στυλ. (Διαθέσιμο μόνο για στυλ 

σχεδίασης με όνομα). 

 
5. Κάντε κλικ στο OK. 

 

 
12.2.10. Αρχεία Plot σε άλλες μορφές 

 
Τα αρχεία πλοκής έχουν διάφορες μορφές. Μπορείτε να εξάγετε σχέδια σε οποιεσδήποτε μορφές εικόνας με μοναδικό 
πρόγραμμα οδήγησης plotter. 
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12.2.11. Δημοσίευση σχεδίων 

 
Καθορίζει φύλλα σχεδίασης τα οποία μπορείτε να συναρμολογήσετε, να αναδιατάξετε, να μετονομάσετε, να αντιγράψετε και 

να αποθηκεύσετε για δημοσίευση ως σετ σχεδίασης πολλαπλών φύλλων. Μπορείτε να δημοσιεύσετε το σύνολο σχεδίων σε 

ένα αρχείο DWF, DWFx ή PDF ή να το στείλετε στο plotter που έχει οριστεί στη ρύθμιση σελίδας για έξοδο σε έντυπη 

μορφή ή ως αρχείο plot. Στο πλαίσιο διαλόγου δημοσίευσης εμφανίζονται οι ακόλουθες επιλογές: 

 

1. Κουμπί Load Sheet List: Εμφανίζει το παράθυρο διαλόγου Load Sheet List, στο οποίο μπορείτε να επιλέξετε 

ένα αρχείο DSD ή ένα αρχείο BP3 (Batch Plot) για φόρτωση. 

2. Αποθήκευση λίστας φύλλων Κουμπί: Εμφανίζει το παράθυρο διαλόγου Αποθήκευση λίστας ως, στο οποίο 

μπορείτε να αποθηκεύσετε την τρέχουσα λίστα σχεδίων ως αρχείο DSD. 

3. Λίστα φύλλων: Εμφανίζει το τρέχον αρχείο συνόλου σχεδίων (DSD) ή παρτίδας (BP3).  

4. Δημοσίευση σε: Καθορίζει τον τρόπο δημοσίευσης της λίστας των φύλλων. Μπορείτε να δημοσιεύσετε είτε σε 

ένα αρχείο DWF, DWFx ή PDF πολλαπλών φύλλων. 

5. Αυτόματη φόρτωση όλων των ανοιχτών σχεδίων: Τα περιεχόμενα όλων των ανοικτών εγγράφων φορτώνονται 

αυτόματα στη λίστα δημοσιεύσεων. 

6. Κουμπί Προσθήκη φύλλων: Εμφανίζει το παράθυρο διαλόγου Επιλογή σχεδίων, στο οποίο μπορείτε να 

επιλέξετε σχέδια για να τα προσθέσετε στο κατάλογος φύλλων σχεδίασης. 

7. Αφαίρεση φύλλων Κουμπί: Διαγράφει τα επιλεγμένα φύλλα σχεδίασης από τη λίστα φύλλων. 

8. Μετακίνηση φύλλου προς τα πάνω Κουμπί: Μετακινεί τα επιλεγμένα φύλλα σχεδίασης μία θέση επάνω στη 

λίστα. 

9. Μετακίνηση φύλλου προς τα κάτω Κουμπί: Μετακινεί τα επιλεγμένα φύλλα σχεδίασης μια θέση κάτω στη 

λίστα. 

10. Κουμπί προεπισκόπησης: Εμφανίζει το σχέδιο όπως θα εμφανιστεί όταν σχεδιαστεί σε χαρτί εκτελώντας την 

εντολή PREVIEW. 

11. Όνομα φύλλου: Συνδυάζει το όνομα του σχεδίου και το όνομα της διάταξης με μια παύλα (-). 

12. Page Setup/3D DWF:Εμφανίζει την ονομαστική ρύθμιση σελίδας για το φύλλο. Μπορείτε να αλλάξετε τη 

ρύθμιση σελίδας κάνοντας κλικ στο όνομα της ρύθμισης σελίδας και επιλέγοντας μια άλλη ρύθμιση σελίδας 

από τη λίστα 

13. Κατάσταση: Εμφανίζει την κατάσταση του φύλλου όταν αυτό φορτώνεται στη λίστα φύλλων. 

14. 14/15.Εμφάνιση και επιλογή λεπτομερειών φύλλου: Εμφανίζει και αποκρύπτει τις περιοχές Selected Sheet 

Information (Πληροφορίες επιλεγμένου φύλλου) και Selected Page Setup Information (Πληροφορίες 

επιλεγμένης σελίδας).  

15. Επιλογές δημοσίευσης: Ανοίγει το το παράθυρο διαλόγου Επιλογές δημοσίευσης, στο οποίο μπορείτε να 

καθορίσετε τις επιλογές για τη δημοσίευση. 

16. Αριθμός αντιτύπων: Καθορίζει τον αριθμό των αντιγράφων που θα δημοσιευτούν. 

17. Ακρίβεια: Βελτιστοποιεί τα dpi των αρχείων DWF, DWFx και PDF για τον τομέα σας: κατασκευή, αρχιτεκτονική 

ή πολιτικός μηχανικός. 

18. Συμπεριλάβετε τη σφραγίδα οικοπέδου: Τοποθετεί μια σφραγίδα σε μια καθορισμένη γωνία κάθε σχεδίου και 

την καταγράφει σε ένα αρχείο. 

19. Ρυθμίσεις σφραγίδας οικοπέδου: Εμφανίζει το το πλαίσιο διαλόγου Plot StampPlot Stamp Settings Dialog Box, 

στο οποίο μπορείτε να καθορίσετε τις πληροφορίες, όπως το όνομα του σχεδίου και την κλίμακα του 

οικοπέδου που θέλετε να εφαρμοστεί στη σφραγίδα του οικοπέδου. 

20. Δημοσίευση στο παρασκήνιο: Ενεργοποιεί τη δημοσίευση στο παρασκήνιο για τα επιλεγμένα φύλλα. 
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21. Αποστολή των φύλλων στον εκτυπωτή με αντίστροφη σειρά: Όταν είναι επιλεγμένο, στέλνει τα φύλλα στο  

 

22. πλόττερ με αντίστροφη σειρά από την προεπιλεγμένη. Αυτή η επιλογή είναι διαθέσιμη μόνο εάν έχει επιλεγεί 

η επιλογή Plotter Named in Page Setup (Ονόματα πλόττερ στη ρύθμιση σελίδων). 

23. Ανοίξτε στο πρόγραμμα προβολής όταν Τελειώσει: Όταν ολοκληρωθεί η δημοσίευση, το αρχείο DWF, DWFx ή 

PDF θα ανοίξει σε μια εφαρμογή προβολής. 
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13. Δημιουργία και επεξεργασία δυναμικών μπλοκ 

 
Οι δυναμικές αναφορές μπλοκ περιέχουν λαβές ή προσαρμοσμένες ιδιότητες που αλλάζουν τον τρόπο με τον οποίο η αναφορά 

εμφανίζεται στο σχέδιο μετά την εισαγωγή της. Τα δυναμικά μπλοκ σας επιτρέπουν να εισάγετε ένα μπλοκ που μπορεί να 

αλλάξει σχήμα, μέγεθος ή διαμόρφωση, αντί να εισάγετε έναν από τους πολλούς ορισμούς στατικών μπλοκ. 

Ορισμένα δυναμικά μπλοκ ορίζονται έτσι ώστε η γεωμετρία εντός του μπλοκ να μπορεί να επεξεργαστεί μόνο σε 

ορισμένα μεγέθη που καθορίζονται στον ορισμό του μπλοκ. Όταν χρησιμοποιείτε μια λαβή για να επεξεργαστείτε την 

αναφορά του μπλοκ, εμφανίζονται σημάδια επιλογής στις θέσεις των έγκυρων τιμών για την αναφορά του μπλοκ. Εάν αλλάξετε 

την τιμή μιας ιδιότητας του μπλοκ σε τιμή διαφορετική από αυτήν που καθορίζεται στον ορισμό, η παράμετρος θα προσαρμοστεί 

στην πλησιέστερη έγκυρη τιμή. 

 
13.1. Δυναμικός επεξεργαστής μπλοκ 

 
Μπορείτε να αποκτήσετε πρόσβαση στον επεξεργαστή μπλοκ πληκτρολογώντας την εντολή edit ή κάνοντας διπλό κλικ στο μπλοκ 

χωρίς χαρακτηριστικό. Η διεπαφή της κορδέλας Block Editor θα εμφανιστεί όπως παρακάτω, τα μαύρα βέλη σηματοδοτούν τη 

στάση για τις παραμέτρους, ενώ ο κίτρινος φωτισμός είναι το σύμβολο για τη δράση. Θα αναδυθούν γραμμές εργαλείων σε 

μια κλασική διεπαφή. 

 

 
 

13.1.1. Πίνακες εργαλείων δυναμικού επεξεργαστή μπλοκ 

 
Η χρήση των εργαλείων σε αυτόν τον πίνακα εργαλείων για τον ορισμό, την επεξεργασία και την τροποποίηση των ορισμών 
δυναμικών μπλοκ , το καθιστά πολύ βολικό και γρήγορο. 

 

Διαχείριση 

Αποθήκευση ή Αποθήκευση ως προεπιλεγμένο μπλοκ; 
Δημιουργία ή επεξεργασία άλλου μπλοκ. 

μπλοκ. 
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Εργαλείο 

Ορισμός, επεξεργασία ή ενημέρωση του χαρακτηριστικού 
μπλοκ. 

 

 
Παράμετρος 

Μπορείτε να προσθέσετε παραμέτρους για δυναμικά 
μπλοκ σε αυτό το πάνελ. 

 

 
Δράση 

Μπορείτε να προσθέσετε ενέργειες για δυναμικά μπλοκ σε 
αυτό το πάνελ. 

 

 
 
 

 
13.1.2. Παράμετροι 

Σετ παραμέτρων 

Μπορείτε να προσθέσετε το σύνολο παραμέτρων σε αυτόν 
τον πίνακα. 

 

 
 
 

 
Ορατότητα 

Αυτός ο πίνακας χρησιμοποιείται ειδικά για την 
επεξεργασία της ορατότητας. 

 

 
Κλείστε το 

Χρησιμοποιείται για την έξοδο από τον επεξεργαστή μπλοκ. 

Πριν από την έξοδο, ορισμένες εντολές όπως αποθήκευση ή 

άνοιγμα κ.λπ. μπορεί να μην λειτουργούν. 

 

 
Ορίστε προσαρμοσμένες ιδιότητες για το δυναμικό μπλοκ, καθορίζοντας θέσεις, αποστάσεις και γωνίες για τη γεωμετρία 

στο μπλοκ. Προσθέτετε παραμέτρους σε έναν ορισμό δυναμικού μπλοκ στον επεξεργαστή μπλοκ. Στο Block Editor, οι 

παράμετροι έχουν εμφάνιση παρόμοια με τις διαστάσεις. Οι παράμετροι καθορίζουν προσαρμοσμένες ιδιότητες για το 

μπλοκ. Οι παράμετροι καθορίζουν επίσης θέσεις, αποστάσεις και γωνίες για τη γεωμετρία στην αναφορά του μπλοκ. Όταν 

προσθέτετε μια παράμετρο σε έναν ορισμό δυναμικού μπλοκ, η παράμετρος ορίζει μία ή περισσότερες προσαρμοσμένες 

ιδιότητες για το μπλοκ. 

 
Ο ορισμός ενός δυναμικού μπλοκ πρέπει να περιέχει τουλάχιστον μία παράμετρο. Όταν μια παράμετρος προστίθεται σε έναν 

ορισμό δυναμικού μπλοκ, προστίθενται αυτόματα οι λαβές που σχετίζονται με τα βασικά σημεία της παραμέτρου. Στη 

συνέχεια, πρέπει να προσθέσετε μια ενέργεια στον ορισμό μπλοκ και να συσχετίσετε την ενέργεια με μια παράμετρο. 

 
Οι παράμετροι καθορίζουν και περιορίζουν επίσης τιμές που επηρεάζουν τη συμπεριφορά της δυναμικής αναφοράς μπλοκ σε 

ένα σχέδιο. Ορισμένες παράμετροι μπορούν να έχουν ένα σταθερό σύνολο τιμών, ελάχιστες και μέγιστες τιμές ή τιμές 

προσαύξησης. Για παράδειγμα, μια γραμμική παράμετρος που χρησιμοποιείται σε ένα μπλοκ παραθύρου μπορεί να έχει το 

ακόλουθο σταθερό σύνολο τιμών: 10, 20, 30 και 40. Όταν η αναφορά του μπλοκ εισάγεται σε ένα σχέδιο, μπορείτε να αλλάξετε 

το παράθυρο μόνο σε μία από αυτές τις τιμές. Η προσθήκη ενός συνόλου τιμών σε μια παράμετρο σας επιτρέπει να 

περιορίσετε τον τρόπο με τον οποίο γίνεται χειρισμός της αναφοράς μπλοκ σε ένα σχέδιο. 
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Εικονίδιο παραμέτρου σημείου:  

Εντολή: BParameter→O 

Καθορίζει μια θέση Χ και Υ στο σχέδιο. Μια παράμετρος σημείου μπορεί να συσχετιστεί με μια ενέργεια μετακίνησης ή έκτασης. 

 

Γραμμική παράμετρος 

 
Εικόνα: 

Εντολή: BParameter→L 

Εμφανίζει την απόσταση μεταξύ δύο σημείων αγκύρωσης. Περιορίζει την κίνηση της λαβής κατά μήκος μιας προκαθορισμένης 

γωνίας. Μια γραμμική παράμετρος μπορεί να συσχετιστεί με μια ενέργεια μετακίνησης, έκτασης, κλίμακας ή συστοιχίας. 

Εικονίδιο πολικής παραμέτρου:  

Εντολή: BParameter→P 

Εμφανίζει την απόσταση μεταξύ δύο σημείων αγκύρωσης και εμφανίζει μια τιμή γωνίας. Μπορείτε να χρησιμοποιήσετε και τις 

δύο λαβές και την παλέτα Ιδιότητες για να αλλάξετε τόσο την τιμή της απόστασης όσο και τη γωνία. Μια πολική 

παράμετρος μπορεί να συσχετιστεί με μια ενέργεια μετακίνησης, κλίμακας, έκτασης, πολικής έκτασης ή συστοιχίας. 

Εικονίδιο παραμέτρου XY:  

Εντολή: BParameter→X 

Εμφανίζει τις αποστάσεις Χ και Υ από το σημείο βάσης της παραμέτρου. Μπορεί να συσχετιστεί με μια ενέργεια μετακίνησης, 

κλίμακας, έκτασης ή συστοιχίας. 

 

Εικονίδιο παραμέτρου περιστροφής:  

Εντολή: BParameter→R 

Ορίζει μια γωνία. Η γωνία περιστροφής μπορεί να έχει οποιαδήποτε τιμή ή να οριστεί σε ένα εύρος ή μια καθορισμένη τιμή. 

 

Εικονίδιο παραμέτρου ευθυγράμμισης:  

Εντολή: BParameter→A 

Ορίζει μια θέση Χ και Υ και μια γωνία. Μια παράμετρος ευθυγράμμισης ισχύει πάντα για ολόκληρο το μπλοκ και δεν χρειάζεται 

δράση που σχετίζεται με αυτό. Μια παράμετρος ευθυγράμμισης επιτρέπει στην αναφορά μπλοκ να περιστρέφεται αυτόματα 

γύρω από ένα σημείο για να ευθυγραμμιστεί με ένα άλλο αντικείμενο στο σχέδιο. Μια παράμετρος ευθυγράμμισης 

επηρεάζει την ιδιότητα περιστροφής του μπλοκ. 

 
Παράμετρος Flip 

 
Εικόνα: 

Εντολή: BParameter→F 

Μια παράμετρος flip αναποδογυρίζει τα αντικείμενα. Μπορείτε να συσχετίσετε μια παράμετρο flip με μια ενέργεια flip. 
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Παράμετρος ορατότητας 

 
Εικόνα: 

Εντολή: BParameter→V 

Ελέγχει την ορατότητα των αντικειμένων στο μπλοκ. Μια παράμετρος ορατότητας ισχύει πάντα για ολόκληρο το μπλοκ και 

δεν χρειάζεται καμία ενέργεια που να σχετίζεται με αυτήν. Σε ένα σχέδιο, κάνετε κλικ στη λαβή για να εμφανίσετε μια λίστα με 

τις καταστάσεις ορατότητας που είναι διαθέσιμες για την αναφορά του μπλοκ. 

Εικονίδιο παραμέτρου αναζήτησης: 

Εντολή: BParameter→K 

Καθορίζει μια προσαρμοσμένη ιδιότητα που μπορείτε να καθορίσετε ή να ορίσετε για να αξιολογήσετε μια τιμή από μια 

λίστα ή έναν πίνακα που ορίζετε. Μπορεί να συσχετιστεί με ένα μόνο lookup grip. Στην αναφορά μπλοκ, κάνετε κλικ στη λαβή 

για να εμφανίσετε μια λίστα με τις διαθέσιμες τιμές. Μπορείτε να συσχετίσετε μια παράμετρο αναζήτησης με μια 

ενέργεια αναζήτησης. 

Εικονίδιο παραμέτρου σημείου βάσης: 

Εντολή: BParameter→B 

Ορίζει ένα σημείο βάσης για την αναφορά του δυναμικού μπλοκ σε σχέση με τη γεωμετρία του μπλοκ. Δεν μπορεί να συσχετιστεί 

με καμία ενέργεια, αλλά μπορεί να ανήκει στο σύνολο επιλογής μιας ενέργειας. 
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13.1.3. Δράσεις 

 
Οι ενέργειες καθορίζουν τον τρόπο με τον οποίο η γεωμετρία ενός δυναμικού μπλοκ αναφοράς θα μετακινείται ή θα αλλάζει 

όταν οι προσαρμοσμένες ιδιότητες του μπλοκ αναφοράς χειρίζονται σε ένα σχέδιο.

 



Κεφάλαιο 13_ Δημιουργία και επεξεργασία δυναμικών μπλοκ 
 

Σ ε λ ί δ α  210 | 296  

 
 

 
13.1.4. Τα γενικά βήματα της δημιουργίας ενός δυναμικού ορισμού μπλοκ 

 
Για να αποκτήσουμε έναν ορισμό δυναμικού μπλοκ, να βελτιώσουμε την αποτελεσματικότητα της επεξεργασίας μπλοκ και να 

αποφύγουμε τις επαναλαμβανόμενες τροποποιήσεις, μπορούμε να δημιουργήσουμε ένα δυναμικό μπλοκ με τα 

ακόλουθα βήματα. 

 

Μετακίνηση  ICommand:BActionTool→M 

Μια ενέργεια μετακίνησης προκαλεί τη μετακίνηση αντικειμένων σε μια καθορισμένη απόσταση και γωνία, όπως ένα 

σημείο, μια γραμμική, μια πολική, μια παράμετρος XY κ.λπ., μετακινεί όλα τα αντικείμενα σε ένα σύνολο επιλογής προς 

μια/κάθε κατεύθυνση. 

Κλίμακα
 
 Εντολή:BActionTool→S 

Μια ενέργεια κλίμακας, όπως μια γραμμική, μια πολική, μια παράμετρος XY κ.ο.κ., κλιμακώνει τα επιλεγμένα αντικείμενα προς 

την κατεύθυνση της παραμέτρου. Οι χρήστες μπορούν να χειριστούν τις λαβές με διαφορετικό τρόπο αλλάζοντας τις 

ιδιότητες και τις τιμές στην παλέτα Properties (Ιδιότητες). 

Stretch   

Εντολή:BActionTool→TA stretch action προκαλεί τη μετακίνηση και το τέντωμα των αντικειμένων κατά μια καθορισμένη 

απόσταση σε μια καθορισμένη θέση. Μια ενέργεια τεντώματος που σχετίζεται με ένα σημείο, μια γραμμική, μια πολική, 

μια παράμετρο XY κ.λπ. 

 
Polar Stretch 

Εντολή:BParameter→PIn A 

Η ενέργεια polar stretch περιστρέφει, μετακινεί και τεντώνει τα αντικείμενα κατά μια καθορισμένη γωνία και απόσταση, όταν 

το σημείο κλειδί στοΗ σχετική πολική παράμετρος αλλάζει μέσω μιας λαβής ή της παλέτας Ιδιότητες.Μια ενέργεια πολικής 

έκτασης μπορεί να εφαρμοστεί μόνο σε μια πολική παράμετρο. 

Περιστροφή   Εντολή:BActionTool→P 

Μια ενέργεια περιστροφής συνδέεται πάντα με μια παράμετρο περιστροφής. Τα επιλεγμένα αντικείμενα μπορούν να 

περιστραφούν ελεύθερα ή ο τρόπος χειρισμού των λαβών είναι διαφορετικός στην παλέτα Ιδιότητες. 

 
Εντολή Flip:BActionTool→F 

Μια ενέργεια αναστροφής συνδέεται πάντα με μια παράμετρο αναστροφής. 

 

Συστοιχία
 
 Εντολή:BActionTool→A 

Μια ενέργεια συστοιχίας σχετίζεται με μια γραμμική, μια πολική, μια παράμετρο XY, κ.λπ., αντιγράφει και συστοιχίζει 

επιλεγμένα αντικείμενα με διαφορετικό τρόπο. 

Αναζήτηση   Εντολή:BActionTool→L 

Μια ενέργεια αναζήτησης μπορεί να συσχετιστεί μόνο με μια παράμετρο αναζήτησης. 

 

 

 



Κεφάλαιο 13_ Δημιουργία και επεξεργασία δυναμικών μπλοκ 
 

Σ ε λ ί δ α  211 | 296  

 

 

Βήμα1: Σχεδιασμός 

Πριν από τη δημιουργία του Δυναμικού Μπλοκ, είναι απαραίτητο να σχεδιάσετε το Δυναμικό Μπλοκ, να σχεδιάσετε τις 

λειτουργίες, την εμφάνιση, τη μέθοδο σχεδίασης και τις απαιτούμενες παραμέτρους και ενέργειες που απαιτούνται για την 

επίτευξη των μελλοντικών λειτουργιών. 

 
Βήμα2: Σχεδιάστε γεωμετρικό σχήμα 

Το βασικό εικονοστοιχείο που περιλαμβάνεται κατά τη διάρκεια της δυναμικής σχεδίασης, φυσικά, μπορείτε να σχεδιάσετε 
αυτά τα εικονοστοιχεία στο Block Editor. 

 
Βήμα3: Προσθήκη παραμέτρου και ενέργειας 

Αυτό είναι το πιο κρίσιμο βήμα κατά τη δημιουργία του Dynamic Block. Όταν επεξεργάζεστε την Παράμετρο και τη Δράση, δεν 

εξετάζετε μόνο την επίτευξη της Παραμέτρου και της Δράσης, αλλά και την αναγνωσιμότητα του Δυναμικού Μπλοκ και την 

ευκολία της Τροποποίησης, αφήστε το σημείο δράσης της Παραμέτρου να συνδεθεί με το αντίστοιχο εικονοστοιχείο όσο το 

δυνατόν περισσότερο και τοποθετήστε τη Δράση κοντά στη σχετική παράμετρο, εάν υπάρχουν περισσότερες Παράμετροι και 

Δράσεις, πρέπει ακόμα να μετονομαστούν για την κατανόηση, την επεξεργασία και την Τροποποίηση. 

Βήμα4: Δοκιμή δυναμικού μπλοκ 

Αποθηκεύστε και βγείτε από τον επεξεργαστή μπλοκ, ξεκινήστε τη δοκιμή δυναμικού μπλοκ για να ελέγξετε αν φτάνει στο μελλοντικό αποτέλεσμα. 

 
13.2. Δείγματα δημιουργίας δυναμικών μπλοκ 

 
Δείτε τι μπορείτε να κάνετε μέσα από το Dynamic Block Editor και αξιοποιήστε στο έπακρο το σχέδιό σας. Δείτε τα ακόλουθα δείγματα: 

 
13.2.1. Παράμετρος σημείου βάσης 

 
Παρόλο που η πλειονότητα των παραμέτρων λαμβάνεται υπόψη μόνο όταν οι λειτουργίες 

αντιστοιχίζονται με ενέργειες, υπάρχουν εξαιρέσεις, η παράμετρος του σημείου βάσης είναι 

μία από αυτές. 

 

 

 
1. Ορίστε τα μπλοκ: Ορίστε μπλοκ και σχεδιάστε έναν κύκλο στον επεξεργαστή μπλοκ, όπως φαίνεται στην εικόνα. 

 
 

 
2. Προσθέστε το σημείο βάσης: Κάντε κλικ στην παράμετρο "σημείο βάσης" στον πίνακα παραμέτρων, τοποθετήστε την 

παράμετρο στο κέντρο του κύκλου σύμφωνα με την προτροπή του συστήματος, όπως φαίνεται στην παρακάτω εικόνα. 
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3. Εισαγωγή μπλοκ: Αποθήκευση και έξοδος από τον επεξεργαστή μπλοκ, 

εισαγωγή του μπλοκ στο μοντέλο. Μπορείτε να συνειδητοποιήσετε ότι το 

σημείο βάσης γίνεται το σημείο εισαγωγής του μπλοκ μετά την προσθήκη 

της παραμέτρου του σημείου βάσης. Λάβετε υπόψη, εάν ορίσετε ένα σημείο 

εισαγωγής μέσω του πλαισίου διαλόγου ορισμού μπλοκ και προσθέσετε επίσης 

μια παράμετρο σημείου βάσης, το σημείο βάσης είναι το προεπιλεγμένο σημείο 

εισαγωγής. 

 
 
 

 
13.2.2. Ορατότητα 

 
Χρησιμοποιώντας τη λειτουργία Παράμετρος ορατότητας, μπορείτε να ελέγχετε την εμφάνιση και την απόκρυψη μιας 
συγκεκριμένης προβολής στο δυναμικό μπλοκ. 

 
1. Προετοιμάστε την προβολή: Προετοιμάστε μια προβολή τριών αυτοκινήτων και ορίστε την ως μπλοκ. 

 

 

 
2. Προσθήκη παραμέτρου ορατότητας: Κάντε διπλό κλικ στο μπλοκ ή κάντε δεξί κλικ στο μενού, κάντε κλικ στο κουμπί 

Ορατότητα της παραμέτρου στον πίνακα παραμέτρων, ορίστε τη θέση της παραμέτρου σύμφωνα με την προτροπή του 

συστήματος, όπως φαίνεται παρακάτω. 
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3. Επεξεργαστείτε τις καταστάσεις ορατότητας: Θα εμφανιστεί το παράθυρο διαλόγου Καταστάσεις ορατότητας. Στο 

πλαίσιο διαλόγου, μπορείτε να μετονομάσετε, να δημιουργήσετε νέες και να καταργήσετε τις καταστάσεις ορατότητας. Για να 

ελέγξουμε την ορατότητα της προβολής τριών αυτοκινήτων σε αυτό το παράδειγμα, κάνουμε κλικ στο new για τις τρεις 

καταστάσεις ορατότητας, όπως φαίνεται στην ακόλουθη εικόνα. 

 
Κάντε κλικ στο ακόλουθο κουμπί όπως φαίνεται στην εικόνα και επιλέξτε roadster στο πτυσσόμενο μενού. 

 

 
Κάντε κλικ στο κουμπί "Αορατότητα" στον πίνακα εργαλείων ορατότητας, επιλέξτε το 

φορτηγό και το αυτοκίνητο και κάντε τα αόρατα στην κατάσταση "roadster", όπως 

φαίνεται στην ακόλουθη εικόνα, αφού επιλέξετε, πατήστε enter για επιβεβαίωση. Για 

την κατάσταση "Car" και "Truck", ορίστε τα με τον ίδιο τρόπο. 

 
 

 
4. Μετακίνηση και προσαρμογή: Μετά την ολοκλήρωση της επεξεργασίας των 

καταστάσεων ορατότητας, μετακινήστε την προβολή των τριών αυτοκινήτων ώστε να 

επικαλύπτονται, όπως φαίνεται στην παρακάτω εικόνα. 

 
 

 
5. Δοκιμή δυναμικού μπλοκ: Εισάγετε το επεξεργασμένο Δυναμικό Μπλοκ σε ένα σχέδιο, επιλέξτε το Δυναμικό Μπλοκ 

και κάντε κλικ στο πιάσιμο της παραμέτρου ορατότητας, επιλέξτε ένα στοιχείο από την αναδυόμενη πτυσσόμενη λίστα, το 

Δυναμικό Μπλοκ θα αλλάξει αυτόματα την κατάσταση εμφάνισης, όπως φαίνεται στην ακόλουθη εικόνα. 
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13.2.3. Ευθυγράμμιση 

 
Η παράμετρος ευθυγράμμισης μπορεί να δώσει στα δυναμικά μπλοκ τη λειτουργία της 

αυτόματης ευθυγράμμισης, η οποία μπορεί να εξοικονομήσει το βήμα της περιστροφής των 

μπλοκ. 

 
1. Προσθήκη παραμέτρου ευθυγράμμισης για ένα σύμβολο τραχύτητας: Σχεδιάστε ένα σύμβολο τραχύτητας στο Block 

Editor. Επιλέξτε το εικονίδιο της παραμέτρου ευθυγράμμισης. Καθορίστε τη θέση και τον προσανατολισμό ευθυγράμμισης της 

παραμέτρου ακολουθώντας αυτό που σας ζήτησε ο υπολογιστής, όπως φαίνεται στην εικόνα, η διακεκομμένη γραμμή 

είναι η ευθυγράμμιση 

προσανατολισμός. 

 
2. Δοκιμάστε το δυναμικό μπλοκ: Τοποθετήστε τα 

δυναμικά μπλοκ τραχύτητας, μετακινήστε τις λαβές 

ευθυγράμμισης, το σύμβολο θα ευθυγραμμιστεί με τη 

διεπαφή των διαστάσεων, όπως φαίνεται στην 

παρακάτω εικόνα. 

 
 
 

 
Flip: Όταν χρησιμοποιείτε το "μπλοκ συμβόλων τραχύτητας" για να επισημάνετε τα ανταλλακτικά, το σύμβολο είναι μερικές 

φορές ήδη στη σωστή θέση, ωστόσο η κατεύθυνση των χαρακτήρων δεν είναι σωστή. Πρέπει να προσθέσουμε τη λειτουργία 

"αναστροφή χαρακτήρων" για να λάβετε τη σωστή ετικέτα. 

 
1. Προσθέστε την παράμετρο flip: Κάντε κλικ στο κουμπί παραμέτρου "flip", 

προσθέστε την παράμετρο flip σύμφωνα με την προτροπή, όπως φαίνεται 

στην εικόνα. 
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2. Προσθέστε δράση αναστροφής: Κάντε κλικ στο κουμπί flip action στον πίνακα ενεργειών, αντιστοιχία 

παράμετρος και αντικείμενο για την ενέργεια. Εδώ, επιλέγουμε την "τραχύτητα" ως αντικείμενο και τοποθετούμε το κουμπί δράσης, όπως φαίνεται 
στην εικόνα 

 
 
 
 

 
Χρησιμοποιήστε την ίδια 

μέθοδο για να προσθέσετε 

ένα ζεύγος παραμέτρων 

αναστροφής και δράσης της 

κάθετης κατεύθυνσης, όπως 

φαίνεται στην εικόνα: 

 
 
 

 
13.2.4. Κίνηση σημείων 

 

1. Σχεδιάστε ένα σχέδιο: Σχεδιάστε ένα σχέδιο και ορίστε το ως μπλοκ. 
 
 

 
2. Προσθήκη παραμέτρου σημείου: Κάντε κλικ στην παράμετρο σημείου στη 

γραμμή εργαλείων, ορίστε τη θέση της παραμέτρου σύμφωνα με την προτροπή, 

όπως φαίνεται στην εικόνα. 

 

 
3. Προσθέστε ενέργεια κίνησης: Κάντε κλικ στο κουμπί δράσης μετακίνησης στον πίνακα ενεργειών, αντιστοιχίστε την 

παράμετρο και το αντικείμενο για την ενέργεια και ορίστε τη θέση. Η θέση της ετικέτας της ενέργειας δεν επηρεάζει το 

αποτέλεσμα του δυναμικού μπλοκ, ωστόσο, για λόγους ομορφιάς & ευκολίας, προσπαθήστε να τοποθετήσετε την 

ετικέτα κοντά στη σχετική παράμετρο. 

 

 

 

κάτω από την εικόνα. 
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4. Δοκιμάστε το δυναμικό μπλοκ: Εισάγετε το δυναμικό μπλοκ, σύρετε τη μπλε 

λαβή, και στη συνέχεια μετακινήστε τη διάβαση προς τα δεξιά ανάλογα, όπως 

φαίνεται στην παρακάτω εικόνα. Προφανώς, το δυναμικό μπλοκ μπορεί να 

επιτύχει τα αναμενόμενα αποτελέσματα. Παρακαλείστε να δώσετε προσοχή, εάν δεν 

εκτελείται με ορθοπεριορισμό, ο βασικός διάδρομος μπορεί να κινηθεί προς κάθε 

κατεύθυνση, επειδή η κατεύθυνση της παραμέτρου σημείου είναι τυχαία, η 

το χαρακτηριστικό της 

παραμέτρου καθορίζει το 

χαρακτηριστικό της δράσης. 

 
13.2.5. Γραμμική κίνηση 

 
Στην πραγματικότητα, με βάση τις απαιτήσεις των μηχανικών χαρακτηριστικών του υλικού, επιτρέπεται η τοποθέτηση της 

εγκοπής μόνο στην κεντρική γραμμή. Έτσι, μια οριζόντια κίνηση είναι αρκετή για την εγκοπή και η κίνηση προς άλλη 

κατεύθυνση δεν έχει νόημα. Στη συνέχεια θα εκμεταλλευτούμε τη γραμμική παράμετρο για να καθορίσουμε την κατεύθυνση 

κίνησης της φρεατίου στην κεντρική γραμμή του άξονα βαθμίδας. 

 
1. Ισοπαλία: Σχεδιάστε το ακόλουθο σχέδιο και ορίστε το ως μπλοκ. 

 

 
2. Προσθήκη γραμμικής παραμέτρου: Και οι δύο προσπαθούν να 

τοποθετήσουν το σημείο απορρόφησης της παραμέτρου στην κεντρική 

γραμμή του άξονα του βήματος. 

 

 
3. Προσθέστε ενέργεια κίνησης: Μετά τον προσδιορισμό της 

παραμέτρου, το σύστημα θα σας ζητήσει: Καθορίστε την παράμετρο 

που σχετίζεται με 

κίνηση. Επιλέξτε τη δεξιά λαβή της παραμέτρου ως "Σχετικό σημείο παραμέτρου", όπως 

όπως φαίνεται στην ακόλουθη εικόνα. 

 
Το σημείο της παραμέτρου που αναφέραμε αντιστοιχεί στο σημείο λειτουργίας 

του Move. Μετά την έξοδο από το Block Editor μπορείτε να σύρετε αυτό το 

σημείο για να κάνετε αντίστοιχη αλλαγή του δυναμικού μπλοκ. Αφού 

επιλέξετε το σχετικό σημείο παραμέτρου μπορείτε να καθορίσετε τα 

αντικείμενα κίνησης για δράση, όπως φαίνεται στην ακόλουθη εικόνα. 

Τοποθετήστε την ετικέτα δράσης, αποθηκεύστε και βγείτε από το 

δυναμικό μπλοκ. 

 
4 .Δοκιμή δυναμικού μπλοκ: Επιλέξτε το δυναμικό μπλοκ και σύρετε τη 

δεξιά λαβή της παραμέτρου. Εν τω μεταξύ, ανεξάρτητα από τον τρόπο με τον 

οποίο κινείται ο δρομέας, η βασική οδός περιορίζεται στην κεντρική γραμμή 

του βηματικού άξονα. Δηλαδή με τον περιορισμό της γραμμικής 

παραμέτρου, το δυναμικό μπλοκ μπορεί να κινηθεί μόνο κατά μήκος της 

κατεύθυνσης που καθορίζεται από τη γραμμική παράμετρο. 
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13.2.6. Αριθμός λαβών 

 
Στο Block Editor, επιλέξτε τις γραμμικές παραμέτρους, αλλάξτε 

τον αριθμό των λαβών σε "1" στον πίνακα ιδιοτήτων. 
 
 
 
 

 
Αποθηκεύστε και βγείτε από το Block Editor, επιλέξτε το Dynamic 

Block, θα διαπιστώσετε ότι η μία λαβή έχει εξαφανιστεί. Στην 

πραγματικότητα, μετά την αλλαγή του αριθμού των λαβών από "2" σε 

"1", το πρώτο πράγμα που εξαφανίστηκε ήταν η βασική λαβή των 

παραμέτρων, δηλαδή το πρώτο σημείο κατά την προσθήκη 

παραμέτρων. 

 
13.2.7. Μετατόπιση γωνίας 

 
Ανοίξτε τον επεξεργαστή μπλοκ, επιλέξτε τη μετατόπιση 

γωνίας από 0°έως 30° στην ιδιότητα δράσης, 

αποθηκεύστε και βγείτε από τον επεξεργαστή μπλοκ. 

 
 

 
Επιλέξτε το δυναμικό μπλοκ και, στη συνέχεια, μετακινήστε τη δεξιά 

πλευρά της λαβής. Θα διαπιστώσετε ότι μπορεί να κινηθεί μόνο προς την 

κατεύθυνση των 30°, όπως φαίνεται στην επόμενη εικόνα. Η κατεύθυνση της 

δράσης μπορεί να αλλάξει ανάλογα με τη μετατόπιση γωνίας. 

 

 
13.2.8. Γραμμικό τέντωμα 

 
Κατά τη διάρκεια ενός μηχανολογικού σχεδιασμού, συχνά χρειάζεται να αλλάξουμε τη θέση καθώς και τη διάσταση της 

εγκοπής. Σε αυτή την ενότητα, θα προσθέσουμε τη λειτουργία γραμμικού εφελκυσμού για την εγκοπή της φρεατίου 

στον άξονα βαθμίδας. 

 
1. Προσθήκη γραμμικής παραμέτρου: 
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2. Προσθέστε δράση τεντώματος: Κάντε κλικ στο κουμπί δράσης 

τεντώματος στον πίνακα δράσης, επιλέξτε την παράμετρο 

σύμφωνα με την προτροπή και ορίστε τη δεξιά λαβή ως βασικό 

σημείο παραμέτρου, όπως φαίνεται στην παρακάτω εικόνα. Το 

μαύρο αντικείμενο είναι το λειτουργικό αντικείμενο της 

ενέργειας, το πλαίσιο διακεκομμένης γραμμής είναι το πλαίσιο 

τάνυσης, τα αντικείμενα που τέμνονται με το πλαίσιο τάνυσης θα 

τεντωθούν, τα αντικείμενα που θα επιλεγούν από το πλαίσιο 

τάνυσης θα μετακινηθούν. 

 
3. Δοκιμή δυναμικού μπλοκ: σύρετε τη λαβή τεντώματος για να 

τεντώσετε την οπή κλειδιού, όπως φαίνεται στην εικόνα. 

 
13.2.9. Παράμετρος Ορισμός τιμής 

 
Για μηχανολογικές κατασκευές, συχνά χρειάζεται να τεντώσουμε την αυλάκωση σε ένα συγκεκριμένο μήκος. Τώρα, ας δούμε 

πώς μπορούμε να πραγματοποιήσουμε μια ακριβή επιμήκυνση. Διαλέξτε τη γραμμική παράμετρο στον επεξεργαστή μπλοκ, 

κάντε κλικ στο πλαίσιο εισόδου που βρίσκεται στη δεξιά πλευρά του "τύπου απόστασης" στον πίνακα ιδιοτήτων, θα 

εμφανιστεί ένα αναπτυσσόμενο μενού. 

 
Εκεί, το none είναι η προεπιλεγμένη επιλογή, που 

σημαίνει ότι μπορεί να τεντωθεί προαιρετικά. Με 

τις άλλες δύο επιλογές, μπορείτε να ορίσετε τον 

μέγιστο και τον ελάχιστο αριθμό αντίστοιχα. 

 
 

 
"Αύξηση" σημαίνει τέντωμα όλο και περισσότερο, ένα σύνολο τιμών 

εμφανίζεται όπως φαίνεται παρακάτω μετά την επιλογή increment. Εάν 

επιλέξετε "λίστα", εμφανίζεται ένα σύνολο τιμών όπως φαίνεται στην 

παρακάτω εικόνα, το δυναμικό μπλοκ μπορεί να τεντωθεί μόνο 

σύμφωνα με τον αριθμό στη λίστα. 

 
Κάντε κλικ στο πλαίσιο κειμένου που βρίσκεται στη δεξιά 

πλευρά της "λίστας τιμών απόστασης", και θα εμφανιστεί ένα 

κουμπί με ελλειπτική γραμμή. Κάντε κλικ σε αυτό το κουμπί, 

θα εμφανιστεί το πλαίσιο διαλόγου "Add distance" 

(Προσθήκη απόστασης). Προσθήκη 

τρεις αριθμούς "1". "1.5". "2" στο πλαίσιο διαλόγου, όπως 

φαίνεται στην παρακάτω εικόνα. 

 
Βγείτε από τον επεξεργαστή μπλοκ και τεντώστε τη δεξιά λαβή, 

θα δείτε αρκετές γκρίζες γραμμές να εμφανίζονται στη δεξιά 

πλευρά της εγκοπής, 
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και η εγκοπή μπορεί να τεντωθεί μόνο στη θέση της γκρίζας γραμμής, όπως φαίνεται στην παρακάτω εικόνα. Προφανώς, 

μέσω της λίστας τιμών, μπορείτε να ορίσετε ορισμένους αριθμούς του τεντώματος, για να πραγματοποιήσετε ένα 

ακριβές τέντωμα. 

 

 

 
13.2.10. Συμμετρικό τέντωμα 

 
Υπάρχει ένας εύκολος τρόπος για να πραγματοποιήσετε το αμφίδρομο τέντωμα που είναι η προσθήκη δύο ενεργειών 

τεντώματος. Παρόλο που μπορεί να πραγματοποιήσει ένα αμφίδρομο τέντωμα, η δράση του τεντώματος είναι ανεξάρτητη. Η 

παράμετρος χρειάζεται κάποια πρόσθετη ρύθμιση για την υλοποίηση του συμμετρικού τεντώματος διπλής κατεύθυνσης. 

 
-Πρώτα, προσθέστε δύο ενέργειες τεντώματος για την παράμετρο και επιλέξτε τις δύο λαβές των δύο παραμέτρων ως το σχετικό σημείο κάθε 
ενέργειας. 

-Δεύτερον, στο misc, τροποποιήστε τη θέση της βάσης από "Start Point" σε "Mid Point", όπως φαίνεται στην παρακάτω 

εικόνα. Αποθηκεύστε και βγείτε από τον επεξεργαστή μπλοκ. 

 
Για την ευκολία παρακολούθησης του αποτελέσματος, σχεδιάσαμε μια κατακόρυφη 

κεντρική γραμμή στη μέση της εγκοπής και στη συνέχεια τεντώσαμε τη λαβή στην 

αριστερή πλευρά της εγκοπής ή στη δεξιά πλευρά, όπως φαίνεται στην παρακάτω εικόνα. 

Καθώς οι λαβές κινούνται, πραγματοποιείται το συμμετρικό τέντωμα προς δύο 

κατευθύνσεις. 

 
 
 
 

 
13.2.11. Πολλαπλασιαστής απόστασης 

 
Πάρτε τον άξονα βήματος ως παράδειγμα, εάν τεντώσουμε το αριστερό τμήμα του άξονα 

βήματος και η εγκοπή εξακολουθεί να βρίσκεται στο κεντρικό σημείο του άξονα 

μικρότερης διαμέτρου μετά την τάνυση. Τότε, χρησιμοποιούμε την ιδιότητα 

"Πολλαπλασιαστής απόστασης" της δράσης για την επίτευξη του στόχου. 
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1. Προσθέστε γραμμική παράμετρο και δράση τεντώματος 

για τον άξονα βήματος: Το πλαίσιο τέντωμα δράσης είναι 

όπως στην ακόλουθη εικόνα, το αντικείμενο με έντονη 

γραφή είναι το αντικείμενο λειτουργίας δράσης. 

 
 
 
 

 
2. Προσθέστε ενέργεια μετακίνησης για το φρεάτιο: 

Επιλέξτε την αριστερή λαβή της γραμμικής παραμέτρου 

κατά τη μετακίνηση, τεντώνοντας τα σχετικά σημεία της 

παραμέτρου. Μετακινήστε τα αντικείμενα της ενέργειας και 

επιλέξτε ολόκληρη την οδόντωση της πλήμνης, όπως 

στην ακόλουθη εικόνα. 

 
 
 

 
3. Τροποποιήστε τον πολλαπλασιαστή απόστασης 

της δράσης: Επιλέξτε Move Action και τροποποιήστε 

την προεπιλεγμένη τιμή από 1 σε 0,5 στην ιδιότητα του 

πολλαπλασιαστή απόστασης, αποθηκεύστε και 

βγείτε από τον επεξεργαστή μπλοκ. 

 

 
4. Δοκιμή δυναμικού μπλοκ: Εν τω μεταξύ, η οδός κλειδιού βρίσκεται στο 

κέντρο του άξονα μικρότερης διαμέτρου του άξονα βήματος όλη την ώρα. 

Παρόλο που το Stretch και το Move έχουν κοινή παράμετρο, όταν ο 

πολλαπλασιαστής απόστασης του Move τροποποιηθεί σε 0,5, η μετατόπιση του 

Move μπορεί να τεντωθεί μόνο 0,5 φορές της μετατόπισης. 

 

 
13.2.12. Δράση αλυσίδας 

 
Εάν θέλετε να πραγματοποιήσετε μια συμμετρική τάνυση χωρίς να αλλάξετε το κέντρο της φρεατίου και το μήκος του άξονα 

μικρότερης διαμέτρου αλλάζει ταυτόχρονα με την τάνυση, πώς μπορείτε να το πραγματοποιήσετε αυτό; 

 
1. Προσθέστε τέντωμα για τον άξονα βήματος: Προσθέστε την 

παράμετρο και την ενέργεια τέντωμα για τον άξονα βήματος, όπως 

δείχνει η ακόλουθη εικόνα. Εκεί μέσα, τα αντικείμενα με έντονη 

γραφή υποδεικνύουν το αντικείμενο λειτουργίας της ενέργειας. Επειδή 

η επόμενη λειτουργία δεν θα τεντώσει τον άξονα βήματος με τις λαβές 

αυτής της γραμμικής παραμέτρου, ο αριθμός της λαβής της γραμμικής 

παραμέτρου μπορεί να τροποποιηθεί σε "0". 
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2. Προσθήκη γραμμικής παραμέτρου για τις 

νευρώσεις: Για να υλοποιήσετε τη λειτουργία 

συμμετρικού τεντώματος, ορίστε τη θέση του 

σημείου βάσης της παραμέτρου γραμμής ως 

"Κέντρο". 

 
 

 
3. Προσθέστε τη δράση τεντώματος προς τα δεξιά για το φρεάτιο και υλοποιήστε τη δράση της αλυσίδας: Επιλέξτε τη 

γραμμική παράμετρο "Distance" και τροποποιήστε την αλυσιδωτή δράση της ευημερίας από "NO" σε "Yes", όπως δείχνει η 

ακόλουθη εικόνα: 
 

 
Προσθέστε την ενέργεια Stretch Leftwards για την εγκοπή κλειδιού, όπως 

δείχνει η ακόλουθη εικόνα. Ειδική σημείωση: Επιλέξτε "Απόσταση" για τη 

γραμμική παράμετρο για να τεντώσετε προς τα αριστερά τα αντικείμενα 

λειτουργίας που έχουν οριστεί. Αυτή είναι μια απαραίτητη διαδικασία 

της λειτουργίας της αλυσίδας. 

 

 
4. Δοκιμή δυναμικού μπλοκ: αλλά και ο άξονας μικρότερης διαμέτρου του 

άξονα βήματος θα τεντωθεί αυτόματα. Πρόκειται για μια αλυσιδωτή δράση. Η 

υλοποίηση μιας αλυσιδωτής δράσης έχει δύο σημαντικές διαδικασίες: Πρώτον, 

τροποποιήστε την τιμή της ιδιότητας της παραμέτρου που πρέπει να συμβεί ως 

σύνδεση και τροποποιήστε την ιδιότητα "chain action" από "NO" σε "YES". 

Δεύτερον, επιλέξτε την παράμετρο των αντικειμένων που έχουν επιλεγεί 

για την ενέργεια σύνδεσης να οριστεί. 

 

 
13.2.13. Δράση κλίμακας 

 
Η δράση κλίμακας μπορεί να συνδυαστεί με τη γραμμική παράμετρο, την πολική παράμετρο και την παράμετρο XY για 

να επιτευχθούν διάφορα δυναμικά εφέ. Γραμμική κλίμακα 

1. Ισοπαλία: Ολοκληρώστε τη σχεδίαση μιας οπής πρόσβασης σε ένα χώρο μοντέλου και 

ορίστε την ως μπλοκ, όπως φαίνεται στην ακόλουθη εικόνα. 
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2. Προσθήκη γραμμικής παραμέτρου: Εισέλθετε στον 

επεξεργαστή μπλοκ για να προσθέσετε μια γραμμική 

παράμετρο. Το σημείο εκκίνησης της γραμμικής παραμέτρου 

είναι το κέντρο του κύκλου και επιλέξτε τον αριθμό των λαβών 

ως "1", όπως φαίνεται στην ακόλουθη εικόνα. 

 
 
 
 
 
 

 
3. Προσθήκη δράσης: Κάντε κλικ στο εικονίδιο Κλίμακα στον Πίνακα Δράσης, 

ορίστε την παράμετρο για τη Δράση και τοποθετήστε ολόκληρη την οπή 

πρόσβασης ως Αντικείμενο Δράσης, όπως φαίνεται στην ακόλουθη 

εικόνα. 

 
 

 
4. Δοκιμή δυναμικού μπλοκ: Τα αντικείμενα (καρύδια) θα κλιμακωθούν 

μαζί του. 

Πολική κλίμακα 

 
Όταν μετακινούμε τη λαβή κλίμακας της οπής πρόσβασης στα αριστερά του κέντρου του 

κύκλου, δηλαδή μετακινούμε το σημείο βάσης της γραμμικής παραμέτρου στα αριστερά του 

κέντρου του κύκλου, θα διαπιστώσουμε ότι το μπλοκ δεν έχει αντίστοιχη κλίμακα, όπως 

φαίνεται στην ακόλουθη εικόνα. 

 
 

 
Ο λόγος για αυτό είναι ότι το τελικό σημείο της γραμμικής παραμέτρου δεν μπορεί να διασχίσει 

το σημείο βάσης της, οπότε αλλάζουμε τη γραμμική παράμετρο σε πολική παράμετρο, χωρίς 

να αλλάξουμε καμία άλλη λειτουργία, όπως φαίνεται στην ακόλουθη εικόνα. 

 
 
 

 
Έξοδος από τον επεξεργαστή μπλοκ, Σύρετε τις λαβές του μπλοκ 

τρύπα πρόσβασης και πάλι, μπορείτε να δείτε, ότι μετά την 

αλλαγή από γραμμική παράμετρο σε πολική παράμετρο, 

μπορούμε να σύρουμε τη λαβή για να κλιμακώσουμε το δυναμικό 

μπλοκ προς οποιαδήποτε κατεύθυνση. 
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13.2.14. Χαρακτήρας κλίμακας 

 
Σε αυτή την ενότητα, θα εξηγήσουμε μερικούς χαρακτήρες κλίμακας χρησιμοποιώντας την παράμετρο XY και την ενέργεια κλίμακας σε ένα 
παράδειγμα ζεύγους. 

 
1. Σχεδίαση γραφικών: Σχεδιάστε τα γραφικά που χρειάζονται ένα δυναμικό μπλοκ και ορίστε τα ως μπλοκ όπως παρακάτω: 

 

 

 
2. Προσθήκη παραμέτρου XY: XY Παράμετρος: Επεξεργαστής μπλοκ εισόδου, προσθήκη παραμέτρου XY. Η προσθήκη 

παραμέτρων είναι παρόμοια με τη γραμμική παράμετρο. Διαλέξτε το πρώτο σημείο της παραμέτρου από την αριστερή κάτω 

γωνία του ορθογωνίου ως σημείο βάσης, το δεύτερο σημείο από την πάνω δεξιά γωνία και αλλάξτε το Number of Grips σε 

"1". Στη συνέχεια, προσθέστε το Scale Action, όπως φαίνεται παρακάτω. 

 

 
3. Δοκιμάστε το δυναμικό μπλοκ: Μπορείτε να δείτε ότι ολόκληρο το δυναμικό 

μπλοκ κλιμακώνεται καθώς κινείται η λαβή. Είναι εύκολο να διαπιστώσετε ότι τόσο 

ο κύκλος όσο και το ορθογώνιο κλιμακώνονται από το σημείο βάσης της 

παραμέτρου XY. 

 

 
5. Τροποποίηση της βάσης δράσης: Τροποποίηση τύπου βάσης: επιστρέψτε στον επεξεργαστή, επιλέξτε Scale Action και 

αλλάξτε το προεπιλεγμένο "Dependent" σε "Independent". 
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Καθορίστε τη νέα βάση: Μπορείτε να εισαγάγετε χειροκίνητα την 

τιμή των συντεταγμένων ή μπορείτε να κάνετε απλό κλικ στο 

μικρό κουμπί με τις ελλειπτικές τελείες στα δεξιά του πλαισίου 

εισαγωγής και να ασφαλίσετε το σημείο βάσης, όπως φαίνεται 

στην εικόνα: 

 
Καθορίστε το σημείο βάσης με το σταυρόνημα και το κέντρο του κύκλου ως 

σημείο βάσης. Μετά την έξοδο από το Block Editor, κλιμακώστε το δυναμικό 

μπλοκ. Μετά την τροποποίηση του τύπου και της θέσης Base, το κέντρο 

κλίμακας του δυναμικού μπλοκ αλλάζει από το σημείο βάσης XY Parameter στο 

νέο καθορισμένο σημείο βάσης (κέντρο του κύκλου). 

 

 
6. Τύπος κλίμακας: Τύπος κλίμακας: Υπάρχει η 

επιλογή "Τύπος κλίμακας" στις Ιδιότητες δράσης 

κλίμακας. Η προεπιλεγμένη τιμή είναι "Κλίμακα XY". 

Εάν επιλέξετε "XY Scale", το δυναμικό μπλοκ 

κλιμακώνεται κάθε φορά που η λαβή κλίμακας 

μετακινείται στον άξονα X ή στον άξονα Y. Αν επιλέξετε 

"X Scale", κλιμακώνεται μόνο όταν η λαβή της 

κλίμακας μετακινείται στον άξονα X. 

Το ίδιο, όταν επιλέγετε "Κλίμακα Υ". 
 
 
 

 
13.2.15. Περιστροφή 

 
Σε αυτή την ενότητα, θα χρησιμοποιήσουμε μια παράμετρο περιστροφής και μια ενέργεια 

περιστροφής για να προσθέσουμε μια δυναμική λειτουργία περιστροφής στην προβολή συμβόλων 

ευρετηρίου (αγγλικό σύστημα) που χρησιμοποιούνται συχνά σε αρχιτεκτονικά σχέδια. 

 
1. Σχεδιάστε ένα σχέδιο: Σχεδιάστε ένα σύμβολο δείκτη προβολής και ορίστε το ως μπλοκ, 

όπως φαίνεται στην παρακάτω εικόνα. Ορίστε τον αριθμό προβολής και τον αριθμό σχεδίασης ως 

κείμενο χαρακτηριστικών, ώστε να μπορείτε να τον αναθεωρείτε όποτε θέλετε. 

 

 
2. Προσθήκη παραμέτρου περιστροφής: επιλέξτε το κέντρο του κύκλου ως το πρώτο σημείο της παραμέτρου, το σύστημα το 

προεπιλέγει ως σημείο περιστροφής, ορίστε τον τύπο γωνίας ως "αύξηση" και ορίστε τον αριθμό του ως 15 μοίρες, όπως 

φαίνεται παρακάτω. 
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3. Προσθήκη ενέργειας περιστροφής: Κάντε 

κλικ στο κουμπί δράσης περιστροφής στον 

πίνακα δράσης, αντιστοιχίστε την 

παράμετρο, το αντικείμενο και τη θέση για την 

δράση και επιλέξτε ολόκληρο το σύμβολο 

ευρετηρίου ως αντικείμενο της δράσης. 

 

 
4. Δοκιμή δυναμικού μπλοκ: Βγείτε από τον επεξεργαστή μπλοκ και 

εισάγετε το μπλοκ, σύρετε τη λαβή περιστροφής για να επιτύχετε το 

αποτέλεσμα της περιστροφής, όπως φαίνεται στην παρακάτω εικόνα. 
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Σχήμα 3.1 

 
 
 
 
 
 

 
Σχήμα 3.2 

 
 
 
 
 

 
Σχήμα 3.3 

 
 
 
 
 

 
Σχήμα 3.4 

 
13.2.16. Polar Stretch 

 
Χρησιμοποιούμε τη λειτουργία Polar Stretch των Dynamic Blocks για να σχεδιάσουμε το σύμβολο της τομής σε αυτό το τμήμα. 

 
1. Σχεδιάστε, καθρεφτίστε και ορίστε ως μπλοκ: Η ακόλουθη σχεδίαση περιλαμβάνει το κείμενο χαρακτηριστικών που μπορεί 

να τροποποιηθεί όπως χρειάζεστε. Στη συνέχεια, καθρεφτίστε αυτό το σχέδιο και ορίστε το καθρεφτισμένο αντικείμενο ως 

μπλοκ. 
 

2. Προσθέστε ενέργεια και παράμετρο για το κείμενο του 

χαρακτηριστικού: Είναι έτοιμο για το επόμενο βήμα για τη 

δημιουργία αλυσιδωτής ενέργειας για την ενέργεια 

Polar Stretch. 

 
 

 
3. Προσθήκη πολικής παραμέτρου και ενέργειας: του οποίου το πρώτο 

σημείο θα πρέπει να είναι το κέντρο του συμβόλου της τομής. Αυτό το 

σημείο θα είναι το κέντρο περιστροφής της πολικής παραμέτρου. 

Ακολουθήστε τις παρακάτω οδηγίες: 

 

 
1. Επιλέξτε τη δεξιά λαβή της πολικής παραμέτρου ως σχετικό σημείο παραμέτρου και καθορίστε το πλαίσιο Stretch (Σχ. 3.1). 

2. Επιλέξτε τα αντικείμενα προς τέντωμα και την παράμετρο Σημείο "θέση" μαζί, η οποία μπορεί να επιτύχει ότι το κείμενο και 

το σύμβολο τομής κινούνται μαζί (Εικ. 3.2). 

3. Καθορίστε αντικείμενα που περιστρέφονται μόνο για την ενέργεια Polar Stretch (Εικ. 3.3). 

4. Καθορίστε τη θέση του συμβόλου δράσης (Εικ. 3.4) 

5. Επαναλάβετε τα παραπάνω βήματα για να προσθέσετε την ίδια σειρά παραμέτρων και ενεργειών για το αριστερό μέρος. 
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Είναι καλύτερα να αποκρύψετε τις λαβές που δεν σχετίζονται με την παράμετρο Polar Stretch, όπως παρακάτω: 

 

 
 
 

 
4. Δοκιμή δυναμικού μπλοκ: Ανοίξτε το γραφικό 

που πρέπει να διαστασιολογηθεί και εισάγετε το 

ολοκληρωμένο δυναμικό μπλοκ (Σχ. 4.1). 

Σύρετε τη λαβή του δυναμικού μπλοκ, το 

σύμβολο της τομής μπορεί να τεντωθεί προς 

τα έξω και να περιστραφεί γύρω από το 

κέντρο, και ολοκληρώνετε το σήμα του 

συμβόλου της τομής (Εικ. 4.2). 

 
Σχήμα 4.1 Σχ. 4.2 

 
 
 

 
13.2.17. Χαρακτηριστικά δράσης Polar Stretch 

 
Τροποποιήστε τον αριθμό των λαβών της πολικής παραμέτρου στο δυναμικό μπλοκ 

συμβόλου τμήματος του τελευταίου παραδείγματος, ώστε να εμφανίζονται και οι 

δύο λαβές της πολικής παραμέτρου. Από την ακόλουθη εικόνα μπορούμε να δούμε 

ότι η κεντρική λαβή είναι σαφώς διαφορετική πριν και μετά. 

Πριν από την τροποποίηση, το κεντρικό σημείο ήταν στην πραγματικότητα το σημείο βάσης του μπλοκ και αυτό ήταν το 

σημείο εισαγωγής. Αλλά μετά την τροποποίηση, το κεντρικό σημείο του μπλοκ είναι το σημείο βάσης της πολικής 

παραμέτρου. 

 
Κάνοντας κλικ στην κεντρική λαβή μπορείτε να μετακινήσετε τη λαβή προς οποιαδήποτε κατεύθυνση. Εν τω μεταξύ, το 

σκούρο μπλε σημείο εισαγωγής του μπλοκ θα εμφανιστεί ξανά, όπως φαίνεται στην ακόλουθη εικόνα. Προφανώς, το σημείο 

εισαγωγής καλύπτεται μόνο από το σημείο βάσης της πολικής παραμέτρου. Το σημείο βάσης της πολικής παραμέτρου μπορεί 

να μετακινηθεί αυθαίρετα, αλλά για το μπλοκ φαίνεται ότι δεν 

η αλλαγή συμβαίνει. Αλλά είναι αλήθεια; 
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Για να επιβεβαιώσουμε αν το μπλοκ αλλάζει ή όχι, μετακινούμε τις 

λαβές και στους δύο ακροδέκτες και μπορούμε να διαπιστώσουμε ότι το 

σύμβολο της τομής δεν κεντράρει στο σκούρο μπλε σημείο βάσης κατά 

την αλλαγή, αλλά παίρνει το σημείο βάσης της πολικής παραμέτρου ως 

κέντρο περιστροφής, όπως φαίνεται στην ακόλουθη εικόνα. 

 

 
Εισάγετε τον επεξεργαστή μπλοκ, μετακινήστε την παράμετρο προς τα πάνω και οι άλλες ρυθμίσεις δεν αλλάζουν. 

 

 

 
Βγείτε από τον επεξεργαστή μπλοκ, μετακινήστε τη δεξιά 

λαβή και μπορείτε να δείτε ότι το κέντρο περιστροφής 

μετακινείται προς τα πάνω μαζί με την παράμετρο. Από τα 

παραπάνω παραδείγματα είναι δύσκολο να καταλάβετε ότι 

η πολική παράμετρος δεν μπορεί να κινείται αυθαίρετα 

όπως η παράμετρος σημείου 

και γραμμική παράμετρος, ο λόγος είναι ότι το σημείο βάσης της πολικής παραμέτρου καθορίζει το κέντρο περιστροφής του 

αντικειμένου, μόλις μετακινηθεί η παράμετρος, το κέντρο περιστροφής θα μετακινηθεί ανάλογα. Το ότι η παράμετρος 

περιστροφής δεν μπορεί να μετακινηθεί αυθαίρετα έχει τον ίδιο λόγο. 

 
13.2.18. Συστοιχία 

 
Για τη λειτουργία Array του Dynamic Block πρέπει να χρησιμοποιήσουμε την ενέργεια Array Action, χρησιμοποιούμε την ενέργεια 

Array Action για να ταιριάξουμε με τις παραμέτρους Linear Parameter, Polar Parameter, XY Parameter για να επιτύχουμε 

διάφορες συστοιχίες. 

 
Γραμμική διάταξη 

 
1. Ισοπαλία: Σχεδιάστε έναν κατάλογο εξαρτημάτων και ορίστε τον ως μπλοκ. 
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Συστοιχία XY 

Σε σύγκριση με τη γραμμική διάταξη, η 

διάταξη XY έχει διάταξη 

κατακόρυφης κατεύθυνσης. 

 

 
2. Προσθήκη γραμμικής παραμέτρου: αλλά προφανώς, ελπίζουμε μόνο να επιτύχουμε μια συστοιχία προς τα πάνω της 

κενής γραμμής, όχι μια συστοιχία προς τα κάτω, οπότε για να αποφύγουμε τα λάθη, θα πρέπει να κρύψουμε τη λαβή κάτω 

από την Παράμετρο, όπως στην ακόλουθη εικόνα. 

 

 
3. Προσθήκη ενέργειας συστοιχίας: Κατά τη διάρκεια της ενέργειας Προσθήκη συστοιχίας, το σύστημα θα απαιτήσει να 

ορίσετε χώρο μεταξύ των στηλών. Ο χώρος μεταξύ των στηλών είναι η απόσταση μεταξύ των αντικειμένων που δημιούργησε η 

συστοιχία. Εδώ, το πλάτος της γραμμής είναι 7mm, για τη γραμμή μεταξύ των γραμμών μπορεί να επιλεγεί μια κοντινή 

συστοιχία, ορίζουμε ότι ο χώρος μεταξύ των στηλών είναι 7mm. 
 

 

 
4. Δοκιμή δυναμικού μπλοκ: Εισαγωγή δυναμικού μπλοκ, σύρετε την επάνω δεξιά γωνία προς τα πάνω, ο αριθμός γραμμής 

της λίστας εξαρτημάτων θα προστεθεί αυτόματα, όπως στην ακόλουθη εικόνα. 
 

 
 

 
Πολική διάταξη 

Βλέπουμε ένα παράδειγμα Δυναμικού μπλοκ ως 

εξής, αφού σύρετε τη λαβή, το αποτέλεσμα θα είναι 

όπως στην ακόλουθη εικόνα. Μπορείτε να δείτε, όχι 

μόνο μπορούμε να τεντώσουμε τον φράχτη, αλλά 

μπορούμε επίσης να περιστρέψουμε την κατεύθυνση 

περιστασιακά, αυτό είναι το αποτέλεσμα που 

συνδυάζει το Polar Stretch με το Polar Array. 
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Εισάγετε στο Block Editor; τεντώστε, οι τρόποι προσθήκης 

Array Action όπως φαίνεται στην ακόλουθη εικόνα, το 

έντονο αντικείμενο εκφράζει τη συνάφεια με την επιλεγμένη 

ενέργεια. Η πολική παράμετρος καθορίζει τον τρόπο της 

συστοιχίας άμεσα, η πολική συστοιχία θα θεωρήσει την 

κατεύθυνση της πολικής παραμέτρου ως κατεύθυνση 

συστοιχίας, επιτυγχάνοντας λειτουργίες συστοιχίας σε 

οποιαδήποτε κατεύθυνση. 



Κεφάλαιο 14_ Παραμετρικοί περιορισμοί 
 

Σ ε λ ί δ α  231 | 296  

 
14. Παραμετρικοί περιορισμοί 

 
Οι γεωμετρικοί περιορισμοί διαχειρίζονται τον τρόπο με τον οποίο τα αντικείμενα σχετίζονται με άλλα, επιτρέποντας την 

αυτόματη προσαρμογή άλλων αντικειμένων όταν γίνονται αλλαγές. Περιορίζουν επίσης τις αλλαγές στις τιμές των 

αποστάσεων και των γωνιών, εξασφαλίζοντας την ακρίβεια του σχεδιασμού. 

Υπάρχουν 12 τύποι γεωμετρικών περιορισμών που αντιστοιχούν σε 12 σχέσεις: Οριζόντιες, κάθετες, εφαπτόμενες, ομαλές, 

συμμετρικές και ίσες. 

Σημείωση: Αυτή η λειτουργία είναι διαθέσιμη μόνο στην έκδοση GstarCAD 2025 Plus. 

 

 

 
14.1. Σύμπτωση 

 
Περιορίζει δύο σημεία να συμπίπτουν ή ένα σημείο να βρίσκεται οπουδήποτε πάνω σε ένα αντικείμενο ή στην προέκταση ενός αντικειμένου. 

 

 
⮚  Πρόσβαση: Γεωμετρική   ή πληκτρολογήστε την εντολή GCCOINCIDENT. 

⮚  Ενδείξεις εντολών: 

⚫  Επιλέξτε το πρώτο σημείο ή το [Αντικείμενο]: Επιλέξτε το πρώτο σημείο ή αντικείμενο που πρέπει να συμπέσει. 

⚫  Επιλέξτε το δεύτερο σημείο ή [Αντικείμενο]: Επιλέξτε το δεύτερο σημείο ή αντικείμενο που συμπίπτει με το πρώτο 
σημείο ή αντικείμενο. 

⮚  Παράδειγμα: 
 

 
14.2. Collinear 

 
Περιορίζει δύο γραμμές να βρίσκονται στην ίδια άπειρη γραμμή. 

 

 
⮚  Πρόσβαση: Γεωμετρική   ή πληκτρολογήστε την εντολή GCCOLLINEAR. 
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⮚  Ενδείξεις εντολών: 

⚫  Επιλέξτε το πρώτο αντικείμενο ή [Πολλαπλά]: Επιλέξτε το πρώτο αντικείμενο ή πολλαπλά αντικείμενα που πρέπει να είναι κολλητά, 

⚫  Επιλέξτε το δεύτερο αντικείμενο ή [Πολλαπλά]: Επιλέξτε ένα ή πολλαπλά αντικείμενα που είναι εφαπτόμενα με το 
πρώτο αντικείμενο ή την ομάδα αντικειμένων. 

 
⮚  Παράδειγμα: 

 

 
14.3. Ομόκεντρο 

 
Περιορίζει τον επιλεγμένο κύκλο, τα τόξα ή τις εκλείψεις ώστε να διατηρούν το ίδιο κεντρικό σημείο. 

 

 
⮚  Πρόσβαση: Γεωμετρική   ή πληκτρολογήστε την εντολή GCCONCENTRIC. 

⮚  Ενδείξεις εντολών: 

⚫  Επιλέξτε το πρώτο αντικείμενο: Επιλέξτε το πρώτο αντικείμενο που πρέπει να είναι ομόκεντρο, 

⚫  Επιλέξτε το δεύτερο αντικείμενο: Επιλέξτε το δεύτερο αντικείμενο που είναι ομόκεντρο με το πρώτο αντικείμενο. 

⮚  Παράδειγμα: 
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14.4. Fix 

 
Περιορίζει ένα σημείο ή μια καμπύλη σε μια σταθερή θέση και προσανατολισμό σε σχέση με το Παγκόσμιο Σύστημα Συντεταγμένων. 

 

 
⮚  Πρόσβαση: Γεωμετρική   ή πληκτρολογήστε την εντολή GCFIX. 

⮚  Γραμμή εντολών: 

⚫  Επιλέξτε σημείο ή [αντικείμενο]: Επιλέξτε το σημείο ή το αντικείμενο που πρέπει να σταθεροποιηθεί, 

⮚  Παράδειγμα: 

 

 
 

14.5. Παράλληλη 

 
Περιορίζει δύο γραμμές να διατηρούν την ίδια γωνία. 

 

 
⮚  Πρόσβαση: Γεωμετρική   ή πληκτρολογήστε την εντολή GCPARALLEL. 

⮚  Ενδείξεις εντολών: 

⚫  Επιλέξτε το πρώτο αντικείμενο: Επιλέξτε το πρώτο αντικείμενο που πρέπει να παραλληλιστεί, 

⚫  Επιλέξτε το δεύτερο αντικείμενο: Επιλέξτε το δεύτερο αντικείμενο που είναι παράλληλο με το πρώτο αντικείμενο. 

⮚  Παράδειγμα: 
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14.6. Κάθετη 

 
Περιορίζει δύο γραμμές ή τμήματα πολυγραμμής να διατηρούν γωνία 90 μοιρών μεταξύ τους. 

 

 
⮚  Πρόσβαση: Επιλέξτε Κορδέλα  Παραμετρική  Γεωμετρική   ή πληκτρολογήστε την εντολή GCPERPENDICULAR. 

⮚  Ενδείξεις εντολών: 

⚫  Επιλέξτε το πρώτο αντικείμενο: Επιλέξτε το πρώτο αντικείμενο που πρέπει να είναι κάθετο, 

⚫  Επιλέξτε το δεύτερο αντικείμενο: Επιλέξτε το δεύτερο αντικείμενο που είναι κάθετο με το πρώτο αντικείμενο. 

⮚  Παράδειγμα: 
 

 
14.7. Οριζόντια 

 
Περιορίζει μια γραμμή ή ζεύγη σημείων να βρίσκονται παράλληλα με τον άξονα Χ του τρέχοντος UCS. 

 

 
⮚  Πρόσβαση: Γεωμετρική   ή πληκτρολογήστε την εντολή GCHORIZONTAL. 

⮚  Ενδείξεις εντολών: 

⚫  Επιλέξτε ένα αντικείμενο ή [2Points]: Επιλέξτε το αντικείμενο ή δύο σημεία που πρέπει να είναι παράλληλα με τον άξονα Χ. 

⮚  Παράδειγμα: 
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14.8. Κατακόρυφο 

 
Περιορίζει τις γραμμές ή τα ζεύγη σημείων να βρίσκονται παράλληλα στον άξονα Υ του τρέχοντος UCS. 

 

 
⮚  Πρόσβαση: Γεωμετρική   ή πληκτρολογήστε την εντολή GCVERTICAL. 

⮚  Ενδείξεις εντολών: 

⚫  Επιλέξτε ένα αντικείμενο ή [2Points]: Επιλέξτε το αντικείμενο ή δύο σημεία που πρέπει να είναι παράλληλα με τον άξονα Υ. 

⮚  Παράδειγμα: 

 

 

 
14.9. Tangent 

 
Περιορίζει δύο καμπύλες ώστε να διατηρούν ένα σημείο εφαπτομένης μεταξύ τους ή στις προεκτάσεις τους. 

 

 
⮚  Πρόσβαση: Γεωμετρική   ή πληκτρολογήστε την εντολή GCTANGENT. 

⮚  Ενδείξεις εντολών: 

⚫  Επιλέξτε το πρώτο αντικείμενο: Επιλέξτε το πρώτο αντικείμενο που πρέπει να εφάπτεται, 

⚫  Επιλέξτε το δεύτερο αντικείμενο: Επιλέξτε το δεύτερο αντικείμενο που εφάπτεται με το πρώτο αντικείμενο. 

⮚  Παράδειγμα: 
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14.10. Ομαλή 

 
Περιορίζει ένα spline να είναι συνεχόμενο και να διατηρεί τη συνέχεια G2 με ένα άλλο spline, γραμμή, τόξο ή πολυγραμμή. 

 

 
⮚  Πρόσβαση: Γεωμετρική   ή πληκτρολογήστε την εντολή GCSMOOTH. 

⮚  Ενδείξεις εντολών: 

⚫  Επιλέξτε την πρώτη καμπύλη spline: Επιλέξτε το πρώτο αντικείμενο που πρέπει να εξομαλυνθεί, 

⚫  Επιλέξτε το δεύτερο αντικείμενο: Επιλέξτε το δεύτερο αντικείμενο που ικανοποιεί τη συνέχεια G2 με το πρώτο αντικείμενο. 

⮚  Παράδειγμα: 
 

 
14.11. Συμμετρική 

 
Περιορίζει δύο καμπύλες ή σημεία σε αντικείμενα ώστε να διατηρείται η συμμετρία γύρω από μια επιλεγμένη γραμμή. 

 

 
⮚  Πρόσβαση: Γεωμετρική   ή πληκτρολογήστε την εντολή GCSYMMETRIC. 

⮚  Ενδείξεις εντολών: 

⚫  Επιλέξτε το πρώτο αντικείμενο ή [2Points]: Επιλέξτε το πρώτο αντικείμενο που πρέπει να παραλληλιστεί, 

⚫  Επιλέξτε το δεύτερο αντικείμενο ή [2Points]: Επιλέξτε το δεύτερο αντικείμενο που είναι παράλληλο με το πρώτο αντικείμενο. 

⚫  Επιλέξτε γραμμή συμμετρίας: Επιλέξτε τον άξονα συμμετρίας. 

⮚  Παράδειγμα: 
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14.12. Equal 

 
Περιορίζει δύο γραμμές ή τμήματα πολυγραμμών ώστε να διατηρούν ίσα μήκη ή τόξα και κύκλους ώστε να διατηρούν ίσες τιμές ακτίνας. 

 

⮚  Πρόσβαση: Γεωμετρική   ή πληκτρολογήστε την εντολή GCEQUAL. 

⮚  Ενδείξεις εντολών: 

⚫  Επιλέξτε το πρώτο αντικείμενο ή [Πολλαπλά]: Επιλέξτε το πρώτο(α) αντικείμενο(α) που πρέπει να είναι ίσο(α), 

⚫  Επιλέξτε το δεύτερο αντικείμενο ή [Πολλαπλά]: Επιλέξτε το(α) αντικείμενο(α) ίσο(α) με το πρώτο αντικείμενο. 

⮚  Παράδειγμα: 

 

 

 

 
Εμφάνιση/απόκρυψη (CONSTRAINTBAR): Επιλέξτε αντικείμενα για να εμφανίσετε ή να αποκρύψετε τους σχετικούς γεωμετρικούς 
περιορισμούς τους. 

 

 
Εμφάνιση όλων: Εμφάνιση όλων των γεωμετρικών περιορισμών. 

 

 
Απόκρυψη όλων: Απόκρυψη όλων των γεωμετρικών περιορισμών. 

 

 
Διαγραφή περιορισμών (DELCONSTRAINT): Διαγραφή όλων των περιορισμών που σχετίζονται με τα επιλεγμένα αντικείμενα. 

 

 
Ρυθμίσεις περιορισμών (CONSTRAINTSETTINGS): Διαχείριση των ρυθμίσεων που σχετίζονται με τους περιορισμούς 
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Σημείωση: Μπορείτε επίσης να χρησιμοποιήσετε την εντολή GEOMCONSTRAINT για να δημιουργήσετε ή να διατηρήσετε 

γεωμετρικές σχέσεις μεταξύ αντικειμένων ή σημείων σε αντικείμενα. 

Η σειρά και τα σημεία επιλογής των αντικειμένων μπορούν να επηρεάσουν τις σχετικές θέσεις τους όταν εφαρμόζεται ένας 

γεωμετρικός περιορισμός σε ένα ζεύγος αντικειμένων. 

Κάθε επιλογή αυτής της εντολής αντιστοιχεί σε μια μεμονωμένη εντολή από (1) έως (12). 
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Παραμετρικός περιορισμός Μεταβλητές συστήματος που σχετίζονται με το σύστημα 

 

Μεταβλητή 
συστήματος 

Περιγραφή Αξία Αξία Περιγραφή 

 
 
 

 
CONSTRAINTBARDISPLAY 

 

 
Ελέγχει την εμφάνιση των ράβδων 

περιορισμών για γεωμετρικούς 

περιορισμούς που εφαρμόζονται στη 

συνέχεια, καθώς και την εμφάνιση 

κρυφών περιορισμών για επιλεγμένα 

αντικείμενα. 

0 
 

 
1 

 

 
2 

Κρύβει αυτόματα τις μπάρες 

περιορισμών μετά την εφαρμογή 

γεωμετρικών περιορισμών. Εμφανίζει 

τις μπάρες περιορισμών όταν τα 

αντικείμενα έχουν γεωμετρικούς 

περιορισμούς. 

Εμφανίζει τυχόν κρυμμένους 

περιορισμούς, αλλά μόνο αν τα 

περιορισμένα αντικείμενα είναι 

επιλεγμένο. 
 

1 Οριζόντια 

 

 
CONSTRAINTBARMODE 

Ελέγχει την εμφάνιση των 

γεωμετρικών περιορισμών στις μπάρες 

περιορισμών. Η ρύθμισή του ως 4095 

θα μπορούσε να εμφανίσει μπάρες 

περιορισμών για όλους τους τύπους 

περιορισμών. 

2 

 
4 

Κατακόρυφο 

 
Κάθετη 

  
8 Παράλληλη 

  

16 Tangent 

32 Ομαλή 

64 Σύμπτωση 

128 Ομόκεντρο 

256 Collinear 

512 Συμμετρική 

1024 Equal 

2048 Διορθώστε το 

 

 
ΠΕΡΙΟΡΙΣΜΌΣ 

Ελέγχει αν οι γεωμετρικοί περιορισμοί 

συνάγονται κατά τη δημιουργία 

0 Off 
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και την επεξεργασία της γεωμετρίας. 1 Οι γεωμετρικοί περιορισμοί 

συνάγονται 
  

0 Όνομα (για παράδειγμα, Πλάτος) 

 
CONSTRAINTNAMEFORMAT 

Ελέγχει τη μορφή κειμένου για τους 

διαστατικούς περιορισμούς. 

 
1 

 
Τιμή (για παράδειγμα, 4.0000) 

  

2 
Έκφραση (για παράδειγμα, width = 

4.0000) 

 

 
CONSTRAINTSOLVEMODE 

 

Ελέγχει τη συμπεριφορά των περιορισμών 

κατά την εφαρμογή ή την επεξεργασία 

των περιορισμών. 

 
0 

Δεν διατηρεί τη γεωμετρία της 

μέγεθος όταν εφαρμόζεται ή 

επεξεργάζεται ένας περιορισμός 

  
1 

Διατήρηση του μεγέθους της 
γεωμετρίας όταν 

ένας περιορισμός εφαρμόζεται ή 
επεξεργάζεται 

 
CBARTRANSPARENCY 

Ελέγχει τη διαφάνεια των ράβδων 

περιορισμών. 

 
50 

Η έγκυρη τιμή κυμαίνεται από 10 έως 
90. 

Μεγαλύτερη τιμή κάνει τις μπάρες 

περιορισμών πιο αδιαφανείς. 
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15. Μοιραστείτε την ημερομηνία μεταξύ των εφαρμογών 

 
 

15.1. Net Framework Υποστήριξη 

 
.NET API σας επιτρέπει να χειρίζεστε την εφαρμογή και τα αρχεία σχεδίασης προγραμματιστικά με βιβλιοθήκες που είναι 

εκτεθειμένες και μπορούν να προσπελαστούν από πολλές διαφορετικές γλώσσες προγραμματισμού, όπως VB.NET, C# και 

Managed C++.κ.λπ. Οι χρήστες είναι σε θέση να αυτοματοποιήσουν εργασίες όπως η δημιουργία και η τροποποίηση 

αντικειμένων που είναι αποθηκευμένα στη βάση δεδομένων ενός αρχείου σχεδίασης ή η αλλαγή των περιεχομένων 

ενός αρχείου προσαρμογής. 

 
15.2. API του ObjectARX 

 
Το GstarCAD 2025 GRX είναι συμβατό με τα API του AutoCAD ObjectARX 2020, τα προγράμματα μπορούν να 

μεταγλωττιστούν, να φορτωθούν και να χρησιμοποιηθούν με επιτυχία χωρίς επεξεργασία κώδικα, γεγονός που 

εξοικονομεί πολύ χρόνο στη μετάβαση εφαρμογών που έχουν αναπτυχθεί με το AutoCAD ObjectARX. 

 

 
15.3. Εντολή Copylink 

 
Χρησιμοποιώντας την εντολή COPYLINK, οι χρήστες μπορούν να αντιγράψουν την τρέχουσα προβολή σχεδίασης στο Πρόχειρο 

και στη συνέχεια να επικολλήσουν τα περιεχόμενα του Πρόχειρου σε ένα άλλο έγγραφο ως συνδεδεμένο αντικείμενο 

OLE. 

 
15.4. Αποσφαλματωτής Lisp 

 
Μπορείτε να εισαγάγετε την εντολή VLISP ή VLIDE ή να κάνετε κλικ στην Κορδέλα  Διαχείριση  Εφαρμογές  Visual 

LISP Editor για να εκκινήσετε το Visual Studio Code ως τον αποσφαλματωτή Lisp στο GstarCAD 2025, στον οποίο 

μπορείτε να επεξεργαστείτε και να αποσφαλματώσετε προγράμματα Lisp με ευκολία. 
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Αν δεν έχετε εγκαταστήσει το λογισμικό Visual Studio Code, θα εμφανιστεί μια προειδοποίηση που θα σας ζητήσει να το εγκαταστήσετε πρώτα. 

Εάν το λογισμικό Visual Studio Code έχει εγκατασταθεί στον υπολογιστή σας, θα ανοίξει σε λίγα δευτερόλεπτα. 

Μπορείτε να επισκεφθείτε τον επίσημο ιστότοπο του VS Code 

(https://code.visualstudio.com/docs/getstarted/userint 

erface) για να μάθετε περισσότερες 

λεπτομέρειες. 

GstarLisp:Αυτή η επέκταση προσθέτει υποστήριξη για 

αρχεία Lisp στο Visual Studio Code. Σας επιτρέπει να 

επεξεργάζεστε και να αποσφαλματώνετε τα 

προγράμματα lisp σας με το GstarCAD. Όταν ξεκινάτε 

το VS Code μέσω του GstarCAD, θα εγκαταστήσει 

την επέκταση GstarLisp για εσάς από προεπιλογή. Και 

όταν υπάρχει μια νέα έκδοση της επέκτασης 

GstarLisp, θα ενημερώνεται 

https://code.visualstudio.com/docs/getstarted/userinterface
https://code.visualstudio.com/docs/getstarted/userinterface
https://code.visualstudio.com/docs/getstarted/userinterface
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αυτόματα την επόμενη φορά που θα εκκινήσετε το VS Code μέσω του GstarCAD. Ή, μπορείτε επίσης να το αναζητήσετε και να το 
εγκαταστήσετε στην αγορά. 

 
1. Άνοιγμα αρχείου 

Μπορείτε να ανοίγετε αρχεία LSP ή αρχεία DCL και 

να τα αποσφαλματώνετε όταν ανοίγει το VS Code 

και είναι εγκατεστημένη η επέκταση GstarLisp. 

⮚  Κάντε κλικ στο εικονίδιο της επέκτασης GstarLisp και, 

 στη συνέχεια, κάντε κλικ στην επιλογή 

"Άνοιγμα φακέλου", επιλέξτε το φάκελο 

και τα αρχεία .lsp και .dcl θα 

φιλτραριστούν. 

⮚  Κάντε κλικ στο αρχείο στη λίστα για 

να το ανοίξετε στην περιοχή 

επεξεργασίας. 

⮚  Κάντε κλικ στο κουμπί ανανέωσης για να 

επαναφορτώσετε το επιλεγμένο αρχείο, αν 

χρειαστεί. 

 
 
 
 
 

 
2. Επεξεργασία αρχείου 

Τι μπορείτε να κάνετε για να επεξεργαστείτε το 

πρόγραμμα με την επέκταση GstarLisp στο VS Code: 

⮚  Επισήμανση σύνταξης 

⮚  Αναδίπλωση κώδικα 

⮚  Έξυπνες συμβουλές 

⮚  Αυτόματη συμπλήρωση 

⮚  Αποσπάσματα κώδικα 

 
 
 
 
 
 

 
3. Αποσφαλμάτωση 

Τα βασικά βήματα εντοπισμού σφαλμάτων περιλαμβάνουν: 

⮚  Βήμα 1. Εκκίνηση κώδικα VS 

⮚  Βήμα 2. Ανοίξτε ένα αρχείο LSP ή ένα αρχείο DCL 

⮚  Βήμα 3. Προσθέστε ρυθμίσεις εντοπισμού σφαλμάτων και επεξεργαστείτε το launch.json 

⮚  Βήμα 4. Επιλέξτε μια διαμόρφωση εντοπισμού σφαλμάτων: GstarLisp-Launch ή GstarLisp-Attach 

⮚  Βήμα 5. Κάντε κλικ στο Run>Start Debugging (ή πατήστε F5) 
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GstarLisp-Attach: 

Σας επιτρέπει να συνδεθείτε σε μια εκτελούμενη παρουσία της εφαρμογής GstarCAD για να κάνετε αποσφαλμάτωση του τρέχοντος αρχείου LSP ή 
DCL. 

 

Εφόσον επιλέγετε τη διαμόρφωση GstarLisp-Attach, πρέπει να επιλέξετε ένα τρέχον GstarCAD ως προσαρμογέα εντοπισμού 

σφαλμάτων. Εάν δεν υπάρχει τρέχον παράδειγμα GstarCAD στον υπολογιστή σας, θα εμφανιστεί μια προειδοποίηση 

και το αρχείο δεν μπορεί να αποσφαλματωθεί. 
 

 

 
GstarLisp-Launch: 

Εκκινεί μια νέα διεργασία της εφαρμογής GstarCAD για την αποσφαλμάτωση του τρέχοντος αρχείου LSP ή DCL. 
 

Εφόσον επιλέγετε τη διαμόρφωση GstarLisp-Launch, πρέπει να καθορίσετε την απόλυτη διαδρομή του αρχείου gcad.exe στις 

ρυθμίσεις επέκτασης της επέκτασης GstarLisp (μορφή διαδρομής C://Program files//Gstarsoft//GstarCAD2023//gcad.exe). 
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Αν δεν έχετε ορίσει απόλυτη διαδρομή για το αρχείο gcad.exe, το παράθυρο εντοπισμού σφαλμάτων θα σας ζητήσει να ορίσετε τη διαδρομή. 

 

 

 
4. Ενέργειες εντοπισμού σφαλμάτων 

Μόλις ξεκινήσει μια συνεδρία εντοπισμού 

σφαλμάτων, η γραμμή εργαλείων 

εντοπισμού σφαλμάτων θα εμφανιστεί στο 

επάνω μέρος του επεξεργαστή. 

 
⮚  Συνέχεια / Παύση: Μετάβαση 

στο επόμενο σημείο διακοπής. 

⮚  Πήγαινε πιο πέρα: 

Ολοκληρώνει την τρέχουσα 

γραμμή και μεταβαίνει στην 

επόμενη γραμμή κώδικα της 

τρέχουσας συνάρτησης. 

⮚  Μπείτε μέσα: Ολοκληρώνει την επόμενη γραμμή κώδικα. Εάν αυτή η γραμμή περιέχει μια συνάρτηση, πηγαίνει 
στην πρώτη γραμμή του κώδικα της συνάρτησης και σταματά. 

⮚  Βγείτε έξω: Ολοκληρώνει όλο τον κώδικα της τρέχουσας συνάρτησης και σας επιστρέφει στην προηγούμενη 
συνάρτηση που "κάλεσε" αυτή τη συνάρτηση. 

⮚  Επανεκκίνηση: Επανεκκίνηση της συνεδρίας εντοπισμού σφαλμάτων. 

⮚  Διακοπή: Διακόπτει τη συνεδρία εντοπισμού σφαλμάτων. 

 
Σημείωση: 

⮚  Στο GstarLisp, πατήστε F10 για να ολοκληρώσετε την τρέχουσα γραμμή και να μεταβείτε στην επόμενη γραμμή 

κώδικα, ενώ στο AutoLisp, πατήστε F10 για να ολοκληρώσετε την τρέχουσα γραμμή και στη συνέχεια πατήστε 

F10 για να μεταβείτε στην επόμενη γραμμή. 

⮚  Όταν κάνετε κλικ στο εικονίδιο Επανεκκίνηση: 

• Διαμόρφωση GstarLisp-Attach: Η τρέχουσα συνεδρία εντοπισμού σφαλμάτων δεν θα διακοπεί και η 

αποσφαλμάτωση θα επανεκκινήσει στην τρέχουσα περίπτωση CAD. 

• Ρύθμιση παραμέτρων του GstarLisp-Launch: Διακόπτει την τρέχουσα συνεδρία εντοπισμού σφαλμάτων, 

τερματίζει την τρέχουσα περίπτωση CAD (χωρίς να ρωτήσει αν θα αποθηκευτεί το σχέδιο) και στη συνέχεια 

εκκινεί εκ νέου μια νέα περίπτωση CAD για εντοπισμό σφαλμάτων. 

 



Κεφάλαιο 15_ Κοινή χρήση δεδομένων μεταξύ 
εφαρμογών 

 

Σ ε λ ί δ α  246 | 296  

 

⮚  Όταν κάνετε κλικ στο εικονίδιο Stop: 

• Διαμόρφωση GstarLisp-Attach: Διακόπτει τη συνεδρία εντοπισμού σφαλμάτων, αλλά διατηρεί την τρέχουσα περίπτωση CAD. 

• Ρύθμιση παραμέτρων του GstarLisp-Launch: τερματίζει την τρέχουσα περίπτωση CAD (χωρίς να ρωτήσει 

αν θα αποθηκευτεί το σχέδιο). 
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5. Προβολή εκτέλεσης 

Μόλις ξεκινήσει μια συνεδρία εντοπισμού σφαλμάτων, θα εμφανιστούν τα παράθυρα Run View στα αριστερά του επεξεργαστή, που περιλαμβάνουν: 
 

 
⮚  ΜΕΤΑΒΛΗΤΕΣ 

Τα παράθυρα Locals και Last Value εμφανίζουν τις τιμές των μεταβλητών κατά την 

αποσφαλμάτωση. Τα παράθυρα είναι διαθέσιμα μόνο κατά τη διάρκεια μιας 

συνεδρίας αποσφαλμάτωσης. Το παράθυρο Locals δείχνει τις μεταβλητές που 

ορίζονται στην τοπική εμβέλεια, η οποία είναι συνήθως η τρέχουσα συνάρτηση ή μέθοδος. 

Το παράθυρο Τελευταία τιμή εμφανίζει την τιμή της τελευταίας αλλαγμένης 

μεταβλητής. 

 
⮚  ΔΕΙΤΕ 

 
Ενώ κάνετε αποσφαλμάτωση, μπορείτε να 

χρησιμοποιείτε παράθυρα 

παρακολούθησης για να παρακολουθείτε 

μεταβλητές και εκφράσεις. Τα παράθυρα 

είναι διαθέσιμα μόνο κατά τη διάρκεια 

μιας συνεδρίας εντοπισμού 

σφαλμάτων. 

Τα παράθυρα παρακολούθησης μπορούν 

να εμφανίζουν πολλές μεταβλητές 

ταυτόχρονα κατά την αποσφαλμάτωση. 

Μπορείτε να προσθέσετε, να 

επεξεργαστείτε ή να αφαιρέσετε εκφράσεις 

κάνοντας δεξί κλικ στα παράθυρα 

παρακολούθησης. 

 
⮚  CALL STACK 

 
Τα παράθυρα Call Stack εμφανίζουν μια λίστα με όλες τις διαδικασίες 

που έχουν εκτελεστεί. Εμφανίζει το όνομα της συνάρτησης ή της 

διαδικασίας που βρίσκεται αυτή τη στιγμή στη στοίβα. Στην GstarLisp, η 

στοίβα κλήσεων εμφανίζει κυρίως το όνομα της καλούμενης 

συνάρτησης. 

 
⮚  BREAKPOINTS 

Ένα σημείο διακοπής είναι μια ρύθμιση που μπορείτε να προσθέσετε σε μια γραμμή 

κώδικα για να διακόψετε προσωρινά την εκτέλεση σε αυτή τη γραμμή. Τα σημεία 

διακοπής μπορούν να ενεργοποιηθούν κάνοντας κλικ στο περιθώριο του επεξεργαστή ή 

χρησιμοποιώντας το F9 στην τρέχουσα γραμμή. Τα παράθυρα Σημεία διακοπής σας 

επιτρέπουν να ελέγχετε όλα τα σημεία διακοπής. 
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15.5. Python 

 
Η GstarCAD βελτιώνει συνεχώς την ακεραιότητα και τη συμβατότητα 

των GRX, .NET και LSP, διασφαλίζοντας ότι τα προγράμματα 

δευτερεύουσας ανάπτυξης των χρηστών λειτουργούν ομαλά μετά τη 

μετάβαση, μειώνοντας έτσι το κόστος της μετάβασης στη 

δευτερεύουσα ανάπτυξη. 

 
Στο GstarCAD 2025, υποστηρίζουμε τη χρήση της Python στα 

Windows για την επέκταση των δυνατοτήτων της πλατφόρμας 

GstarCAD. Με πάνω από 790 συχνά χρησιμοποιούμενες διεπαφές 

Python, καλύπτουμε καθημερινά σενάρια χρήσης, όπως η 

δημιουργία προσαρμοσμένων εντολών, προσαρμοσμένων 

γραφικών και οντοτήτων, η πρόσβαση και τροποποίηση 

διαφόρων δεδομένων σχεδίασης και η υλοποίηση 

προσαρμοσμένοι αλγόριθμοι σχεδίασης και ανάλυσης. Οι χρήστες μπορούν να αξιοποιήσουν τα ισχυρά χαρακτηριστικά της 

Python για προσαρμοσμένη ανάπτυξη και αυτοματοποίηση, επεκτείνοντας σημαντικά τη λειτουργικότητα του GRX. Αυτή η 

κλήση των διεπαφών GRX βάσει σεναρίων υποστηρίζει την ανάπτυξη σε πολλαπλές πλατφόρμες και μειώνει το κόστος 

εκμάθησης για νέους προγραμματιστές. 

 
Απαιτήσεις περιβάλλοντος συστήματος 

⮚  Python 3.11.8 

⮚  Windows 10 και άνω 

 
15.5.1. Εγκαταστήστε την Python 

 
Κατεβάστε το πακέτο εγκατάστασης και εγκαταστήστε το ως διαχειριστής, ρυθμίστε τις επιλογές όπως παρακάτω: 
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15.5.2. Διεπαφή εισαγωγής 

 
Χρησιμοποιήστε την εντολή Import στο αρχείο Python για να εισαγάγετε το δευτερεύον πακέτο 

ανάπτυξης: from pygcad.core import * 

from pygcad.pygrx import * 

Η pygcad.core περιλαμβάνει συγκεκριμένες διεπαφές πυρήνα της Python, όπως ο 

διακοσμητής @command.Η pygcad.pygrx περιέχει διάφορους τύπους και μεθόδους που 

αντιστοιχούν σε διεπαφές GRX. 

 
15.5.3. Καταχώρηση προσαρμοσμένων εντολών CAD 

 
Κατά τη διάρκεια της ανάπτυξης, όταν μια συνάρτηση που έχει οριστεί από τον χρήστη είναι διακοσμημένη με @command, η 

συνάρτηση αυτή καταχωρείται αυτόματα ως εντολή στο GstarCAD, με το όνομα της συνάρτησης ως το προεπιλεγμένο 

όνομα εντολής. Για παράδειγμα: 
 

Η συνάρτηση pyDrawLine() είναι διακοσμημένη με την @command(), καταχωρίζοντάς την αυτόματα ως την εντολή GCAD 

PYDRAWLINE. Αν δεν θέλετε να χρησιμοποιήσετε το όνομα της συνάρτησης ως όνομα εντολής, μπορείτε να το καθορίσετε στη 

διακοσμητική συνάρτηση command(). Ο διακοσμητής @command ορίζεται ως εξής: 

def command(local_name="", global_name="", group_name="", cmd_flags=0): 

Όταν το local_name είναι κενό, το όνομα της διακοσμημένης συνάρτησης χρησιμοποιείται αυτόματα ως local_name. Εάν το 

global_name είναι κενό, χρησιμοποιείται αυτόματα το local_name ως global_name. Εάν το group_name είναι κενό, 

επιλέγει το global_name ως group_name. Για παράδειγμα: 

Αυτό ορίζει μια προσαρμοσμένη εντολή: PY_MY_CMD. 

 
15.5.4. Φόρτωση στο GstarCAD 

 
Για παράδειγμα, χρησιμοποιήσαμε τη δευτερεύουσα διεπαφή ανάπτυξης για να αναπτύξουμε τη δική μας εντολή PYMKENTS. 

Το αρχείο Python είναι: ents.py. Μετά την εκτέλεση της εντολής, το πρόγραμμα θα σχεδιάσει μια γραμμή, έναν κύκλο με 
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κόκκινο τύπο γραμμής και θα δημιουργήσει ένα επίπεδο με όνομα ASDK_MYLAYER. 

⮚  Ανοίξτε το GstarCAD 2025, πληκτρολογήστε την εντολή APPLOAD, θα εμφανιστεί το παράθυρο διαλόγου Load/Unload Applications: 

 

 
⮚  Κάντε κλικ στο κουμπί Load και επιλέξτε το αρχείο ents.py, η εντολή θα καταχωρηθεί αυτόματα: PYMKENTS 

 
⮚  Κλείστε το παράθυρο διαλόγου και πληκτρολογήστε την εντολή PYMKENTS, το πρόγραμμα εκτελείται αυτόματα. 
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16. Ασφάλεια 

 
 

16.1. ΑΣΦΑΛΕΙΑ 

 
Η εντολή SECURITY ορίζει το επίπεδο παρακολούθησης της ασφάλειας του συστήματος και εμφανίζει ή διαγράφει το 

τρέχον αξιόπιστο πιστοποιητικό εκδότη. Μπορούν να φορτωθούν αρχεία έργου VBA χωρίς όνομα χωρίς προειδοποίηση. 

 
16.2. Επιλογές ασφαλείας στην Αποθήκευση ως 

 
Οι χρήστες μπορούν να προσθέσουν επιλογές ασφαλείας για το καθορισμένο αρχείο σχεδίασης, οι οποίες θα έχουν ισχύ κατά 

την αποθήκευση του σχεδίου. Όποιος θέλει να ανοίξει το αρχείο σχεδίασης πρέπει να εισάγει τον σωστό κωδικό 

πρόσβασης. Να θυμάστε τον κωδικό πρόσβασης, διαφορετικά, το σχέδιο δεν μπορεί να ανακτηθεί. 
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16.3. Ψηφιακή υπογραφή 

 
Οι εντολές DIGITALSIGN και SIGVALIDATE παρέχονται για την υποστήριξη της επισύναψης και επικύρωσης ψηφιακών 

υπογραφών, οι οποίες μπορούν να προσφέρουν αξιόπιστες πληροφορίες και να επικυρώσουν τη γνησιότητα και την 

ακεραιότητα των σχεδίων. 

 

Μεταβλητή 
συστήματος 

Περιγραφή Αξία Αξία Περιγραφή 

 

 
SIGWARN 

Ελέγχει εάν το παράθυρο διαλόγου 

Περιεχόμενα ψηφιακής υπογραφής 

εμφανίζεται όταν είναι ανοιχτό ένα 

αρχείο με έγκυρη ψηφιακή υπογραφή. 

0 

 
1 

Οι πληροφορίες δεν παρουσιάζονται 

εάν ένα αρχείο έχει έγκυρη 

υπογραφή 

Οι πληροφορίες παρουσιάζονται εάν 
ένα αρχείο 

έχει έγκυρη υπογραφή 

 
Εμφάνιση πληροφοριών ψηφιακής υπογραφής: Βρίσκεται στη διεύθυνση Λογότυπο  Επιλογές  Άνοιγμα και αποθήκευση

 Προφυλάξεις ασφαλείας αρχείων  Εμφάνιση πληροφοριών ψηφιακής υπογραφής, έχει το ίδιο αποτέλεσμα με τη 

μεταβλητή συστήματος SIGWARN. 
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Εάν η ψηφιακή σας υπογραφή έχει κωδικό πρόσβασης, θα πρέπει 

πρώτα να εισαγάγετε τον κωδικό πρόσβασης. 

 

 
Σημείωση: Η ψηφιακή υπογραφή θα καταστεί άκυρη όταν: 

• Το αρχείο τροποποιείται μετά την επισύναψη της 

ψηφιακής υπογραφής. 

• Το αρχείο καταστρέφεται κατά τη μετάδοση ή όταν 

επισυνάπτεται μια ψηφιακή υπογραφή. 

• Το ψηφιακό πιστοποιητικό έχει ανακληθεί από την αρχή 

έκδοσης πιστοποιητικών. 

 
16.3.1. DIGITALSIGN 

 
Μπορείτε να εισαγάγετε την εντολή DIGITALSIGN για να επισυνάψετε μια ψηφιακή υπογραφή σε ένα σχέδιο, η οποία μπορεί 

να παρέχει αξιόπιστες πληροφορίες σχετικά με την προέλευση, την ταυτότητα και την κατάσταση ενός αρχείου σχεδίου. Και 

αν γίνει μια μη εξουσιοδοτημένη αλλαγή ή το υπογεγραμμένο αρχείο καταστραφεί, η ψηφιακή υπογραφή καθίσταται 

άκυρη. 

 

 
Αφού εκτελέσετε την εντολή DIGITALSIGN, θα εμφανιστεί το παράθυρο Security Options (Επιλογές ασφαλείας), και αφού 

επιλέξετε την επιλογή 'Attach digital signature after saving drawings' (Επισυνάψτε την ψηφιακή υπογραφή μετά την 

αποθήκευση των σχεδίων), μπορείτε να επιλέξετε ένα ψηφιακό αναγνωριστικό και να επεξεργαστείτε τις πληροφορίες 

της υπογραφής (Time stamp και Comments). 
 

 
Αλλά, αν δεν υπάρχει έγκυρο ψηφιακό πιστοποιητικό στον υπολογιστή σας, θα εμφανιστεί ένα πλαίσιο προειδοποίησης. 

Εκτός από την εντολή DIGITALSIGN, μπορείτε επίσης να εισαγάγετε την εντολή 'SAVEAS' ή να κάνετε κλικ στο λογότυπο  

Αποθήκευση ως  Επιλογές ασφαλείας, για να ανοίξετε το παράθυρο διαλόγου 'Αποθήκευση σχεδίου ως' και να επισυνάψετε 

μια ψηφιακή υπογραφή στο σχέδιο. Το παράθυρο Επιλογές ασφαλείας που ανοίγει είναι το ίδιο με την εντολή DIGITALSIGN. 
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Σημείωση: Μπορείτε να υπογράψετε ψηφιακά μόνο τους ακόλουθους τύπους αρχείων: 

• Αρχεία DWG και DWT που είναι συμβατά με το AutoCAD 2000 και μεταγενέστερες μορφές αρχείων σχεδίασης. 

• Αρχεία DWS. 
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16.3.2. Εργαλείο ψηφιακής υπογραφής παρτίδας DWFX 

 

 
Μπορείτε να βρείτε την εφαρμογή digitalsign.exe στη διαδρομή εγκατάστασης του προγράμματος για να υπογράφετε αρχεία 

DWFX, DWG και DWT μαζικά με ψηφιακές υπογραφές αποτελεσματικά. 

Στο παράθυρο διαλόγου Επισύναψη ψηφιακών υπογραφών: 
 

⮚  Αρχεία προς υπογραφή: Εμφανίζει μια λίστα των αρχείων που προστέθηκαν προς υπογραφή με τους φακέλους 

τους και την κατάστασή τους (κενά, υπογεγραμμένα, προηγούμενες υπογραφές). Ο αριθμός των αρχείων που 

προσθέσατε εμφανίζεται επίσης στο κάτω αριστερό μέρος της λίστας. 

⮚  Προσθήκη αρχείων: Εμφανίζεται το παράθυρο διαλόγου Επιλογή αρχείου και μπορείτε να επιλέξετε τα αρχεία στα οποία θέλετε να 
επισυνάψετε ψηφιακή υπογραφή. 

⮚  Αναζήτηση φακέλων: Μπορείτε να επιλέξετε το φάκελο με τα αρχεία στα οποία θέλετε να επισυνάψετε μια 

ψηφιακή υπογραφή και στη συνέχεια να κάνετε κλικ στο κουμπί OK. 

⮚  Αφαιρέστε: Αφαιρεί τα επιλεγμένα αρχεία από τη λίστα 

⮚  Clear List: αδειάζει ολόκληρη τη λίστα αρχείων 

⮚  Επιλέξτε ένα ψηφιακό αναγνωριστικό (πιστοποιητικό): Επιλέξτε ένα ψηφιακό αναγνωριστικό που θα επισυνάψετε στα αρχεία που 
επιλέξατε στη λίστα Αρχεία προς υπογραφή. 

⮚  Πάρτε τη σφραγίδα ώρας από: Επιλέξτε μια υπηρεσία ώρας, αν θέλετε να προσθέσετε μια σφραγίδα ώρας στα υπογεγραμμένα αρχεία. 

⮚  Σχόλιο: Προσθέστε οποιαδήποτε επιπλέον περιγραφή στα αρχεία που υπογράφετε. 

⮚  Αρχεία υπογραφής: Θα εμφανιστεί ένα παράθυρο 

διαλόγου Signing Complete (Ολοκλήρωση υπογραφής) 

μετά την ολοκλήρωση και θα εμφανιστεί η ένδειξη 

ο αριθμός των υπογεγραμμένων αρχείων. 

⮚  Κοντά: Κλείστε το παράθυρο διαλόγου Επισύναψη ψηφιακών υπογραφών. 
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Εάν το αρχείο που θέλετε να υπογράψετε είναι μόνο για 

ανάγνωση, θα εμφανιστεί το παράθυρο διαλόγου Αρχείο μόνο 

για ανάγνωση, το οποίο μπορείτε να επιλέξετε ανάλογα με τις 

ανάγκες σας. 

 
 

 
Σημείωση: Αν επιλέξατε Μέσο ή Υψηλό επίπεδο ασφαλείας όταν 

αποκτήσατε το ψηφιακό αναγνωριστικό σας, θα εμφανίζεται ένα 

μήνυμα κάθε φορά που προσπαθείτε να επισυνάψετε μια 

ψηφιακή υπογραφή σε ένα αρχείο. 

 
Μενού δεξιού κλικ: 

 

⮚  Διαγραφή: διαγράφει το επιλεγμένο αρχείο 

⮚  Ιδιότητες: Εμφανίζεται το παράθυρο Ιδιότητες του συστήματος 

⮚  Στοιχεία υπογραφής: Εμφανίζεται το παράθυρο View the signature details 
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16.3.3. SIGVALIDATE 

 
Μπορείτε να κάνετε κλικ στο εικονίδιο επικύρωσης υπογραφής στη γραμμή κατάστασης ή να εισαγάγετε την εντολή 

SIGVALIDATE για να διαπιστώσετε αν η ψηφιακή υπογραφή που επισυνάπτεται σε ένα αρχείο σχεδίασης είναι έγκυρη ή άκυρη. 

Εμφανίζεται το παράθυρο διαλόγου Επικύρωση ψηφιακών υπογραφών που εμφανίζει πληροφορίες σχετικά με την ψηφιακή 

υπογραφή. 

 

 

Μετά την εκτέλεση της εντολής SIGVALIDATE, εμφανίζεται το παράθυρο διαλόγου Επικύρωση ψηφιακής 

υπογραφής. Όταν είναι έγκυρη: Όνομα: Εμφανίζει τη θέση και το όνομα του αρχείου του οποίου η ψηφιακή 

υπογραφή προβάλλεται. 

Κατάσταση ψηφιακής υπογραφής: Εμφανίζει ένα εικονίδιο έγκυρης υπογραφής εάν η ψηφιακή υπογραφή είναι έγκυρη και 

ένα εικονίδιο άκυρης υπογραφής εάν η ψηφιακή υπογραφή δεν είναι έγκυρη. 

Προβολή υπογραφής βάσης: Εμφανίζει το παράθυρο διαλόγου Περιεχόμενα ψηφιακής υπογραφής. Η επιλογή είναι 
διαθέσιμη μόνο εάν η ψηφιακή υπογραφή είναι έγκυρη. 

Προβολή σχεδίων Xref: Εμφανίζει τα σχέδια Xref που περιέχονται στο βασικό σχέδιο ενός αρχείου. Αφού το ελέγξετε, θα 

εμφανιστεί παρακάτω μια λίστα με τα σχέδια Xref εφόσον υπάρχουν κάποια σχέδια Xref που περιέχονται στο τρέχον 

υπογεγραμμένο αρχείο. 

Προβολή υπογραφής Xref: Εμφανίζει το παράθυρο διαλόγου Περιεχόμενα ψηφιακής υπογραφής του αρχείου Xref. Μπορεί 

να γίνει κλικ μόνο εάν το αρχείο Xref είναι επιλεγμένο στη λίστα. 

 
Το παράθυρο διαλόγου Περιεχόμενα ψηφιακής υπογραφής περιλαμβάνει, 

⮚  Όνομα: Εμφανίζει τη θέση και το όνομα του αρχείου του 

οποίου προβάλλεται η ψηφιακή υπογραφή. 

⮚  Κατάσταση ψηφιακής υπογραφής: Εμφανίζει ένα εικονίδιο έγκυρης υπογραφής εάν μια 

η ψηφιακή υπογραφή είναι έγκυρη, και ένα εικονίδιο Άκυρη 

υπογραφή εάν η ψηφιακή υπογραφή δεν είναι έγκυρη. 

⮚  Υπογράφεται από: Εμφανίζει τη θέση και το όνομα του 

αρχείου του οποίου προβάλλεται η ψηφιακή υπογραφή. 
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⮚  Άλλα πεδία: εμφανίζει το θέμα, τον εκδότη, την ημερομηνία 

ισχύος από, την ημερομηνία ισχύος έως και τον αύξοντα αριθμό 

στο πλαίσιο Τιμές. 

 
• Θέμα: Εμφανίζει πληροφορίες σχετικά με τον οργανισμό ή το άτομο που κατέχει το ψηφιακό αναγνωριστικό και 

επισύναψε την ψηφιακή υπογραφή. 

• Εκδότης: Εμφανίζει το όνομα της αρχής πιστοποιητικού που εξέδωσε αρχικά το ψηφιακό αναγνωριστικό. 

 
• Ισχύει από: Εμφανίζει την ημέρα, τον μήνα, το έτος και την ακριβή ώρα, το ψηφιακό αναγνωριστικό ισχύει από εκείνη την ώρα. 

 
• Ισχύει για: Η ψηφιακή ταυτότητα θα είναι άκυρη μετά από αυτό το χρονικό διάστημα. 

 
• Σειριακοί αριθμοί: Εμφανίζει τον αύξοντα αριθμό που έχει εκχωρηθεί στο ψηφιακό αναγνωριστικό. 

⮚  Αξίες: Εμφανίζει πληροφορίες σχετικά με μια ψηφιακή υπογραφή με βάση το στοιχείο που επιλέγετε στην αναπτυσσόμενη λίστα Άλλα 
πεδία. 

⮚  Σχόλιο: Εμφανίζει σχόλια σχετικά με την ψηφιακή υπογραφή που επισυνάπτεται στο τρέχον αρχείο. 

⮚  Ημερομηνία και ώρα υπογραφής：Εμφανίζει την ημερομηνία και την ώρα που επισυνάφθηκε η ψηφιακή υπογραφή 

στο τρέχον αρχείο. Η ημερομηνία και η ώρα βασίζονται στην υπηρεσία ώρας που χρησιμοποιήθηκε όταν 

επισυνάφθηκε η υπογραφή. 

⮚  Χρησιμοποιούμενη υπηρεσία ώρας：Εμφανίζει την υπηρεσία ώρας που χρησιμοποιείται για την προσθήκη της σφραγίδας ώρας στο τρέχον 

αρχείο. 

⮚  Κλείσιμο：Κλείνει το παράθυρο διαλόγου. 

⮚  Βοήθεια：Ανοίγει το σύστημα ηλεκτρονικής βοήθειας, Αρχική σελίδα - Εντολές - S - Εντολή SIGVALIDATE. 

 
Όταν το αρχείο σχεδίασης δεν υπογράφεται: 
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17. Υ π ο σ τ ή ρ ι ξ η  BIM  

 
 

17.1. IFCIMPORT 

 
Μπορείτε να εισαγάγετε την εντολή IFCIMPORT ή να κάνετε κλικ στην Κορδέλα  BIM  Άνοιγμα αρχείων IFC για να εισαγάγετε ένα αρχείο IFC με 
πλήρη δεδομένα BIM. 

 
Αφού ανοίξετε ένα αρχείο IFC, μπορείτε να επιλέξετε μια οντότητα και να μεταβείτε στον πίνακα ιδιοτήτων για τις πληροφορίες BIM. 

Μπορείτε επίσης να ελέγξετε και να διαχειριστείτε τις οντότητες χρησιμοποιώντας το Structure Panel, το οποίο εμφανίζει μια 

δενδρική δομή οντοτήτων με βάση τα δεδομένα BIM. Μπορείτε να εκτελέσετε λειτουργίες κάνοντας κλικ στα κουμπιά της 

Κορδέλας  BIM ή εισάγοντας τις ακόλουθες εντολές. 

 
⮚  STRUCTUREPANEL: Ανοιχτός πίνακας δομής 

⮚  STRUCTUREPANELCLOSE: Κλείσιμο πίνακα δομής 

⮚  STRUCTUREPANELUPDATE: Ενημέρωση πίνακα 

δομής 
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Μενού πίνακα δομής: Εμφανίζει το κύριο μενού του πίνακα δομής. 

 
⮚  BIM: Εμφανίζει μια δομή βασισμένη σε οντότητες BIM. 

⮚  Διαμόρφωση δέντρου δομής: Ανοίγει το παράθυρο διαλόγου Configure Structure Tree, το οποίο σας επιτρέπει να 

ορίσετε τις διαμορφώσεις του δέντρου δομής. 

⮚  Επιλέξτε Διαμόρφωση...: Σας επιτρέπει να φορτώσετε αρχεία διαμόρφωσης δομικών δέντρων (*.gst). 
 

 
 
 

 
Μενού δεξιού κλικ στον πίνακα δομής: Θα μπορούσατε να ολοκληρώσετε 

λειτουργίες όπως εμφάνιση, απόκρυψη, απομόνωση, ζουμ, επέκταση όλων, 

κατάρρευση όλων και να ανοίξετε τον πίνακα διαμόρφωσης. 

 
 
 
 
 
 
 
 
 
 

 
Διαμόρφωση δέντρου δομής: Επιτρέπει στους χρήστες να καθορίσουν τη 

δενδρική δομή του δομικού πίνακα. 

⮚  Αρχείο: 

⚫  Άνοιγμα...: επιλέξτε για να ανοίξετε ένα άλλο αρχείο διαμόρφωσης *.gst. 

⚫  Αποθήκευση: αποθηκεύει την τρέχουσα διαμόρφωση 

⚫  Αποθήκευση ως: αποθηκεύει την τρέχουσα διαμόρφωση με διαφορετικό όνομα. 

⮚  Ομάδα/Ταξινόμηση 

⚫  Προσθέστε: Προσθέτει ένα νέο κανόνα ή ιδιότητα 

o Επιλέξτε έναν υπάρχοντα κανόνα και, στη συνέχεια, 

κάντε κλικ στο κουμπί Προσθήκη ή κάντε δεξί κλικ και επιλέξτε 

Προσθήκη κανόνα στο μενού δεξιού κλικ. 
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o Ο νέος κανόνας θα προστεθεί κάτω από τον επιλεγμένο κανόνα. 

 
o Κάντε δεξιό κλικ στον νέο κανόνα και επιλέξτε Μετονομασία στο μενού δεξιού κλικ και εισαγάγετε ένα νέο 

όνομα. 
 

o Επιλέξτε τον κόμβο Φίλτρο του νέου κανόνα και, στη συνέχεια, κάντε κλικ στο κουμπί Προσθήκη ή κάντε δεξί 
κλικ και επιλέξτε Προσθήκη ιδιότητας φίλτρου. 

 
o Επιλέξτε τον κόμβο Ομάδα του νέου κανόνα και, στη συνέχεια, κάντε κλικ στο κουμπί Προσθήκη ή κάντε δεξί 

κλικ και επιλέξτε Προσθήκη ιδιότητας ομαδοποίησης. 
 

o Επιλέξτε τον κόμβο Ταξινόμηση του νέου κανόνα και, στη συνέχεια, κάντε κλικ στο κουμπί Προσθήκη ή κάντε 
δεξί κλικ και επιλέξτε Προσθήκη ιδιότητας ταξινόμησης. 

 
o Εμφανίζεται το παράθυρο διαλόγου Select Property (Επιλογή ιδιότητας), επιλέξτε μια ιδιότητα και, στη 

συνέχεια, κάντε κλικ. 

⚫  Διαγραφή: διαγράφει τον επιλεγμένο κανόνα ή ιδιότητα. 

⚫  Μετακίνηση προς τα πάνω: μετακινεί τον επιλεγμένο κανόνα ή ιδιότητα προς τα πάνω. 

⚫  Μετακίνηση προς τα κάτω: μετακινεί τον επιλεγμένο κανόνα ή ιδιότητα προς τα κάτω. 

⚫  Εναλλαγή αρνήσεων: μόνο ιδιότητες φίλτρου 
 

 
⮚  Εμφάνιση/παραλείψεις: 

Μπορείτε να επιλέξετε μια επιλογή και στη συνέχεια να επιλέξετε τους τύπους οντοτήτων που θέλετε να ακολουθήσουν την 
επιλογή που επιλέξατε. 

 

 
⮚  Επιλογές: 

⚫  Η αναπτυσσόμενη λίστα είναι για να επιλέξετε τι θα συμβαίνει στο χώρο του μοντέλου όταν επιλέγονται οντότητες στο 
δέντρο δομής. 

⚫  Τα πλαίσια ελέγχου επιλέγουν τι θα συμβαίνει στο δέντρο δομής όταν μια οντότητα επιλέγεται/αποεπιλέγεται στο μοντέλο. 

χώρο. Οι ακόλουθες επιλογές είναι προεπιλεγμένες: Κατά την επιλογή οντότητας, επιλογή στο δέντρο- Κατά την 

επιλογή οντότητας, επέκταση γονέα στο δέντρο- Κατάργηση επιλογής οντοτήτων κατά την απόκρυψη. 
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Με βάση την εισαγωγή IFC, μπορείτε τώρα να εξάγετε αρχεία IFC και να εισάγετε αρχεία RVT με πλήρη δεδομένα BIM, και η 

ενότητα STEP/IGES θα περιλαμβάνεται στο πρόγραμμα εγκατάστασης του GstarCAD, δεν χρειάζεται να την 

εγκαταστήσετε ξεχωριστά. 

 
17.2. IFCEXPORT 

 

 
Με βάση το IFCIMPORT, μπορείτε τώρα να εισαγάγετε την εντολή IFCEXPORT ή να μεταβείτε στην Κορδέλα  BIM  Εξαγωγή 

αρχείων IFC για να εξάγετε σχέδια σε μορφή IFC με τα πλήρη δεδομένα BIM. 
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Εκτός αυτού, υπάρχει επίσης μια προστιθέμενη μεταβλητή συστήματος για το χειρισμό αρχείων IFC στο GstarCAD: 
 

Μεταβλητή συστήματος Περιγραφή Αξία Αξία Περιγραφή 

 
 

 
SHOWALLIFCENTITIES 

 

 
Ελέγχει την εμφάνιση και απόκρυψη 

οντοτήτων σε αρχεία IFC που δεν 

σχετίζονται με οντότητες κτιρίου. 

 
0 

 

 
1 

Αποκρύπτει οντότητες στο σχέδιο IFC 

που δεν σχετίζονται με οντότητες 

κτιρίου. 

Εμφανίζει οντότητες στο σχέδιο IFC 

που δεν σχετίζονται με οντότητες 

κτιρίων. 

 
 

17.3. RVTIMPORT 
 

 
Μπορείτε να εισαγάγετε την εντολή RVTIMPORT ή να μεταβείτε στην Κορδέλα  BIM  Άνοιγμα αρχείων RVT για να 

εισαγάγετε σχέδια σε μορφή RVT με τα πλήρη δεδομένα BIM. 

 

 

 
17.4. Υποστήριξη αρχείων STEP/IGES 

 
Το STEP (Standard for the Exchange of Product Model Data) είναι ένα διεθνές πρότυπο που θεσπίστηκε από τον 

Διεθνή Οργανισμό Τυποποίησης (ISO) και ορίζει τον τρόπο με τον οποίο οι πληροφορίες για τα προϊόντα αναπαρίστανται και 

ανταλλάσσονται καθ' όλη τη διάρκεια του κύκλου ζωής του προϊόντος. Οι μορφές αρχείων περιλαμβάνουν .step, .stp και 

.ste. 

Το IGES (The Initial Graphics Exchange Specification) είναι ένα γενικό πρότυπο ανταλλαγής πληροφοριών ANSI 

που βασίζεται στα συστήματα CAD (Computer-Aided Design) και CAM (Computer-Aided Manufacturing). Οι μορφές 

αρχείων περιλαμβάνουν .igs ή .iges. 
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Το GstarCAD 2025 υποστηρίζει την εισαγωγή αρχείων STEP/IGES, ενισχύοντας τη δυνατότητα της πλατφόρμας μας για δεδομένα 
τρισδιάστατων μοντέλων. 

 

 
Μπορείτε να μεταβείτε στο λογότυπο του GstarCAD  Άνοιγμα ή στο λογότυπο του GstarCAD  Εισαγωγή  Άλλες μορφές και 

να επιλέξετε STEP/IGES στην αναπτυσσόμενη λίστα Αρχεία τύπου για να ανοίξετε ή να εισαγάγετε αρχεία STEP/IGES. 

Εκτός αυτού, θα μπορούσατε επίσης απλά να εισαγάγετε την εντολή IMPORT, STPIMPORT ή IGSIMPORT. 
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18. Καινοτόμα χαρακτηριστικά 

 

18.1. Βελτίωση γραμμής 
Η επιλογή ANGLE (A) προστέθηκε για την εντολή line, με αυτή την επιλογή μπορείτε να έχετε έναν γρήγορο τρόπο για να 

σχεδιάσετε μια γραμμή χωρίς τη βοήθεια της πολικής ή της xline. Μπορείτε να εισαγάγετε απευθείας την τιμή της γωνίας που 

αναφέρεται στον άξονα Χ, καθώς και να λάβετε άλλη γραμμή ως αναφορά για την εισαγωγή της τιμής της γωνίας, ακόμη και να 

εισαγάγετε την τιμή της γωνίας που αναφέρεται απευθείας στην προηγούμενη γραμμή. 

 

Παράδειγμα πρακτικής: 

 
Για να σχεδιάσετε την κόκκινη γραμμή στην 

Εικόνα 1-1, ακολουθήστε τα παρακάτω 

βήματα: 

1. Εκτέλεση εντολής γραμμής 

2. Καθορίστε το πρώτο σημείο: 

3. Καθορισμός επόμενου σημείου ή [Γωνία/Μήκος/Αναίρεση]:a 

4. Καθορίστε τη γωνία [Αναφορά] <0>:35 (το λογισμικό θα λάβει 

τον άξονα Χ ως αναφορά) 

5. Μήκος γραμμής: 500 

 
Για να σχεδιάσετε την κόκκινη γραμμή στην Εικόνα 1-2, ακολουθήστε τα παρακάτω βήματα: 

1. Εκτέλεση εντολής γραμμής 

2. Καθορίστε το πρώτο σημείο: 

3. Καθορισμός επόμενου σημείου ή [Γωνία/Μήκος/Αναίρεση]:a 

4. Καθορισμός γωνίας [Αναφορά] <0>:r 

5. Επιλέξτε ένα αντικείμενο γραμμής: (Επιλέξτε τη γραμμή αναφοράς) 

6. Καθορίστε μια γωνία: 38 7. Μήκος γραμμής: 500 

 
Για να σχεδιάσετε την κόκκινη γραμμή στην Εικόνα 1-3, ακολουθήστε τα παρακάτω βήματα: 

1. Εκτέλεση της εντολής line (για να σχεδιάσετε τη γραμμή 1). 

2. Καθορίστε το πρώτο σημείο: 

3. Καθορισμός επόμενου σημείου ή [Γωνία/Μήκος/Αναίρεση]: l 

4. Καθορίστε το μήκος: 300 

5. Καθορίστε το επόμενο σημείο ή [Γωνία/Μήκος/Αντιστροφή] (για να σχεδιάσετε τη γραμμή 2): a 

6. Καθορισμός γωνίας [Αναφορά/αναφορά σε 

προηγούμενη/συμπεριλαμβανόμενη γωνία] <0>: p(Εδώ μπορείτε να 

δοκιμάσετε την επιλογή αναφορά σε προηγούμενη, η οποία θα λάβει την 

επέκταση της προηγούμενης γραμμής ως αναφορά) 

7. Καθορίστε μια γωνία: 127 

8. Μήκος γραμμής: 500 

9. Καθορίστε το επόμενο σημείο ή [Γωνία/Μήκος/Κλειστό/Αναίρεση]:a (για να σχεδιάσετε τη γραμμή 3) 

10. Καθορισμός γωνίας [Αναφορά/αναφορά στην προηγούμενη/συμπεριλαμβανόμενη γωνία] <0>: I (Δοκιμάστε την 
επιλογή Included angle) 

11. Καθορίστε μια γωνία: 37 

12. Μήκος γραμμής: 400 
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18.2. Βελτίωση πολυγραμμής 

 
Η επιλογή ANGLE (A) στην εντολή polyline, η συμπεριφορά της οποίας είναι παρόμοια με 

εκείνη της εντολής line, προστίθεται επίσης στην εντολή Polyline. Υπάρχουν ακόμα τρεις 

επιλογές για την επιλογή γωνία, μπορείτε είτε να εισαγάγετε την τιμή της γωνίας που παίρνει τον 

άξονα X ως αναφορά είτε να εισαγάγετε τη γωνία "αναφορά στην προηγούμενη" ή τη γωνία 

"Included angle". Στο λογισμικό CAD, πολλά αντικείμενα αποτελούνται από Polyline, για 

παράδειγμα: ορθογώνιο, πολύγωνο και σύννεφο αναθεώρησης, donut. Τώρα αυτές οι 

λειτουργίες ταξινομούνται κάτω από την αναπτυσσόμενη λίστα Polyline, όπου μπορείτε να 

έχετε γρήγορη πρόσβαση σε αυτές. 

 
 

 
18.3. Ενίσχυση ορθογωνίου 

 
Το OBLIQUE(O) είναι μια νέα πρόσθετη επιλογή για να σχεδιάσετε ένα περιστρεφόμενο ορθογώνιο. Η συμπεριφορά της 

επιλογής oblique είναι παρόμοια με τη συμπεριφορά της εντολής line. Με την επιλογή oblique, μπορείτε να εντοπίσετε τον 

άγγελο της κάτω γραμμής και το μήκος για να λάβετε ένα ορθογώνιο περιστροφής, μπορείτε να σχεδιάσετε ένα ορθογώνιο 

που έχει συγκεκριμένη γωνία με τον άξονα Χ και οριζόντια ή έχει τυχαία γωνία που αναφέρεται σε οποιαδήποτε 

γραμμή. 

 
Παράδειγμα πρακτικής: 

 
Για να σχεδιάσετε το ορθογώνιο περιστροφής στην Εικόνα 1-4, ακολουθήστε τα παρακάτω βήματα: 

1. Εκτελέστε την εντολή RECTANG και εισαγάγετε την επιλογή oblique ή 

κάντε κλικ στο εικονίδιο περιστροφής ορθογωνίου στον πίνακα 

κορδέλας. 

2. Καθορίστε το πρώτο σημείο: 

3. Καθορίστε το επόμενο σημείο ή [Γωνία]: a (επιλογή γωνίας εισόδου) 

4. Καθορίστε τη γωνία [Αναφορά] <0>:20 

5. Εισάγετε πλάτος ορθογωνίου: 800 

6. Εισάγετε ύψος ορθογωνίου: 350 

 
Για να σχεδιάσετε το ορθογώνιο περιστροφής όταν υπάρχει μια γραμμή αναφοράς στην Εικόνα 1-5, ακολουθήστε τα παρακάτω βήματα: 

1. Εκτελέστε την εντολή RECTANFG και εισαγάγετε την επιλογή oblique ή 

κάντε κλικ στο εικονίδιο περιστροφής ορθογωνίου στον πίνακα 

κορδέλας. 

2. Καθορίστε το πρώτο σημείο: 

3. Καθορίστε το επόμενο σημείο ή [Γωνία]a 

4. Καθορισμός γωνίας [Αναφορά] <0>:r 

5. Επιλέξτε ένα αντικείμενο γραμμής: (Επιλέξτε τη γραμμή αναφοράς) 

6. Καθορίστε μια γωνία: 20 

7. Εισάγετε πλάτος ορθογωνίου: 800 

8. Εισάγετε ύψος ορθογωνίου: 350 
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18.4. Ενίσχυση κύκλου 

 
Η επιλογή CONCENTRIC(C) είναι μια νέα προσθήκη στην εντολή κύκλου, μπορείτε να εισάγετε ακτίνα αρκετές φορές για 

να δημιουργήσετε πολλούς ομόκεντρους κύκλους αφού καθορίσετε το κέντρο του κύκλου, με αυτή τη νέα επιλογή, 

μπορείτε να πάρετε ομόκεντρους κύκλους με απλό τρόπο. 

 
Παράδειγμα πρακτικής: 

 
Για να σχεδιάσετε τον ομόκεντρο κύκλο στην Εικόνα 1-6, ακολουθήστε τα παρακάτω βήματα: 

1. Εκτελέστε την εντολή circle και εισαγάγετε την επιλογή concentric 

ή κάντε κλικ στο εικονίδιο concentric στον πίνακα ribbon. 

2. Καθορίστε το κεντρικό σημείο για τον κύκλο: 

3. Καθορίστε την ακτίνα του κύκλου ή [Διάμετρος] <400.0000>:100 

4. Καθορίστε την ακτίνα του κύκλου ή [Διάμετρος/Αποκλεισμός] <100.0000>:200 

5. Καθορίστε την ακτίνα του κύκλου ή [Διάμετρος/Αποκλεισμός] <200.0000>:300 

 
18.5. Βελτίωση αντιγραφής 

 

Υπάρχουν τρεις επιλογές: μέτρο（Ε）, διαίρεση（Ι）, διαδρομή（P）. επιλογές προστίθενται στην εντολή αντιγραφής, ο 

χρήστης μπορεί εύκολα να ολοκληρώσει το σχέδιο χωρίς τη βοήθεια άλλων λειτουργιών, όπως η διαίρεση με τμήμα, με 

απόσταση, συστοιχία ή διάταξη με μονοπάτι στην προηγούμενη έκδοση. 

 

1. measure（E）όταν οι χρήστες πρέπει να αντιγράψουν αντικείμενα με την ίδια απόσταση και την ίδια κατεύθυνση, αυτή η επιλογή θα είναι πολύ 

χρήσιμη. 
 

 

2. Divide（I）, μπορείτε να αντιγράψετε πολλά αντικείμενα με την ίδια απόσταση σε μια καθορισμένη απόσταση. 
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3. Διαδρομή（P）Μετά την επιλογή διαδρομή, μπορείτε να επιλέξετε ξανά την επιλογή διαίρεση ή μέτρηση για να εντοπίσετε τα αντικείμενα 

καταμέτρησης. 

 

18.6. Ενίσχυση περιστροφής 

 
Η επιλογή πολλαπλών αντιγράφων (M) προστίθεται στην εντολή περιστροφής, με αυτή την επιλογή μπορείτε είτε να 

αντιγράψετε πολλά αντικείμενα με διαφορετικές γωνίες περιστροφής είτε να σχεδιάσετε συστοιχία κύκλων. 

Κατά την περιστροφή, μπορείτε να επιλέξετε την επιλογή πολλαπλής αντιγραφής και να εισαγάγετε διάφορες τιμές γωνίας.Το 

λογισμικό θα περιστρέψει και θα αντιγράψει το αντικείμενο σύμφωνα με την τιμή που εισαγάγατε. Μπορείτε να δοκιμάσετε 

να αντιγράψετε και να περιστρέψετε 45, 90, 135 μοίρες που αναφέρονται στο αρχικό αντικείμενο κάθε φορά, όπως το 

ακόλουθο σχήμα. 

 

 
Παράδειγμα πρακτικής: 

Περιστρέψτε και αντιγράψτε τα αντικείμενα στην Εικόνα1-7, τα βήματα όπως παρακάτω: 

1. Εκτελέστε την εντολή: ROTATE 

2. Επιλέξτε αντικείμενο: 

3. Καθορίστε το σημείο βάσης: (Επιλέξτε το κέντρο του ομόκεντρου) 

4. Καθορίστε τη γωνία περιστροφής ή [Αντιγραφή/πολλαπλάσια/αναφορά] <135>: m 

5. Καθορίστε τη γωνία περιστροφής ή [Between/Fill]: 45 

6. Καθορίστε τη γωνία περιστροφής ή [Έξοδος/Ακύρωση]: 90 

7. Καθορίστε τη γωνία περιστροφής ή [Έξοδος/Ακύρωση]: 135 

 
Εάν η γωνία του παρακείμενου αντικειμένου είναι σταθερή, μπορείτε να 

επιλέξετε "γωνία μεταξύ αντικειμένων（B） ή γωνία γεμίσματος（F）", στη 

συνέχεια εισαγάγετε τη γωνία και την ποσότητα, αυτή η επιλογή μπορεί να 
αντικαταστήσει τη σειρά κύκλων. 

 

 
Περιστρέψτε και αντιγράψτε τα αντικείμενα στην Εικόνα1-8, τα βήματα όπως παρακάτω: 

1. Εκτελέστε την εντολή: ROTATE 

2. Επιλέξτε αντικείμενο: (Επιλέξτε το κέντρο του ομόκεντρου) 

3. Καθορίστε το σημείο βάσης: 

4. Καθορίστε τη γωνία περιστροφής ή [Αντιγραφή/πολλαπλάσια/αναφορά] <30>: m 

5. Καθορίστε τη γωνία περιστροφής ή [Between/Fill]: b 

6. Καθορίστε τη γωνία περιστροφής: 60 

7. Καθορίστε τον συνολικό αριθμό των στοιχείων: 4 
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Περιστρέψτε και αντιγράψτε τα αντικείμενα στο Σχήμα1-9, τα βήματα όπως παρακάτω: 

1. Εκτελέστε την εντολή: ROTATE 

2. Καθορίστε το σημείο βάσης: (Επιλέξτε το κέντρο του ομόκεντρου) 

3. Καθορίστε τη γωνία περιστροφής ή [Αντιγραφή/πολλαπλάσια/αναφορά] <60>: m 

4. Καθορίστε τη γωνία περιστροφής ή [Between/Fill]: f 

5. Καθορίστε τη γωνία συμπλήρωσης <360>: 

6. Καθορίστε τον συνολικό αριθμό των στοιχείων: 1 
 
 
 
 
 

 
18.7. Μεγεθυντικός φακός 

 
MAGNIFIER (μια πραγματική εναλλακτική λύση για να αλλάξετε τη συνήθεια να βλέπετε λεπτομέρειες και να σχεδιάζετε το πιο 

σύνθετο σχέδιο με μια ματιά). Αυτό το εργαλείο βοηθάει στην προβολή μιας συγκεκριμένης περιοχής του σχεδίου σας ως 

μεγεθυντικός φακός με τη δυνατότητα εντοπισμού σημείων χωρίς να εκτελείτε μεγέθυνση/σμίκρυνση σε μεγάλα σχέδια όπως 

ο χάρτης ή η τοπογραφία και είναι επίσης πρακτικό στη χρήση και την προσαρμογή. Εξοικονομήστε χρόνο για την 

εξερεύνηση μικρών λεπτομερειών του σχεδίου σας ή ακόμη και για τη σχεδίαση σε μια ζούγκλα διασταυρούμενων 

αντικειμένων εύκολα και γρήγορα. 

 
 

 
1.- Πριν εκτελέσετε την εντολή MAGNIFIER, ας εξηγήσουμε τις ρυθμίσεις της. Στη γραμμή κατάστασης υπάρχει ένα εικονίδιο 

μεγεθυντικού φακού, απλά κάντε δεξί κλικ με το ποντίκι και επιλέξτε την επιλογή > ρυθμίσεις... 
 

 
2.-Στο παράθυρο διαλόγου Ρυθμίσεις σχεδίασης, στην καρτέλα Μεγεθυντικός φακός, θα δούμε διάφορες επιλογές. Ας εξηγήσουμε μία προς μία. 
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Ενεργοποίηση του μεγεθυντικού φακού με το κουμπί κύλισης: Εάν επιλέξετε αυτή την επιλογή, μπορείτε να 

ενεργοποιήσετε/απενεργοποιήσετε την εντολή μεγεθυντικού φακού κάνοντας κλικ στον τροχό κύλισης του ποντικιού. 

Επίσης, το πλήκτρο συντόμευσης Ctrl+E είναι διαθέσιμο για την ενεργοποίηση του μεγεθυντικού φακού. 
 

Στυλ μεγεθυντικού φακού 

 
Περιφέρεια: περιοχή: Όταν ενεργοποιείτε τον μεγεθυντικό φακό, θα μεγεθύνει το σημείο που επιλέγετε από το σχέδιό σας 

εντός του σχήματος του μεγεθυντικού φακού. Ο δρομέας μπορεί να κινηθεί μόνο μέσα στο σχήμα του μεγεθυντικού φακού. 

Μπορείτε να εκτελέσετε ζουμ, να πανοραμίσετε και να σχεδιάσετε αντικείμενα κ.λπ. για να δείτε τις μεγαλύτερες και 

σαφέστερες λεπτομέρειες. 

 
Παράθυρο: Μεγέθυνση: Όταν ενεργοποιείτε τον μεγεθυντικό φακό, δεν θα μεγεθύνει μόνο το μέρος που επιλέγετε, αλλά και 

ολόκληρο το σχέδιο σύμφωνα με τον συντελεστή μεγέθυνσης που έχετε ορίσει. Με το στυλ παράθυρο, ο δρομέας μπορεί να 

μετακινείται μέσα και έξω από το σχήμα του μεγεθυντικού φακού. Οι λειτουργίες, για παράδειγμα μεγέθυνση ή σχεδίαση 

αντικειμένων, δεν θα περιορίζονται στο σχήμα του μεγεθυντικού φακού. 

 
Σχήμα μεγεθυντικού φακού 

Τετράγωνο: Αν επιλέξετε την επιλογή τετράγωνο, ο μεγεθυντικός φακός θα πάρει 

τετράγωνο σχήμα. Κύκλος: Εάν επιλέξετε την επιλογή κύκλος, ο μεγεθυντικός 

φακός θα υιοθετήσει κυκλικό σχήμα. 

Μέγεθος μεγεθυντικού φακού: Μπορείτε να ρυθμίσετε το μέγεθος 

του μεγεθυντικού φακού όπως θέλετε. Έλεγχος εξασθένισης: 

Μπορείτε να ρυθμίσετε το εφέ εξασθένισης του σχήματος μεγεθυντικού 

φακού. 

Συντελεστής μεγεθυντικού φακού: Μπορείτε να ρυθμίσετε τον παράγοντα ζουμ μέσα στο σχήμα μεγεθυντικού φακού. 
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18.8. Κωδικός QR 

 
Ο κωδικός QR (κωδικός γρήγορης απόκρισης) είναι ένας τύπος 

γραμμωτού κώδικα που χρησιμοποιείται για να παρέχει εύκολη 

πρόσβαση σε πληροφορίες μέσω μιας κινητής συσκευής όπως το 

έξυπνο τηλέφωνο ή το tablet. Σε σύγκριση με τον γραμμωτό 

κώδικα, ο κώδικας QR μπορεί να αποθηκεύσει περισσότερες 

πληροφορίες και εφαρμόζεται ευρέως σε πολλούς τομείς, για 

παράδειγμα: αντι-παραποίηση προϊόντων, προώθηση 

διαφημίσεων, σύνδεσμοι στο διαδίκτυο, λήψη δεδομένων, 

συναλλαγή εμπορευμάτων, εντοπισμός θέσης/πλοήγηση, 

ηλεκτρονικά έγγραφα, ανταλλαγή επαγγελματικών καρτών κ.λπ. 

Επωφεληθείτε από τον κώδικα QR για να κάνετε το κείμενο και 

τα χαρακτηριστικά μπλοκ από το σχέδιό σας ανιχνεύσιμα 

χρησιμοποιώντας οποιοδήποτε κινητό τηλέφωνο ή tablet με κάμερα. 

Το μόνο που χρειάζεστε είναι μία από τις πολλές διαθέσιμες 

εφαρμογές ανάγνωσης κώδικα QR για τη συσκευή σας. 

Πληκτρολογήστε QRCODE για να εκτελέσετε την εντολή. 

Υποστηρίζεται επίσης η λειτουργία γραμμής εντολών -QRCODE, 

που διευκολύνει τη δημιουργία κωδικών QR μέσω σεναρίων ή 

προγραμμάτων. 

 

Παράμετροι του QR Code Creator όπως παρακάτω： 

Εισαγωγή: Στην περιοχή εισαγωγής κειμένου, μπορείτε να εισαγάγετε το κείμενο απευθείας ή να επιλέξετε δεδομένα κειμένου 
από το σχέδιο, επίσης μπορείτε να επιλέξετε τα προκαθορισμένα δεδομένα που μπορούν να εμφανιστούν αυτόματα στο 
πλαίσιο εισαγωγής κειμένου. 

Έχει ήδη εισαχθεί:0/500：Εμφανίζει τον εισαχθέντα αριθμό κειμένου και τον μέγιστο αριθμό κειμένου 

εισόδου. Clear：Καθαρίζει όλα τα δεδομένα που εμφανίζονται στην περιοχή εισαγωγής κειμένου. 

Διαλέξτε το αντικείμενο: Μπορείτε να επιλέξετε τρεις επιλογές για την επιλογή αντικειμένων από το σχέδιό σας. 

Κείμενο：Επιλέγει κείμενο από το αρχείο σχεδίασης, το κείμενο θα εμφανιστεί αυτόματα στο πλαίσιο κειμένου εισόδου αφού το επιλέξετε. 

Μπλοκ：Επιλέγει το μπλοκ χαρακτηριστικών από το αρχείο σχεδίασης, προσθέτει την ετικέτα και την τιμή στο πλαίσιο κειμένου εισαγωγής. 

Χρησιμοποιείται πάντα για την επιλογή του 

πληροφορίες της καρτέλας. 

Κωδικός 2D: Διαλέγει τον κωδικό QR από το αρχείο σχεδίασης για να πάρει τις πληροφορίες του κωδικού QR. 

Προεπιλεγμένα δεδομένα： Μπορείτε να προεπιλέξετε δεδομένα, όταν τα δεδομένα είναι απαραίτητα, απλά ελέγξτε την 

αντίστοιχη επιλογή. Οι πληροφορίες θα προστεθούν αυτόματα στην περιοχή κειμένου εισαγωγής. 

Όνομα σχεδίασης: Το όνομα του σχεδίου θα εμφανιστεί στην περιοχή κειμένου εισαγωγής. 

Ημερομηνία και ώρα： Όταν επιλέξετε την επιλογή Ημερομηνία και ώρα, η τρέχουσα ημερομηνία και ώρα θα εμφανιστεί 

στην περιοχή κειμένου εισαγωγής. Παράμετροι του πεδίου "Κοστούμια" όπως παρακάτω： 
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Όνομα> Προσθήκη/Επεξεργασία： Μπορείτε να προσαρμόσετε το πεδίο που χρησιμοποιείται συνήθως, όταν το πεδίο είναι 

απαραίτητο, κάντε κλικ στην αναπτυσσόμενη λίστα για να το βρείτε και να το εμφανίσετε στο πλαίσιο κειμένου 
εισόδου. 

 
Όχι: Εισάγετε τον αριθμό του 
πεδίου. Όνομα: Εισάγετε το 
όνομα του πεδίου. Αξία: 
Εισάγετε την τιμή του πεδίου. 
Προσθήκη: Προσθήκη νέου 
προσαρμοσμένου πεδίου. 
Διαγραφή: Διαγραφή 
προσαρμοσμένου πεδίου. 

Εικόνα: Στο QR Code μπορεί να προστεθεί το 

λογότυπο της εταιρείας ή άλλες σημειωμένες εικόνες. 

Μπορείτε επίσης να περιηγηθείτε σε εικόνες από 

τον υπολογιστή σας, υποστηρίζονται μορφές 

JPG\BMP\PNG\TIF\TGA.etc. 

Διαγραφή： Διαγραφή της επιλεγμένης εικόνας. 

 
Παράμετροι κώδικα QR: Μπορείτε να ορίσετε τις παραμέτρους της εικόνας του κώδικα QR 

πριν την εισαγωγή. Έκδοση：Δημιουργεί κώδικα QR σύμφωνα με τα δεδομένα που έχετε 

εισάγει. Ορίζει την έκδοση του κώδικα QR, ο αριθμός έκδοσης θα προσαρμόζεται ανάλογα με 
την αύξηση του κειμένου. 

Επίπεδο σφάλματος：Επίπεδο σφάλματος για τα παραγόμενα δεδομένα κώδικα QR. 

Μέγεθος：Ρυθμίστε το πλάτος του κώδικα QR. H (30%)\Q (25%)\M (15%)\L (7%): η συμβατότητα της διόρθωσης. 

περίπου 15% σφάλμα δεδομένων. 

Κωδικός：QR Σύστημα κωδικών. Προς το παρόν υποστηρίζουμε τον Code93. 

Κλίμακα：Ρυθμίστε την κλίμακα εκτύπωσης του κώδικα QR, πίσω από την επιλογή κλίμακας βρίσκεται η λίστα 

κλίμακας. Μπορείτε να επιλέξετε την 

κλίμακα που απαιτείται, εν τω μεταξύ, ο κατάλογος κλίμακας μπορεί να υπενθυμίσει στο χρήστη 

τον κώδικα QR που παράγει σχετίζεται με την κλίμακα εκτύπωσης. Τέλος, θα δημιουργήσει 

ως μπλοκ, η κλίμακα που έχετε ορίσει μπορεί να είναι η κλίμακα μπλοκ για να 

διασφαλιστεί ότι ο κώδικας QR μπορεί να εκτυπωθεί σωστά σε διαφορετικές κλίμακες 

εκτύπωσης. 
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Αντιγραφή Barcode: Αντιγράφει έναν υπάρχοντα κώδικα QR από 

το τρέχον σχέδιό σας. 

Αποθήκευση εικόνας: Μπορείτε είτε να χρησιμοποιήσετε 

την εικόνα για να την εκτυπώσετε ή να την εισάγετε σε άλλο 

έγγραφο ή σε σχέδιο CAD. 

Εισαγωγή： Εισάγει τον παραγόμενο κώδικα QR στο σχέδιο ως 

μπλοκ 

Ακύρωση： Ακυρώστε το παράθυρο διαλόγου και αποθηκεύστε τις τρέχουσες ρυθμίσεις, όταν ανοίξετε το παράθυρο 

διαλόγου την επόμενη φορά, θα εμφανιστεί η ρύθμιση που αποθηκεύσατε την τελευταία φορά. 

 
18.9. Barcode 

 
Η τεχνολογία barcode έχει χρησιμοποιηθεί ευρέως σε διάφορους κλάδους. Σε ορισμένες εταιρείες σχεδιασμού, ο γραμμωτός 

κώδικας έχει επίσης χρησιμοποιηθεί στο σύστημα διαχείρισης σχεδίων, που χρησιμοποιείται κυρίως για την αντιστοίχιση 

εγγράφων σε χαρτί και ηλεκτρονικού αρχείου σχεδίων, μόνο με τη σάρωση του γραμμωτού κώδικα στο χαρτί για τον γρήγορο 

εντοπισμό του αντίστοιχου τμήματος στο ηλεκτρονικό αρχείο σχεδίων. 

 

 

Παράμετροι του Bar Code Creator όπως παρακάτω： 

Πλάτος： Ορίστε το πλάτος εκτύπωσης 

γραμμωτού κώδικα. Ύψος： Ορίστε το ύψος 
εκτύπωσης γραμμωτού κώδικα. 

Κλίμακα： Ορίστε την κλίμακα εκτύπωσης γραμμωτού κώδικα, πίσω από την επιλογή κλίμακας υπάρχει η λίστα κλίμακας, μπορείτε να 

επιλέξετε την κλίμακα που χρειάζεστε, 

ο κατάλογος κλίμακας μπορεί να υπενθυμίζει στο χρήστη ότι ο γραμμωτός κώδικας που παράγεται σχετίζεται με την κλίμακα 

εκτύπωσης. Τέλος, ο γραμμωτός κώδικας θα δημιουργηθεί ως μπλοκ, η κλίμακα που έχετε ορίσει μπορεί να είναι η 

κλίμακα μπλοκ για να διασφαλιστεί ότι ο γραμμωτός κώδικας μπορεί να εκτυπωθεί σωστά σε διαφορετικές κλίμακες 

εκτύπωσης. 

Εμφάνιση δεδομένων： Ελέγξτε αν θα εμφανίζονται τα δεδομένα κάτω από τον γραμμωτό κώδικα. 

Μέγεθος： Εάν η επιλογή "Εμφάνιση δεδομένων" είναι ενεργοποιημένη, μπορείτε να ορίσετε το ύψος των δεδομένων. 

Κώδικας：Σύστημα κωδικών ράβδων. Προς το παρόν υποστηρίζουμε τον Code93. 

Προεπισκόπηση: Εμφανίζει την εικόνα του γραμμωτού κώδικα και την εισαγωγή δεδομένων. 

Πλαίσιο εισαγωγής δεδομένων：Μπορείτε να εισαγάγετε απευθείας δεδομένα γραμμωτού κώδικα, επίσης μπορείτε να κάνετε κλικ στο σπόρο για να 

δημιουργήσετε γραμμωτό κώδικα. 

Seed： Δημιουργία δεδομένων γραμμωτού κώδικα με τυχαίο αλγόριθμο. Κάντε κλικ στο κουμπί "σπόρος", τα δεδομένα γραμμωτού κώδικα θα  
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δημιουργηθούν τυχαία και εμφανίζεται απευθείας στο παραπάνω πλαίσιο εισαγωγής δεδομένων. 

Μήκος： Ορίστε το μήκος των δεδομένων γραμμωτού κώδικα. Υπάρχουν δύο τρόποι: ο ένας είναι ο έλεγχος του μήκους 

των δεδομένων που εισάγονται χειροκίνητα και παράγονται τυχαία. Ο άλλος είναι ο έλεγχος του μήκους δεδομένων που 

παράγεται τυχαία, ελέγξτε τον "σπόρο" πριν ενεργοποιήσετε αυτή τη ρύθμιση. Pick： Διαλέξτε κείμενο ή γραμμωτό κώδικα. 

Εάν επιλέξετε τα δεδομένα, θα λάβετε μόνο τα δεδομένα που εμφανίζονται, αλλά εάν επιλέξετε τον γραμμωτό κώδικα, θα 
λάβετε τις πληροφορίες για το πλάτος, το ύψος και την αναλογία του γραμμωτού κώδικα και τα δεδομένα 

 

Αποθήκευση εικόνας： Αποθηκεύστε τον γραμμωτό κώδικα σε εικόνα μορφής BMP, μπορείτε να χρησιμοποιήσετε την εικόνα 

είτε για εκτύπωση είτε για εισαγωγή σε άλλο έγγραφο ή σε σχέδιο CAD. 

Εισαγωγή： Ορίστε τον γραμμωτό κώδικα που δημιουργείται ως μπλοκ και πάρτε το αριστερό κάτω μέρος του γραμμωτού 

κώδικα ως σημείο βάσης. Μπορείτε να εισαγάγετε τον γραμμωτό κώδικα στο αρχείο σχεδίασης μέσω του σημείου 
εισαγωγής με την κλίμακα που έχει οριστεί προηγουμένως. 

Ακύρωση： Ακυρώστε το παράθυρο διαλόγου και αποθηκεύστε τις τρέχουσες ρυθμίσεις, όταν ανοίξετε το παράθυρο 

διαλόγου την επόμενη φορά, θα εμφανιστεί η ρύθμιση που αποθηκεύσατε την τελευταία φορά. 

 
18.10. Συμμετρική κλήρωση 

 
Δεν έχει σημασία αν πρόκειται για τη βιομηχανία AEC ή MFG, υπάρχουν πολλά συμμετρικά σχήματα σχεδίασης. Ο συνήθης 

τρόπος για να φτιάξετε ένα συμμετρικό σχήμα είναι να σχεδιάσετε το πρώτο μισό του σχήματος και στη συνέχεια να πάρετε 

ένα άλλο συμμετρικό μισό με αντίγραφο ή καθρέφτη. 
 

 
Είναι δυνατή η άμεση σχεδίαση συμμετρικών σχημάτων με το εργαλείο Symmetric Draw. Όταν σχεδιάζετε το πρώτο μισό, 

λαμβάνετε αυτόματα ένα άλλο μισό. Ο προεπιλεγμένος άξονας συμμετρίας είναι ο άξονας Χ, αλλά ο χρήστης μπορεί να 

καθορίσει τον άξονα Υ ή οποιαδήποτε γραμμή στο σχέδιο ως αναφορά στον άξονα συμμετρίας. 
 

Οι χρήστες μπορούν εύκολα να ενεργοποιήσουν/απενεργοποιήσουν αυτό το εργαλείο κάνοντας κλικ στο κουμπί Symmetric 

Draw στη γραμμή κατάστασης. Παρεμπιπτόντως, το εργαλείο Symmetric Draw υποστηρίζει όλες τις εντολές σχεδίασης του 

GstarCAD. 
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Εξερεύνηση των συμμετρικών ιδιοτήτων σχεδίασης 

Κάντε δεξί κλικ στο κουμπί Symmetric Draw στη γραμμή κατάστασης και επιλέξτε την επιλογή Settings (Ρυθμίσεις). Θα εμφανιστεί το παράθυρο 
διαλόγου Ρυθμίσεις σχεδίασης. Τώρα 

ας εξερευνήσουμε τις ιδιότητες στην καρτέλα Symmetric 

Drawing. Ενεργοποίηση συμμετρικής σχεδίασης: Ενεργοποιεί το 

εργαλείο συμμετρικής σχεδίασης εάν είναι επιλεγμένο. 

Επιλογή συμμετρικού άξονα: Μπορείτε να επιλέξετε τον άξονα 

X, Y ή έναν προσαρμοσμένο άξονα για να ξεκινήσετε να 

εργάζεστε. 

Υποστηριζόμενα αντικείμενα: γραμμή, κύκλο, ορθογώνιο, 

πολύγωνο, ακτίνα, πολυγραμμή, έλλειψη, τόξο, xline και 

spline αντικείμενα που μπορούν να σχεδιαστούν ως 

συμμετρικό σχήμα. 

Επιλογή όλων/ Διαγραφή όλων: Μπορείτε να επιλέξετε ή να 

καταργήσετε την επιλογή όλων των υποστηριζόμενων 

αντικειμένων ταυτόχρονα. 

 

 
Επίδραση συμμετρικού άξονα 

Επιλογή άξονα X: Τα αντικείμενα που 

σχεδιάζονται θα λαμβάνουν το σύστημα 

συντεταγμένων Χ ως αόρατη γραμμή άξονα. Το 

αποτέλεσμα της επιλογής X Axis είναι η 

αντανάκλαση των σχεδιασμένων αντικειμένων 

προς τα πάνω ή προς τα κάτω σύμφωνα με τη 

θέση προέλευσης του συστήματος 

συντεταγμένων X. 

 
 
 
 

 
Επιλογή άξονα Y: Τα αντικείμενα που σχεδιάζονται θα λαμβάνουν το 

σύστημα συντεταγμένων Υ ως αόρατη γραμμή άξονα. Το 

αποτέλεσμα της επιλογής Y Axis είναι η αντανάκλαση των 

σχεδιασμένων αντικειμένων στη δεξιά ή αριστερή πλευρά 

σύμφωνα με τη θέση προέλευσης του συστήματος 

συντεταγμένων Y. 
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Επιλογή Custom/Pick Axis: Τα αντικείμενα που σχεδιάζονται θα 

λαμβάνουν τον διανυσματικό προσανατολισμό ενός 

επιλεγμένου αντικειμένου ως ορατή γραμμή άξονα. Το 

αποτέλεσμα της επιλογής Custom/Pick Axis 

(Προσαρμοσμένος/Προσαρμοσμένος άξονας) είναι η 

αντανάκλαση των αντικειμένων που σχεδιάζονται σύμφωνα 

με τον προσανατολισμό διανύσματος ενός επιλεγμένου 

αντικειμένου, είτε είναι κεκλιμένος, κάθετος ή οριζόντιος. 

 

 
Pick Symmetric Axis: Στη γραμμή κατάστασης, εκτός 

από το κουμπί Symmetric Draw βρίσκεται ένα άλλο 

κουμπί που ονομάζεται Pick Symmetric Axis. Η 

λειτουργία αυτού του κουμπιού είναι ίδια με τις 

επιλογές Custom και Pick Axis. 

 

 

18.11. Outline Objects Η 

εντολή OUTLINE είναι μια 

άλλη 

καινοτόμο εργαλείο του GstarCAD. 

Αυτό το εργαλείο επιτρέπει την 

εξαγωγή του σχήματος 

περιγράμματος των επιλεγμένων 

κλειστών αντικειμένων με τη 

μέθοδο επιλογής παραθύρου. Αυτό 

το περιγεγραμμένο σχήμα είναι 

στην πραγματικότητα ένα 

πολυγραμμικό αντικείμενο που 

δημιουργείται στο τρέχον επίπεδο με 

το οποίο εργάζεστε. 

 
Για παράδειγμα, χρησιμοποιήστε αυτό το εργαλείο για να εξαγάγετε το περίγραμμα ενός ορόφου φυτείας για να υπολογίσετε 

αργότερα το συνολικό του εμβαδόν ή για να σχεδιάσετε την οροφή του. 

Παρατήρηση: AutoXLSTable, CAD Table to Excel, Text Incremental Copy, Statistics Summation, Text on line, GstarCAD 

Tools, Drawing Compare, Drawing Lock, Batch Purge, κλπ. Ανατρέξτε στον οδηγό εργαλείων express. 
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18.12. Πίνακας περιοχής 

 
Η περικλειόμενη περιοχή και το αντικείμενο μπορούν να 

επισημανθούν ως αριθμός ή περιοχή και ο πίνακας περιοχής 

μπορεί να δημιουργηθεί ταυτόχρονα. Τα δεδομένα 

περιοχής μπορούν να εξαχθούν σε αρχείο κειμένου ή πίνακα. 

Οι τιμές στον πίνακα μπορούν να αλλάζουν αυτόματα όταν 

αλλάζει ο αριθμός ή το μέγεθος της περιοχής. 

Βήματα για τη χρήση του Πίνακα Περιοχής 

1. Κάντε κλικ στο "Express Tools">"Area Table" με τη σειρά. 

2. Αναδυόμενο παράθυρο διαλόγου "Πίνακας περιοχής". 

3. Κάντε κλικ στο "Pick Point" ή στο "Select Obj" για να επισημάνετε την περιοχή. 

4. Εάν έχετε επιλέξει το "Generate Table" (Δημιουργία πίνακα), πρέπει να καθορίσετε τη θέση του πίνακα ή τον πίνακα που θα προστεθεί. 

5. Κάντε κλικ στη διαθέσιμη συντεταγμένη σημείου για να μεταβείτε απευθείας στην επόμενη διαδικασία. Ή επιλέξτε τον 

διαθέσιμο πίνακα υφιστάμενης περιοχής για να εισέλθετε στην επόμενη διαδικασία. 

6. Αφού δημιουργηθεί ή επιλεγεί ο πίνακας, η περιοχή μπορεί να ενημερωθεί αυτόματα με τις επιλογές "Pick Point" ή "Select Obj". 

 
18.13. Αυτόματη στρώση 

 
Προκαθορίζει τη συσχέτιση μεταξύ του τύπου 

αντικειμένου και του επιπέδου που πρέπει να 

σχεδιαστεί σε ένα σχέδιο. Το σύστημα αλλάζει 

αυτόματα την τρέχουσα στρώση κατά τη 

σχεδίαση του γραφήματος και σχεδιάζει το 

γράφημα στην καθορισμένη στρώση. Εάν το 

καθορισμένο στρώμα δεν υπάρχει, το σύστημα 

θα δημιουργήσει αυτόματα αυτό το στρώμα με 

βάση τις ρυθμίσεις. 

Σχετικά με το παράθυρο διαλόγου 

Αυτόματη στρώση Λίστα 

αυτόματης στρώσης: 

Εμφανίζει το όνομα της εντολής και τις αντίστοιχες ρυθμίσεις αυτόματης 

στρώσης. Δημιουργία μιας ρύθμισης στρώματος: 

Δημιουργήστε μια νέα ρύθμιση στρώματος που περιλαμβάνει το όνομα της εντολής και τις 

αντίστοιχες ρυθμίσεις στρώματος. Διαγραφή ρυθμίσεων στρώματος: 

Διαγραφή μιας ή περισσότερων επιλεγμένων 

αυτόματων ρυθμίσεων στρώματος. Ενεργοποίηση 

αυτόματης στρώσης: 

Αφού επιλέξετε αυτό το πλαίσιο ελέγχου, το λογισμικό μπορεί να εκχωρήσει αυτόματα το επίπεδο με βάση τις ρυθμίσεις κατά τη σχεδίαση, εάν δεν 

ελεγχθεί, δεν λειτουργεί. 

Αποθήκευση ρυθμίσεων: 

Αποθηκεύστε τις τρέχουσες ρυθμίσεις 

σας σε ένα αρχείο κειμένου.  
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Φόρτωση ρυθμίσεων: 

Διαβάστε το αρχείο ρυθμίσεων που έχει αποθηκεύσει ο χρήστης και διαβάστε τις 

ρυθμίσεις στο παράθυρο διαλόγου. Διαγραφή ρυθμίσεων: 

Διαγραφή όλων των τρεχουσών ρυθμίσεων αυτόματης στρώσης. 

Παρατήρηση: οι τρέχουσες ρυθμίσεις λειτουργούν μόνο για το σχέδιο που επεξεργάζεται τη δεδομένη στιγμή. 
 
 

 
18.14. Αύξηση χαρακτηριστικών 

 
Η επιλογή Αύξηση χαρακτηριστικών μπορεί να 

ταξινομήσει και να αυξήσει την τιμή του 

χαρακτηριστικού του μπλοκ χαρακτηριστικών με 

το ίδιο όνομα σύμφωνα με τον τρόπο που έχετε 

ορίσει. Η τιμή της ιδιότητας του μπλοκ 

χαρακτηριστικών τροποποιείται με βάση την τιμή 

ταξινόμησης. Για παράδειγμα, η τιμή 

χαρακτηριστικού του αριθμού άξονα αυξάνεται 

με τον τρόπο που έχει οριστεί. 

Παράθυρο διαλόγου Σχετικά με την 

αύξηση χαρακτηριστικών Αυτόματη 

αύξηση 

Όλες οι αναφερόμενες ιδιότητες του επιλεγμένου μπλοκ αυξάνονται αυτόματα, το οποίο αντιγράφεται, εισάγεται, 

διαγράφεται στο γράφημα και ο αριθμός της ιδιότητας ενημερώνεται αυτόματα. Όταν η επιλογή "ATTINC" είναι 

ενεργοποιημένη, εφόσον το σχέδιο δεν είναι κλειστό, κατά την αντιγραφή, την εισαγωγή και τη διαγραφή του μπλοκ στο 

σχέδιο, ο αριθμός της ιδιότητας μπορεί να ενημερωθεί αυτόματα. 

Αυξήστε το select: 

Επεξεργάζεται μόνο το επιλεγμένο μπλοκ και η ιδιότητα του επιλεγμένου μπλοκ αυξάνεται με τη σειρά δημιουργίας. 

 
Επιλέξτε ένα μπλοκ: 

Κάντε κλικ στο κουμπί "Επιλέξτε το μπλοκ" και μπορείτε να επιλέξετε ένα μπλοκ από τα γραφικά και να αποκτήσετε το όνομα του μπλοκ. Εάν δεν 
υπάρχει 

στο μπλοκ που πήρατε, και στη συνέχεια ζητήστε: Το επιλεγμένο μπλοκ δεν έχει χαρακτηριστικά. Και πρέπει να το 

ξαναπιάσετε. Μπλοκ: 

Επιλέξτε ένα μπλοκ στη λίστα μπλοκ. Εάν δεν υπάρχει κανένα χαρακτηριστικό στο μπλοκ που επιλέξατε, τότε ζητήστε το: Το 

επιλεγμένο μπλοκ δεν έχει χαρακτηριστικά. Και πρέπει να επιλέξετε ξανά. 

 
Επιλέξτε το χαρακτηριστικό που θέλετε να αυξήσετε: 

Επιλέξτε τις ετικέτες που θέλετε να αυξήσετε. Εάν το μπλοκ έχει μόνο ένα χαρακτηριστικό, τότε το μοναδικό χαρακτηριστικό θα 

επιλεγεί αυτόματα. Αν όμως το μπλοκ έχει περισσότερα από ένα χαρακτηριστικά, τότε θα εμφανιστούν όλα τα χαρακτηριστικά 

και μπορείτε να επιλέξετε ένα ή περισσότερα χαρακτηριστικά για αύξηση. Παράμετρος: 

Αύξηση: 

Η τιμή του χαρακτηριστικού του επιλεγμένου μπλοκ αυξάνεται κατά την τιμή 

προσαύξησης. Προσθήκη αναλογίας: 

Προσθέστε την ίδια τιμή προσαύξησης στον αριθμό προσαύξησης ή στο γράμμα της τιμής του 

χαρακτηριστικού στο μπλοκ χαρακτηριστικών. Λειτουργία αύξησης: 



Κεφάλαιο 18_ Καινοτόμα χαρακτηριστικά 
 

Σ ε λ ί δ α  279 | 296  

 

Ακολουθούν 3 τρόποι αύξησης: Αύξηση κάθε αριθμού, Αύξηση του τελευταίου αριθμού και Αύξηση του πρώτου αριθμού. 

Η προεπιλεγμένη επιλογή είναι Αύξηση του τελευταίου αριθμού. Εάν υπάρχουν αριθμοί στο τέλος, οι αριθμοί αυτοί 

αυξάνονται συνολικά. Εάν επιλέξετε Αύξηση του πρώτου αριθμού και υπάρχουν αριθμοί στο πρώτο, αυξάνονται και αυτοί ως 

σύνολο. Εάν επιλέξετε Increase every number (Αύξηση κάθε αριθμού), κάθε αριθμός στην τιμή του χαρακτηριστικού 

αυξάνεται. 

Αριθμός αύξησης: 

Ο προεπιλεγμένος αριθμός είναι "1" και μπορείτε να τον τροποποιήσετε εάν χρειάζεται. 

 
Ταξινόμηση: 

Ορίστε το είδος της προσαύξησης ως εξής: Από αριστερά προς τα δεξιά, Από πάνω προς τα κάτω και Η διαδρομή της 

καμπύλης. Η προεπιλεγμένη ταξινόμηση είναι Draw Order, μπορείτε να επιλέξετε άλλες ταξινόμηση. 

Εάν επιλέξετε Η διαδρομή της καμπύλης, το σύστημα θα σας ζητήσει να επιλέξετε μια καμπύλη.Η καμπύλη μπορεί να είναι μια 

καμπύλη ή μια πολυγραμμή που τέμνει το επιλεγμένο μπλοκ και να ταξινομηθεί σύμφωνα με τη σειρά του σημείου που 

βρίσκεται πλησιέστερα στο σημείο εισαγωγής κάθε μπλοκ χαρακτηριστικών στην καμπύλη. Εάν όλα τα σημεία είναι ως το 

ίδιο σημείο, τότε σύμφωνα με την απόσταση μεταξύ κάθε σημείου εισαγωγής του μπλοκ χαρακτηριστικών και της 

καμπύλης για την ταξινόμηση. 

Αρνητική ακολουθία: 

Αντιστρέψτε την παραπάνω σειρά. 
 
 

 
18.15. Θέα από το μοντέλο 

 
Δημιουργεί ένα παράθυρο προβολής στο χώρο διάταξης 

επιλέγοντας αντικείμενα στο χώρο του μοντέλου. Και στη 

συνέχεια υπολογίζει το μέγεθος του παραθύρου προβολής 

σύμφωνα με την καθορισμένη αναλογία και εντοπίζει το 

παράθυρο προβολής στο χώρο διάταξης. Μπορείτε να 

δημιουργήσετε και να ορίσετε γρήγορα ένα παράθυρο 

προβολής των γραφικών. 

 
Βήματα για να χρησιμοποιήσετε το Viewport από το μοντέλο 

1. Στο χώρο σχεδίασης 2D. Κάντε κλικ στο "View">"Layout Viewport" με τη σειρά. 

2. Καθορίστε το πρώτο γωνιακό σημείο και το διαγώνιο σημείο. 
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Εκτάσεις: EXTMIN και EXTMAX στο χώρο του μοντέλου. Όταν οι τιμές EXTMIN και EXTMAX είναι ίδιες ή λανθασμένες, η 

επιλογή "Extents" δεν εμφανίζεται. 

Οθόνη: Σχεδιάζει το πεδίο που εμφανίζεται στο χώρο Model (Μοντέλο) αυτή τη στιγμή. 

Όρια: Λήψη της τιμής των μεταβλητών LIMMIN και LIMMAX του συστήματος. στο χώρο του μοντέλου. 

Όταν λαμβάνεται ένα πεδίο σφάλματος, το παράθυρο προβολής δεν δημιουργείται και εμφανίζεται η ένδειξη "Το πεδίο για τη δημιουργία του 
παραθύρου προβολής απέτυχε". 

3. Επιλέξτε τη διάταξη που θέλετε να δημιουργήσετε 

Αφού επιλέξετε το πεδίο εφαρμογής, το σύστημα θα σας ζητήσει να επιλέξετε τη διάταξη που θέλετε να δημιουργήσετε. 

-Εάν η εντολή εκτελείται στο χώρο διάταξης, το παράθυρο προβολής δημιουργείται απευθείας στο χώρο διάταξης της εντολής. 

-Εάν η εντολή εκτελεστεί στο χώρο Μοντέλο, εμφανίζεται το παράθυρο διαλόγου για να επιλέξετε τη διάταξη. 

4. Καθορίστε το σημείο εισαγωγής στο παράθυρο προβολής 

-Μετά τον ορισμό της διάταξης, μεταβείτε αυτόματα στην επιλεγμένη διάταξη και καθορίστε το σημείο εισαγωγής του παραθύρου προβολής. 

-Μπορείτε να εισαγάγετε συντεταγμένες ή να κάνετε κλικ σε ένα σημείο για να ορίσετε τη θέση του παραθύρου προβολής σε ένα γραφικό παράθυρο. 

-Μετά τον ορισμό της θέσης, το υπολογισμένο παράθυρο προβολής δημιουργείται στην καθορισμένη θέση κ α ι  το παράθυρο 

προβολής κλειδώνει. 

 
18.16. Ελεύθερη κλίμακα 

 
Η εντολή FREESCALE σας επιτρέπει να κλιμακώσετε ένα αντικείμενο ή μια ομάδα αντικειμένων χωρίς περιορισμούς με 

τρεις μεθόδους: Μη ομοιόμορφη, Ορθογώνια και Ελεύθερη. 

Μη ομοιόμορφη κλίμακα: Η κλίμακα των αξόνων Χ και Υ μπορεί να εισαχθεί ξεχωριστά. 

Κλίμακα Rect: Μπορείτε να κλιμακώσετε ένα γραφικό ώστε να ταιριάζει με ένα ορθογώνιο πλαίσιο. Το ορθογώνιο δεν 

χρειάζεται να σχεδιαστεί, απλώς καθορίστε δύο διαγώνια σημεία. 

Ελεύθερη κλίμακα: Μπορείτε να μετακινήσετε ή να αντιγράψετε και να κλιμακώσετε τα γραφικά σε ένα κλειστό τετράπλευρο 

πλαίσιο σε ένα άλλο κλειστό τετράπλευρο πλαίσιο, το οποίο μπορεί να χρησιμοποιηθεί για τη δημιουργία του μοτίβου των 

γραφικών κλίσης ή της προοπτικής παραμόρφωσης. 

 

 
Μάθετε περισσότερα καινοτόμα χαρακτηριστικά από: https://www.gstarcad.net/help/GstarCAD_2025_en-US.html 

https://www.gstarcad.net/help/GstarCAD_2025_en-US.html
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19. Συνεργασία 

 

 
Το GstarCAD 365 είναι ένα ισχυρό εργαλείο πολλαπλών πλατφορμών που έχει σχεδιαστεί για να ενισχύει την 

αποδοτικότητα της ομάδας στην προβολή σχεδίων, τη διαχείριση έργων, την επικοινωνία και τον συνεργατικό σχεδιασμό. Οι 

επιχειρήσεις μπορούν να επιλέξουν μεταξύ της ανάπτυξης Public Cloud ή Private Cloud βάσει συγκεκριμένων αναγκών. 
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